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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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When you invoke the application, the Sign In screen is displayed.
oRAcLE: B O

Financial Services Lending and Leasing

sign In
Please enter userid and passviord

*User1d

Password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

1.4 Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

141 Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
o Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

oy I ©

 Origination
> Servicing
> Collections
> WFP

> Tools

> setup

You can view the application version details and copyright information by clicking About link
at the right corner of the screen.

be errorfree. Ifyou find any errors, please reportthem o us i wrting.

behaf of the U.S. Government, the follwing nofce is

i any inherenty
appications

abity for

acte Corporation and s
Oracle Corporation and fs

ur access 1o or use o third-party cor

[x] Close

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

Change Password

m  UserInfo i

— Change Password — Click to change the current password.
=~ A [ e O

vt
-
L v

Il!il
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Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone  JSER TIME ZONE v
Division US01 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDYA Company US/CENTRAL (CENTRAL STANDARD
) st Branch Time TIME)
Responsibility SUPERUSER e
GL Post Date 02/10/2016 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|3 Submit | 3E Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on := List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

DashBoard 3 System Monitor [3] Close
Batch Jobs  Jobs | Services Database Server Log Files | Parked Transactions | Users A
Database Server Log Files
View v Format~ Freezz i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 lob 5706 02/18/2016 06:14: 11 AD »
ALERT lob 395 02/22/2016 03:59: 16 AN_|
CSYPRC_EN_100_01 DB12C_3794335 lob 6390 02/22(2016 04:53:00 AP =
CSVPRC_EN_100_01 DB12C_3854338 lob 116750 02/22/2016 05:36:42 A}
JSYPRC_EN_000_01_DB12C_2094362 lob 5708 02/18/2016 10:57:09 AP =
e = ‘ :
r
File Content
View = Format v Freeze & Detach &l Wrap o0} 7 Beginning @) End  # of Lines ' 50 [E] show File
Text i
0
o cmnsyp_cl_000_D1.get_syp parameter value value: weblogic
o

: 45:FLL:1v_use BI::¥ [
cunsyp_cl_| get_syp parameter value value: http://ofss2221142.in.oracle.com:.

cmnsyp_cl_ .get_syp_parameter_value valus: http://ofss2221142.in.oracle.com:

emnsyp_cl_

cunsyp cl 000 Ol.get syp parameter value parameter: JSV BI USER
J5V_REPORT_ARCHIVE_DIRECTICRY
JSV_REPORTS_SERVER_TIMECUT

1.get_syp parameter value value: /scratch/work area/DEV/QA143REL/r.. |~
cmnsyp cl_000_0l.get syp parameter_value parameter

o oo oo

: cmnsyp_cl_000_01l.get_syp_parameter value parameter:

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug
details.

Time Zone Level - Select the time zone preference as User/Company Branch/
Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of
this user manual.

Click Submit to save the changes or Close to close the screen without changes.
e Accessibility — Click the link to view accessibility features of the system.
Refer accessibility document for further details.
e Sign Out — Click the link to sign off from the application. You can also click on
icon to sign off from the application.
Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and < to collapse them.

> DashBoard
> Origination
Servicing
Eles 5
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions

m

Account Documents d
Collateral Management
Reparts
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions -
> Collections
> WFP
» Tools

> Setup
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To open a screen, navigate to Module Master Tab to which the screen belongs, expand the

tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is

displayed in the main window/work area.

ORACLE’
Financial Services Lending and Leasing

A @8 | Access

Appiication Documents (Crigination)

»» Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

Application Retrieval(Criginator) Data | Sceen | Reports || Correspondence | Transaction

Asset Types(Setup Products) —

Account Documents(Servicng) e Freese Efipetadh
Beess e ey d Organization Division

AP Transactions(Servicng Interfaces) e ot

Applcation Entry(Origination) e e

Audit Tables{Setup System) B B

Advances(Servicing Batch Transactions) = e

Company Branch Alowed

AL
AL
AL
AL

(3] Close:

add | ZEdt | Fvien || o Audit

ALL
ALL
AL

i
2
Y
AL Y

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,

you need to clear the data in the search field.

Right Window

The Right Window can also be termed as work area. When you click the screen link on left

pane, system displays the corresponding screen in the right pane.

RACLE
Financal Services Lending and Leasing

Sales Lead x

/'Le;aknl’l’v Follow-up | Maintenance
g Fresze

Applicant Information

> DashBoard

L-00003002 121772015

Te
CAR/MOBILE PHONE

a0 | P | Elwew || & avae

HowE UNITED STATES

e |[ Z e ][ Blyew || o aui

Phone Current
(0015323123 ¥

ORACLE



You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

ORACLE"
Financial Services Lending and Leasing
el

| Auount Dowuments || Collatel 1 x| Revortsse | Puod Abva Panets x| F P Tiarsact GLTiamadtivns x
2 Edt || Elview || & avsie
hecker © maker O both @
honz=d o comments
Reuwiied

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Applications at the same time as separate tabs in the right
window, provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'
in MENU_ACCESS table.

le

Having this option enabled you can view and update a maximum of 15 Applications in parallel

tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Origination Module Master
Tab. In the Left Menu of Origination Module Master Tab, you can open multiple applications
by clicking on the following links. Each successive click, opens a new Origination tab.

e Simple Application Entry
e Application Entry

e Underwriting

e Funding

ORACLE'
Financial Services Lending and Leasing

a‘| Origination % || Origination s | Crigination x | Origination x (36 Clos=
Search/Task | Funding: 0000001010 | Revien Requests (Pendng: 0) -
> DashBoard
T Application: 0000001010: MILLEN JOHN Elvew | o Audt
i = Frezze [fiDetach ¢ W v
pro— View = Format B ity P W overide ok jarning OK MANUAL Contract
Origination Sta Producer Contact =
ot App = Sub Unit Status c:::a OnSEEE producer Name me:: OMEL eicting Customer  Dupiicate Application Contact £
impie Appication Entry
07/28/20%5 0000001010 UNDEFINED APPROVED - FUND... FUNDED MN-00004:SOUT... (6124512211 N 2
Applcation Entry = = — .
Underwriting
Funding
Applcation Retrieval
oo Ay Summary | Applicant | Request | Decsion  Contract | Collatersl | Comments | Tracking || Document | Verification || Correspondence | Tools
Applcation Documents
Image Maintenance Applicant
Reports
Producers Applicant
Vendors < Relation Type FirstName Last Name Birth Dt Oun /Rented
3] prIMARY J0HN MILLEN o7f17/1991 UNDEFINED
Ratios
Ratios
Grade Score What IFPmt Amt Assets Amt Lisbiites (3 Net-Warth Amt
> 0 0.00 0.00 0.00 0.00
Bureau
> servicing
> Collections Bureau
S Gpen Auto
> WFP Burezu Repart Name FICO Score Tradeines * AutoTradelines = PPV E BIP Notices (IFE)  Type ot
> Tools Hee CREDIT REPORT ... JONATHAN JENKINS 53 B E [ 0 MANUAL 07/26)
> Setup i . b
Copyright © 1998, 2016, Oradle and|or its affiiates. Al rights reserved. About
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Few screens in Origination are identical and are linked. Hence, when multi tab option is not
enabled, you can open only one screen at a time from the group. A sample of the grouping
structure is given below, based on stages of the screens:

Origination:
e Simple Application Entry
e Application Entry
e Underwriting
e Funding

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.
Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |:to toggle the view of Right Splitter/Action Window.

Origination Screens
In Origination > Application screens, you can use the Right Splitter/Action Window to do the

ORACLE" ) ) 3 Welcome, VAVAIDVA +  pccessivitty  ENETEIGN] ©
Financial Services Lending and Leasing
fose
e Origination x 3L
. Search/Task | Funding: 0000000378 Review Requests (Pending: 0)
origination '9: L 5 Quick Search
Application: 0000000378: TIFFANY RUSSEL / GRACE B view | o auit B

Vieww Format~ B 1] Freeze i Detach wap | @) OvemdeOK ¥ WamingOK ¥

Origination Stage

uplicate
oo Contact:

ou %
Applicaton S sibmit [ @ cea
01/01/2012 0000000378 UNDEFINED /APPROVED - FUNDED FUNDED GA-00004 : ADVANCE LEA. N N

Pre
3 app Sub Unit Status Producer Name Co Evisting Customer
i

» Summary
Requested  Approved
1500000 15,000.00
8.9900 49900
36 3

Summary | Applicant | Request || Decision || Contract | Collateral | Comments | Tracking | Document || Verfication | Correspondence | Tools

Vendors

> Applicant

‘ > Ratios

» Bureau
Queue FUNDED APPLICATIONS QUELE
b Checklist Change Status

Status APPROVED - FUNDED

Collateral

Collateral
Asset Type SubType Primary  Year Hake Model Hileage Hew Wholesale Value
~ Servidng VEHICLE car # 2012 CHEVROLET MONTE CARLO on 10,000.00

> Collections Tie v

3 Sub v
RWER. Trade-Tn ™

* Comment

Add Comment
= Alert

> Tools

> Setup Trade-In

e Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

e Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

e Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

e Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
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Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

ORACLE'

Financial Services Lending and Leasing

P — [=])

> DashBoard

> Origination

Servicing

> Collections
> WP

> Tools

> Setup

Customer Service x

Search | G : v :0)

Account(s): 20120200010231: YUTAKA OZAKA / AKANE
View mat v Freeze i Detach

Branch Sub Unit Account & Product
20120200010231  LEASE VEHICLE

USRL UNDEFINED

story | PmtModes | Bankuptcy | Repo/For

Alerts Conditions
Alerts Conditions

Alet Condition
o data to displ: LIEN DATA CHANGE

Account Details Other Information

Dues Collateral Information

01/10/2015 12/1072014 11/10/2014 10/10/2014
0 0.00 2012 MERCEDES E300 4DR

Delg Due 000 Total bue 0.00 Future Pt 02/10/2015 <
oo o Customer Information

Lcoue 000 Todays
NSF Due 0.00 Payoff D\dz:(m; 02/10/2015 [ustume‘r Name

OtherDue Futue 000 p

s Di 040 Payoff 000000... OZAKA A YUTAKA

Amt paid 0.00
Bicess

D00D00... AKANE B YUTAKA

Future 01/03/2016
Payoff Date

Delinquency Information

Lte 30 & %0 20 1m0 1w
o 0 0 o 0 0 0
BP(Lie) 0 NSF(Life) 0 Collector GIRI
BP(Year) 0 NsF{vear) 0
Activities

Adtive Dt 11/01/2012 App# 0000000590 LastPmtAmt 224576
12/24/2015  paid Off Dt chi
Fifective Dt 021102012

Address Information

Start Dt Followup Dt
02/10/2016 02/10/2018

Identification = ear  Asset Class
2GaWSSIISII0621 2012 MEW

Relation ssi
PRIMARY Socs003140
SPOUSE oc00-3399

[ Close

Quick Search
hccs

Customer 1d
ssh
entiication #
[B submit | | @ Clear
Queue/ Condition v
Auto Run
[ et Account

Add Comment

= Alert

Type REGULAR A

Hrostcomment | [ & o
Add call Activity
= Acton -
*Rest -
Contact -
Reason -
B
Time Zone v

Group Follovup_
rocallacty | | @ dlear

‘Copyright © 1998,2015, Ora

e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click =u to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.
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1411

Time Zone Preference

Oracle Financial Services Lending and Leasing %
User Info
Organization DMC Time Zone |JSER TIME ZONE v
Division S0 Level
First Hame VARSHA User Time Zone UNDEFINED
Last lame VAIDYA Company US/CENTRAL (CENTRAL STANDARD
Branch Time TIME)

Responsibility SUPERUSER Zone

G Bost Lere IR 20 Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)

Session Language DEFAULT b skin Family Skyros (Default) il

Debug Enabled Ind

DE Submit || ¥ Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e In the Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone'is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.
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To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

1.4.2 Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘Sea\ch Customer Service: 20120200010231 Pmewﬂeque:t‘\?endmg:0)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE Ely\w.' o Audit

View Formatv (5 Freeze fDetach | ¢ Wrap W & @ curent O ShowAll O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
Uso1 USR1 UNDEFINED 2012020010231 LEASE VEHICLE 0 USD. 0.00 0.00 ACTIVE 02/10/2015

‘Eunr\'al‘f Customer Service  Account Details | Customer Details | Transaction History | Pmt Modes =~ Bankmuptcy | RepojForeclosure | Deficiency | Collateral | Bureau C\u::,‘bpSEHAftmliE:‘

‘CallAdi\lilies Maintenance ~ Comments Promises = Checdists Tracking Attributes ~ References  Correspondence  Letters  Document Tracking

Call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Adtion Result Contact Reason Cancel Promise Dt Promise Amt. Condition Appointr Follovup D Time Zone Adj Followup Dt Cor
AT PH ANSWERING MACHINE N 12/30f2015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
AT P ANSWERING MACHINE N 123002015 1,000.00 NONE N 127302015 12/29/2015 12:30:00 P

b

You can click # to view the hidden tabs, if any.

1.5 Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations
e Basic Actions
e Personalization Options

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
e Edit
e View
e Audit

e add | A Edit | S view | o Audit
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1.5.2

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation

Description

Add

Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit

Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View

Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit

Click to view audit info. If an audit is set for a field, then the system
tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close

Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

E Save and Add

E Save and Stay

E Sawve and Return

{3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.
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The summary screens consist of the following navigations. The table below gives a snapshot
of them:

Basic Actions Description

Click to navigate to the first record.
')

Click to navigate to the previous record.

= [F[E

Click to navigate to the next record.

Click to navigate the last record.

A

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|ﬁ' Download File - Click to download the details of selected data.

1.5.3 Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl
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The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View’.

M Format ~ | [&p Freeze pfiDetach

Columns ’ Show Al

|  Freez= + Product |
Detach + Description |
Sort v ¥ StartDt
Reorder Columns... + End Dt

+ Direct
+ Enabled

Query By Example

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...

Format Click to resize columns or wrap a data in the table cells.
| =
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column =

Column DESCRIPTION

width | 100 ] [Pixels  [=]
OK. Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View » Format’ Freeze i Detach o1l Wrap 0
¢ i i G| B [
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.
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Options Description

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

loan | lne | lemse
Product Definition dhadd | SEdt | Even | of audt
vew - [ | © | Mrrece gtococr | QM| @ vewrodct st copy
I I I I I I (CredtBureau
ot et Jenao [prea Fxive Repayment Enabled Jocdateraype  |cotatera subype [hedtBuens |
W oanse LOANHOME (R)  pij01/1500 12/31/3000 ¥ ¥ 12 "HOME COLLATERAL  REAL PROPERTY HOM INSTALLMENT
LOAN SECURED
Loans6 12/31/4000 N N v HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT
Loanam (R NSECREDR 1511500 12/31/4000 v v ¥ UNSECLRED COLLATIUNSECLRED INSTALLMENT
Loanve LOANVEHICLE ()1 b1/01/1800 12731/42000 N v v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MoP1 wopL 3/08/1863 12/31/4000 v N v VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT
MURABAHA B povse 031372013 v N v HOME COLLATERAL  REAL PROERTY HON INSTALLMENT
nDs1 NORM DSER 3/11/1853 1273174000 v N ¥ UNSECLRED COLLATIUNSECLRED ISTALLMENT
o1 et 1017201 12/31/4000 v N 2 HOME COLLATERAL REAL PROPERTY HOMMORTGAGE

Click to refresh the data in the table.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the

contents on the screen as is without scroll bars. This button is available along with other

options in the Action block. Clicking on this provides a browser print functionality and a new

tab is opened where the print content is displayed.

Detach

oRACLE
Financial Services Lending and Leasing

Close
e L3 customerservee ¢ e
 Origination Search | G 2 quest (Pending: 0) %
Servicing
Senvcing Account(s): 20120200010231: YUTAKA OZAKA / AKANE Bl view | «2 Audt
Ctboics: Sl Viewv Formatw [5 Freeze 5 Detach o wrap W & @ curent O ShowAll C* Group Follow-up
Secuitization Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due Dt
Transaction Authorization usot Usk1 UNDEFINED 0120200010231 LEASEVEHICLE 01D 000 0.00 ACTIVE 02j10/2015
Post Date Cheds
SronTeaoe Summary | Customer Service | Account Details | Customer Details Transaction History | PmtHodes || Bankruptey | RepojForeclosure | Deficency | Collateral | Bureau | CrossUp el Actvities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes  References Corespondence  Letters Document Tracking
Repoits
Producers i i
Veridors Transaction Batch Information P add | AEdt | B view | o Auit
Batch Transactions View~ Formatv [ Freeze 5 Detach Wrap o Frrost [ vod
Adnies Date Honet Transaction status Batch
Payments 021072015 'ADD CUSTOMER ADDRESS PHONE POSTED N
Fees oot v TERMINATE ERROR ]
Iterfaces 01/06/2016 v TERMINATE vom N “
P Trancact QUSDILE EXTENSION vom "
Detached Table %
View~| Format v [ Freeze [[EBetadh vap @ ot [5hvoid
Date Wonetary Transaction Status Batch
02/10/2016 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/06/2015 Y TERMIATE von ]
01/06/2016 Y EXTENSION o N
12124/2015 Y PAYOFF QUOTE LEASE POSTED N
View~ Formatv [ Freeze Gl Detach wep @
> Collections Transaction Processing Details
>wee ||| | W= Direct Record Update, Transaction Posting Successful **++%
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can

either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

e Drop-down list — Provides the selection option. You can either select a record from the

list or enter first alphabet of the required value.
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e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

ORACLE" 71 Welcome, VAVATOVA +  accessibility ©
Financial Services Lending and Leasing

ustomer Service x. Close.
> DashBoard Gt =
» Origination Semg]| G 8
Servicing
sening Account(s): 20151200010012: MADHU BOBBURT Elview | o2 audit
Customer Service 54 Freeze & @ current O show All © Group Follow-up
Securtization Branch + Days Past Due Curency Pay Off At Amount Due Status Oldest Due Dt
Transaction Authorization uskg 0010012 LOANVEHICLE (FR) 210 S031881 EECEN CTivE:DEL Q:NON PERFO.. [STTEUTS
s
e Summary | Customer Service | Accourt De ory | Pt Modes || Bankrupkcy | RepolForedos g0 T =
Cullseal Morogerent Gall Adtvities | Maintenance | Comments || Promises | Cheekists || Tracking Attributes || References || Correspondence || Letters [ Zsaarch ]
. . ® all O Ay
Transaction Batch Information ad || Z it | [Eiew | F nudt
View v Formatv [ Freeze EfiDetach ¢l wrap 5] S post [ vaid
Date Vonetary Transaction ACCOUNT 1
Payments vt Trareso
o a2f0j206 ¥ P [ search: Transactdl
e q 01/2572016 N ACCOUNT SUBUNTT TRANSFER o
Interfaces 01/22/2016 N ACH VAINTENANCE " iyt Search Basi
AP Transactions o1/07/2016 " ACH ONE TIME PHONE PA T o v o ey
e s b, deiald ADIUSTMENT; Match @
6L Transactions /152015 ¥ ADIUSTMENT TO ADVANCE / PRINCIPAL - ADD

Casa Recondliation Tun Code

Conversion Accounts | Description
n

Transaction Batch Information
Reset | | AddFields || Reorder

Date 02/10/2016
* Monetary @)

Parameters

> Collections View » Fomat~ | [ Freeze if Detach Wrap w

: ::5 No data to display.

RaSetup Result v

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu Do this
Basic Click ‘Basic’ for normal search.
Advanced Click ‘Advanced’ for advanced search. In this mode, you can select

the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual
ones.

| * Channel | WEB ENTRY = * Producer Name [
NY-02 : PR : HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR e 1
MR-UUUUL U TEST-UUL ALUJUNTAS U ]
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.
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1.6 Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1. Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

2. Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

4. Arrow Keys to hover within the drop-down list.

1.6.1 Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom

level.
Shortcut Action
Ctrl++ To increase zoom level.
Ctrl+- To decrease zoom level.
Ctrl+0 To set zoom level to default level.
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1.7

1.8

1.8.1

1.8.2

1.8.21

Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Application

A UDFIED
s ponts B

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled. You can set the
accessibility preferences after login. On the landing screen using 'Accessibility’ link on the
right end of the header set the following preferences as required

Screen Reader

Screen reader provides assistance to the visually impaired users. It interprets the screen
elements by reading them aloud.

High Contrast

High contrast feature increases contrast level to make the screen more appealing for the
reader with low vision.

Large Fonts

Large fonts feature increases font size to ensure clear display and appropriate spacing. This
benefits the reader with low vision.

For Visual Challenges

The visual challenges varies widely, however it generally includes, blindness, low vision or
color blindness. To make the application more accessible, following features are provided.

Blindness:

In order to interpret the visual display information in the audible form, Screen reader
compatibility is provided.
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1.8.2.2

1.8.2.3

1.8.3

1.8.3.1

In places where Screen reader technology cannot obtain information from images, text
equivalents for images are provided.

For Users with difficulty in using mouse, since it requires hand and eye coordination,
Keyboard navigation is provided. Details of keyboard navigation is provided in ‘Section 1.8.3.2
Keyboard Compatibility’.

Low vision:

For Users who cannot view the content that has small font size and cannot be enlarged,
Software magnifier is provided to enlarge text and images beyond normal font enlargement.

Also, there is no information presented using attributes such as depth, size, location, font etc.

For high contrast requirements Screen setting can be adjusted.

Color blindness:

Oracle Accessibility guidelines have been followed and hence accessibility issues relating to
color blindness are addressed.

Also, high contrast colors have been used to address difficulty in identifying shades of colors.
For example, Black text in white background.

For Hearing Challenges

People with hearing challenges or hard of hearing might encounter problems accessing the
information presented using sounds. Some application features minimize their concerns.

Visual representations of audible information is provided so that Users with this challenge do
not miss information presented using audio.

For Age-related Challenges

Apart from the above, there can be aging issues like week eye-sight or hearing.

Issues related to weak eyesight can be addressed through Application features for Visual
Challenges provided in ‘Section 1.8.2.1 For Visual Challenges’.

Issues related to hearing can be addressed through Application features for hearing
challenges provided in ‘Section 1.8.2.2 For Hearing Challenges’.

For Users who are less familiar with computers, the simplified user interface with easy
navigation options, uniform layout and design and commonly used terminology in the
application is of great advantage.

To address issues relating to understanding complex information, User manuals are provided
for online help and tool tips at all required places are provided. In addition, system messages
like error, warning or information helps you through.

Other Accessibility Considerations

Documentation Accessibility

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics
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1.8.4

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate

Setting up Accessibility Preferences

You can setup or change the accessibility preferences.

To edit accessibility settings

1. Click Accessibility in the header part of application. The system displays the following
screen:

Oracle Financial Services Lending and Leasing *
| Accessibility Preferences
Edit Accessibility Settings

Any setting made is saved until changed here again.' : 'Any setting must
be made for each browser session,

[T screen reader

[FLarge fonts

E[E Submit $2 Cancel

2. Select any or all of the required options to edit or change the accessibility settings.

3. Click Submit.

Note

You need to define the required Settings for each browser session and defined settings
are saved until next modification.
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2.1

2. Search Function

Oracle Financial Services Lending and Leasing allows you to search for an account, customer
or application using specific search criteria. Since this section details the general search
options available in the User Interface, some or all the parts of this section are applicable to
you as per access provisions & licensing. The following sections explain the Search options
in detail.

Search Criteria

Search criteria has a list of parameters which enables to query the application / account from
the database by providing one or more parameter values. There are 15 parameters whose
values can be specified in combination with comparison operators which are described in the
table below. The Reset button enables to clear the comparison values for a fresh search.
Apart from this, Search can also be performed using wild card characters.

ORACLE P — [=]
Financial Services Lending and Leasing

Customer Service 5 [E3k=
Search | Customer Service | Review Request (Pending: 0)
> Quick Search

Search Criteria

& Reset Critenia || @8 Search
View+ Formatv  [EH| MFresze ifivemch | o wrap [e0)

e =]
Lixe ] =
LIKE ~
EQU [~
LIKE [~
Like =2
EQUAL =
Like I~
Lixe =
Eau [~
LIKE ~]

e ~]

LIKE [~

Lixe ]

LIKE ~l

ke = =
) Lixe ~1

ke

<

Search Results
View + Format~ | B Frocze i Dotach oo | @R
> Collections Company Branch Account F Date Titke Product Status AopeenY  Amount Due
> WP Mo data to displar.
- <
> Tools
> Setup

Description | Example Expression

LESS THAN | APPLICATION DATE < 01/22/2002

Result: The system searches for all applications created before Jan.
22, 2002.

LESS THAN | APPLICATION DATE <= 01/22/2002

gg EQUAL Result: The system searches for all applications created on or before
Jan. 22, 2002.

EQUAL APPLICANT SSN = 111-22-3333
Result: The system searches for all applications with applicant social
security number 111-22-3333.

NOT APPLICANT SSN <> 111-22-3333

EQUAL

Result: The system searches for all applications except those with an
applicant whose social security number is 111-22-3333.
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Description | Example Expression

GREATER APPLICATION DATE > 01/22/2002

THAN Result: The system searches for all applications created after Jan. 22,

2002.

GREATER APPLICATION DATE >= 01/22/2002

THAN Result: The system searches for all applications created on or after
OR EQUAL | Jan. 22, 2002

IN ACCOUNT NUMBER IN (20001000012512°, <20010100012645°,
£20010300012817)

IN is used with values that are within parenthesis.

Result: The system searches for the applications with the account num-
bers of 20001000012512”, <20010100012645”, and 20010300012817.)

NOT IN ACCOUNT NUMBER NOT IN (‘20001000012512°, 20010100012645°,
€20010300012817)

NOT 1IN is used with values that are within parenthesis.

Result: The system searches for all applications except those with the
account numbers of 20001000012512°, <20010100012645°, and
120010300012817°.)

IS VIN IS NULL

IS is only used with a value of “NULL”. It enables you to search for crite-
ria that has no value; that is, fields where no information is present.

Result: The system searches for all applications without a vehicle iden-
tification number.

ISNOT VIN IS NOT NULL

ISNOT is only used with a value of “NULL". It enables you to search for
criteria that has any value; that is, fields where information is present.

Result: The system searches for all accounts with a VIN, vehicle identi-
fication number.

LIKE ASSET TYPE LIKE VEH%

LIKE enables you to search for close matches using wildcard charac-
ters.

Result: The system searches for all applications with asset type begin-
ning with the characters “veh” such as “vehicle car” or “vehicle van.”

NOT LIKE ASSET TYPE NOT LIKE VEH%

NOT LIKE enables you to search for close matches using wildcard
characters.

Result: The system searches for all applications with asset type other
than those starting with the characters “veh.”

Using Wildcard Characters

e Wildcard characters can only be used with the operator LIKE and NOT LIKE.
e % (percent) represents any number of characters, including no characters.
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e _ (underline) represents any single character.

Using Criteria Value

Search criteria values of 1234% will locate character strings of any length that begin with
“1234” for example,

e 1234ACB
e 12345678
e 1234

o 12348

e 12340980988234ABIL230498098

Search criteria values of 1234_ will locate character strings of five characters that begin with
“1234” for example,

o 12345
e 1234A
e 12340

Search criteria values of %1234 will locate character strings of any length that end with
“1234” for example,

e 1234
e 01234
e (098908LKJKLJLKJI000988071234

Search criteria values of _1234 will locate five character strings that end in “1234” for
example,

e A1234
e 11234

Search criteria values of %1234% will locate character strings of any length that contain
“1234” for example,

e 1234
e 01234
e 12340

e AKJLKJ1234128424

Search criteria values of _1234_ will locate character strings of 6 characters that contain
“1234” for example,

e A1234B
e 012341
e A12341

Using Search Criteria examples

Result: The system searches for all applications with application date May 1, 2001.

Criteria Comparison Operator Value
APPLICATION EQUAL 05/01/2001
DATE
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Criteria Comparison Operator Value
APPLICATION DATE EQUAL 05/01/2001
APPLICATION NUMBER | GREATER THAN OR EQUAL 0000000278

Result: The system searches for all applications with application date May 1, 2001 and an

application number greater than or equal to 0000000278.

Criteria

Comparison Operator

Value

FIRST NAME

EQUAL

JAN

Result: The system searches for all applications with applicant whose first name is “JAN”

e JAN ARBOR
e JAN FISHER

Criteria

Comparison Operator

Value

FIRST NAME

LIKE

JAN%

Result: The system searches for all applications with applicant’s first name starting with “JAN”

e JAN ARBOR
e JAN FISHER

e JANE MEYERS
e JANETTE NORDSTROM

ORACLE



Application Status

While you are searching for an application in the Origination screens, the Search Result/
Task tab lists all the available applications and also the status of each application for edits.
The following table indicates the application status:

ORACLE’ s AKRRAQ v Accessibility o
Financial Services Lending and Leasing

AT Origination (] Close
‘Origination SeardﬂTask Application Entry: 0000001023~ Review Requests (Pending: 0)
-
;;;:ZGS'S‘E:::;” ey App # 0000001537 ssN Identification # B submit
Undernriting
Funding Queue [] | BB Next Application
Application Retrieval
Scenario Analysis » Search Criteria
Application Documents
Image Maintenance ﬂ' New Application L:} Open Application @ View Application ‘Unlock Application
Reports
Producers Search Results/Task
Vendors Viewv Fomaty [ Feze Hiveach | dwep @) vewAl M
Critical Locked  Allowsd  Company Branch App # Datz Tite Product Status Sub Status
e o1 USHQ 0000001023  12/12/2015 CHODA PHANINDRA [... LEASE VEHICLE APPROVED FUNDED
0 UsoL UsHQ 0000 12/14/2015 MADHU BOBBURI | BA... LOAN VEHICLE (FR) NEW BLANK i)
@ uso1 USHQ 093 06/01/2015 HONEYSINGH YOYO LEASE VEHICLE APPROVED FUNDED
@ usot UsHQ 56 12/15/2015 BOND JAMES LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ UsoL UsHQ 62 02/02/2016 55AM LOAN VEHICLE (FR) APPROVED FUNDED
1 @ usoL UsHQ 08/01/2015 HOOD MARK LOAN VEHICLE (FR) NEW REVIEW REQUIRED
@ Usot UsHQ 5 01/04/2016 KABADE KIRAN LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL USHQ 02/02/2016 VANKAYA JOGAIAH LOAN VEHICLE (FR) APPROVED VERIFYING
@ usoL UsHQ 94 12/19/2015 MARTINEZ ANDRES / A... LINE HE (FR) APPROVED VERIFYING
@ UsoL UsR1 58 02/01/2012 LEWISJERRY [ JEAN LOAN VEHICLE (FR) APPROVED FUNDED
%) UsoL UsHQ 03/01/2012 JONATHAN RYAN / JUL... LOAN VEHICLE (FR) APPROVED FUNDED
%] NLOZ NLRI 04/01/2012 GARCIA PETER [ SHAR... LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 70 05/01/2012 WALKER SIDNEY / SAM_. LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsR1 01/01/2012 FLOWER ANDY / JEAN  LOAN VEHICLE (FR) APPROVED FUNDED
@ usoL UsHQ 01/01/2012 TIFFANY RUSSEL/ GR.. LOAN VEHICLE (FR) APPROVED FUNDED
@ usot USHQ 02/01/2012 TOLMAN GREG | EVA LOAN VEHICLE (FR) APPROVED AUTO APPROVED
@ usoL UsR1 03/01/2012 STANDFORD MICHEAL.. LOAN VEHICLE (FR) APPROVED FUNDED v
@ UsoL UsR1 04/01/2012 SAXTON MARTIN / CH... LOAN VEHICLE (FR) APPROVED FUNDED
< >
» Servicing
» Collections
> WEFP
> Tools
» Setup

Description | Example Expression

CRITICAL Whenever any application is updated with dealer comments, a system
generated alert will be posted in the application and a critical icon would
be displayed in this column against that application. Once User has
acted on the critical item, the alert flag should be manually be
unchecked by the User to remove the 'Critical' flag on the application.

LOCKED An application already opened by another User will have a lock icon in
this column against the application. User with appropriate privileges can
unlock the application and proceed.

ALLOWED This field displays whether you can open the application from the
respective Origination Screen or not i.e. if the application is in decision
stage, a red flag will be displayed in Application Entry stage indicating
that the application can only be viewed and User has to open the appli-
cation in Underwriting for actioning. User can also see a green flag in
Underwriting against this application indicating that it can be actioned in
Underwriting.
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2.2

2.21

Searching for an Application

Oracle Financial Services Lending and Leasing allows you to search and retrieve a particular
application.

During application entry, queues can be created based on your user id and your user
responsibility. You can view the assigned queues in the Origination screen of DashBoard.

ORACLE’ . ; " & Welcome, PRAKRRAQ ~  Accessibility o
Financial Services Lending and Leasing
o
e DashBoard 5 [] Close.
DashBoard
DashBoard Origination Setup Admin
Users Productivity
System Monitor My User Queues Product Expiring in Next One Month Critical Batch Job Status
Producer Analysis Description Count Froduct End Date Baich Job Status
Process Files No data to display. No data to display. No data to display.
My Pending Review Requests By Applications
App % Friority
No data to display.
My Pending Review Requests By Priority
Priority Count
No data to display.
R Servicing Producer Vendor
Number of Queues Hard Assigned
A Producers Count By Status Vendors Count By Status
Queus Description Count
e i by Status Count Status Count
ACTIVE 2 ACTIVE 35
Number of Accounts L o
Queue Description e, Producers Expiring in Next One Month Vendors Expiring in Next One Month
No data to display. Producer End Date Company Name End Date
No data to display. No data to display.
My Pending Review Requests By Accounts
AcE Priority
No data to display.
P GmEston My Pending Review Requests By Priority
Priority Count v
> Servicing No data to display.
> Collections
> WFP
> Tools
> Setup

In each stage of application, the queue name to which the selected application is assigned,
appears in Queue name field in Result screen.

You can begin processing the applications in the order in which they are listed. Select the
record and click Submit.

Search/Task tab

To view the Search/Task screen during Loan origination

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2-6 ORACLE



Depending on the task to be performed and the link clicked, the respective screen opens
in the Search Results/Task screen.

ORACLE’
Financial Services Lending and Leasing

jinati Close
e Origination » 7}
Origination Search[Task Application Entry ~ Review Requests (Pending: 0)
Quick Search
Simple Application Entry . N B - =
Application Entry App # SSN Identification 2 [ submit
Underwriting
Funding Queue [~] | [ next Application
Application Retrieval
Scenario Analysis * search Criteria
Application Documents.
Image Maintenance P New application | | [J) Open application || 5] view application Unlock Application
Reports.
Producers Search Results/Task
Vandars View~ Format~ R freeze [fiDetach | ol wrap W viewan [
Crit Loc Allo Company Branch App # Date Title Product Status Sub Status Qu
No data to display.
< >
Columns Hidden 1
“
> Servicing
> Collections
> WFP
> Tools
> Setup

2. Click the Search Criteria tab.

ORACLE"
Financial Services Lending and Leasing

Origination

PashAoard

SenrchfTack | Applicarion rriry || Review Requests (ending: 0)
> Quick Search
Search Criteria
& Reset Criteio || @ Search
view ~ rormat~ | [ [DFresze EiDstacn | ofl wrap @
& ~]
Critaria Comparissn Opsrator S valve
Ve EQuUAL

<

EQuAL L~
TSI = =S
[ET3 =3 =
Line ~ =l
ik =
Bt =
e 1
ke L]
e 3]
ke &
ke L]
ke =
[ET =1

i =
ke <1

@ New appiicarion | | (O anen anpticarion | | (5] wiew appiicanon Linieck applicaion
Search Results/Task
View ~ Format~ [ Frecze  {iff Detach 0 wrap @ veewan O
. Branh A et Titke Product Statea Suls Status au

> Servicing
> Collections.
> wre

> Tools

> Setup

The search tab enables you to locate an application using a broad range of search criteria.

e During Loan origination, the results are sorted according to the priority of application and
application identification number. However you can sort the records using any criteria.

e If you try to open an application which is already opened by another user, system
displays an alert message indicating “Application is locked by <User Name> Phone
<phone number>".

The Search Results/Task screen.

3. On the Results screen, select the application you want to load and click Open
Application.
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2.2.2

The system loads the application on the respective screen.

ORACLE
Financial Services Lending and Leasing
R Close
DashBoard Origination EE
Origination Search/Task | Application Entry: 0000001537 || Review Reauests (Pending: 0) ~
Application: 0000001537: RODRIGUEZ ROBINSON Bl iew || 2 audit
View v Format~ | P Frecze [ Detach Wrop Override OK ¥ Warning OK v
Origination Stage Producer Contact 5 Duplicate
ot App = Sub Unit Status i Producer Name  FTOdUCE! Bxisting Customer  DUBICALE Contact
0s/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H.. (818)-761-2277 N N
2>
Summary || Applicant || Business || Request | Dedision || Contract | | Gallateral || Comments || Tracking || Document | | Verification || Correspondence || Toals
Vendors > Applicant
> Ratios
> Bureau
4
“«
» Checkdist
Collateral
Collateral
Asset Type Sub Type Primary  Year rake Model Mileage New Wholesale Volue  Retail
VEHICLE car ¥ 2015 Aupr A oy 12,000.00 13,500
< >
Trade-In
Trade-In
Asset Type Asset Sub Type Description Identification Year Make Model BaseRetail Amt  Addons
> Servicing VEHICLE 2015 DODGE RAM... 3GCPCRECSEG145196 2015 DODGE RAM PICKUP 2500  5,300.00 200.00
verICLE 2012 CHEVROLET .. 3GCPCRECSEG145647 2012 CHEVROLET camaro 1,600.00 0.00
> Collections < >
> WFP
> Tools
> Requested -
> Setup

You are now ready to begin work on the application.

Quick Search section

Quick Search enables to search for an application using any one of the following values -
Application Number, SSN, Identification Number or Queue.

To load an application using the Quick Search section:

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. Inthe Quick Search section’s App # field, specify the application number you want to load
and click Submit.

You can also load the application by specifying the last 4 digits of the SSN Number. System
retrieves only those applications where the searched SSN is of the Primary Applicant. If
multiple matches are found, system displays an error message as ‘Multiple Matches found for
the SSN, Please use normal Search’.
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Note

Search cannot be performed using wild card characters in the Quick Search section.

ORACLE
Financial Services Lending and Leasing

Queue ~1 | B Next application

Search Results/Task
i Format+ B Freere i netach wean T viewan O
ny = Title

> Servicing
> Collections
> WEP

> Tools
> Setup

The system loads the selected application.

To load an application from a queue during application entry

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Origination master tab.

2. In the Quick Search section’s Queue field, select the queue you want to work with and
click Next Application.

2.2.2.1 Other Features on the Results screen

The Results screen on the Applications screen has below listed common features (these
features are not present on the Result screen on Customer Service screen):

What is it? What does it do?

View All If you select View All check box, all applications in the system acces-
sible with your user id appear in the Results screen under search sec-
tion.

Queue Name This display only field indicates the queue in which the selected appli-
field cation is currently in. (This in normally related to one or more of the
following, based on setup: producer, state, or status.)

Secured box Indicates that the selected application is secured (that is, that the
applicant is an employee of the organization) and may only be loaded
by authorized users.

Copy Applica- | Creates a copy of the selected application. This feature is usually
tion button used when an applicant has submitted a previous application or when
an applicant submits a second application and you don’t want to
retype the information.

New Applica- | Opens a screen where a user can create a new application by provid-
tion ing required details.
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2222

What is it? What does it do?

Open Applica- | Displays the application details for the selected application.
tion

Unlock Appli- | Unlocks the selected application locked by another user.
cation

Copying an Application

Once the application clears the pre-qualification edits successfully, it moves to the
underwriting queue. In the Underwriting/Funding screen, you can copy the information of an
existing application into a new application. using Results screen. The new application will
contain duplicated data of application information, the requested Loan information, credit
bureau data, and collateral information. The new application will have status/sub status as
NEW - REVIEW REQUIRED.

To copy an application

1. Open the Underwriting/Funding screen and use Quick Search screen to locate the
application you want to copy.

2. Select the application you want to copy on the Search Results/Task screen.

3. Click Copy Application.

ORACLE . . . 2 Welcome, PRAKRRAQ v Accessibility o
Financial Services Lending and Leasing

— Origination 5 (39 Gose

‘Originatis

(@ Information
Application copy successful. New application # success
Search/Task = Underwriting: 0000001537 ~ Review Requests (Pending: 0)
Quick Search

pp # | DDDODO1537 £ Identification # [ subm

Queue [~] | BB Next Application
©» Search Criteria

3 Open Application | | [E] wiew Application | | % inkock Application | § [i5] Copy Application

Search Results/Task
View~ Format~ P Frecze Gt Detach Wrap W viewar

Crit Loc Allo Company Branch App # Date Title Froduct Status Sub Status Qu
No data to display.

* Servicing
> Collections
> WFP

> Tools

> Setup

An Information message is displayed as “Application copy successful. New application # (new
application number).”

System creates a new application with details of the copied application with status NEW -
REVIEW REQUIRED. The new application can be accessed from the underwriting screen
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irrespective of whether it is copied in Underwriting/Funding screen. The system also notes

that this is a copied application with a system generated comment.

ORACLE" . . & Welcome, PRAKRRAO ~  Accessibility o
Financial Services Lending and Leasing
tginath Close
e Origination x 7]
Origination Search/Task  Underwriting: 0000001533  Review Requests (Pending: 0)
‘Onigination
SelesLead Application: 0000001533 SIGG MARK Zedt | Evew | o aude
simple Application Entry _—
Application Entry View - Format~ [ Freeze i Detach Wrap W overrideok v Waming Ok v
Undenwriting Origination Stage Producer Contact 3 Duplicate
i Dt App # Sub Unit Status Code Producer Nama N Existing Customer application ‘Contact
Apglication Retrieval 05/05/2015 0000001533 REJECTED - AUTO.. NEW CA-00003 : ACE H... (B18)-761-2277 N N
Scenario Analysis < >
Application Documents
Image Maintenance
Reports Summary | Applicant || Business | Request| Decision  Bureas | Collstersl Comments | Tracking | Document | Verification || Comespondence | Tools
Producers
Vendors
Comments
add || [ saveandstay | [ save and Retum || Ca Retum
View v Format~ [ Freeze (i Detach 1l Wrap @
Alert Type Sub Type ‘Comment Comment By Comment Dt
O REGULAR [v] | LOAN GRIGINATION [v] PRAKRRAQ 02/04/2016 04:35:38 AM
‘
DECISION_MULTI_OFFER LETTER GENERATED, ~ i
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: INTERNAL 02/01/2016 08:33:04 AM
CNLNCE_DEC_MULTIOFFER_FAX_VR JOB REQUEST 1D: ¥
'CONTRACT_FUNDING LETTER GENERATED.
O SYSTEM GENERATED SYSTEM GENERATED (CORRESPONDENCE: CNLNCE_CON_LTR_VR 3OB REQUEST VEROUTHU 01/30/2016 12:30:35 AM
1D: 41039)
DECISION LETTER GENERATED. (CORRESPONDENCE:
O SYSTEM GENERATED SYSTEM GENERATED CNLNCE_DEC_FAX_VR JOB REQUEST ID: 41038) VEROUTHU 01/30/2016 12:06:18 AM
HAVING GOOD REFERRAL
O REGULAR LOAN ORIGINATION VEROUTHU ©£1/29/2016 11:24:13 PM
> Servicing
> Collections
> WEP
> Tools
> Setup

2.2.2.3 Unlocking an Application

When an application is opened by a user, the same would be locked for other users. Using

Results screen in the Applications screen user can unlock the application.

To unlock an application

1. Open Applications Entry screen and use Quick Search screen to locate the application

you want to work with.

Submit.

On Search Results/Task screen, select the application you want to load and click

An Information message appears with the message: “An application is locked by another
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user.”

ORACLE" . . & Welcome, PRAKRRAD +  Accessibity o
Financial Services Lending and Leasing

i Close
TR Origination x 5]

Origination Search/Task | Undenwriting | Review Requests (Pending: 0)

Origination

el Quick Search

Simple Application Entry . _ . B =
Aoslication Entry App ¥ DODODD1622 Y Identification # (3 submit
Underwriting & Warning *

Funding Queue v] | EBn

Application Retrieval [E2 - Application is locked by: KGOUDU Phane: 0 - Ext.: 0

Scenario Analysis “ Search Criteria el

Application Documents || || — L e j

Image Maintenance (] Cpen Application | | [Z] view Application Unlock Application Copy Application
Reports

Producers Search Results/Task

Vendors View v Formst~  [EF Freeze i Detach vrap W viewan ]

Critical Locked  Allowed  Company Branch  App # Dat= Title Product Status Sub Status [
No data to display.
<

> Servicing
> Collections
> WFP

> Tools
 Setup

3. Click Unlock Application.

4. Click Open Application. The system loads application on the Underwriting screen.

2.2.2.4 View Application

2.3

The View Application button is available in all origination screens (Application Entry,
Underwriting and Funding). You can view a selected application in the search results by
clicking on the View Application button even when the application is locked by another User.

The application will be opened in ‘View Mode’ only and no edits are allowed. However in Tools

sub tab, the 'Initialize' and 'Calculate’ buttons will be enabled allowing you to use the calculator
options.

Searching for an Account and Customer

You can search or retrieve a particular account or customer through Customer Service
screen. The search tab available in the screen enables you to locate an account or customer
using a broad range of search criteria.

To view the Search screen during Loan servicing

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the
Servicing master tab.

2. If you want to perform a customer service task on the application, click Customer
Service link.
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Depending on the link clicked, Customer Service screen appears, opening at Results
screen.

ORACLE"
Financial Services Lending and Leasing

@ Customer Service [® dose
Search  Customer Service  Review Request (Pending: 0)  Queve Assignment Z
> DashBoard N
Quick Search
 Origination
Servicing A Customer 1d s Identification [ submit
Servidng 5
Customer Service Queue/ Condition [=] autorun [ | B NextAccount
Seauitization
Transaction Authorization > Search Criteria
Post Date Checks W
Escrow Transactions
Ac;uunt l‘)mumems Search Results
Collateral Management -
view + Fomatv [ Freeze i Detach
Reports — E @
Producers 4
et ‘ Branch Account = Date Tidle Product Status DAY ountue g“‘m"“‘”g Producer g
Batch Transactions = aiance 3
Advances USRHQ 0160700010472 07/27/2016 SECURED ACCOU... LINEHE (VR) 00000 0000 00000 00000 CA-D0005 : ~
Payments USRHQ 0160700010521 07/27/2036 STATEMENTLINE  LINE HE (VR) K 00 o000 0000 CA-00005 1
Fees USRHQ 0160700010513 07/26/2016 SECURED ACCOL... LEASEVEHICLE 00000 o000 00000 00000 CA-D000S
Interfaces USRHQ 0160700010456 07/27/2016 ACCOUNT SECURED LOAN VEHICLE (FR) o000 0000 o000 00008 AA-00002:
AP Transactions USRHQ 160700010464 07/27/2016 ACCOUNT-1 SECU... LOAN VEHICLE (FR) 00000 o000 00000 00000 AK-00002
6L Transactions USRHQ 0160700010117 07/26/2016 SPOUSEBANKO  LINE UNSECURED (VR) ACTIVE:BKRP 39 0.00 637.02  CA-00006
Conversion Accounts UsRHQ 0160100010121 01/03/2016 RAJESHMAC LOAN  LOAN VEHICLE (FR) ACTIVE:DELQ:BKRP:NON PE... 197 1468689  23877.33  PR-00002:
usRHQ 2016020001018 02/26/2016 NAV IN LOAN VEHICLE (#R) CLOSED:CHARGED OFF 0 0.00 0.00 CA-00002 ¢
nHQ 0160700010076 07/26/2016 MILLEN JOHN LOAN VEHICLE (#R) ACTIVE:EKRP 12 20.00 50,020.00  MN00DD4
UsRHQ 0160700010082 07/26/2016 NAVEEN NAVEEN  LOAN VEHICLE (FR) CLOSED:CHARGED OFF 0 0.00 0.00 CA-00002 ¢
o USRHQ 20160700010141  07/26/2015 KLM NAVEEN LOAN VEHICLE (FR) CHARGED GFF [ 0.00 0.00 CA-00002
& USRHQ 0160700010034 07/26/2016 CUSTOMER BANKO  LOAN VEHICLE (FR) CLOSED:PAID OFF 0 0.0 139 CA-00005 ¢
> Collections USRHQ 0160700010109 07/26/2016 ‘THIS APPLICANT ... LOAN VEHICLE (FR) ACTIE 1 50.00 100,265.28  CA-00003:
S WER USRHQ 0150100010130 01/01/2015 KNavIN LOAN VEHICLE (FR) ACTIVE:EKRPREPO:NON PE... 9 0.0 22,755.25  CA-00003:
 Toaks USRHQ 0160700010026 07/26/2016 KNAVIN LOAN VEHICLE (FR) CHARGED OFF 0 0.0 0.00 CA-00002: -
« [ i ] y 4
> Setup
Copyright © 1998, 2016, Oracie andjor its affiiates. Allrights reserved. About

Note

Oracle Financial Services Lending and Leasing does not display the financial details of se-
cured accounts if the logged-in user is not authorized. Though the search display the re-
sults, the fields such as Status, Delinquency Days, Amount Due, and Outstanding Balance
are masked with ‘xxxxx’ and clicking on the same displays an error message indicating
‘Cannot open secured account’.

3. Click the Search Criteria tab.

ORACLE"
Financial Services Lending and Leasing

] Customer Service [3€] Cose:
> Origination Search | Customer Service | Review Request (Pendng: 0) z
Servicing > Quick Search
Serviang .
Customer service Search Criteria
Seauriization Search Options: @ Account @ Customer © Business
Transacton Autherization
Post Date Checks @ ResetCrienia || @@ search
Escrow Transactions View ™ Format v Freeze flietach ol wrap ® S
Account Documents Griteria Comparison Operator Value i
Collateral Management: Py e =
?fi;:i,s ACCOUNT STATUS it = =
Jendors PRODUCT LIKE [=] HLOAN%
Batch Transactions CUSTOMER SSN EQUAL =]
Advances g CUSTOMER LAST NAME LKE [=]
Payments CUSTOMER FIRST NAME i = g
Fes cusromER EquaL ]
Interfaces
e e susiess nave e =
GLTransactions VI 10 [=
CASA Reconcliation VEAR EQUAL [+
Conversion Accounts i e =
WooEL 1 ]
psser e e 7]
PRODUCER # e ]
> Collections PRODUCER NAME Lie [=]
> WP ACCOUNT CONDITION LIKE [+ =
> Tools QUEE NAME (UNDEFINED FOR DEFALLT) LIE [=]
o QUELE DESCRIPTION e & )

Using the Search tab

1. Create a search criteria by specifying the required details in Comparison Operator and
Value columns.

2. Click Search. System displays all accounts that meet the search criteria in the Results
tab.
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2.31

3. Onthe Search Results/Task screen, select the account you want to load and click Open

Account.

The system loads account on Customer Service screen.

Financial Services Lending and Leasing
> DashBoard Customer Service @Q\&
 Origination Search  Customer Service: 2016070010141 Review Request (Pending: 0) | Quee Assgnment 2
Servicing
Servicng . Account(s): 20160700010141: KLM NAVEEN Elgew || o auit
Customer Service View v Formatv [ Freee fiDetach ] Wrap W & ©curent show Al D) Group Folow-p
Seaitzation Company Branch Sub it Account # Product Days Past Due Currency Pay Off Amt Amount Due St
Transaction Authorization ust USRHQ UNDEFINED 2016070001014 LOAN VEHICLE (FR) <24 UsD 27,0200 0.00 At
S - ok aabihs SeahlllS = L -
Escron Transactions .
Account Documents Summary = Customer Service | AccountDetals | CustomerDetails | Transaction History | PmtModes  Bankrupicy | RepofForedosuwre | Defidency | Collateral | Bureau  CrossfUp Sel Activi > 7
Collateral Management
Reports
: Alerts Conditions
Producers
Vendors ic
Batch Transactions plests S
5 Hlert Condition Start Ot Followup Dt
vances | ;
- B No data to display. (ON ACTIVE MILITARY DUTY 07/26/2016 07/26/2016
ayment
" g DO NOT CHARGE OFF 07/26/2016 07/26/2016 o
Fees
Interfaces
AP Transactions
6L Transactions
Canversian Accounts Account Details Other Information
Dues | Collateral Information k|
Descrption Tdentification # Yesr  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 0TOYOTA CAVRY 0 NEW VEHCLE |
7 i o i '
= DelgDue 0.00 TodaysPayoff 27,02L00  AmtPaid Excess 0.00 " )
N = LCDue 0.00 FutwePayoff 27,05L.00  Memo Excess 0,00 Cistomer Information
 Collections 5 is Fipamey
— NSFDue 0.00 Future Payoff 08/12/2016 g, + Name Relation s National
’ Date Paid Term 0
i O 0.0 ) 000000 NAVEENKLM FRIMARY X065 -0
» Tools Total Due 0.00 FutwePmtDt 08/26/2016  Remaining Term 12 Pl e ———— S
" Setup OldestDue Dt 08/26/2036  Days to Time Bar | 0
MaBon csrmmens Tofaumantine i

Copyright © 1398,2016, Crade and/or is affiates. Al rights reserved.

Quick Search section

About

The Quick Search section in Customer Service screen enables you to load accounts using
any one of the fields Account Number, Customer Id, SSN, Identification #, or Queue/

Condition.

To load an account using the Quick Search section

1. Onthe Oracle Financial Services Lending and Leasing Application home screen, click the

Servicing master tab.

2. If you want to perform customer service task on the application, click Customer

Service.
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2.3.2

3. Inthe Quick Search section’s Acc#/Customer Id/SSN/Identification # fields, specify the
corresponding Account number, or Customer Id, or last four digits of SSN or complete
SSN in the respective fields and click Submit.

ORACLE - K P ——— [=)
Financial Services Lending and Leasing
Close
e Customer Servie x EE
> Origination Search | Customer Service: 20150900014275 | Review Request (Pending: 0)
Quick Search
Ace = | 20150500014275 customer 10 ssn sdentification = [ suome
Queus/ Condition =] Autorun 1[5 Mok Accoune
> Search Criteria
() Open Account

Search Results
View ~ Format-~ B Frocze G Detach 1l wrop @
company tranch Account % vate 1t Froduct status Solnauency  amount

No dals Lo display.

>

> collactions

> wep
> Tools

> Sctup

4. When the request to access an application comes from an external system, user needs
to check ‘Auto Run’ and click ‘Next’ button. System displays the customer service screen
for the respective Account.

To load an account from a queue

In the Quick Search section’s Queue field, select the queue you want to work with and click
Next Account.

Search Using Customer Details

There are different ways to search a customer account using the customer details.

To search for and load the customer details with the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

Select Customer as a search option.

ORACLE’
Financial Services Lending and Leasing

" Customer Service % 3 Close
> Origination Search | Customer Service  Revien Request (Pending: 0) B
Seicag > Quick Search
Servicng
Customer Service Search Criteria
Seaedion; Search Options: ) Account @ Customer () Business

Transaction Authorization

Post Date Checks & Reset Criteria || @@ Search

Escrow Transactions ven * Fomat~ [ Freeze i Detach wep | R
Account Documents Criteria Comparison Operator Value
Colateral Management e e =
Renors CUSTOMER FIRST NAVE 3 [=]
Producers
N CUSTOMER LAST NAME LiKE [=]
Batch Transactions CUSTOMER S5N EQUAL [=]
Advances CUSTOMER NATIONAL D LiE [=] =
«
Payments CUSTOMER PASSPORT NUMBER LIKE [=]
Fees CUSTOMER PHONE NUMEER EQUAL [=]
Interfaces =
AP Traneactons CUSTOMER ZIP CODE e ~
GL Transactions
Conversion Accounts W
Search Results
View ¥ Format~ Freeze i Detach Wirap o)
Customer 1d Natioral I First Name Last Name ssh Passport # Zp
o data to display.
> Collections
YL View~ Fomst~ [P Freeze [ Detach wep @
> Tools Company Branch Account # Product Currency Pay Off Amt Amount Due Status Oldest Due Dt Type
B Getun o data to display.
< i El |
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1. On Search Criteria screen, use Comparison Operator and Value columns to create a
search criteria to find the account using customer details. You can click Reset Criteria at
any time to clear the Comparison Operator and Value columns.

2. Click Search.

The system locates and displays all the accounts that meet your search criteria on Search

Results screen.

ORACLE’
Financial Services Lending and Leasing
@8 Customer Service x
Search Results
View = Format v Freeze Detach
> DashBoard 4 E @
= Customer #
> Origination FE
Servidng
Servidng
Customer Service View~ Formatv [ Freeze i Detach rap W
Seauritzation Company Branch Account # Product
e A usos usHo 0160800012758 LOAN VEHICLE (FR)
Post Date Checks
Escrow Transactions
Account Documents = a
Collateral Management fosipmer et
Reports
Producers 4« Customer Information
Vendors
Batch Transactions
Advances Ven~ Fomatv P Freeze i Detach o
Payments
Five: Customer # Relation ECOA Name
Interfaces 0000002079 PRIMARY INDIVIDUAL AMLT ORACLE
AP Transactions g . ]
6L Transactions
Comiersion foeoumb Addresses || Telecoms || Employments | Tracking Attributes
> Collections Address lnfurma;n
View > Format v Freeze Detach
> WEP < ks @
> Tools Type Current Permission toCall  Confirmed
» Setup. HOME i Y N

[®elose
National ID Fist Name Last Name ss Passport & 7
014626-2315 M ORACLE 0005203 01151
Currency Pay Off Amt Amount Due Status OldestDue Dt Type
usD 9,285.21 187545 ACTIVE:IDELQ 09/24/2016 PRIMARY
5] vew
= BirthDt Marital Status Enzbled Language Educatio
003005203 08/23/1590 Y ENGLISH
’
[E] dew
Mailng Country Address = city state Postal Address Type Str
¥ UNITED STATES. 5 SPRINGFIELD MASSACHUSETTS ~ NORMAL ADDRESS  NO
3

3. On the Search Results screen, view the following information for each account:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Loan product of the account.

Currency The currency in which the account is operated.
Pay Off Amt The total pay off amount on the account.

Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.

Type The type of account.

Also the ‘Customer Details’ section below displays the Customer Information along with
Addresses, Telecoms, Employments, and Tracking Attributes. You can click ‘View’ to display
the details in each section.

4. On the Search Results screen, select the customer you want to retrieve. The system
displays all the accounts pertaining to that customer Id. Select an account and click Open
Account.

The system displays the account details on Customer Service tab.
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2.3.3 Search Using Account Details

To search for and load an account using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >
Servicing > Customer Service > Search Criteria

1. Select Account as a search option.

ORACLE’

Financial Services Lending and Leasing

- DashBoard
> Origination
Servicing
Servicng
Customer Service
Securitization
Transaction Authorization
Fost Date Checks
Escron Transactions
Account Documents
Colateral Management
Reparts
Producers
vendors
Batch Transactions
Advances
Fayments
Fees
Interfaces
AP Transactions
6L Transactions
CASA Recondlation
Conversion Accounts

 Collections
> WP

> Tools

> Setup

Customer Service

Search | Customer Service
» Quick Search

Search Criteria

Vew = Famat~ | B
crtera
accounT =
ACCOUNT STATUS
PRODUCT
cusTomeR ssu
CUSTONER LAST e
CUSTOMER FIRST NAME
CUSTOMER ID
asIESS v
s
YEAR
mae
mooeL
ssserTvPE
PRODUCER #
PRODIICER HAE
accounT coprmion

Review Request (Pending: 0)

Freeze fiDetach | llwrap

‘QUEUE NAME {UNDEFINED FOR DEFAULT)

QUELE DESCRIPTION

Comparison Operator
LkE
LKe
LIKE
EQUAL
LiKE
LIKE
EQUAL
LikE
LKe
EQUAL
Lke
LIKE
LKe
LKE
Lke
LIKE
LIKE
LkE

i o e o

3 dose

Search Options: @) Account(©) Customer ©) Business

& ResetCritenia || @8 Search

Value

=

%LOAN%

=

2. On the Criteria screen, use the Comparison Operator and Value columns to create a
search criteria to find an account. You can click Reset Criteria at any time to clear the
Comparison Operator and Value columns.

3. Click Search. The system locates and displays all the accounts that meet your search
criteria on Results screen.

ORACLE’

Financial Services Lending and Leasing

> DashBoard
> Origination
Servidng
servicing
Customer Service
Secuitzation
Transaction Authorization
Fost Date Checks
Escrow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
GL Transactions
CASARecondiiation
Conversion Accounts

> Collections
> WFP

> Tools

> Setup

Customer Service

Search | Customer Service
Quick Search
Acs
Queue/ Condition

» Search Criteria

Search Results
View v Formatv [

Company Branch
usoL UsHQ
usoL ustQ
usoL UsHQ
usoL UsHQ
usot UsHQ
usoL UsHQ
usoL ustQ
usoL UsHQ
usoL UstQ
usoL UsHQ
usoL UsHQ
usot UsHQ
UsoL UsHQ
usoL ustQ
Uso1 UsHQ

Review Request (Pending: 0)

Customer 1d

[z auorn B

Freeze ffiDetach | o Wrap
Account ¥ Date

2151200011060 12/10/2015
151200011391 12/13/2015
DI51200012331  12/10/2015
0151200012349 12/17/2015
MDISI0012612  12/18/2015
151200012894 12[24/2015
2015120013008 12/30/2015
0160100013092 01/06/2016
2160100013216 01/14/2016
60100013274 01/18/2016
160100013414 01/19/2016
0160100013068 01/20/2016
151200014064 12/17/2015
2016010014149 01/20/2016
160100014206 01/20/016

ssn

[EB Next Account

Title

NATH NATH
MADELLA SURESH
KNAVIN

SDF SDF

KNAVIN

ASHOK PADMA
UME

SPARROW MARYY
JONES ANGELINA
RANADE SHWETA
DALE ALAN

0

KNAVIN

HEGDE SUBHASH /...

HEGDE SUBHASH /.

dentification #
Product Status
LOANVEHICLE (FR) PENDING
LOAN VEHICLE (FR) ACTIVE:DELQ
LOAN VEHICLE (FR) PENDING
LOAN VEHICLE (FR) PENDING
LOAN VEHICLE (FR) PENDING
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) PENDING
LOAN VEHICLE (FR) ACTIVE
LOAN VEHICLE (FR) ACTIVE

i

(3 dose
3 Submit
(1] Open Account

::‘Y‘Z"“"“ AmountDue g;:f:d‘”g Producer 2
0 0.00 0.00 CA-00002 : RAND) ~

u L4782 25030.00  CA00002:RANDY ]
0 0.00 0.00 CA-00002 : RAND'
0 0.00 0.00 AK-00001 ¢ HELL
o 0.00 0.00 CA-000D2 : RAND'

12 0.00 20,00000  CA-00001: DEMO

) 0.00 100,000.00  CA-00009 : HARRY

ol 0.00 5000000 CA-00001: DEMO

16 0.00 50,0000 CA-00001: DEMO

-3 0.00 500,000.00  CA-00001 : DEMO

a1 0.00 42,000.00  CA-00002 : RAND"

30 0.00 15,000.00  GA-00002: ADVAM
0 0.00 0.00 CA-00002 : RAND'

24 0.00 15,000.00  GA-00002: ADVAY

24 0.00 15,000.00  GA-00002 : ADVAN =

| v

4. On the Search Results screen, view the following information for each account:

In this field:

View this:

Company

The company of the account.

Branch

The branch of the account

Account #

The account number
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In this field:

View this:

Date

The date the account was created.

Title

The primary and other applicant(s) attached to the account.

Product

The Loan product of the account.

Status

The status of the account.

Delinquency days

The number of days the account has been delinquent.

Amount Due

The total amount due for the account.

Outstanding Balance

The total outstanding balance for the account.

Producer

The producer of the account.

Secured

If selected, indicates the account is secured and may only be
loaded by authorized users.

Account.

5. On the Results screen, select the application you want to retrieve and click Open

The system loads the account under the tab

ORACLE"
Financial Services Lending and Leasing
ustomer Service x Cloze
> DashBoard CuStomer S =
* Origination Search | Customer Service: 2015100011054 Review Request (Pending: 0)
Servicing
= Account(s): 20151000011054: K NAVIN B vew || 2 audit
View Format + rezze Elivetach  cJwrap | @ & © Curtent O showAll O Group Followup
Company Branch Sub Uit roduct Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usox usrg UNDEFINED 2015100011054 LOAN VEHICLE (FR) 227 UsD 531462 0.00 ACTIVE 10/01/2016.
Summary | Customer service || Account Details || Customer Details | Transaction fistory | Pmt Modes  Bankruptcy || RepojForedosure | Deficency | Collateral | Bureau || Cross/Up Sell Actvties
Alerts Conditions
Alerts Conditions
Alert Condition Start Ot Followup Dt
TesT o data to dispay
‘. Account Details Other Information e
Dues Collateral Information
Description Ientification = 2 s AssetTpe  SubType
000 000 000 0.00 000 o 0 xc i
o 0 i i
Delq Due 0.00 Future Pt Dt 10/01/2016 o 0 i 3
LCDue 0.00 Oldest Due Dt 10/01/2016
1SF Due 2000 Amt paid Excess 0.00 3
Other Due 0.00 Future Payoff Date 02/27/2016 Customer Information
: . USEOTET Name Relation B Bith Dt Gender
Delinquency Information B
Gy o 000000... KAVINK PRIMARY 020008677 02/12/1587
4 0 o i = 000000... RICHARD MURRAY 3R PRIMARY 000009332 12/08/1585 UNDEFINED
»
ep(life) 0 NSF(lfe) 1 Collector DEMOCOLL
ep(vear) 0 NSF(vear) 1 Email Disability N
Language ENGLISH
T Activities sl Sat
£ ollacions. Adive Dt 12/10/2015 Corresp
> Wrp st 02/1772016
> 1 3
atonis Address Information
> setup Custo s Twe cument P wiing Address Phon -
CoPGNt © 1998,2016, Oratle and/or s afilates. AllGhts recerves ~ "About

You are now ready to begin work on the account.

You can view the accounts pending for your review by selecting Receiver in the Review

Request tab.

Search Using Business Details

To search and load an account with specific business using the Search screen

On the Oracle Financial Services Lending and Leasing home screen, click Servicing >

Servicing > Customer Service > Search Criteria
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1. Select Business as the search option.

ORACLE'

Financial Services Lending and Leasing

> DashBoard
> Origination
Sarvicing
Servidng
Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Doauments
Colateral Management
Reports
Producers
Vendars
Batch Transactions
Advances
Payments
Fees
Interfaces
AP Transactions
6L Transactions
Conversion Accaunts

> Collections
o WP
> Tools

> setup
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On the Criteria screen, use the Comparison Operator and Value columns to create a

search criteria to find the business type. You can click Reset Criteria at any time to clear
the Comparison Operator and Value columns.

criteria on ‘Search Results’ section.
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Click Search. The system locates and displays all the records that meet your search

> DashBoard
> Origination
Servicing
Serviding
Customer Service
Seauritzaton
Transaction Authorization
Post Date Checks
Escow Transactions
Account Documents
Collateral Management
Reports
Producers
Vendors
Batch Transactions
Advances
Payments
Fees
Interfaces
2P Transactions
GL Transactions
Conversion Accounts

> Collections
> WEP
 Tools

» setup

@  Customer Service x

Search Results
View ~ Format~ P ze [ Detach Wrap W

Business & Business Name:

0000021005 oFsiL
Vien > Format~ [ Freeze  ff Detach Wrap W
Company Branch Account # Product
uso1 usHQ 2017020029956 LOAN VEHICLE (FR)
Business

Business Details

Vew Fomatv | B | [Freere Rivemh | (lwrd | @
Organization Type  Type of Business
CCORP CORPCRATE CORPORATE OFSLL.
4 - It

Addresses Telecoms | Partners | Afffiates | Tracking Attrbutes

Address Information

view > Format > [ Freeze  EfiDetach | ol wrap @
AddressType  Current Country Address #
WORK ¥ UNITED STATES

.

Business Category  Name of the Business

[ dose
Tax 1d Start Dt Phone Number Zp
55236 02/08/2010 (000}-000-0000 01152
Currency Pay Off amt ‘Amount Due Status Oldest Due Dt
usD 10,000.00 0.00 AcTivE 03fisjz017
Bl
Legal Name: TaxID # Start Dt # of Employees(Cur) #of
OFsLL XXKXX5236 02/08/2010 200 E
v
Elven
State Postal Type StreetPre Sireet Name Street Type St
MASSACHUSETTS  NORMAL ADDRESS
3

You can view the view the following information for each business record:

In this field:

View this:

Business #

The registered business number of the company.

Business Name

The name of the business.

Tax ID

The taxation identity number of the business.

Start Dt

The date when the business was initiated.

Phone Number

The contact number of the business.

Zip

The zip code where the business is established.
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4. Onthe Results screen, select the business type of your interest. The sub section displays
the accounts associated with the selected business with the following details:

In this field: View this:

Company The company of the account.

Branch The branch of the account

Account # The account number

Product The Loan product of the account.

Currency The currency in which the account is operated.

Pay Off Amt The total pay off amount on the account.

Amount Due The total amount due on the account.

Status The status of the account.

Oldest Due Dt The oldest payment due date on the account.

Also the ‘Business’ section below displays the Business Details along with Addresses,
Telecoms, Partners, Affiliates and Tracking Attributes. You can click ‘View’ to display the
details in each section.

5. Select the required account and click Open Account. The system loads the account
associated with the business type in the tab

RACLE
Financial Services Lending and Leasing

Close
P Customer Servie x EE
> Origination search| + 2015100011054 “ :0)
Serviding
s Account(s): 20151000011054: K NAVIN Byew | « it
Views Fomot B [fresze BDetach | olwp | @ & © curent O showAll O Grow Folloveup
Company Branch Sub Unit ccount Product Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due bt
usot usrg UNDEFINED 2015100001054 LOAN VEHICLE (FR) 227 UsD 531462 0.00 A 10/01/2016,
Summary || Customer Senice | Account Details | Customer Detals | Transaction History | Pt Modes || Bankruptcy || Repo/Foredosure || Deficency | Collateral || Bureau | Cross/Up Sell Activties
Alerts Conditions
Alerts Conditions
Alert Condition Start Dt Followup Dt
esT o data to dispay
4 Account Details Other Information e
Dues Collateral Information
Description Uentiication = Year  AssetClass AssetTpe  SubType
000 000 000 000 000 0 o new i i
0 o new 1 1
Delq Due 0.00 Total Due 2000 o o new i i
LC Due 0.00 off 4531462
SF Due 2000 off 4537630 <
Other Due 0.00 i R i ws s CIIS(tﬂtrlIerInfurmatm||
" - USLOMe! ame Relation ssn Bith ot Gender
Delinquency Information B
T I S S 000000... KAVIN K PRINARY 010008677 02/12/1987
n 5 5 5 5 ¥ s = 000000... RICHARD MURRAY JR PRIMARY 008332 /08185 UNDEFINED
,
ep(ife) 0 NSF(Life) 1 Collector DEMOCOLL
BP(vear) 0 sF{vear) 1 email Disabilty N Privacy Ot Out ¥
- Language ENGLISH p acti uty
ST Activities Marita Status
B Collechions Acive Dt 12/10/2015 App # 0000001013 Correspond
> Wrp "
> ot 10/1212015 "
> Tools Gurencht. 356,90 Address Information
> setup Customer Grade B Last Bil Amt. 0.00 e curent PSS aiing address Phone -
Copyright © 1998,2016, Oracle anor it ffiates. All ighes reserved N “About
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3.1

3.2

3. Dashboards

Introduction

This document is designed to help acquaint you with the features of Dashboard, on the
landing screen of Oracle Financial Services Lending and Leasing. Information from multiple
products is integrated and displayed as Dashboard on home screen of the application.

This manual explains the functionality of Dashboard facility and various Dashboards present
in the system. Since this section details the general dashboard options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing. Besides providing these details, the manual also provides a brief description of
other features associated with Dashboard link. The Dashboard main Menu further provides
links to the following screens:

e Dashboard

e Users Productivity
e System Monitor

e Producer Analysis

Dashboards

Dashboards are the tiny windows displayed on landing screen of the Application. Dashboard
renders quick and crisp information of specific transactions or tasks mapped to the ‘User
Role’, who logs on to the system.

The system facilitates integration of Information from different levels and displays it as
Dashboard on home screen, also called the landing screen of the application.

Navigating to Dashboards
Click Dashboard > Dashboard > Dashboard.

ORACLE"
Financial Services Lending and Leasing

@ DashBoard [ Close:
Origination Setup Admin
DashBoard -
DashBoard My User Queues Product Expiring in Next One Month Critical Batch Job Status
DashBoard o] 5] (5]
Users Productivity Description Count. Product. End Date Batch Job Status
System Monitor No data to display. No data to display. BATCH TXNS (MONETARY) READY
Producer Analysis BEGINING OF DAY JOBS READY
Process Fles
My Pending Review Requests By Applications  |=
App = Priority
0000001046 HIGH

My Pending Review Requests By Priority

oW
Priarity Count 2
Servicing Vendor
Number of Queues Hard Assigned Vendors Count By Status
@ @
Queue Desaription Count Status Count
No data to display. ACTIVE %
> Origination i
Number of Accounts 'Vendors Expiring in Next One Month
» servicing =)
£ @
> Collections Queue Description Count Company Name End Date
> WP Mo data to dsplay. TEST 02/02/2017
> Tools
> Setup My Pending Review Requests By Accounts
N i

Features

Following are the features of Dashboard:
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3.3

3.3.1

3.3.1.1

e The system organizes Dashboards to provide comprehensive and consolidate snapshot
in tiny windows, to access information easily. Thus, helping to; analyze, monitor and
make better decisions which in turn help save time and cost.

e The screen is designed to display six Dashboards, distributed in two rows with three
Dashboards per row, without scroll bars.

e The height and width of all Dashboards are fixed; however, you can expand or collapse
the Dashboards. Click the arrow heads at the top left corner of the Dashboard windows
to expand or collapse the dashboard windows.

e Each section in Dashboard is hyperlinked to home screen of the respective section. The
main screen will present descriptive information of details shown in Dashboard only.

e Each window in the dashboard is provided with a Refresh button and clicking on the
same would fetch the latest status of the dashboard being viewed.

User Productivity

Oracle Financial Services Lending and Leasing User Productivity Setup screen is a
supervisor feature that allows you to monitor the daily performances of users completing Loan
origination and servicing tasks.

These tasks are categorized as underwriting funding tasks (loan origination).The system
updates these details on daily basis.

Using the User Productivity Setup screen, you can review the following daily tallies:

e Number of applications entered, by user

e Number of underwriting decisions (approved, rejected, conditioned, or withdrawn), by
user

e Number of funding decisions (verified or funded), by user
e Number of applications entered, by queue

This chapter explains how to use the User Productivity Setup screen to view this information.

Navigating to User Productivity Screen
1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > User Productivity.

2. The system displays the User Productivity screen. You can view the tasks related to:
e Underwriting/Funding
e Customer Service/Collection

Viewing Underwriting/Funding tasks

Daily tallies from the

e Collector Activity

Collector Activity

The Collector Activity screen displays the number of accounts worked and call activities by
collector for the day. It also displays details regarding calls and total number of calls per
queue.
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To use the Collector Activity

1. Click Dashboard > Dashboard > User Productivity > Collector Activity. The details
on this screen are grouped into two:

e Users
e Activity Details

2. In the Users section, you can view the following information.

ORACLE # Welcome, PRAKRRAD ~  Accessibiity o
Financial Services Lending and Leasing

e Users Productivity 3 [ Gose
DashBoard Apglication Ertry | Underwiting || Funding || Origination Queues | Collector Activity: | Senvice/Collection Queuss:
DashBoard
Users Productivity
System Monitor Users
Producer Analysis View~ Fomaty [ Frecze Tt Detach Wrap 5]

Process Files User Neme Accourts Call Activities

No data to display.

Activity Details
Viewv Format~ [ Freeze [t Detach J wrap i

Queue Name LeftMessages  Promisa To Pay Mo Answer Gther Total
No data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

User Displays the user code.

Name Displays the user name.

Accounts Displays the number of accounts worked.
Call Activities Displays the number of call activities.

3. Inthe Activity Details section, you can view information for the selected user. A brief
description of the fields is given below:

Field: View this:

Queue Name Displays the queue name.

Left Messages Displays the left message activity count.

Promise To Pay | Displays the promise to pay activity count.

No Answer Displays the no answer activity count.

Other Displays the other activity count.
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3.4

3.4.1

Field: View this:

Total Displays the total activity count.

System Monitor

The System Monitor screen is the one stop place to check all the activities in and around the
system. It maintains the progress of;

e Batch Jobs

e Jobs

e Services

e Database Server Log Files
e Parked Transactions

e Users

Navigating to System Monitor

On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor.

Monitoring Batch Jobs

The system tracks the success of each batch process on the Batch Job. If either a set of batch
jobs or specific batch job should fail, you can resubmit it on this screen and review the results
in Request Details section.

The Monitor Batch Jobs screen is only a display screen that contains the following sections:
e Batch Job Sets
e Batch Jobs
e Batch Jobs Threads
e Request Details
e Request Results

To Monitor Batch Job
1. Click Dashboard > Dashboard > System Monitor > Batch Jobs.
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2. Inthe Batch Job Sets section, you can view the following information

ORACLE’ % Welcome, PRAKRRAC v Accessibility o
Financial Services Lending and Leasing

V Close
DashBoard System Monitor —

Batch Jobs | Jobs | Services | Database Server Log Files | Parked Transactions | Users

Users Productivity

System Monitor Batch Job Sets
Producer Analysis Vieww Formatw [} Fresze i Detach Wrap T BB Re-submit Job Set
Process Files Set Code Job Set Description  Status Fraquency Frequency Value  Start Time Enzbled Critical Last Run Dt Next Run DI
SET-AAD ACCOUNT CREATL.. READY DAILY DAILY 10:00 AM N N 08/08/2003 08/09/2003 A
SET-ACR ACCRUALS AND D... READY DAILY DAILY 10:30 PM N ¥ 08/07/2003 08/08/2003
<
Batch Jobs
Vieww Format~ [ Freeze ) Detach & wrap @ BB re-submit Job
Seq Job Type Job Code Status Job Description Threads Commit Count Errors Allowed Weskend Holiday
1 PROCEDURE AAIPRC_B1_100_01 COMPLETED APPLICATION TO. i ¥
2 PROCEDURE TXNACT_E]_100_01 COMPLETED ACCOUNT ACTIVA 1 100 50Y Y
< >
Batch Job Threads
U View- Fomat~ & Freeze ) Detach ¢l wrap (65
Thread Status Errors Records Trace Level Enzbled
1IDiE 0 ] ok
Request Details
View ~ Format+ [ Fresze ) Detach Wrap (5]
Request Type Status Start Dt End Dt Run Start Dt Run End Dt Process Dt
No data to display.
>
Request Results
View» Fomate [ Frezze ! Detach Wrap ®
Requast Result Description
> Origination No datz to display.
> Servicing
> Collections
> WEP
> Tools
> Setup

A brief description of the fields is given below:

Field: View this:

Set Code Displays the code for batch job set.

Job Set Description | Displays the description for batch job set.

Status Displays the job set status.

Frequency Code Displays the frequency at which the job set is to be executed.

Frequency Value Displays the value of frequency code chosen for the job set.

Start Time Displays the start time for the job set.

Enabled Displays if the job set is enabled or not.

Critical Displays if this job set is critical or not.

Last Run Dt Displays the date of last run of the job set.

Next Run Dt Displays the next run date for job set.
Parent Displays the preceding job set.
Dependency Displays the type of dependency on predecessor.

To resubmit a batch job set
Whenever a batch job set fails, it is best to resubmit it after correcting the errors that caused

the failure. Resubmitting a set causes system to re-perform the batch job set and dependent
batch jobs.
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e Inthe Batch Job Sets section, choose the batch job set to resubmit (only a batch job
set with a status of FAILED can be resubmitted), then click Resubmit Job Set button.

The Batch Jobs section lists the batch jobs within a job set. The status, threads, commit
count, dependencies, enabled indicator and the holiday and weekend runtime indicators are

shown for each job.

A brief description of the fields is given below:

Field: View this:

Seq Displays the batch job sequence number.
Job Type Displays the batch job request type.

Job Code Displays the batch job request code.
Status Displays the job status.

Job Description

Displays the batch job description.

Threads

Displays the number of threads used by the job.

Commit Count

Displays the number of rows after which auto-commit is
triggered.

Errors Allowed

Displays the number of errors allowed.

Weekend Displays if the batch job will execute job on weekend or
not.

Holiday Displays if the batch job will execute job on a holiday or
not.

Enabled Displays if the job is enabled or not.

Parent Displays the preceding job.

Dependency Displays the type of dependency on predecessor.

Command Displays the command line for the job.

Rollback Segment

Displays the rollback segment for job.

To resubmit a batch job

Whenever a batch job fails, it is best to resubmit it after correcting the errors that caused

failure. Resubmitting a set will cause system to re-perform the batch job.

e In the Batch Jobs section, choose the batch job to resubmit (only a batch job with a

status of FAILED can be resubmitted), then choose Resubmit Job Set.

e The Batch Job Threads section displays the status of individual threads.

A brief description of the fields is given below:

Field: View this:
Thread Displays the name of thread.
Status Displays the status of thread.
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Field: View this:

Errors Displays the number of errors in the thread.

Records Displays the number of records in the thread.

Trace Level Displays the SQL trace level (0, 1, 4, 8, 12).

Enabled Displays if the job thread is enabled or not.

The Request Details section displays the status and runtimes for each time the selected job
ran.

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Start Dt Displays the job request is valid from this date and time.

End Dt Displays the job request is valid till this date.

Run Start Dt Displays the date and time on when the job run started.

Run End Dt Displays the date and time at which the job run ended.

Process Dt Displays the transaction is posted with this General Ledger effec-
tive date.

Description Displays the job request description.

If a particular job requires that a result message be created, then that message appears in the
Request Results section. A message is usually created in the event of an error.

A brief description of the fields is given below:

Field: View this:

Request Results | Displays the result of job request.

Description Displays the result details.

3.4.2 Monitoring Jobs

The Monitor Jobs screen provides another view of monitoring all system processes, including
credit bureau requests and payment posting. This screen displays the data in reverse
chronological order of the Run Start Date/Time, whereas the Monitor Batch Jobs screen
provides the historical data about each job and job set.

To Monitor Job Details

1. Click Dashboard > Dashboard > System Monitor > Jobs.

2. On the Job screen, select the type of jobs you want to view in the Job Details section.
You can select any of the following jobs:

e Batch
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e Back Ground
e Credit Request

ORACLE . . . f & Welome, PRAKRRAQ ~  Accessibiity o
Financial Services Lending and Leasing

: Close
DashBoard System Monitor x =

DashBaard Batch Jobs | Jobs || Services | Database Server Log Files | Parked Transactions | Users
DashBoard

Batch | Back Ground | Credit Request

Job Details
View » Fomat~ [P Freeze i Detach | wrap T view Last @ 1 DayO 2 DeysO) 5 Days O Al Days View () Failed @) All

& 2/1/2016 )

Request Type Status Job et Job Description Thread Errors Records A1 Sart

OGS e fTime Run End D

No data to display.

Job Detail Description

Job Results
View » Fomat~ [ Freeze  ffi Detach 1| wrap @
4 Request Result  Description
Na data to display.

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the different jobs available is given below:

Select: System Displays:

Batch Batch jobs (used primarily for the nightly processes).

Back Ground User submitted requests, such as reports and payment posting.
Credit Request Credit bureau requests.

3. In the Job Details section, select the time frame of the contents of Job Details section.
You can select any of the following options:

Select: System Displays:

1 Day All the types of jobs selected in Jobs Type section in last one-day.
2 Days All the types of jobs selected in Jobs Type section in last two days.
5 Days All the types of jobs selected in Jobs Type section in last five days.
All Days All the types of jobs selected in Jobs Type section.

4. If you select Failed option in the View section, the system displays failed jobs on the type
and time frame you have selected.

5. In the Job Details section, you can view the following information about jobs matching
the contents of Job Type, View Last and Failed boxes:
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3.4.3

A brief description of the fields is given below:

Field: View this:

Request Type Displays the job request type.

Status Displays the job request status.

Job Set Displays the job set code.

Job Displays the job description.

Thread Displays the job thread.

Errors Displays the number of errors.

Records Displays the number of records processed by the job.

Run Start Date/Time

Displays the job run start date time.

Run End Date/Time

Displays the job run end date time.

Description

Displays the job request description.

Process Dt

Displays the job process date.

Valid Execution Period

Start Date/Time

Displays the job start date/time.

End Date/Time

Displays the job end date time.

6. Inthe Job Results section, you can view the following information about the Job selected

in Job Details section:

A brief description of the fields is given below:

Field: View this:
Request Type Displays the job request type.
Description Displays the job request description.

Monitoring Services

The Services screen allows you to track and maintain the system’s processing services,
including credit bureaus, fax-in and batch job scheduler. The system administrator can start
or stop the service on this screen using the action buttons respectively.

To stop, start or refresh a processing service

1. Click Dashboard > Dashboard >System Monitor > Services.

3-9 ORACLE



2. Inthe Services section, you can view the following information about the system’s
processing services:

ORACLE" _ . # Wekome, PRAKRRAO »  Accessibiity o
Financial Services Lending and Leasing

. Close.
DashBoard System Monitor 3 -
Dich Bl Batchiobs | Jobs | Services  Datobase Server Log Fles  Parked Transactions || Users
DashBoard
Users Producivity )
System Monitor Services

Producer Analysis View ~ Format~ [Ep Freeze  Ef Detach Wrap W @ sttus Dstet Ostop

Binks rkes Service Company Branch Description Status
v AL AL CREDIT BUREAU SERVICE (EFX TEST FILES)
csv AL ALL CREDIT BUREAL SERVICE (EXP TEST FILES)
csv AL ALL CREDIT BUREAU SERVICE (TUC TEST FILES)
Xsc AL ALL JOB SCHEDULER
v ALL ALL 0B SERVICE

> Origination
> Servicing
> Collections
> WFP

> Tools

> Setup

A brief description of the fields is given below:

Field: View this:

Service Display the service name.
Company Display the service company.
Branch Display the service branch.

Description Display the service description.

Status Display the service status.

3. Inthe Action section, select the processing service you want to work with and choose
one of the following commands in Action section.

Choose: System:

Status Refreshes (updates) the status of service. The Service screen does
not update the status in real time. You must choose Status after
choosing Start or Stop to perform that command.

Start Starts the job service.

Stop Stops the job service.

344 Data Server Log Files

Various processes in the system create reports in different log files with regards to what tasks
they performed and what they encountered (for example, errors, failures, erroneous data and
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3.4.5

so on). The Database Server link lists and describes all such log files within the system on the
database server.

To view a log file on the database server

1. Click Dashboard > Dashboard > System Monitor > Database Server Log Files.

2. Inthe Database Server Log Files section, click List Files.

ORACLE’ & Welcome, PRAKRRAO ~  Accessifility o
Financial Services Lending and Leasing

: Close
DashBoard System Monitor -

DashBoard Batch Jobs | Jobs  Sanvices  Database Server Log Files | Parked Transactions | Users
DashBoard

Database Server Log Files
View » Formatw [} Freezz Hfi Detach Nrap @ IS ustFiles } Download File
File Name File Type: File Size File Time
No data to display.

File Content
View  Format v Fresze i Detach Vrap M O Beginning® End #of Lines 50
Text
No data to display.

> Origination
> Servicing
> Callections
> WEP

> Tools

> Setup

3. Then in the Database Server Log Files section, you can view the following information.
A brief description of the fields is given below

Field View this:

File Name Displays the name of file.

File Type Displays the type of file.

File Size Displays the size of file.

File Time Displays the time stamp of file.

4. Inthe File Content section you can view the content of the file selected in the Database
Server Log Files.

5. Click Show File. A File Download - Security Warning dialog box is displayed with the
confirmation message “Do you want to save this file?”

6. Click Save.

7. In Save As dialog box, select the location you want to save the file, and click Save.

Monitoring Users

The Users Logins section allows you to view all users who have logged on to the system,
along with the log on time stamp and logout time stamp. The information appears in reverse
chronological order of the log on time stamp.
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3.5

To monitor users who have logged on to the system

1. Click Dashboard > Dashboard >System Monitor > Users.

2. In the User Logins section, you can view the following information

ORACLE"

Financial Services Lending and Leasing

DashBoard
Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WFP

> Tools

 Setup

System Monitor 5

Batchlobs  Jobs  Senvices | Database Server Log Files | Parked Transactions | Users

User Logins
View » Format -

User

NARESH
LMANGALA
SARAMAN
NARESH
VINOARUM
VINOARUM
VAVAIDYA
VINOARUM
NVINNAKO
VINOARUM
PRAKRRAC
VINOARUM
PRAKRRAC
PRAKRRAQ
NARESH
VINOARUM
HMACHA
VIBHATIA
MADHUKARAN

nonESH

53 Freeze i Detach
User Name

NARESH CHAMARTHI
LALITHA MANGALAGIRI
SARAVANAN RAMAN
NARESH CHAMARTHI
VINOTH ARUMUGASAMY
VINOTH ARUMUGASAMY
VARSHA VAIDYA
VINOTH ARUMUGASAMY
NAGAVENKATA VINNAKOTI
VINOTH ARUMUGASAMY
PRAKRUTI RAC

VINOTH ARUMUGASAMY
PRAKRUTI RAC
PRAKRUTI RAD

NARESH CHAMARTHI
VINOTH ARUMUGASAMY
HARISH MACHA

VINAY BHATIA
MADHUKARAN R

NARFEH CHAMARTHT

Wrap i} View Last @ 1 Day O 2 DaysO 5 Days O All Days

Details

View User

[ Close
© Current User ® All Users
Login Date and Logout Date and
Time
02/09/2016 11:19... 12/30/4000 12:30...
12/30/4000 12:30. A

12/30/4001
02/08/201¢
02/08/201¢

02/09/2016 10:47.
02/09/2016 10:46.
02/08/2016 10:41... 0
02/09/2016 10:
02/05/2016 10:34
02/05)

/2016 10:44
12/30/4000 12:30.
02/09/2016 10:29.

mo/narnis n7oR

A brief description of the fields is given below:

Field:

View this:

User Displays the user ID.
User Name Displays the user name.
Details Displays the details.

Login Date and Time

Displays the login date time for the user.

Logout Date and Time

Displays the logout date time for the user.

Producer Analysis

The Producer analysis screen enables you to view and know the status of all applications
sourced by different Producers.
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Navigating to Producer Analysis
Click Dashboard > Dashboard > Producer Analysis.

ORACLE" 2 Welcome, PRAKRRAO »  Ac

Financial Services Lending and Leasing

Producer Analysis 5

oard

Select Criteria
Users Productivity
System Monitor Company ALL [v] Teritory 2 Funder ALL ]
Producer Analysis Branch ALL[¥] Salles Agent ALL [v] Status >
Process Files

Region AL [v] Undenwriter ALL [v] zip &
Producers | Terrtories Activity | Volume || Mix
> Dealer

Recent Activity
No data to display. e Roiad Approved Funded
No data to display.

Recently Approved Applications
Applicant Name  Application # Amt. Collateral Desc
No data to display.

Recently Funded Applications
Applicant Name Application # Amt Collateral Desc
No data to display.
4

Recent Comments
&F petach
Date Comment Desc
No data to display.

> Origination
> Servicing
> Collections
> WEFP

> Tools

> Setup

B submit

Comments

You can filter producer details based on any or all of the following criteria:

e Company

e Branch
e Region
e Territory

e Sales Agent
e Underwriter
e Funder

You can select the values from the adjoining drop-down list. Click ‘Submit’ button. System

displays the Producer details satisfying the criteria, you selected.

The following details are displayed under Producer Details section:

e Producer #
e Name

e Company
e Branch

e Type

Select the producer you need to view the statistics. The system displays the statistics under

‘Summary’ sub tab and the status and sub status of various applications under ‘Applications’

sub tab, of the selected producer.

The system displays the following details under ‘Summary’ sub tab:

e Year
e Total Apps
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Approved
Conditioned
Rejected
Withdrawn
Funded
Amount

The system displays the following details under ‘Applications’ sub tab:

Company
Branch
App #
Date

Title
Product
Status

Sub Status

Process Files

The Process files interface allows you to view the incoming and outgoing files exchanged with
other systems for processing and also perform a bulk upload of required files.

The Process files interface also provide information on the type of files uploaded with other
attributes. In-order to facilitate the process files handling, the following parameters has to be
enabled in Setup > Administration > System > System Parameters screen.

For more information on enabling system parameters, refer to ‘System Parameters’ section
in Setup Guides.

CMN_FILE_PROCESS_TO_LOB

On enabling the above parameter, system stores the incoming / outgoing documents in
the relevant tables and not in the file system.

UIX_INCOMING_FILE_PATH
UIX_OUTGOING_FILE_PATH

On enabling the above two parameters, the incoming and outgoing file path of
application server need to be defined to the required folder path by updating the
‘Parameter Value’ which by default is ‘SETME’. (For example: /tmp)

Depending on the CLOB parameter option, if set to ‘Y’ the incoming/outgoing file directories
are to be manually created in Web Logic server. For details of directories, refer to ‘Creating
Application Home directory’ section in Database Installation Guide.
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3.6.1 Incoming Process File

The incoming process file screen displays the list of files being shared from an external
system along with other attributes such as directory path, file name, type, size, date and
status. You can select the file required and upload it into the system forimmediate processing.

ORACLE’ -3 AKRRAO
| Financial Services Lending and Leasing
|

Close
Sy Process Files x (g
DashBoard - Incoming Process File  Outgoing Process Flie
DashBoard
Users Productivity Incoming Process File
System Monitor
Producer peclicss Host Name whfogace.in.oradk.com Upload from  fscratch/wark_area/DEV/QA 143REL finput
Process Files
view = Format v | [ Freeze fliDetoch o wrap B iSUstfles [ Upload
E en [~ B
Select Al [7]  Directory Name File Name File Type File Size(bytes) File Date Status
F /DEVQA143REL ofsll_sample_file 5. CALL ACTIVITY POSHI\‘ ~| 154 12/02/201502:12:15 AM NONE
= [seratehjwork_area/DEV/QA143REL finputyitu ofsl_sample_fie_u.. TRANSACTION UPLOAQ=]| 154 12/02{201502:12:15 AM NONE
“
Uploaded Files

View v Format v Freeze  fiDetach | ViewLast © 1Day® 2Days @ 5Days@ AllDays [ DownloadBadData [ Download Log Data
File Name le Type File Dt Status
ofsll_sample_fie_uss.txt CALL ACTIVITY POSTING ON ACCOUNT  02/22/2016 PROCESSED ERROR
ofsll_sample_file_ssuss.tet LOCKBOX 02/19/2018 UPLOADED
ofsll_sample_fle_SSuss. txt TRANSACTION UPLOAD 02/19/2016 UPLOADED

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

View the list Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files.

A brief description of the fields is given below:

Field: Description:

Select All Select this option to select all the listed files.

Directory Name View the directory path where incoming file is
stored.

File Name View the name of the file.

File Type Select the type of file with the option available
in the drop-down list.

File Size(bytes) View the size of incoming file.

File Date View the date and time when the incoming file

was placed in the directory.

Status View the status of the file.

Upload Incoming Process File

1. Click Dashboard > Process Files > Incoming Process File.

2. Inthe Incoming Process File section, click List Files. System displays the list of incoming
files. You can click L2l to refresh the grid data.

3. Select the check box adjacent to the required file and click Upload. You can also click
Select All check box to perform a bulk upload of all the listed files.
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3.6.2

The uploaded files are listed in below ‘Uploaded Files’ section and the status of the files
are changed from ‘Generated’ to ‘Uploaded’. In case of a processing error, the status of
the file is indicated as ‘Processed Error’.

Uploaded Files

The uploaded files section displays the list of incoming files uploaded into the system. You
can sort and view the list of files depending on the number of days based on Last 1 Day / 2
Days / 5 Days / All Days. You can click 2 to refresh the grid data.

On selection, you can view the following information:

Field: Description:

File Name View the name of file uploaded.

File Type View the type of file uploaded.

File Dt View the date when the file was uploaded.
Status View the status of upload.

In the Uploaded Files section, you can do the following:

e Click Download Bad Data to download the list of uploaded files which had processing
errors due to bad data.

e Click Download Log Data to download a log of all the files uploaded.

Outgoing Process File

The outgoing process file section displays the list of files being shared for upload to other
system for processing and allows you to download the required file for inspection.

ORACLE’ * PRAKRRAO = Accessibity o
Financial Services Lending and Leasing

: Close
DashBoard Process Files -

Incoming Process Fl= | Outgoing Process File

Outgoing Process File

Download to << OUTGOING PROCESS FILE PATH >>

View v Format~  Ep Freeze  ffDetach Wrap ) Viewlast @ 1Day(© 2Days( 5Days ) All Days
Select Al ] File Name File Date File Size{bytes) Status
MNo data to display.

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can sort and view the list of files depending on the number of days based on Last 1 Day
/ 2 Days / 5 Days / All Days.
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On selection, you can view the following information:

Field: Description:

Select All Select this option to select all the listed files.
File Name View the name of upload file.

File Date View the date when the file was shared for

upload.

File Size(bytes)

View the size of upload file.

Status

View the status of upload file.

Download Outgoing Process File

1. Click Dashboard > Process Files > Outgoing Process File.
System displays the list of files shared for upload. You can click ' to refresh the grid

data.

2. Select the check box adjacent to the required file and click Download. You can also click
Select All check box to download all the listed files.
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4.2

4. Sales Lead

Introduction

The Sales Lead screen enables you to record information gathered during a sales query or a
call from a potential borrower. A sales representative can then use Sales Lead screen to
follow-up with the borrower. This is not a mandatory screen. You can always begin Loan
origination process directly using the Application Entry screen Information on Sales Lead
screen can be attached to the Application Entry screen as optional information. Attaching a
lead to an application can help the sales department analyze the effectiveness of following-
up with prospective borrowers. Once a lead is attached to an application from the Sales Lead
screen, the system changes its status to COMPLETED.

Lead Entry

The Lead Entry screen enables you to record information regarding prospective borrowers
from a sales query or a call to be used in a follow-up call. The initial status for the lead can be
set as NEW or FOLLOW-UP.

To Navigate to Lead Entry screen

1. On the Oracle financial Services Lending and Leasing Application home screen, click
Origination > Origination > Sales Lead.

2. Onthe Sales Lead screen, click Lead Entry tab.

ORACLE" ; . & Wekome, PRAKRRAO + Accessiilty o
Financial Services Lending and Leasing
Close
DashBoard Suies ey e
Origination Lead Entry ~ Follow-Up = Maintanance
Origination
Seles Lesd Applicant Information Fadd | Aedt | [ view || oF aude
Simple Application Enfry 2 .
Application Entry View v Fomat~ B Freee BiDemch | Jwap @
Underwriting Lead # Lead Dt Company Branch First Name Last Name Birth Dt Channel Source
Funding UNDEFINED: 02/04/2016
Application Retrieval L-00002006 12/15/2015 NLO2 NLHQ ROSEMARY BLACK 12/08/1987 CONSULTATION WEB ENTRY a)
o i L-00001002 12/02/2015 Us01 USHQ TEST TEST LAST NAME  01/01/1990 ESTATE AGENT FAX IN
Application Documents L-00003002 5 usot UsHQ BOND JAMES 01/01/1997 WEB WEB ENTRY
Image Maintenance L-00002002 uso1 USHQ PHANINDRA CHODA 10/10/1982 CONSULTATION ~ WEB ENTRY
Reports L-00002004 us01 UsHQ BOREN ROBERT 12/01/1970 WEB WEB ENTRY
Prnibicers: L-00006002 usot UsHQ NITIN J05HI 07/25/1983 CONSULTATION  OFFLINE APPLICV
Vandors L-00004004 12/19/2015 usot UsHO ANDRES MARTINEZ 08051983 CONSULTATION  WEB ENTRY
<

Applicant Information
[ saveandadd || [ saveand Stay | [ Save and Retum || Ga Retum

Applicant Information Address
“
Lead # UNDEFINED «Type = zp -
Lead Dt 02/04/2016 i
- * Country |UNITED STATES [v] oy
* Company [+ “stmte ¥
- * Postal Type NORMAL ADDRESS v
Branch [+ Email
Address #
La
Street Pre v
* First Name dsi 5
* Birth Dt [5“@ Street Name ﬂ
= Channel [v] Stres I Status Dt 02/04/2016
v e 5}
* Source =] [~ Followup D D
Telecoms | Comments | Documents | Requests
= Telecom Information o add || 7 Edit =] Vi o Aydi
paSnviomg View - Format~ B Freeze i Detach irap [50]
> Collections Telecom Type Phone Current
> WFP No data to display.
> Tools
> Setup

3. Inthe Lead Entry screen, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:
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Applicant Information

Applicant Information Section

Field Do this

Lead # View the sales lead number.

Lead Date View the sales lead date. System defaults the current date.
Company Select the company name.

Branch Select the branch name.

First Name Specify the applicant’s first name.

Last Name Specify the applicant’s last name.

Birth Dt Specify the birth date.

Channel Select the channel of the sales lead.

Source Select the source of the sales lead.

Address Section

Field Do this

Type Select the address type.

Postal Type Select the postal address type.
Address # Specify the address.

Street Pre Select the street prefix (directional).

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt # Specify the apartment number.
Address 1 Specify the first address line.
Address 2 Specify the second address line.
City Specify the city.
State Select the state.
Zip Select the zip code.

Note: For non US country, you have to enter zip code.
Country Select the country code.
Email Specify the e-mail address.
Alternate Specify the alternate e-mail address.
Email
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4.2.2

Field Do this

Assigned By | View the user code creating the sale lead.

Status Select the status for the sale lead.

Status Dt View the last sales lead status change date.

Follow-up Dt | Specify the sales lead follow-up date.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Telecoms Sub Tab

The Telecoms sub tab records phone numbers for the sales lead.
1. Click Telecoms sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Telecom Select the type of telecommunications device

Type

Phone Specify the phone number

Current Select the Current check box to indicate the phone
number is in service.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments sub tab

The Comments sub tab records any comments regarding the sales lead.
1. Click Comments sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the comment type.
Sub Type Select the comment sub type.
Comment Specify the comment.

Comment Dt | View the date when comment was entered and saved.

Comment By | View the user id of the person who entered and saved
the comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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423 Documents sub tab

The Documents sub tab needs to be completed if:

e The customer had requested any documents
e Any document has been sent to the customer during sales lead entry.

1. Click Documents sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Document Select the document type.

Type

Sub Type Select the document sub type.

Documents Specify the document.

Document Dt | View the date when document was entered and saved.
Document By | View user id of the person who entered and saved the document.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

424 Requests sub tab

The Requests sub tab records product the customer is interested in and the requested
amount for each product.

1. Click Requests sub tab available on Sales Lead screen.

2. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Product Specify the requested product as Loan.
Requested Specify the requested amount.
Amount

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.3 Follow-Up tab

The Follow-Up tab enables you to update customer information based on sales lead follow-
ups with customer.
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1. On the Sales Lead screen, click Follow-Up tab.

ORACLE"

Financial Services Lending and Leasing

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Agplication Retrievl
Scenario Analysis
Application Documents.
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WP

> Tools

> Setup

Sales Lead s

Lead Entry  Follow-Up  Maintenance

Follow-Up Details
View » Fomat- Ep Freeze i Detach J wrap B @ newO Followup
Company Branch Followup Dt Lead # Lead Dt
No data to display.
<

Follow-Up Details

Company
Branch
Followup Dt
Lead &

D Al

Name

& Welcome, PRAKRRAO +  Accessitility o
(%) Close
Z et || B A Aud
® Assigned By O Al
Assigned By Status Status Dt

[ save and Sty || [ Saveand Retum | {3 Retum

Assigned By
Status
Status Dt

2. In the Status field, click:
— New to view all leads on the Follow-Up screen with status of NEW.

_O r_

— Follow Up to view all leads on the Follow-Up screen with status of FOLLOW UP.

_0 r_

— All to view all leads on Follow-Up screen.

3. Inthe Assigned field, click:

— Assigned By to view all leads on the Follow-Up screen assigned to the current user.

_0 r_

— All to view all leads on the Follow-Up screen assigned to any user.

4. You can perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Company View the company name of sales lead.
Branch View the branch name of the sales lead.
Followup Dt Select the follow-up date of the sales lead.
Lead # View the sales lead number.

Lead Date View the creation date of the sales lead.
Name View the applicant’s name.

Assigned by | View the user assigned to the sales lead.
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Field

Do this

Status

Select the status of the sales lead.

Status Dt

View the last sales lead status change date.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Maintenance tab

The Maintenance tab enables you to attach a sales lead to a different or missed application

or change status of lead as NEW.

To attach a sales lead to an application

1. On the Sales Lead screen, click Maintenance tab.

You can view the following information:

Field View this

Lead # View the sales lead number.

Last Name View the last name of the sales lead.

First Name View the first name of the sales lead.

Status View the status of the sales lead.

Company View the company of the sales lead.

Branch View the branch of the sales lead.

Days of Inac- | View the number of days of inactivity regarding the sales
tivity lead.

2. Select the sales lead you want to attach to the application and click Attach to an
Application button.

3. You can view the following details of application attached to the lead:

Field

View this

Priority

The priority of the sales lead.
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Field

View this

Application# | The application number of the sales lead.
Date The date of the application.

Title The title of the application.

Product The product of the application.

Status

The status of the application.

Producer

The producer of the application.

If the wrong sales lead was attached to an application, detach it from the existing application
by clicking Change to New Status, then attach it to the correct application clicking Attach to

an Application, completing the App # field, and clicking Post.
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5.2

5. Simple Application Entry

Introduction

The first step in the Loan origination process is entering credit application data into Oracle
Financial Services Lending and Leasing Application. The Simple Application Entry screen
enables you to specify information from the credit application into the system and request a
credit bureau report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in the Applications
section. The product defines the type of credit application: Loan as well as any collateral,
such as vehicles or homes, associated with the Loan. When you save the application,
system activates the links on Applications screen that are associated with the product,
streamlining the application process. The producer is the dealer supplying the application.
When selected, the status of the Producer is displayed along with Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Loan such as Loan amount and
number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by the credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications
section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.

To enter a new application

1. Click Origination > Origination > Simple Application Entry.
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2. The Simple Application Entry screen appears, opened at the Search link’s Results

screen.

ORACLE’
Financial Services Lending and Leasing

e Origination 5
Origination Bearch/Task | Simple Application Entry || Review Requests (Pending: 0)
Crigination =
Sales Lead Quick Search
Simple Application Entry §
Atuliation Eatiy App = B Identfication =
Underwriting
Funding Queue [l Next Application
Application Retrievel
e Aok > Search Criteria
Application Documents
Image Maintenance o New Application
Reports
Producers Search Results/Task
Vendors Viewv Formate [ Freeze i Detach ) W vewal [
Critical Locked Allowed Company Branch App # Date Title Product
No data to display.
<
)
> Servicing
> Collections
> WFP
> Tools
 Setup

Submit

() Open Application || [5] View Application Unlock Application

Status Sub Status Q

The Recreate Instance button appears only when the BPEL parameter is YES.

3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s

Applications Entry screen opens at the Simple Application Entry tab.

ORACLE
Financial Services Lending and Leasing
e Origination 5 [ Close.
Origination Search/Task | Simple Application Entry: 0000001533 | Review Requests (Pending: 0) ~
Origination
Sales Lead Application: 0000001533: SIGG MARK
Simple Application Entry
‘Application Entry View v Formatv [ Freeze [ Detach B OvemideOK v WamingOK v {88 Process Application {8} Pre-Qualify Application
Underwriting Origination Stage Producer Gontact A Duplicate
Fke Dt App # Sub Unit Status Code Producer Nama Number Buisting Customer Application Contact
Application Retrieval [ | 09/05/2015 0000001533 REJECTED - AUTO... NEW CA-DO003 : ACE H. (818)-761-2277 N N
Scenario Analysis >
Application Documents
Image Maintenance
Reports Application
Producers (2 Retum
Vendors
App# 0000001533 Billng Cycle MONTHLY Class SMALL BUSINESS
Dt 03/05/2015 Purpose VEHICLE LOAN OR LEASE Seles Agert DEMOSUPR
Product LOAN VEHICLE (FR) Producer DEALER Joint _
Channel WEB ENTRY Producer Name  CA-D0003 : ACE HEADQUARTERS INC( ACTIVE ) €oSigned
Priority NORMAL Producer (818)763-2277 Contact
Company US01 Contact Lead # L-00001002 : TEST TEST LAST NAME
B Branch USHQ Number o8 Pull ¥ 0
Sub Unit PI1 Region ALL Override OK ¥
Status REJECTED - AUTO REJECTED Territory ALL Warning OK ¥
Origination Stage Code NEW
.
Duplicate —
Application
Loan Currency USD
Applicant  Business | Request Collateral =~ Comments Tracking  Verification
Applicant  Customer Search
Applicant padd | AEdt | Bl view | <2 Audit
View~ Fomatw B Freeze 5 Detach ol Wrap 0 [E Cony Lead Details
S Relation Type First Name NI Last Name Suffix 5N Birth Dt License # License State L
m | PRIMARY MARK DOUGLAS SI6G R 008660 01/05/1985 COLORADO &
> Collections < >
> WFP
> Tools Address | Employments | Telecoms
v
> Setup

For field description refer Applications of the Underwriting chapter:
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5.3

Copying Lead details

After selecting the sales lead number in the Lead # field and on clicking Copy Lead Details,
the applicant details which were captured in the Sales Lead screen are populated in the
Simple Application Entry screen. The Copy Lead Details button will be enabled only when you
select the lead number in the Lead # field.

Pre-qualifying an Application

After entering the basic details of the applicant like identification and demographic details
along with the address, employment, assets, liabilities and other income information and
requested details, the user has to check whether the application pre-qualifies or not by
clicking Pre-qualify Application button. This is governed by a set of Pre-qualification edits.

If pre-qualified edits are satisfied, the status is changed to NEW-PREQUALIFY APPROVED
and user can modify or update any further details in the Application Entry screen.

If the edits are not satisfied, application will be pushed to REJECTED APPLICATIONS queue
with a status update to REJECTED-PREQUALIFY REJECTED. You can also view rejected
pre-qualification in the Underwriting screen.

When specific services listed in Dashboard -> System Monitor -> Services tab are 'stopped’,
the application status will display 'NEW PRE-SCREEN APPROVED' and user will not be able
to change the status manually to move it to Underwriting queue. In such cases, services
should be started post which the application is processed automatically by the system and
falls in the appropriate queue as per work flow.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes

e Summary

e Credit Scores

e Duplicate Applicant

e Existing Accounts.
The system uses information on Financial and Liabilities sub tabs to determine the applicant’s
net worth. The system uses information on Employments tab and Other Incomes sub tab to
calculate applicant’s debt-to-income ratio.

Note the following while completing frequency fields:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.
e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information, refer appendix Payment Amount Conversion.
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To complete the Applicants Details screen

1. On the Simple Application Entry tab, click Applicant > Applicant.

ORACLE
Financial Services Lending and Leasing

@& Origination » [38] Close
Applicant i
View | o Audit
» DashBoard S|
Origination View v Format~ [ Fresze 5 Detach Urap @
Origination =
Ssies Lo 7 Relation Type First Name. ML Last Name Suffix SSN Birth Dt License # License State Language
ales Lea

Simple Application Entry Mo data todisplay.
i

Applcation Entry 0 ;
Underariting

Funding Applicant

Application Retrieval 483 Manage Form Gaketum
Scenario Analysis

Application Documents 3 Relation Type Existng Customer ID
Image Maintenance salutation Existing Customer # Reference #
Reports First Name Update Customer Info __ Stats
Praducers M
Vendors f Last Name Other Details FATCA |4
Family Name 4
U Name in'Local Language irth Place
Birth Dt Gender Birth Country
i Mother's Maiden Name Permanent US Resident Status _
Education
c
& a;;I Language Power of Attorney
mai
2 Dependents
Time Zone
Power of Attorey
Marital Status 2 E’H“' i :”E’ =
alder Name
Identity Information ECOA
— Address
= Countr
= =7 Nationaity Ethnicity i
> Servicing Natons Disabiity 22 Nationalty
> Collections S Privacy Opt Cut Telephone Number
> WFP Passport Issue Dt Irseae Opt Ot Military Service
Hilitary Service
> Tools Passpart Expiry Dt Marketing Opt Out __
5 Setu B Secasitoptonl] Active Miltary Duty _
. s License # Prior Bankruptcy

Effectve Dt ex

2. For details on this screen refer Applicant Tab of the Underwriting chapter.

Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving Loan
application during underwriting. The Business Applicant screen is available for Loan and
contains the following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on Application Entry screen.
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2. On the Application Entry screen, click Business.

ORACLE
Financial Services Lending and Leasing

i Close
T Origination 5 [E3fe
‘Origination Search/Task  Simple Application Entry: 0000001537  Review Reguests (Pending: 0) 7~
Qrigination
Sales Lead Application: 0000001537: RODRIGUEZ ROBINSON [El view || o Audit
Simple Application Entry .
Aeplication Ertry. View~ Fomaty P & Detach 1 wrap @ overideox v Waming OK v
Underwriting Origination Stage Producer Contact e Duplicate
F I Dt App = Sub Unit Status Code Producer Name Numl Buisting Customer Appiication Contact
Application Retrieval | 08/05/2015 0000001537 APPROVED - FUN... FUNDED CA-00003 : ACE H. (818)-761-2277 N N
Scenario Analysis >
Application Documents
Image Maintenance
Reporta Applicant || Business || Request || Collateral || Gomments || Tracking || Verification
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Vendors Business | Business Search
Business Details
View~ Fomat- [ Freeze i Detach o)
Organizabon Typs: {BusncssTyps! | Busiess Catogoey Bisiness: Name Lagal Name Tax D # Start Dt Sop Emﬁ“&i # of Employeas
i ceore. SERVICE SETME INTERSHELL INTE.. INTERSHELL INTE. 0000987 01/01/1968 12 32
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Business Details
&a Retum
Organization Type C CORP £ of Employess(Cur) 12 Loan Currency Avg Checking 87790
Business Type SERVICE # of Employess 32 orce
Business Category SETME Contact Person  SHARP .05 lorations 34
Business Name INTERSHELL INTERNATIONAL Business Checking Bank CITT Management Since 1980
Ccorp Bank Acc £ 735334066 Existing Business
Legs| Name INTERSHELL Currency US DOLLAR Existing Business Name UNDEFINED
THIERRATIONAL Avg Checking Balance 87,790.00 Existing Business # 0000000000
TaxID# X000(0987 i
Start D 01/01/1968
Address = Telecoms = Finandals Liabilities = Pariners  Affiliates  Other Details
> Servicing Address Information View || o Audit
> Collections View - Format~ [ Freeze  gffi Detach p et
> WFP Address Type Country Address # Gty State OwinjlLease Comment Fostal Type ‘Street Pre
BUSINESS UNITED STATES 100 CORPORATE CANTON MASSACHUSETTS ~ RENT NORMAL ADDRESS  NORTH
> Tools < >
v
> Setup

For details on this screen, refer Business Tab of Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested tab

To complete Request tab:
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1. On the Application Entry tab, click Request tab.

ORACLE’

Financial Services Lending and Leasing

ssibility o

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x

Search/Task  Simple Application Entry: 0000001536 Review Reguests (Pending: 0)

Application: 0000001536: RODRIGUEZ MILDRED

View~ Format~ [ Freeze i Detach
ot App# Sub Unit
05/05/2015 0000001536

Status
APPROVED - FUN.. FUNDED

@) OverideOK v  Waming OK v

Ongination Stage
e Producer Name

Applicant | Business || Request | Collateral | Comments || Tracking | Verification

Requested
View v Format~ [ Freeze  Eff Detach
Credit Limit Advance Promotion
16,900.00 18,500.00 NONE
Requested

Credit Limit 18,900.00

Ttemization  Trade-In | Subvention

Itemization

Vieww Fomatv [Ep Freeze 54 Detach
Itemization +-
TTM OTHER FEE +

ITM AMOUNT PAID TO OTHERS ON M.

ITM AMOUNT PAID ON MY LOAN ACC... +
ITM AMOUNT GIVEN TO ME DIRECTLY  +

Advance 18,900.00
wep B
Reguested Amt Comment
0.00
18,900.00
0.00
0.00

Existing Customer  DUAICatE Contact

CA00003 : ACE ... (818)-761-2277

[ Gose:

view || < Audit

Application
¥
>

[ Elven || o mat

<A Retum

Promotion UNDEFINED

B vew || o audit

Total Requested 18,500.00

For details on this screen refer Request Tab of the Underwriting chapter:

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screens: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
screens share. If you are entering an unsecured Loan, the Collateral tab is present but

inactive; in which case, skip this step.
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To enter vehicle information from the Collateral tab

1.

On the Application Entry link bar,

click Col

ORACLE

Financial Services Lending and Leasing

lateral.

DashBoard
Origination
Origination
Sles Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Froducers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination 5 (3] Close
Search/Task | Simple Application Entry: 0000001536 = Review Requests (Pending: 0)
Application: 0000001536: RODRIGUEZ MILDRED fiew || o Audit
View » Format— [ Fre & Detach p W Override 0K v Waming OK v
Origination Stage Producer Contact 3 Duplicate
[ App # Sub Unit Status e Producer Name 1 o0U°e Existing Customer RS Contact
1 os/0s/2015 0000001536 APPROVED - FUN... FUNDED CADO003 : ACEH... (B18)761-2277 ¥ B
>
Applicant | Business || Request | Collateral || Comments | Tracking || Verification
Collateral
Home [Eview | o aui
Views Format [ Freeze FfiDetach | of 5]
DN bristing Assetld  Primary  Asset Class Asset Type Sub Type Occupancy Identification #  Country. Address =
N ¥ NEWVEHICE  HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 UNITED STATES 480 NEPONSET 5T
< >
“«
Valuation  Tracking
Valuation View || & Audit
View v Formatw [ Freer= EfiDetach &l o]
Loan Currency Usage Value Amt
Qument . 0N CUTeRY Retail Base Amt () Valuation ot Source Currency Eition Supplement Whalesa
¥ 19,000.00 15,500.00 0.00 0/05/2015 INVOICE US DOLLAR
< >
Addons View || of Audit
View v Formatv B Freeze &4 Detach (22}
Description value Amount Loan Currency Amount
ANTI THEFT 250.00 230,00

To enter home information from the Collateral tab

1.

RACLE’
Financial Services Lending and Leasing

On the Application Entry tab, click Collateral sub tab.

DashBoard
Origination
Origination
Sales Lead
Simpie Application Entry
Application Entry
Underwriting
Funding
Apglication Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination x (3] Close
Search/Task ~ Simple Application Entry: 0000001536 ~ Review Requests [Pending: 0) -
Application: 0000001536: RODRIGUEZ MILDRED Bl view || < Audit
View v Formatv [ Hipetach Wirap 8 Overideok v Waming OK v
Origination Stage Producer Contact 2 Duplicate.
Dt App Sub Unit Status Code Producer Name Number Buasting Customer Aapplication Contact
'7“ 08/05/2015 0000001536 APPROVED - FUN. FUNDED (CA-DO003 : ACE H. (818)-761-2277 L -
>
Applicant || Business | Request| Collateral | Comments  Tracking || Verification
Collateral
Home [El view || < audit
View » Formatw B Freeze  ; Detach wrap 5]
Xe0  pxstingassetld  Prmary  Asset Class asset Type Sub Type Oceupancy Identification £ Country Address & A
i~ ¥ NEW VEHICLE HOME SINGLE FAMILY H.. OCCUPIED BY OW... E26A119602 'UNITED STATES ‘480 NEPONSET S1
<
4
Home
{3 Retum
Bxisting_ State MASSACHUSETTS Legal Deseription
Asset County NORFOLK Lot 23
Pt Sub Division
-‘:Sﬁ u . Type & Description Parced 1D
rimary Census Tract / BNA Code Metes-Bounds.
t NEW HOME -
Aﬂfass ot MSA Code Flood Zone
Pt Type GEQ Code 1098 Not Required ¥
A squire
Sub Type SINGLE FAMILY HOME Condition GOOD CONDITIONED
Oceupancy OCCUPIED BY GWNER AS PRINCIPAL RESIDENCE Description 3015 INVERNIZZT Sacioa
Identification E26A119602 'CONSTRUCTION CO VILLA.
# Year 2015 Construction Permit Dt 01/30/2016
Age O Deed Dt 01/30/2016
T Make INVERNIZZI CONSTRUCTION Dx F
Country UNITED STATES ueaidPlaEafG Issue AMESBURY
P rties Bou om East
Address # 480 NEPONSET 5T wi roper undary from
North
Address Line Width 1200 i
west
B Length 3400 i
Address 15 TN ST Area BELLINGHAM -
o PO # 122 RABEIT
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If collateral is any other, the Collateral link displays information about that collateral.

ORACLE’

Financial Services Lending and Leasing

DashBoard
Origination
Grigination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Froducers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination x (3 doze
Search/Task  Underwriting: 0000001533 Revisw Requesis (Pending: 0) .
Application: 0000001533: SIGG MARK ZEdit | Elvew | o audit
View » Formatw [E T £ Detach J] Wrap B Overide 0K v Waming OK v
Origination Stage Producer Contact 2 Duplicate
Dt App = Sub Unit Status Code Producer Name Nur Existing Customer Application Contact
09/05/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACEH.. (818)-761-2277 N N
>
Summary | Applicant || Business || Request || Dedsion | Bureau | Collateral | Comments | Tracking | Document | Verfication | Comespondence = Tools
Collateral | Seller
Other Collateral dpadd | A Edi | 5 view || o2 Augit
Vieww Fomatv [ &l petach | Wrap @ Existing Asset Id ¥ ok Load Details
z:;"g Existing AssetTd Primary  Asset Class Asset Type Sub Typs Status Year Age Make Model
N : ]
N oy NEW VEHICLE VEHICLE CAR NOT DEFINED 20150 AUDI A4
< 2 X
Other Collateral
B ssveandadd || Bl Save and Stay || [ Save and Retun || 3 Retum
Existing Asset Body 7 3
Existing Asset Id = Registration # UNDEFINED Zip Extn
“ Frimary & 7
Identification # -
* Asset Class NEW ASSET [v] Gity
Description T
= Asst Ty State [v]
Aevel Tyie {HOUEEHOLD EO00S = Condition | GOOD CONDITIONED [~ M =
; v
= Sub Type | GENERAL HOUSEHOLD GOODS / EC[v] =
* Status |NOT DEFINED ] Address Usage Details
= Country UNITED STATES [v] %
Select Make and Model v " Start |0
Address # %
=Year 0 Basz 0
o Address Line 1 B
s
Make Heitutnat *Total 0
Model * Charge Amt 0.0
valuation = Tracking v

For details on this screen, refer Collateral Tab of the Underwriting chapter.

Comments Tab

When using the Simple Application Entry screen, you can add comments to an application at
any time in the application entry process by clicking Comments tab.

ORACLE
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To complete the Comments tab

1. On the Application Entry tab, click comments.

ORACLE
Financial Services Lending and Leasing
DashBoard Oexielion x
Origination Search/Tesk  Simple Application Entry | Review Requests (Pending: 0)

Origination
Sales Lead Kplication
Simple Application Enfry -
‘Application Entry View v Format~ cze I Detach ] Wrap @ Override 0K _  Warning OK __
tileieiiy ot Aop 2 Sub Unit Status Onigination Stage  progcer Name | Froducer Contact
Funding e e
Application Retrieval o (” SO
Scenario Analysis
Application Documents.
Image Maintenance
Reports Applicant | Request = Comments Tracking | Verification
Froducers
Vendors

Comments
View v Formatv [ Freeze i Detach J wrap 5]
et Type Sub Type Comment
O REGULAR [v] | Loan oRIGINATION [v]
o

> Servicing

> Collections.

> WFP

> Tools

> Setup

dpadd | Aedi || 5 view || o audie

Duplicats
Application Conkact

| B sove and stay saveand Retum || GaRetum

[ Close

>

Comment Dt

02/04/2016 05:54:58 AM

For details on this screen, refer Comments Tab of the Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.

What items you choose to track are setup during implementation.
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To track attributes

1. On the application entry screen, click the Tracking tab.

ORACLE" 2 Welcome, VAVAIDYA ~  Accessibility o
Financial Services Lending and Leasing

T Origination x (3 Qlose

Origination SearchfTask  Simple Application Entry | Review Requests (Pending: 0)

Origination

Sales Lead Application dpadd | FEdit | 5] View | < Audit
Simple Application Entry o
Application Entry View - Format~ [ Freeze {f! Detach Wirap B Overide OK__ Wamning OK _
Underviriting s
5 igination Stage Duplicate

Funding ot App # Sub Unit Status b Producer Name CoiExetng Customer i, Contac
AP e o data to display.
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Apglicant || Request | Comments = Tracking | Verification
Vendors

Tracking Attributes | Field Investigation

Tracking Attributes A Edit || of audit

View + Format= (B Freeze i Detach el Wrap ot} 4 Load Tracking

Sub-Parameter Parameter value
No data to display.

> Servicing
» Collections
> WFP
> Tools

> Setup

For details on this screen, refer Tracking Tab of the Underwriting chapter

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

Ifitis an Error, the system will not allow you to change application’s status and approve Loan
until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

To validate a credit application

1. Enter all the information associated with the application on the Application Entry screen.

5-10 ORACLE



5.9.1

2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing

& Welcome, VAVAIDYA -~  Accessibility _ o

: Close
DashBoard Origination —

Origination Search/Task  Simple Application Entry | Review Requests (Pending: 0)

Application
View ~ Format~ B Freeze G Detach Wrap @) Ovemide OK_  Warning OK __

Fadd | AEdt || Bl view || o audit

Pre
ot App # Sub Unit Status ® Producer Name Co Bxsting Customer  DUPlicate Contac
o Application

>

Applicant | Request | Comments | Tracking Verification

Edits

Edit Types

View~ Format~ [ Freeze i Detach Al Wrap o] Edit Type [V] 48 check Edits
Date Edit Typ:
No data to display.
Edit Details
View v Formatv (B3 Freeze  Eff Detach  Wrap [5:]

Edit Name. Result
No data to display.

Expected Value  Actual Value  Override Responsibility

> Servicing
> Collections
> WEP

> Tools

> Setup

For details on this screen, refer Verification Tab of the Underwriting chapter.

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.
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6.1

6.2

6. Application Entry

Introduction

The first step in the Loan origination process is entering credit application data into Oracle
Financial Services Lending and Leasing Application. The Application Entry screen enables
you to specify information from credit application into the system and request a credit bureau
report.

This chapter explains how to use the Applications screen to specify and validate a credit
application.

Entering a Credit Application

There are four main steps in entering an application

1. Select product type and producer at the top of the Application screen in Applications
section. The product defines the type of credit application: Loan as well as any collateral,
such as vehicles or homes, associated with the Loan. When you save the application,
system activates the links on Applications screen that are associated with the product,
streamlining the application process. The producer is the dealer supplying the application.
When selected, the status of the Producer is displayed along with Producer Name.

2. Enterinformation regarding the primary applicant, such as name, social security number,
address, place of employment and financial assets and liabilities. Enter this same
information for any other applicants, such as co-signers or joint applicants, if they exist.
System displays the error message as “The Application does not exist” if the provided
details does not match with any application details.

3. Enter information about the requested credit for the Loan such as Loan amount and
number of terms.

4. Enter information about the collateral.

You can also enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In container. For more details, refer to ‘Application Entry using Fax-
In’ section.

Once the basic details are entered, the user has to check whether the application pre qualifies
or not. Once the pre-qualified edits are satisfied, click Submit in the Application screen. Pre-
qualification edits can be viewed from the 'Verification' sub tab.

When finished, Oracle Financial Services Lending and Leasing checks the application for
completeness using a predefined set of edits. These edits search for errors and warnings
based on your system setup. Status change of the application can be determined by credit
bureau and scoring model of the application. The prescreening checks ensure that automatic
credit bureau reports are pulled only for applications which meet set criteria, thus saving cost.

After an application clears the edits check, click Process Application in the Applications
section. The system begins the processes of prescreening the application and pulling a credit
bureau while you can begin entering the next application in your queue.

Credit Application via External Interface

You can also load credit applications created in external system into Oracle Financial
Services Lending and Leasing for further processing.
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OFSLL integrating with external system facilitates to transfer the pre-populated credit
application data into the system through an xml file. Such credit applications are categorized
in OFSLL as either 'eCONTRACT/DEALER CONTRACT in the actions section. However,
OFSLL generated credit applications are marked as MANUAL CONTRACT.

Once a credit application is successfully validated and loaded in Application Entry screen, a
response is sent back from OFSLL to the external system. Similarly, all subsequent status
changes initiated in OFSLL are updated to the external system. All communications between
OFSLL and external systems are recorded into a log and is accessible through Dashboard >
System Monitor > Database Server Log Files screen. Also the ‘Comments’ screen facilitates
to exchange information regarding credit application processing between OFSLL and external
system as comments, provided the comment Sub Type is selected as 'OUTBOUND TO
INTERFACE' for such communications.

Hence effectively you can by-pass the need to re-create the application in OFSLL and helps
in faster processing of credit applications and decision making.

To enter a new application
1. Click Origination > Origination > Application Entry.
2. The Application Entry screen appears, opened at the Search link’s Results screen.

ORACLE' o wiek
Financial Services Lending and Leasing

7 Close.
> DashBoard Origination xc —

Origination SearchfTask | Appication Eniry | Review Requests Pending: 0)

Quick Search

App # SN Identification # [ submit
Fundng Queue [=] [ Nextapplcation
Application Retrieval
Scenario Analysis > Search Criteria
Application Documents —
Image Maintenance o New Application | | [ Open Application Unlock Application
Reports
Producers Search Results/ Task
Vendors View Fomat~  [B3| ([[Freee fiDetach | @) viewAl @

& %FUNDED%

GritLodl Al Company  Branch App Date Titke Product Status Sub Status
No data to display.

Columns Hidden 1

> Servicing
> Collections
- WFP

> Tools

- Setup

The Recreate Instance button appears only when the BPEL parameter is YES.
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3. Inthe Results tab’s Quick Search section, click New Application. The Search link’s
Applications Entry screen opens at the Application Entry tab.

ORACLE’
Financial Services Lending and Leasing

Origination
 DashBoard dhichuin.
Origination Search/Task  Application Entry: 0000001105  Review Requests (Pending: 0)
Qrigination A
Sales Lead Application: 0000001105: HOOD MARK JEit | [EYen | o At
i'mp"‘a :WI'?‘;D” L View = Format v E\ [l Freeze ﬁ‘ Detach gﬂ Wrap @ﬂ Overide OK ¥ WarringOK ¥ {of Process Application 40 Pre-Qualify Application
pplication Entry "
Underwriting 6’ Ezl) b
Funding Sub Origination Producer Existing  Duplicate
Aoplication Retrieval ot App # it Stetus Stage Code Froducer Name Contact Number Customer Application Sales Agent
Scenario Andlysis 002015 0000001105 | NEW-REVIEWREQUIRED REVIEW ~ CA-0003:HARRYMOTO.. (518)-887-9875 N N DEMOSALES
Application Dacumentsé 4 i }
Image Maintenance
Reports l}
Froducers Application
Vendors [ saveandstay | [ saveandRenm | CaRetm
E | "
3 App # 0000001105 *8ling Cyde MONTHLY = *Class INDIVIDUAL =)
+ i gl
Dt 08/01/2015 & Purpose VEHICLE LOAN OR LEASE =) Sales Agent DEMOSALES
® \ 3 * i
; Product LOAN VEHICLE (FR) B * Producer DEALER. g . Jmn; H
* " CoSignes
thornd (IEAENIE B <o bane cadonns: ek MoTORS(ACTIE) & [
* Priority NORMAL E| Producer Contact (618)-887-9876 ——
Number #
*Company US01 [+ heut =
Region ALL *CRg pul m
*Branch USHQ [+ Territory ALL g
* Override OK 7]
Sub Unit SUBTUFJTrll Exdsting Customer *\arming OK \-ﬂ
Status NEW -REVIEW REQUIRED Duplicate __
Origination Stage Code  REVIEW Application
Loan Currency USD
Summary Applicant | Request Dedsion  Bureau  Collateral Comments Tracking Document  Verification  Correspondence  Tooks

For details on this screen refer Applications section in Underwriting chapter.

Applicants Tab

Using the information supplied on application, complete Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Financials

e Liabilities

e Other Incomes sub screens
e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts
e Tracking Attributes

The system uses the information on the Financial and Liabilities sub tabs in determining the

applicant’s net worth. The system uses information on the Employments screen and Other
Incomes sub screen to calculate the applicant’s debt-to-income ratio.
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To complete the Applicants Details screen

1.

On the Application Entry tab, click Applicant > Applicant.

ORACLE . 3 N AR ity 1§ Sign out
Financial Services Lending and Leasing
@8 Origination @] Cose
Applicant
Save and add || [ SaveandStay | B SoveandRetum || (aRetun
> DashBoard = = =
Origination *Relation Type PRIMARY [=] Existing Customer 1D NONE [0]
Existing Customer # =
Origination P Bl g ) Reference
Soles Lead * Update Customer Info [ — =
* FirstName | SMIT
smple Appiication Entry b
Acplcaton Entry v Other Details catca
u”dj”“”“”'] * LastName | JOHN
Funding Name in Local Language
ly Birth Place
Arplcation Retrieval Family Name PATRICS g El 0
Scenario Analysis suffic [=1 —_— Bt Conia: =
Applcation Documents Sann T Mother's Maiden Neme =
Image Maintenance Education E\ Resident
. * 55N 545826549 Status
eport *Language ENGLISH [=]
Producers *Class NORMAL [=]
*Dependents 0 Power of Attorney
Venders ‘
Email =
Warital Status - I
Time Zone [=] power of [[]
ECOA INDIVIDUAL = Attormey
Holder Name
Identity Information Race = |l
= Address 3
Ethniaty =]
Country
* Nationality USA - Rl == o
Nationality
*=National ID 2584-526-3655 Enter the applicant’s passport number
Telephone
Passport # * Insurance Opt out [ Number
Passport Issue D & * Marketing Opt Out [ SO
. " = ilitary Service
Passport Expiry Dt 2 Share Credit OptOut [0
= ek prior Bankuptcy [ +acve B
et ] Bankruptcy Discharge Dt (£} Miltary Duty
> Collections Hesnse = Effectve Dt
S License State [=1 KC Order Ref #
S Prior Applicant _ Release Dt B
Existing Customer _
> Setup
Address | Employments || Telecoms | Existing Accounts =

For details on this screen refer Applicant Tab section in Underwriting chapter.

B

usiness Applicants Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business screen to assist in approving the Loan
application during underwriting. The Business Applicant screen is available for Loan and
contains the following sub screens:

To
1.

Address
Telecoms
Financials
Liabilities
Partners
Affiliates
Other details

complete the Business Applicant screen

If SME business information is included on the application, select SMALL BUSINESS
inClass field on Applications section and click Save.

The Business tab appears on the Application Entry screen.
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2. On the Application Entry screen, click Business.

ORACLE & Welcome, DEMOSUPR +  ccesspiity 8 sgnout O
Financial Services Lending and Leasing
> DashBoard Origination [ Close
Origination Result/Task Application Entry: 0000002668 Search Review Requests (Pending: 0) ES
V' Origination
i Edit View Audit
Sales Lead Appiication et | Elven | e |
Simple Application Entry View v Format v | Ep Freeze  ffivetach | o wrap B overrice ok [] warning 0K {83 rocess Appicaton | 83 Pre-uaify Applcation |
Application Enry | | Producer ‘
- |arigination Stage Existing
Underwriting Dt App # |5|atus foae Producer Name Contact ‘ e |8
Funding _ = | - - Number_
Applaton Retrieval [ Bz 0000002568 NEW -BLANC New AE-00002 : TIN TAN PRO( ACTIVE ) (14785238570
Scenario Analysis Al L ~ k
Application Documents
Image Maintenance
Rt Summary Applicant Business Request Collateral Comments Tracking Verification Tools
Producers -
i Business Details Fradd | PEdt | [Sven | o audt
Wiew =] Fomat ~ | Freeze  GfiDetach e | B
Organization Type  |Business Type Business Name [Legal Name TaxID £ Start Dt # of Employees(Cur) #of Employees ContactPer
o o
[ i | v
il -
Business Details ﬂ
H seveand add | [ saveandstey | [ saveandRetum | Gametm |
* Orgarization [+] *Start Dt & * Bank Acc #
Type
_ ihw *2of =ava[p
Business [=] Employess(cur) Chedking
Type *40f[g Balance
5 5“5;‘”“5 Employees *#of
ame
Contact Person A
*Legal Name *Management [
* Business S
*TaxID # Checking Bank
5 P — = . '
Address | Telecoms Financials Lizbilties Partners Affiiates Other Details
Address Information dp add | 7 it =] view | o Audit
2| Servicing view  Format v | Ep Freeze £ Detach Il Wrap 5]
>/ Collections |address Type |country |address # |ty |state |ownpLease |comment |Postal Type |streetpre
> WFP Mo data to display.
< m *
>/ Tools % -
Columns Hidden 1
»| setup o

For details on this screen refer Business Tab section in Underwriting chapter.

Request Tab

Depending on the type of product you select, the following screen will be available from

Requested link

To complete the request tab:
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1. On the Application Entry tab, click Request tab.

Financial Services Lending and Leasing
Fe— Close
DA Origination =
e el Search/Task  Application Entry: 0000001015 Review Requssts (Pending: 0)
Origination
Sales Lead Application: 0000001015: K NAVIN EI View | o Audit
Simple Application Entry @ . 2 .
few » Format v Freeze B Detach ] virap OverrideOK ¥ Warming OK ¥
Applcation Entry & el = L > = ‘
N . s Orignation Producer Existng  Dupicate
End:mrmr\g ot App # e Status Stage Cote Producer Name Contact Number Customer Applegtion Contact Sales Agent
e 10/12/2015 0000001015 UND... NEW -REVIEW REQUIRED NEW CA-00002 : RANDYS AUT... (309)-591-4116 Y. Y DEMOSUPR
Application Refrieval 7 = = -
Seenzrio Analysis
Application Documents
Image Maintenance
Reports Summary || Appicant | Request  Dedsion | Bureau | Comments | Tracking | Document | Verification | Correspondence
Producers
Vendors
Requested (£ view || < Audit
View v Format v @ Freeze IfiDetach Il Wrap (5]
Credit Limit Advance Promotion
200,000.00 35,000.00 NONE
4
L
Itemization  Subventon
Ttemization [l view | o Audit
View v Formatw [ Freeze fiDetach 1] Wrap 5]
Itemization +- Requested Amt Comment
TV OTHER FEE + 0.00
ITM AMOUNT PAID GN MY LOAN ACEO... + 0.00
ITM AMOLINT PAID TO OTHERS ON MY ... + 0.00
ITM AMOUNT GIVENTO MEDIRECTLY  + 35,000.00
Total Requested Amt 35,000.00
» Servicing
» Collections
> WFP
> Tools
» Setup

For details on this screen refer Request Tab section in Underwriting chapter.

Bureau Tab

The Bureau tab displays credit report (if pulled) for an applicant. If there is a need for another
pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab

1. Open the Application Entry screen and load the application you want to work with.

6-6

ORACLE



6.7

2. Click Bureau

ORACLE’
Financial Services Lending and Leasing

mr—— Close
e Origination ]
Origination Search/Task | Application Entry | Review Requests (Pending: 0) -
Origination *
Sales Lead
Simple Appication Entry
Application Entry Applicalion padd || ZEdt | [Fven | of Audt
Underwriting view = Format v [f5H| Freeze EfiDetach ol Wrap W overideock _ WamingOK _
Funding S
Application Retrieval ¢ % = sy — e e
; 4 u rigination roducer xistng  Duplicat
Scenario Analysis Dt A = it Status Stage Code  Producer Name Contact Number Customer Appication Contact Sales Agent
Application Documents No data to dsplay.
Image Maint=nance i = ™ D
Reports =
Producers
Vendors
Summary Applicant  Request | Decsion  Bureau  Contract| Comments | Tracking Document | Verificstion — Correspondence
Consumer
Bureau Details qpadd | ZEdt | [ view | o Audit
q IMPORTANT: Access to credit reporting agency systems is for authorized users and only for permissble purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is punishable
by a $2500 fine and/or 1 year in Federal prison per occurrence 4
View v Formatv  Ep Freeze [ffiDetach | ol Wrap @) 3 submitRequest
Type Bureau # Status Dt Report S’Eﬂ;“gﬁ“
No data to display.
< il 3
Bureau Details
CaRetum
Bureau Details
Type Status Credit Bureau Reorder #
Bureau ot AppInd _
= Report
> Servicng Applicant/Customer Details
> Collections i Brevious Next Last
> WFP
Type Suffix Address Line 2
> Tools First Name Include Debt State
> Setup ML Popuiate Debt 7p L

For details on this screen refer Bureau Tab section in Underwriting chapter.

Collateral Tab

Depending on the type of product or producer you select, the Collateral tab opens one of the
three following collateral screen: a vehicle information screen, a home information screen or
an other information screen. Complete the screen that is available on your Applications
screen. After that, complete the Valuation and Tracking sub screen, which the Collateral
link’s screens share. If you are entering an unsecured Loan, the Collateral link is present but
inactive; in which case, skip this step.

To enter vehicle information

from the Collateral tab
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Collateral link displays information about the vehicle

ORACLE

Financial Services Lending and Leasing

On the Application Entry link bar, click Collateral. If the collateral is a vehicle, the

DashBoard
Origination
‘Origination
Sales Lead
Simple Application Entry
Application Entry
Underwiting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination x

Search/Task  Simple Application Entry: 0000001536 | Review Requests (Pending: 0)

Application: 0000001536: RODRIGUEZ MILDRED

View - Formate [Ep Freeze i Detach J wrap W overideoK v  Warning OK v
Dt hpp 2 Sub Unit Status ?L‘dg‘e"a“"" S0 producer Name ;{j’d“‘e’ oMt Ericting Customer
[ osjosy2015 0000001536 APPROVED - FUN... FUNDED CADOD03 : ACE ... (818)-761-2277 ¥
Applicant | Business || Request | Collateral | Comments | Tracking || Verfication
Collateral
Home
View v Format~ [ Freeze i Detach ol Wrap o)
DP  EustngAssetld  Primory  Asset Cless st b oty Hontfication'®  |Coury:
in i NEW VEHIGLE HOME SINGLE FAMILY H.. OCCUPIED BY OW. . E26A119602
4 <
valuation | Tracking
Valuation
View v Formatw  [Ep Freeze i Detach ol Wrep @
an Currency i Usage Value Amt
Cument R e Retail Base Amt {1 veluation Dt Source Currency Edition
¥ 19,000.00 19,500.00 0.00 03/05/2015 INVOICE Us DOLLAR
<
Addons
View v Formatw G Freeze  Eff Detach Wrap [}
Description Value Amount
ANTI THEFT 290.00

UNITED STATES 480 NEPONSET ST
>

[ Close.
Bl Wiow || 2 pudit
Duplicate
Application e
¥
>

Address #

view || < Audit
Supplement Wholesa

>

[Elviow || o audit

Loan Currency Amount:
290.00

If the collateral is a home, the Collateral link displays information about the home.

ORACLE’

Financial Services Lending and Leasing

> DashBoard

Origination

4 Origination
Sales Lead
Simple Application Entry
Application Entry
Underariting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
» Collections
> WFP

> Tools
 Setup

Origination » 3] Dlose
Search/Task | Application Entry: 0000001155  Review Requests (Pending: 0) a
Application: 0000001155: CCINQUWFOIL PIERRE / JEAN At || Elvew || o audt
View v Formatv [ Freeze i Detach ol Wrap ) overideok ¥ WamingOK ¥  {8%Process Application 48 Pre-Qualify Application
Dt App £ Sub Urit Status Origination Stage oy cer Name Pmr::;f’ Contact  picting Customer  Dupicate Applcation’ Contact
04/01/2012 0000001155 UNDEFINED  NEW - REVIEW REQUIRED REVIEW MN-00001: INHO... (3528426287 N N
< - m, | 3
Summary | Appicant | Request | Decsion | Bureau  Collateral | Comments | Tracking | Document  Verification || Correspondence  Tools
Collateral  Seller
Home dqpadd | Fedt | [Guew | o dudt
View » Format~ B} i Detach B Edsting Asset 1d ¥ o Load Detais
DOM0 exstngAssetld  Primary  Asset Class AssetType Sub Type Occupancy Identification = Country Address 2
N i USED HOME 'HOME SINGLE FAMILY H IVFPBOD43SMS 1. UNITED STATES 123 E
s i ] b
Valuation  Tracking
Valuation dpadd | Fedt || [Fven | oAt
View v Formatv Freeze EfiDetach ¢l rap [T
Loan Currency
Current \Wholesale Base Amt Retail Base Amt Usage Value Amt (+) Valuation Dt Source Currency Edition Supplement Wholes
¥ 10,000.00 10,000.00 0.00 0410/2012 INVOICE US DOLLAR
1 m I »
Addons qpadd | FEdt || [Gvew | o Audit
View v Formatv Freeze i Detach e
Desaription Value Amount Loan Currency Amount
No data to display,

If the collateral is any other, the Collateral link displays information about that collateral.
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6.9

For details on this screen refer Collateral Tab section in Underwriting chapter.

ORACLE"
Financial Services Lending and Leasing

Oniginatio 3] lose
 DashBoard s ol
b Search/Task  Application Entry: 0000000382 | Review Requests (Pending: 0)
Origination
Sales Lead Application: 0000000382: TOLMAN GREG / EVA Elyew || o Audit
Simple Application Entry = e e
View v Format Freeze fiDetach ol Wrap Override 0K ¥ Warning OK v
Application Entry & o z @ ?
Underwriting ot nop # S0 Status Crignation Stage Code  Producer Name  Producer Contact Number 0o opnd, Duplicate Application Contact
T 02/01/2012 0000000382 UND.., APPROVED - AUTO APPROVED NEW GA-00004: ADVA... (770)-424-6450 N N
Application Retrieval e e e ¥
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary | Applicant | Request | Dedsion || Contract || Colstersl | Comments || Tracking || Document || Verification || Correspondence || Tools
Producers
Vendors
Comments Bl view | of Audit
View = Format~ Freeze B Detach ] virap o]
Alert Type S Type Comment Comment 8y Comment Dt

Comments Tab

When using the Application Entry screen, you can add comments to an application at any time
in the application entry process by clicking the Tracking tab.

To complete the Comments screen

On the Application Entry tab, click Comments.

ORACLE . . 3 & Welcome, DEMOSUPR ~  Accessbiity 23 Signout O
Financial Services Lending and Leasing
»| DashBoard Origination [ Dose
Origination Result/Task Application Entry: 0000000266 Search Review Requests (Pending: 0) z
V Origination
i Edit View Audit
Sales Lead Application L | Buen | Pt |
Simple Appiicaton Entry View = Format v | B Freeze ffiDetach | o Wirap W overide ok Warning OK {83 Process Appication | {8} Pre-Quailfy Appiication |
Application Entry \ ‘ | | Producer |
e |Origination Stage | |Existing
Underwriting Dt iAw- = e [producerNeme cm:n [cummer =
Fundng E | ) | | : |Mumber
vt .(wuumu 0000000266 'APPROVED - AUTO APPROVED  DECISIONED 'MN-00001 : IN HOUSE (DIRECT DEAL)( ACTIVE ) (952)-942-6297 N
« il [
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary Applicant Request Dedision Contract Comments Tracking Document Verification Correspondence Tools
Producers
Vendors Comments
GaRewmn
View v Formatv | Ep Freeze i Detach 1l wrap 5]
| mlert [Type |sub Type |comment: Comment By |comment pt |
No data to display.
4
; !

For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.
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6.10.1

To track attributes

1. On the application entry screen, click Tracking tab.

ORACLE ) .
Financial Services Lending and Leasing
Originat [ Ciose
> DashBoard RO X
Origination SearchfTask  Application Entry | Review Requests (Pending: 0)
Origination
Sales Lead Application e add | AEdt | 5] view || o Audit
Semple Apicaton Bty View » Format~ [ ol Wrap @) OverideOK __ WamningOK __
Application Entry = 5 =
= sul Origination Producer Existng  Duplicate
ur\dda\ wiriting Dt App # Unt  Status Stage Code _ Producer Name ContactNumber Customer Application Contact Sales Agent
Frdng No data to display.
Application Retrieval o [ r
Scenario Analysis
A tion Documents
Image Maintenance
Reports Summary Appicant Request Dedsion Bureau Confract Comments Tracking Document Verification = Correspondence
Producers
Vendars Tracking Attributes  Field Investigation
Tracking Attributes A Edit || of audt
View v Fomatw B Freeze EfiDetach | ol Wrap (5] o Load Tracking
Sub-Parameter Parameter Value
No data to display.
“
»

For details on this screen refer Tracking Tab section in Underwriting chapter.

Document Tab

Document Sub Tab

Application Entry’s Documents screen enables you to view Application Documents and

Application Documents Details.

ORACLE'
Financial Services Lending and Leasing

. DashBoard Origination
Origination Search/Task  Application Entry | Review Requests (Pending: 0
Origination
Sales Lead Application
Simple Appiication Entry = 5 " :
View v Format v reeze EfDetach ol wrep Override OK Warring OK
Application Entry & o > @ = ikl
Underwriting Dt App = Sub Urit Status g;‘g‘e”m” S8 o oducer Name
Funding No data to display.
Application Retrieval T i
Scenario Analysis
Application Documents
Image Maintenance
Reports Summary | Applicant | Request | Decision | Bureau = Contract Comments Trackng Document  Verification
Producers
Vendors Checklist  Document
Checkiist
View v Formatw [ freere EfDetach Wrap @ o Load Checkist
Checklist Type Checklist Comment
Mo data to dsplay.
‘
Regular  Document
Checklist Actions
View = Formatv [ Freeze  EdiDetach ol Wirap (o]
Action Comment
No data to display.
> Saervicing
»» Collections
> WFP
> Tools
> Setup

[ ose
dpadd | AEdt | E]vew | of Audit
P'u““w Contact st Customer  Duplicate Agplication Contz
'
Correspondence
A Edt || Eyew | o audt
Complete
b
A Edt || [Fven | o Audit

Response

For details on this screen refer Document Tab section in Underwriting chapter.
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6.12

Verification Tab

Oracle Financial Services Lending and Leasing can be configured to automatically validate
portions of an application when you attempt to change its status. The results of this data check
appear on the Verification link’s Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Loan until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move application to queue of the user with required authority.)

To validate a credit application
1. Enter all the information associated with the application on the Application Entry screen.

2. When you are finished entering data, on the Application Entry tab, click Verification sub
tab, then click the Edits sub tab.

ORACLE’
Financial Services Lending and Leasing
=z Close
T Origination [
e Search/Task  Application Entry | Review Requests (Pending: 0)
Qrigination
Sales Lead Application dpadd | At | [Evew | o audt
Simple Application Entry View v Format = S Detach rep 7 »
24 v Freeze H Wrap Override OK War oK
Application Entry & d.h L el = EeE o 3 "
i 2 su Origination Producer Existing  Dupiicate
Unddemmhng Dt App = tnt  Status Stage Code Producer Name Contact Mumber Customer Application CoT¢t Sales Agent
Funding No data to display.
Application Retrieval o = o 3
Scenario Analysis
Application Docments
Image Maintenance
Reports summary = Applicant = Request Dedsion  Bureau | Contract —Comments | Tracking ~Document —Verfication | Correspondence
Producers
Vendors Edits | Audits | History
Edit Types
View = Format= B Freeze fiDetach firap M Edit Type [=] {8 CheckEdits
Date Edit Type
No data to display.
4
v
Edit Details
View v Formatv B Freeze &t Detach Wrap ®
Edit Name: Result Expected Value Actual Value Override Responsibility
No datz to display.
> Servicing
> Collections
> WFP
> Tools
> Setup

For details on this screen refer Verification Tab section in Underwriting chapter.
Tools tab

The Tools tab calculates the payment amount, term, interest rate, Loan amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer Tools chapter.
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6.12.1

Application Entry using Fax-In

You can enter credit application data into Oracle Financial Services Lending and Leasing
Application using the Fax-In image functionality using the Fax-In container. Once the all the
images are loaded into the system using the steps mentioned in ‘Entering a Credit Application’
section, you can view those images in the Fax-In container and perform data entry
concurrently.

The Fax-In container option is a simple image holder which is available to the user on clicking
the ‘New Application’ button. The option is available only if has been enabled in the system
settings by the administrator.

If you are the administrator, you can enable/disable this feature to the users in the access
screen. However, you can view the availability of this feature by navigating to Main Menu >
Setup > Administration > User > Access screen. Select Screen tab and in the Security Access
Definition section, the status of “ACCESS TO MENU IMAGE MAINTAINENCE?” flag defines
the availability of this feature. If the flag is set to Y’ then the Fax-In container is available in
Application Entry screen.

The image container displays the image with the header information stored in the tables
loaded as a part of the loading process. You can navigate through the pictures using the
navigation buttons (First, Previous, Next and Last) available on the top right.

After entering the Application details, you need to select the Image check box placed on the
top of Fax Image container. By doing so the system will automatically associate the current
image with the application and save it along with the other application details. Also the image
will no longer be available in the container since the container only holds those images which
are not associated with any application.
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7. Underwriting

71 Introduction

Underwriting is the next step after application entry in Loan origination cycle. At the beginning
of underwriting process, the application has been entered into Oracle Financial Services
Lending and Leasing, receiving an application number. The application, then passes through
the initial prescreening checks, and receives a credit bureau report. (Credit bureau pulls are
based upon zip code setup.) The system assigns it a custom credit score and based on this,
the application automatically updates its status and sent to the appropriate queue. In doing
so0, one of three things happen to the application:

The application passes all the prescreening requirements and is automatically approved
based on the auto-decisioning process. The system, then, automatically notifies the
producer with a decision fax. You can use the Underwriting screen to view the
application and decision information and proceed to funding.

The application fails the prescreening requirements and is automatically rejected based
on the auto-decisioning process. Again, the system notifies the producer with a decision
fax. You can use the Underwriting screen to view application and decision information.
Also, you can rehash the application.

The application receives a status requiring a manual review and is sent to the
underwriting queue. It is now up to the underwriter to verify data and manually change
the status of application using Underwriting screen.

This chapter explains how to use the Underwriting screen to complete the following tasks:

Loading an application on the Underwriting screen
Verifying the applicant information

Verifying the credit bureau data

Calculating and validate the debt-to-income ratios
Requesting a credit bureau report manually
Adding comments and tracking attributes

Making a decision about an application

Verifying the edits

Rehashing an application

Ageing an application.

Review Requests

7.2 Underwriting Screen - an overview

The underwriting process follows these basic steps:

Opening the Underwriting screen and loading the application you want to work with.
Viewing and verifying information about the applicant supplied during application entry.
Viewing information from the credit bureau report.

Viewing and verifying information regarding the collateral, if present.

Viewing and verifying information regarding the trade-ins, if present.

Calculating and validating the debt-to-income ratios.

Selecting the pricing for the application.
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7.3

7.3.1

e Specifying information regarding stipulations, itemizations, check lists, and rate
schedules (variable rate Loan only), if required. (The checklist can be configured to
display a list of tasks to follow when using the Underwriting screen.)

e Making a decision on the Loan (APPROVE, REJECT, or CONDITION).
e Performing an edits check to verify the information on Underwriting screen.

e Viewing errors and warnings from the edits check and make the required corrections to
the data.

e Changing the status of the application.

Loading an Application on the Underwriting screen

The first step in the underwriting process is to load the application you want to work with. For
details about using the Loading an application, refer Searching for an Application in the
chapter Search Function.

Applications

The Underwriting screen’s Applications section appears at the top of the screen opened from
Underwriting master tab. The screen displays the application number and name on the
header and contains information such as application purpose, product and producer.

In this section, you can perform any of the Basic Operations mentioned in Navigation chapter

ORACLE"
Financial Services Lending and Leasing

2 Welcome, VAVAIDYA v Accessbilty =)

V Clos
DashBoard Origination x —

Search/Task | Underwriting | Review Requests (Pending: 0)

Application
View~ Formatv B

No data to display.
< >

Application

Super Summary

Applicant

sssss

A brief description of the fields is given below:

Field: View this:

App # The application number

Dt The application date

Product The Loan product of the application.

Channel How the application information was received.
Priority The priority of the application.
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Field:

View this:

Company The company of the application.

Branch The branch of the company.

Sub Unit View the Sub Unit associated with the company/branch
combination. System automatically displays the Sub Unit
mapped in Setup > User > Companies > Branch Definition
screen.

Status The status of the application.

Origination Stage Code

The origination stage code of the application.

Billing Cycle The billing cycle of the application.
Purpose The purpose of the application.
Producer The producer type and producer of the application.

Producer Name

The name of the producer of the application. The Producer
Name is displayed as a hyperlink and clicking on the same
will open ‘Producers’ page with details of the producer.

Producer Contact Num-
ber

The system displays the contact number of the producer.

Region

The region of the producer.

Territory

The territory of the producer.

Existing Customer

Indicates if the customer is an existing customer.

Duplicate Application

Indicates if the application is a duplicate application.

Loan Currency

The Loan currency of the application.

Class The class of the application.

Sales Agent The sales agent of the application.

Joint If selected, indicates this is a joint application.

Cosigned If selected, indicates this is a co-signed application.

Contact The contact of the application.

Lead # The lead number will appear in the list only if a lead is
already created using the Sales Lead link.

CRB Pull Check this box to pull an initial credit bureau report, after

the application passes the pre screen edits. Uncheck the
box, if you want to enter an application without pulling a
credit report. To use a previously pulled credit bureau
report, uncheck this box and specify the Bureau and
Bureau Reorder # fields on the Primary Applicant screen.
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7.3.2

Field: View this:

Override Ok Check this box to ignore the overrides.

If the application has been marked as ‘Override OK’ then
the system would allow you to change the application sta-
tus even when override condition exists.

Warning Ok Check this box to ignore the warnings.

If the application has been marked as ‘Warning OK’ then
the system would allow you to change the application sta-
tus even when warning exists.

Proxy for Underwriter If you are acting as a proxy for an Underwriter, then you
can select the Underwriter’'s name from the adjoining
options list. The list displays all the associated Underwrit-
ers, Underwriting Supervisors, and Underwriting Manag-
ers.

However, this is not mandatory and can be used while
auctioning an application on behalf of another underwriter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Changing the Status of the Application

You can use underwriting screen’s Applications master screen to change the status and sub
status of the application.

To change the status of the application

1. On the Underwriting form’s Application master screen, change the status of application
to either APPROVED, CONDITIONED, or REJECTED in the Status field and click Save.

The system checks the information on the Underwriting form using guidelines
established during implementation.

The system finds an error based on these guidelines, a Warning message appears
stating “Validation Error exist, Unable to Change the status. Please check the Edits.”

2. Click the Verification link and begin verifying edits on the Edits screen (For more
information, see the Verification link section in this chapter.)

During status change:

e Ifthereis an errorin the edit, system displays an error message as ‘Errors exist. Cannot
change status. Please Verify Edits.” and previous status is retained.

e Ifthere is an edit which requires override, the system displays an override message as
‘Override Required. Do you want to continue?’

— If you select ‘Yes’, the system will continue with OVERRIDE_REQUIRED
processing by changing the status.

— Ifyou select ‘No’, the system will change the status back to old status.

During status change, if there is a warning in the edit, the system displays an error message
as ‘Warning Exists. Do you want to continue?’.

e If you select ‘Yes’, the system will continue processing by changing the status.
o If you select ‘No’, the system will change the status back to old status.
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7.3.3

7.3.4

7.4

Rehashing an Application

Once the application moves to status of APPROVED, REJECTED, or CONDITIONED status,
you cannot amend the information. However, you can amend the application, by changing the
sub status of the application to REHASHING.

To Rehash the Application

1. Open the Underwriting screen and load the application you want to change with the
APPROVED, REJECTED, or CONDITIONED status.

2. Inthe Applications master section, select REHASHING in the Sub Status field and click
Save.

After you enter the information required in the application, you can change the status to
APPROVED, REJECTED, CONDITIONED, or WITHDRAWN. (For more information,
refer Decision Tab section in this chapter.)

Once the status is changed to Approved, Rejected, conditioned, or Withdrawn, you
cannot make further changes to the information on the Decision tab.

Aging an Application

The Underwriting screen can be configured so that applications will be moved to a separate
queue after a certain amount of time. (This time frame is determined in setup). This
applications receive a sub status of AGED APPLICATION. This housekeeping function allows
you to keep your system free of stagnant application by moving them into an archive.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, you can view the following details in their respective sections:

e Super Summary

e Applicant
e Ratios

e Bureau

e Checklist
e Collateral
e Trade-In

e Requested

e Approved

e Decision Itemizations

e Decision History

e Comments

e Stipulations/Adverse Actions

To view the Super Summary

1. Open the Underwriting screen and load the application you want to work with.
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2. Click Summary tab. By default the system opens the summary tab. Expand the Super
Summary section.

oRacte

Financial Services Lending and Leasing

> DashBoard Origination » (3] Cose
Origination Search/Task  Underwriting: 0000001015  Review Requests (Pending: 0)
Origination
Sales Lead Application: 0000001015: K NAVIN At | Elvien | o adt

Simple Application Entry
View Fomat v Freeze ] Detach wrap Overide OK ¥ Warning OK ¥
Application Entry & e » | @ s

Undervriting
Funding

Dupliate

o L s Origination Stage
ot Az Subunit status Code Applcation

P
Producer Name Co Bxisting Customer Contact Sales Agent Branch Proy
i

Application Retrieval 10]22/2015 000001015 UNDEFINED NEW - REVIEW REQUIRED _ NEW CA-D0002 : RANDYS AUTOL.. .. ¥ ¥ DEMOSUPR UsHQ ]
Scenario Analysis

Application Documents

Tmage Haintenance

Reports

Producers Summary | Applicant || Request | Decision | Bureau | Comments || Tracking | Document | Verification | Comespondence

3

Vendors
Super Summary

Super Summary

Applicant Requested ‘
Relation Type PRIMARY Reg. Cr imit. 200,000.00 Req. Advance 35,000.00
Name NAVINK
SN 2060068677 Decision
National 14 --84 Credit Limit 200,000.00 DrawTem 6
Bith Dt 12/02/1967 Rate(%) 139800 Repayment Term 24
Address AR NAR1BCH N = AR AR3
COAMO PR 00763 Us Contract
Phone (000)-000-0000 Credit Limit 0,00 DrawTerm 0
v Rent OWNS HOME First Pt Dt Repayment Term
Tem 0

Actual Amour(
PR Stated Time at Residence
> Collections Actual Time at Residence

> WEP {53 Verify Address

> Tools
Employment &
» Setup Tene FUllL TIME ’

The Super Summary tab provides a snapshot of all relevant details in a single screen and
contains details of Applicant, Employment, Ratios, Bureau, Requested financials, Decision
updates, Contract updates and Primary Collateral details. You need not have to navigate to
each of these tabs for specific information on the application. Also clicking on the hyperlinks
of Address, Employment, Ratios, and Trade-In helps you to directly navigate to respective
tab(s),

During the Underwriting and Funding stages, 'verified' button is displayed just below the
address and employment details for each of the applicants. This would be enabled only when
the Verified by and Verified Dt in the respective tabs are blank. You can verify the details from
the Super Summary tab. Clicking on Verified will do the following:

1. System will copy the stated values to Actual values.

2. System will stamp the “Verified By” as 'User Name' and 'Verified Date' as 'Current GL
Date' for the respective applicant.

3. If'Verified Details' are already updated in tab or if the details are stamped, this button will
be disabled.

4. ‘'Verified' button will be available when 'Actual Amount' equal to ZERO or 'Verified By' or
'Verified Date' is NULL.

You need not navigate to Address and Employment tab for verifying applicant details.

Decision details will be displayed when application has Origination Stage as “Review,
Decisioned, Contract or Funded”. In case an application is Rehashed, only Decision
information will be displayed and Contract information will not be displayed. Contract details
will be displayed when application has Origination Stage as “Contract or Funded”.

The system displays the collateral details maintained in the collateral tab on click of navigation
button under the headings Primary Collateral and Secondary Collateral. Collateral details for
Unsecured loan also will be displayed if they are maintained.

All the trade-in details, if any, maintained in the application would be displayed on click of
Navigation button.
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7.5

Applicant Tab

Having selected and loaded an application, you can view the information about applicant in
the Applicants tab. This is information that was recorded on the Application Entry screen or
gathered during the credit pull. You can edit data from the Application Entry screen at anytime
in the following steps. Remember to save your work with each change. Information from the
credit bureau pull is available to view only.

Using the information supplied on the application, complete the Applicants tab details and the
following sub tab details:

e Address

e Employments

e Telecoms

e Summary

e Credit Scores

e Duplicate Applicant
e Existing Accounts.

e Tracking Attributes

Primary Applicant details are required for SME applications also. The system uses
information on the Financial and Liabilities sub tabs in determining the applicant’s net worth.
The system uses information on the Employments screen and Other Incomes sub screen to
calculate the applicant’s debt-to-income ratio.

To verify applicant information on the Underwriting screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Applicants tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation
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A brief description of the fields is given below:

Field

Do this

Relation Type

Select the relationship type from the adjoining drop-down list. For
example, primary, spouse, secondary, or cosigner.

Salutation Select the salutation from the adjoining drop-down list.
First Name Specify the applicant’s first name.

Mi Specify the applicant’s middle name.

Last Name Specify the applicant’s last name.

Family Name

Specify the applicant’s family name.

Suffix Select the name suffix/generation from the adjoining drop-down list.

Birth Dt Specify the applicant’s date of birth.

SSN Specify the applicant’s social security number.

Class Select the classification of the applicant from the adjoining drop-down
list. For example, NORMAL or EMPLOYEE. The system uses this
information to restrict access to the database by recognizing employ-
ees as ‘secured applications’.

You can create a SME (Small Medium Enterprise) application by
selecting SMALL BUSINESS. When you select SMALL BUSINESS
and save your entry, the Business Applicants link on the Applicants
link is available. (required).

Email Specify the personal Email ID of the applicant.

Time Zone Specify the time zone to which the applicant belongs. This information

appears when you enter and save the zip code for the primary appli-
cant’s current home address on the Address sub screen. You can also
manually complete this field.

Identity Informa

tion Section

Nationality Select the applicant’s nationality from the adjoining drop-down list.
National ID Specify the national identification number.

Passport # Specify the passport number.

Passport Select the date on which passport was issued.

Issue Dt

Passport Select the passport’s expiration date.

Expiry Dt

Visa # Specify the applicant’s visa number.

License # Specify the applicant’s license number.

License State

Select the state where the license was issued, from the adjoining
drop-down list.
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Field Do this

Prior Appli- Check this box to indicate that the customer is an existing customer.

cant

Existing Cus- | Check this box to indicate that this applicant has a previous account.

tomer

Existing Cus- | Specify the customer ID if the applicant is an existing customer.

tomer ID

Existing Cus- | Specify the customer number if the applicant is an existing customer.

tomer # On saving the applicant details, the data in ‘Existing Customer # is
displayed as a link in ‘Applicant’ section header and clicking on the
same will display the customer details in Search Results section of
Servicing module.

Update Cus- Check this box to indicate if system can override the existing cus-

tomer Info tomer information and create the record with latest address and com-

munication details of the customer.

Other Details section

Name in Local

Specify the applicant’s name in local language.

Language
Gender Select the gender of the applicant from the adjoining drop-down list.
Mother’s Specify the mother’s maiden name.

Maiden Name

Education Select the education of the applicant from the adjoining drop-down
list.

Language Select the applicant’s native language from the adjoining drop-down
list.

Dependents Specify the number of dependents.

Marital Status

Select the marital status of the applicant from the adjoining drop-down
list.

ECOA Select the ECOA (Equal Credit Opportunity Act) code, from the
adjoining drop-down list. This defines the various possibilities on who
is liable; individual, joint, cosigner and so on.

Race Select the applicant’s race from the adjoining drop-down list.

Ethnicity Select the applicant’s ethnicity from the adjoining drop-down list. This
is the information the Home Mortgage Disclosure Act requires to be
reported.

Disability Check this box if the application has a disability.

Privacy Opt Check this box to indicate that the applicant has elected to refrain

Out from the non-public sharing of information.

Insurance Opt
Out

Check this box to indicate that the applicant has elected to refrain
from insurance related inquiries.
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Field

Do this

Marketing Opt
Out

Check this box to indicate that the applicant has elected to refrain
from marketing related inquiries.

Share Credit

Check this box to indicate that the applicant has elected to refrain

Opt Out from financial information and share credit related inquiries.
Prior Bank- Check this box if prior bankruptcy exists.

ruptcy

Bankruptcy Enter the discharge date of prior bankruptcy (if one exists).

Discharge Dt

KYC Section

Reference #

Specify the reference number.

Status Select the status of the applicant from the adjoining drop-down list.
FATCA Section

Birth Place Specify the birth place of the applicant.

Birth Country | Select the country of birth of the applicant.

Permanent US | Check this box if the applicant has permanent US resident status.

Resident Sta-
tus

Power of Attorn

ey Section

Power of
Attorney

Check this box if you hold a power of attorney.

Holder Name

Specify the holder name of the power of attorney.

Address Specify the address of the holder.

Country Specify the country of the power of attorney holder.
Nationality Specify the nationality of the power of attorney holder.
Telephone Specify the telephone number of the power of attorney holder.
Number

Military Service
details and can b

- this section can be used to capture applicant’s Active Military Duty
e validated with applicant Bureau Details.

Active Mili-
tary Duty

Check this box to indicate if applicant is on Active Military Duty.

Effective Dt

Select the date from when the applicant is on Active Military duty
using adjoining calendar.

Order Ref # Specify the Order Reference number which indicates the applicant’s
Active Military duty service.
Release Dt Select the date from when the applicant was released from Active Mil-

itary duty using adjoining calendar.
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7.5.1

4. Perform any of the Basic Actions mentioned in Navigation chapter.

You can verify the personal information about the applicant. Two check boxes indicate if
this is an existing customer or a prior applicant. The Existing Customer field enables you
to select the existing customer.

Address Sub Tab

You can specify more than one address for each applicant, such as a home address, second
home address, and vacation home address. However, at least one must be marked as
current. Also, only one address can be selected as the mailing address, and that address
must be marked as current. Finally, while you can have more than one Home type address,
only one can be marked as current.

To complete the Address sub tab
1. Click Address sub tab.

2. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

Based on the country chosen in the address tab, the fields for capturing the address will
vary.

A brief description of the fields is given below:

Field Do this

Address Type | Select the type of address from the adjoining option list.

Current Check this box if this is a current address.

The mailing address must be marked as current.

Confirmed Check this box if the address is the confirmed one

Mailing Check this box if this is the mailing address. Only one address entry
can be marked as the mailing address.

Permission to | Check this box if customer has provided permission to contact
Call through the specified phone number.

Atleast one phone number per application should have the permis-
sion to call (flagged as 'Y') for the successful pre-qualification of the
application. Else, an error message is displayed.

Country Select the country of mailing address from the adjoining drop-down
list.

Address Details section

Postal Type Select the postal address type from the adjoining drop-down list.

Address # Specify the address number of the mailing address

Street Pre Select the street prefix (directional) from the adjoining drop-down
list.

Street Name Specify street name.

Street Type Select the street type from the adjoining drop-down list.
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Field

Do this

Street Post

Select the street postfix (directional) from the adjoining drop-down
list.

Apt #

Specify the apartment number.

Address Line
1

Specify the first address line.

Address Line
2

Specify the second address line.

Address Line
3

Specify the third address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the extension of the zip code.

City Specify the city of the mailing address.

State Select the state of the mailing address, from the adjoining drop-down
list.

Phone Specify the phone number.

Additional Information section

Own / Rent Select the ownership type from the adjoining drop-down list.
Landlord Specify the landlord’s name.

Landlord Specify the landlord’s phone number.

Phone

Contact Specify the person contacted on behalf of landlord.
Contact Title Specify title of the person contacted on behalf of landlord.

Contact Phone

Specify phone number of the person contacted on behalf of landlord.

Extn

Specify the extension of the phone of the person contacted on behalf
of landlord.

Census Tract/

Specify census tract/BNA (block numbering area). These are defined

BNA code by the US Census Bureau code.

MSA Code Specify the metropolitan statistical area (MSA) code. These are sim-
ilar in concept to a zip code, but used mostly on government reports.

Comment Specify a comment.

Address Rent M

ortgage Stated section

Years

Specify the stated number of years at residence.

Months

Specify the stated number of months at residence.
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Field Do this

Currency Select the currency code of payment amount, from the adjoining
drop-down list.

Pmt Amount Specify the stated payment amount.

Frequency Specify the stated payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Address Rent Mortgage Actual section

Years Specify the Actual number of years at residence.
Months Specify the Actual number of months at residence.
Pmt Amount Specify the Actual payment amount.

Frequency Specify the Actual payment frequency.

Rent/Mortgage | The system displays the rent or mortgage amount.

Verified Section

Verified By The name of the verifier.

Verified Dt The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. If there are more than one addresses associated with the applicant, click Save And Add
on the Address sub screen and add address details.

7.5.2 Employments Sub Tab

Use the Employment sub screen to record employment information about the applicant. You
can have more than one entry.

To complete the Employments sub tab
1. Click Employments sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Current Check this box if this is the current employment.

Permission to Call | Check this box if customer has provided permission to contact
through the specified phone number.

Atleast one phone number per application should have the
permission to call (flagged as 'Y") for the successful pre-quali-
fication of the application. Else, an error message is dis-
played.

Type Select the address type from the adjoining drop-down list.
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Field:

Do this:

Employer Specify the employer’s name.

Occupation Select the occupation from the adjoining drop-down list.
Title Specify the title.

Department Specify the department of the employer.

Employee ID Specify the employee identification.

Employer Address section

Country

Select the country from the adjoining drop-down list.

Address #

Specify the building number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code from the adjoining drop-down list.
For non US country, you have to enter zip code.

Zip Extn Specify the zip code extension.

City Specify the city.

State Select the state from the adjoining drop-down list.

Additional Information section

Phone Specify the work phone number.

Extn Specify phone extension.

Contact Specify the person contacted on behalf of the employer.
Contact Title Specify title of the person contacted on behalf of the employer.

Contact Phone

Specify phone number of the person contacted on behalf of
the employer.

Contact Extn

Specify the extension of the phone of the person contacted on
behalf of the employer.

Comment

Specify a comment.

Employment Details Stated section

Years Specify the stated number of years with the employer.

Months Specify the stated number of months with the employer.

Frequency Specify the stated income frequency from the adjoining drop-
down list.

Currency Select the currency code from the adjoining drop-down list
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7.5.3

Field: Do this:
Income Amt Specify the stated income.
Salary View the salary of the customer.

Employment Details Actual section

Years Specify the Actual number of years with the employer.

Months Specify the Actual number of months with the employer.

Frequency Specify the Actual income frequency from the adjoining drop-
down list.

Income Amt Specify the Actual income.

Salary View the salary of the customer.

Verified Section

Verified By

The name of the verifier.

Verified Dt

The date of verification.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Telecoms Sub Tab

The Telecoms sub screen only needs to be completed if additional phone numbers exist. If
not, this sub screen can be left blank.

To complete the Telecoms sub tab

1. Click the Telecoms sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Type Select the telecommunication type from the drop-down list.

Phone Specify the phone number.

Extn Specify the phone extension.

Current Check this box if this Telecom number is current.

Permission | Check this box if customer has provided permission to contact through

to Call the specified phone number.
Atleast one phone number per application should have the permission
to call (flagged as "Y') for the successful pre-qualification of the applica-
tion. Else, an error message is displayed.

Time Zone Select the applicant’s time zone from the drop-down list.

Start Time Specify the best time to start the call.
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7.5.4

Field Do this

Period Select the time period for the best time to call start time, AM or PM, from
the drop-down list.

Best day to | Select the preferred day of the week to contact the customer from the
call drop-down list.

End Time Specify the best time to end the call.

Period Select the time period for the best time to call end time, AM or PM, from
the drop-down list.

Summary Sub Tab

To View Summary sub tab

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the
Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub
screen, the Liabilities sub screen during application entry, and the credit bureau pull.

Click the Summary sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field

Do this

What if Pmt Amt

Specify the payment amount you want to use in the ratios.

Score View the credit score for the application
Grade View the credit grade for the application
Totals

Monthly Income- Stated
Amt

The stated monthly income.

Monthly Debt- Stated
Amt

The stated monthly liability.

Monthly Income- Actual
Amt

The actual monthly income.

Monthly Debt- Actual
Amt

The actual monthly liability.

Assets Amt - Liabilities
Amt

The net worth amount.

Ratios

Debt - Stated Before (%)

The debt amount stated before.

Debt - Stated After (%)

The debt amount stated after.
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Field Do this

Debt - Actual Before (%) | The actual debt amount before.

Debt - Actual After (%) The actual debt amount after.

Disposable Inc - Stated | The disposable income stated before.
Before (%)

Disposable Inc - Stated | The disposable income stated after.
After (%)

Disposable Inc - Actual The actual disposable income before.
Before (%)

Disposable Inc - Actual The actual disposable income after.
After (%)

Revolving Debt - Stated | The stated revolving debt before.
Before (%)

Revolving Debt -Stated The stated revolving debt after.
After (%)

Revolving Debt - Actual | The actual revolving debt before.
Before (%)

Revolving Debt - Actual | The actual revolving debt after.
After (%)

Pmt to Income - Stated The stated income payment before.
Before (%)

Pmt to Income - Stated The stated income payment after.
After (%)

Pmt to Income - Actual The actual income payment before.
Before (%)

Pmt to Income - Actual The actual income payment after.
After (%)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Once the payment amount is approved in Decision screen, it will be copied and
displayed in the What if Payment field in Summary sub screen.

Calculating Debt Ratios

The system offers powerful tools to the underwriter for analyzing an applicant’s debt-to-
income ratios (total of an applicant’s debt obligation divided by that person’s regular income).
The system calculates debt ratios in the Ratios section on the Summary sub screen
(Applicants link) using the data in the Incomes and Liabilities sections. Information in the
Incomes section comes from the Employments sub screen and the Other Incomes sub screen
during application entry. The information in the Liabilities section comes from the Address sub
screen, the Liabilities sub screen during application entry, and the credit bureau pull.

An underwriter may also add information to the Incomes and Liabilities sections on the
Summary sub screen during the underwriting process.
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The debt-to-income ratios in the Ratios section can be recalculated by including or excluding
information from the Incomes section, Liabilities section and Financials sub screen.

To calculate debt ratios
1. Open the Underwriting screen and load the application you want to work with.
2. In the Underwriting link bar, click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
Show in the Details column.

4. Click Summary sub tab.

5. On the Summary sub screen, view the display only data in the Totals section.

Field: View this:

Monthly Income (Stated) | The stated monthly income.

Monthly Income (Actual) | The actual monthly income.

Monthly Debt (Stated) The stated monthly liability.

Monthly Debt (Actual) The actual monthly liability.

Assets The assets.
Liabilities The liabilities.
Net-Worth The net-worth.

6. Inthe What if Pmt Amt field, enter the payment amount you want to use in the ratios.
Once the payment amount is approved in Decision screen, it will be copied in the What if
Payment field and the ratios are updated accordingly.

Whenever you modify the ‘What If pmt Amt’ field, system automatically calculates the
below ratio's:

— Stated Before DTI - if liabilities, stated income or applicant financials are updated.

— Stated After DTI - if decision payment amount, liabilities, stated income or applicant
financials are updated.

— Actual Before DTI - if liabilities, actual income or applicant financials are updated.

— Actual After DT - if decision payment amount, liabilities, actual income or applicant
financials are updated.

— Stated PTI - if decision payment amount, stated income or applicant financials are
updated.

— Actual PTI - if decision payment amount, liabilities, actual income or applicant
financials are updated.

7.5.4.1 Financials Sub Tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

To complete the Financials sub tab

The Financials sub screen only needs to be completed if financial assets exist on the
application. If not, this sub screen can be left blank.

1. Click Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field Do this

Type Select financial type from the drop-down list. For example, liquid
assets, retirement assets, and so on.

Source Specify source; for example, stocks, 401K, rent received, and so on.
Account # Specify the account number.

Currency Select the currency code from the drop-down list.

Loan Cur- View the Loan currency amount.

rency Amount

Amount Specify amount.
Include Check this box to indicate that the Asset is included.
Comment Specify comment, if any.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.2 Liabilities Sub Tab

All the liabilities of the applicant that are entered during application entry are displayed in this
tab. For example: Rent. In addition, if you need to record additional liabilities for an applicant
the same can be done in this tab. Also any liability information of the applicant received
through credit pull will be displayed under 'Credit Bureau Data' in Liabilities sub tab.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this

Include Check this box to indicate that the liability is included.

Liability Type Select the liability type from the adjoining drop-down list.
Currency Select the currency code from the adjoining drop-down list.
Amount Specify the liability amount.

Loan Currency

View the Loan currency amount.

Amount
Frequency Select the frequency from the adjoining drop-down list.
Account Type Specify the account type.

Account Balance

Specify the account balance.

Loan

View the Loan currency amount.

Comment

Specify a comment, if any.
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Field Do this

Credit Bureau Data

Bureau View the name of credit Bureau.

Open Dt View the opening date of credit account.
Pmt Manner View the mode of payment.

Account # View the account number.

Status View the current status of credit account.
Account Type View the type of account maintained.
Creditor's Name View the name of the Creditor.
Subscriber # View the Subscriber number.

ECOA View the ECOA (Equal Credit Opportunity Act) code.
Term View the term of credit.

Credit Limit View the total credit limit amount.

High Balance View the high balance amount if any.
Past Due Amt View the total past due amount if any.

30 View the number of delinquency days.
60 View the number of delinquency days.
90 View the number of delinquency days.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. The Dedupe Liabilities button removes duplicate (“de-dupes”) liabilities that may be
present from subsequent (manual) credit bureau pulls for nonspousal joint applications

7.5.4.3 Other Incomes Sub Tab

The Other Incomes sub tab only needs to be completed if other incomes exist on the
application. If not, this sub screen can be left blank.

To complete the Other Incomes sub tab
1. Click the Other Incomes sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field Do this

Type Select the income type from the adjoining drop-down list.

Note: In case, the other income of the applicant is from Employment,
then the details of Actual Amount specified in the Employments
Sub Tab is auto populated. Also if the income is verified in the
Employments Sub Tab, then Verified By and Verified Dt details are
auto populated. You can also verify the details here using the current
system date.

Currency Select the currency from the adjoining drop-down list.

Stated Amount Specify the monthly stated income.

Frequency Select the income frequency from the adjoining drop-down list.

Loan Currency View the Loan currency amount stated.

Amount Stated

Comment Specify a comment, if any.

Include By default the include check box is selected indicating that the other
income details are included. You can deselect the same if not
required.

When Include check box is selected system automatically adds the
‘Loan Currency Amount Stated’ and ‘Loan Currency Amount Actual’
details to Applicant > Summary Tab. Also system calculates the DTI
and PTl ratio's based on ‘Actual Amount’ specified.

Actual Amount Specify the actual monthly income amount.

Loan Currency | View the actual Loan currency amount.
Amount Actual

Verified By The Verified By field is auto populated with the logged in user name
only after the record has been verified and saved.

Verified Dt You can verify the record by selecting the current system date from
the adjoining calendar icon.

Note: System displays an error message if any other dates is
selected apart from current system date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.5.4.4 Rescoring a Credit Bureau Report Manually

Any manually pulled credit bureau reports can be used to rescore an application.

To manually rescore a credit bureau report
1. Open Underwriting screen and load the underwriting application you want to work with.
2. Click Applicants.

3. On the Applicants Details screen, select the applicant you want to work with and click
View.

4. Click the Credit Scores sub tab.
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7.5.5

7.5.6

5. In the Rescore Applicant section, select in the Credit Report ID field, the bureau report
you want to use to rescore the applicant.
6. Click Rescore.

The system displays the new information in the Credit Scores and Parameters sections.
This new score automatically appears in the System Recommendation section on the
Decision link.

Credit Score Sub Tab

You can view the credit score based on the system’s internal scoring models in Credit Scores
sub tab.

To View Credit Scores sub tab
1. Click the Credit Scores sub tab.

You can view the following details:

e Credit Score
— Model
— Bureau
— Credit Report ID
— Credit Grade
— Score
— Current

e Parameters
— Parameters
— Value
— Score

Note

If you select No Bureau in the Credit Bureau Report ID field and click Rescore, the best
match internal scoring is used for rescoring the applicant without credit bureau report.

Duplicate Applicant Sub Tab

Click De-dupe Applicants to display the existing customer details of the applicant. While
reviewing the de-dupe results, if the current applicant's credentials are exactly matching with
an existing customer record, you can attach the current application to the existing customer.
The same can be done by just keying in the customer ID in the applicants tab and clicking
save.

In case a particular customer has more than one account, on clicking De-dupe Applicants the
system displays only one account in ‘Duplicate’ sub tab. However, you can view all the
accounts held by customer in 'Existing accounts' sub tab.

To View duplicate applicant’s details, click Duplicate Applicant sub tab. In this section you
can view the duplicate applicant’s details.
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7.5.7

A brief description of the fields is given below:

Field Do this

Source Type View the source type of the duplicate applicant

Applicant Id/ Cus Id View the applicant ID if the source type is applicant and the
customer ID if the source type is customer.

Application # View the application number of the existing applicant details
for the respective records.

Days since last appli- View the total number of days elapsed since the last applica-
cation tion date. System auto calculates this value as ‘Current sys-
tem date (minus) Last application date’.

ID View the applicant ID

First Name View the first name of the duplicate applicant

Middle Name View the middle name of the duplicate applicant

Last Name View the last name of the duplicate applicant

Date of Birth View the date of birth of the duplicate applicant

CIF View the CIF no of the duplicate applicant

SSN #/ National ID View the national ID or SSN number of the duplicate appli-
cant

Driving License # View the driving license number of the duplicate applicant

City View the city of the duplicate applicant

State View the state of the duplicate applicant

Zip View the zip of the duplicate applicant

Existing Account Sub Tab

The Existing Account Sub Tab displays the applicant's details, if it has been previously
maintained in the system. Also along with the applicant's details, the account number of the
applicant is displayed as a hyperlink. Clicking on the hyperlink will display the respective
account details through the Customer Service screen of Servicing module.

In case you do not see a hyperlink associated with the account number, then you might have
restricted access to the Servicing module. You can request your system administrator to
navigate to Setup > User > Access screen, and enable the ‘ACCESS TO SERCOLL UCS
CUSTOMER SERVICE TAB’ option in Security Access Definition section available in the
'Screen' tab. For more information, on defining user privileges, refer to ‘3.3.2 Screen’ section
in Setup guide.

View the following details:

Field: View this:

Account # The account number.
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Field: View this:

Title The account title.
Relation The customer relationship.
Product The Loan product.

Payoff Amount The payoff amount.
Amount Due The delinquent amount due.
Oldest Due Dt The due date.

Status The account status.
Company The company.

Branch The branch.

Total Pay Off Amt The payoff amount.

Total Amt Due The total due amount.

7.5.8 Tracking Attributes Sub Tab

You can add tracking attribute information to an application at any time in the underwriting
process by using the Tracking Attribute tab.

The Tracking tab enables you to record further information associated with the application.
What items you choose to track are setup during implementation.

To track attributes
1. Click Tracking Attributes sub tab.
2. Select the item you want to track.

3. Click Edit to edit the following information:

Field Do this

Sub-Parameter | View the sub-parameter

Parameter View the parameter.

Value Specify the information about the corresponding Value field.

4. Save changes you made to the account.

7.5.8.1 Create Tracking

1. Click Create Tracking, the system loads the tracking parameters.

o If you want to reduce the list of parameters, select a sub-attribute in the Sub Attribute
box.

e If your system has been configured to use the Sub Code field, only attributes in a
particular group appear in the Parameter display.

2. Specify the requested parameter in the Value field and click Save.
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7.6

Customer Search Tab

While creating an application for an existing customer, you can retrieve and copy the
customer details into the new application by using the Customer Search section of the
Simple Application Entry screen.

You can modify only the address, employment, financial details and not the demographic and
identification details.

To copy the Customer Details
1. On the Underwriting screen, click Applicants tab.
2. Click Customer Search tab.

3. Inthe Search Criteria screen, use the Comparison Operator and Values columns to
create the search criteria you want to use to find a customer.

4. Click the Search button.

The system locates and displays all the customer details that meet your search criteria
in the Search Results section.

Select Reset Criteria at any time to clear the Comparison Operator and Values columns
on the Criteria screen.

5. Inthe Search Results section, select a customer you want to load.

6. Select the relation type and click Copy Customer Details.

Business Tab

Oracle Financial Services Lending and Leasing can record SME business related financial
information and business partners on the Business section to assist in approving the Loan
application during underwriting. The Business Applicant screen is available and contains the
following sub screens:

e Address

e Telecoms

e Financials

e Liabilities

e Partners

o Affiliates

e Other details

If there are no business information associated with the application, the Business Applicant
tab is unavailable.

To complete the Business tab

1. If SME business information is included on the application, select SMALL BUSINESS in
the Class field on the Applications section and click Save.

The Business tab appears on the Underwriting screen.
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2. Click BusinessTab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Organization Type

Select the organization type.

Business Type

Select the type of the business.

Business Name

Specify the name of the business.

Legal Name

Specify the legal name of the business.

Tax ID

Specify the tax identification.

Start Date

Specify the business start date.

# of Employees (Cur)

Specify the current number of employees at the business.

# of Employees

Specify the number of employees at the business after
financing.

Contact Person

Specify the contact person at the business.

Business Checking
Bank

Specify the bank name of the business’s checking account.

Bank Acc #

Specify the bank account number.

Avg Checking Balance

Specify the average checking balance.

# of Locations

Specify the number of locations of the business.
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Field:

Do this:

Management Since

Specify the year the current management was established.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Address Sub Tab

You can enter more than one address for the business.

To complete the Address Sub Tab
1. Click Address Sub Tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Address Type Select the address type.

Country Select the country.

Address # Specify the building number.

Own /Loan Select the ownership type.
Comment Specify a comment.

Postal Type Select the address type.

Street Pre Select the street prefix (directional).

Street Name

Specify street name

Street Type

Select the street type.

Street Post

Select the street postfix (directional).

Apt #

Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
Phone Specify the phone number.

3. Perform any of the Basic Actions mentioned in Navigation chapter

4. |If there are more than one addresses associated with business, click Save And Add and
add the address details.

=27 ORACLE



7.6.2

7.6.3

Telecoms Sub Tab

The Business tab’s Telecoms sub tab needs to be completed, if additional phone numbers for
the business exist. If not, this sub tab can be ignored.

To complete the Telecoms sub tab
1. Click Telecoms sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select the telecommunication type.

Phone Specify the phone number.

Extn Specify the phone extension.

Current If selected, indicates that this is a current telecom.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Financials Sub Tab

The Business tab’s Financials sub screen only needs to be completed if financial assets exist
on the application for the business. If not, this sub screen can be left blank.

To complete the Financials sub tab
1. Click the Financials sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Type Select financial type; for example, liquid assets, retirement assets,
and so on.

Source Specify source; for example, stocks, 401K, rent received, and so
on.

Currency Select the currency of the asset.

Amount Specify amount.

Loan Currency The system displays the Loan currency amount

Amount

Comment Specify comment, if any.

Include Check this box to include this record in calculations on the Other
Details sub section.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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7.6.4 Liabilities Sub Tab

The Business Applicant link’s Liabilities sub screen only needs to be completed if financial
liabilities exist on the application for the business. If not, this sub screen can be left blank.

To complete the Liabilities sub tab
1. Click Liabilities sub tab.

7.6.5

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Type Select the liability type.
Currency Select the currency.

Loan Currency Amount

The system displays the Loan currency amount

Amount Specify the liability amount.
Frequency Select the frequency.
Account Type Specify the account type.

Loan Currency Account
Balances

The system displays available Loan currency account
balance.

Account Balance

Specify the account balance.

Comment

Specify comments, if any.

Include

Check this box to include this record in calculations on
the Other Details sub screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Partners Sub Tab

You can enter more than one partner for the business.

To complete the Partners sub tab

1. Click Partners sub tab

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

First Name Specify the partner’s first name.

Mi Select the partner’s middle name.

Last Name Specify the partner’s last name.

Suffix Specify the partner’s suffix.

SSN # Specify the partner’s social security number.
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Field: Do this:

Birth Dt Specify the partner’s birth date.
Birth Place Specify the partner’s birth place.
Title Select the partner’s title.

Ownership (%)

Specify the percentage of ownership held by the customer.

Net worth

Specify the partner’s net worth.

Gross Income

Specify the partner’s gross income.

Language Specify the partner’s language.
Nationality Specify the partner’s nationality.
Country Select the partner’s country code.
Address # Specify the partner’s address number.

Address Line 1

Specify the partner’s first address.

Address Line 2

Specify the partner’s second address line.

Zip Select the partner’s zip code.
For non-US country, you have to enter zip code.
Zip Extn Specify the partner’s zip extension.
City Specify the partner’s city.
State Select the partner’s state.
Phone Specify the partner’s phone number.
Extn Specify the partner’s phone extension.
Email Specify the partner’s email.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Affiliates Sub Tab

You can enter more than one affiliate for the business.

To complete the Affiliates sub tab
1. Choose Affiliates sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Organization
Type

Select the affiliate’s organization type

Legal Name

Specify the affiliate’s legal name
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Field:

Do this:

Business Name

Specify the affiliate’s business name

Tax ID

Specify the affiliate’s tax identification

Ownership (%)

Specify the affiliate’s percentage of ownership

# of Employees

Specify the affiliate’s number of employees

NAICS CODE Specify the affiliate’s North American Industry Classification
System code.

Country Select the affiliate’s country code.

Address # Specify the affiliate’s address number.

Address Line 1

Specify the affiliate’s first address line.

Address Line 2

Specify the affiliate’s second address line.

Zip

Select the affiliate’s zip code.

For non US country, you have to enter zip code.

Zip Extension

Specify the affiliate’s zip extension.

City

Specify the affiliate’s city.

State

Select the affiliate’s state.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Other Details Sub Tab

The Other Details sub screen records information regarding monetary amounts associated

with the business such as profits, sales, and expenses.

To complete the Other Details sub tab
1. Click Other Details sub tab.

2. Click Edit.

3. Verify financial details as well as assets and liabilities linked to the business.

A brief description of the fields is given below:

Field:

Do this:

Other Details section

Currency

Select the currency.

Business Type

Select the type of business.

Analysis Frequency Select the analysis frequency.

Loan Currency Gross
Margin Factor

The system displays the Loan currency business’s gross
margin factor

Gross Margin Factor Specify the business’s gross margin.
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Field:

Do this:

Organization Type

Select the type of organization.

Loan Currency Income

The system displays the Loan currency business income
amount.

Income

Specify the business’s income amount.

Loan Currency Collec-
tion Average

Specify the Loan currency collection average.

Collection Average

Specify the collection average.

LoanCurrency Proj Coll
Avg Annual

Specify the Loancurrency annual projected collection aver-
age.

Proj. Coll.Avg.Annual

Specify the annual projected collection average.

LoanCurrency Book List

Specify the Loancurrency business booklist.

Book List

Specify the business booklist.

LoanCurrency Turn
Over

Specify the Loancurrency turnover amount.

Turn Over

Specify the turnover amount.

LoanCurrency Capital
Amount

Specify the Loancurrency capital amount.

Capital Amt

Specify the capital amount.

LoanCurrency Earned
Surplus

Specify the Loancurrency earned surplus amount.

Earned Surplus

Specify the earned surplus amount.

LoanCurrency Gross
Profit

Specify the Loancurrency gross profit amount.

Gross Profit

Specify the gross profit amount.

LoanCurrency Net Profit

Specify the Loancurrency net profit amount.

Net Profit

Specify the net profit amount.

LoanCurrency Working
Capital

Specify the Loancurrency working capital amount.

Working Capital

Specify the working capital amount.

LoanCurrency Annual
Sales

Specify the Loancurrency annual sales amount.

Annual Sales

Specify the annual sales amount.

LoanCurrency Pro-
jected Sales

Specify the Loancurrency projected sales amount.

Projected Sales

Specify the projected sales amount.
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Field:

Do this:

LoanCurrency Equity

Specify the Loancurrency equity amount.

Equity

Specify the equity amount.

Open Delq

Specify the open delinquency amount.

LoanCurrency Business
Expenses

Specify the Loancurrency business expenses amount.

Business Expenses

Specify the business expenses amount.

LoanCurrency Personal
Expenses

Specify the Loancurrency personal expenses amount.

Personal Expenses

Specify the personal expenses amount.

LoanCurrency Total
Expenses

View the Loancurrency total expenses amount.

Total Expenses

View the total expenses amount.

LoanCurrency Annual
Proj Sales Amt

View the Loancurrency annual projected collection amount.

Annual Proj Sales Amt

View the annual projected collection amount.

LoanAnnual Proj Exp
Amt

View the Loan annual projected expenses amount.

Annual Proj Exp Amt

View the annual projected expenses amount.

LoanCurrency Current
Assets

View the Loancurrency current assets.

Current Assets/Liability
ratio

View the current asset to liability ratio.

LoanCurrency Fixed
Assets

View the Loancurrency fixed assets.

Fixed Assets

View the fixed assets.

LoanCurrency Intangible
Assets

View the Loancurrency intangible assets.

Intangible Assets

View the intangible assets.

Loan

View the Loan

Current Liabilities

View the current liabilities.

Loan

View the Loan

Long Term Liabilities

View the long term liabilities.

Loan

View the Loan

Total Assets

View the total asset amount.
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Field:

Do this:

Loan

View the Loan total net worth amount.

Total Net worth

View the total net worth amount.

Loan

View the Loan

Total Liability

View the total liability amount.

Debt Net worth Ratio

View the debt to net worth ratio.

Current Assets/Liability
ratio

View the current asset to liability ratio.

Title 1-4

Specify the title.

Signature1-4

Specify the signature.

Request Tab

You can calculate Payment, Interest Rate, Term and Loan Amount using Request tab’s
Calculate button. By default, system calculates for monthly repayment term basis. The
payment frequency can be changed only in the Underwriting tab during decisioning.

To complete Request section:

1. On the Application Entry tab, click Request tab.
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

7-34

ORACLE



7.71

A brief description of the fields are given below:

Field

Do this

Requested Advance Amt

Specify the requested advance amount

Pmt Amt

Specify the requested payment amount.

Term

Specify the requested term (number of payments).

Requested Rate

Specify the requested rate of interest.

Down Pmt%

Specify the down payment percentage

Down Pmt Specify the down payment amount
Approx Prc Specify the approximate cash price
Promotion Select the promotion type from the drop-down list.

Balloon Amt

Specify the balloon amount.

Signing Dt

Specify the signing date

Probable Delivery Dt

Specify the probable delivery date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

If you want system to calculate,

1. Select the record you want to work with and from the drop-down option, select the option
you want system to calculate:

e CALCULATE PAYMENT

e CALCULATE INTEREST RATE
e CALCULATE TERM

e CALCULATE LOAM AMOUNT

2. Click Calculate. The system displays the requested calculation in the respective field.

Itemization Sub Tab

The Itemizations sub tab enables you to add or verify any itemized amounts associated with
the application. The list of itemizations is determined by the product you select in the master
screen during the application entry process. The ltemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the ltemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub tab on the Underwriting screen.

Application request details need to be essentially entered in the itemization sub tab for pre-
screening to be successful. Else, the system displays error and application would not proceed
to the next level in work flow. The details of down payment, trade-in, insurance, fees etc. and
the total sale price are recorded under itemization.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Itemizations sub tab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Iltemization View the itemization.

+/- View whether the itemized amount is added or subtracted
from the Loan amount.

Requested Amt Specify the requested amount.

Comment

Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Request > Trade-In.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-In

Asset Type Select the asset type.

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.
Body Specify the body of the asset.

Identification #

Specify the identification number.

Description

View the asset description.

Valuation

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.
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7.8

Field: Do this:

Pay Off Amt (-) Specify the payoff amount.
Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supplement | Specify the valuation supplement.

Edition Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter

Subvention Sub Tab

With the Subvention sub tab, available only for Loan, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Request > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Subvention Plan section:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the

Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Decision Tab

If the application was initially approved automatically, the system displays its
recommendations on the Decision tab’s Approved section.

If the application was initially rejected automatically, the system displays its reasons on
the Decision link’s Stipulation sub tab.
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If you choose to approve or reject the Loan manually, you must manually select the
pricing (rule) set by the portfolio company for a specific product. The system validates this
pricing against the information in the System Recommendation sections. The information in
the Requested section comes from the application entry process and can be edited.

o If the data meets your approval, change the status of the application to either
APPROVED or REJECTED and enter any stipulations.

e If you reject the application, change the status to REJECTED and enter the reasons for
the adverse action on the Stipulations sub screen.

On clicking Calculate, you can calculate the Loan amount, rate, term, and payment. You
can use the calculator available in Tools section for completing this step. For detailed
information on using the Calculator tools, refer “Tools” chapter in the document.

To verify the application decision data

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click Decision tab.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Pricing section

Current Check this box to indicate that this is the current deci-
sion.
Pricing View the pricing.

Decision Dt

View the decision date.

Underwriter

View the underwriter id.
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Field:

Do this:

Status

View the application status.

Sub Status

View the application sub-status.

Approved section

Decision Term

Specify the approved decision term.

Pmt Amt Specify the approved payment amount.
Index Specify the index type.
Index Rate Specify the approved index rate.

Decision Margin Rate

Specify the approved decision margin rate.

Decision Rate

Specify the approved decision rate.

Note: For Islamic products this field is displayed as
‘Profit Rate’.

Pricing Buy Rate

View the pricing buy rate.

Approved Buy Rate

View the approved buy rate which is by default the Pric-
ing Buy Rate displayed above. You can also specify the
required approved buy rate.

Down Pmt %

Specify the approved down payment percentage.

Down Pmt Amt

Specify the approved down payment amount.

Max Advance %

Specify the approved advance percentage.

Max Advance Amt

Specify the approved advance amount.

Max Financed %

Specify the maximum amount financed percentage.

Max Financed Amt

Specify the maximum amount financed.

Maturity Index

Select the approved post maturity index.

Maturity Margin Rt

Specify the maturity rate.

Balloon Amt Specify the balloon amount.
Decision APR Specify the decision APR.
Bureau 1 Specify the Bureau 1.
Bureau 2 Specify the Bureau 2.
Bureau 3 Specify the Bureau 3.
Grade Select the credit grade.
Score Specify the credit score.

Collateral Value

View the collateral value.

LTV1

View the loan to value ratio.
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Field: Do this:

LTV2 View the loan to value ratio.

Comments Specify comments, if any.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click Select Pricing.

The system determines the best pricing match of all enabled Loan pricing strings in the
Setup menu and displays the results in the Pricing and Approved sections.

6. Re-Score

A 'Re-Score' button is available next to 'Calculate’. Whenever any sensitive Financial or
Collateral information is amended in the Application, OFSLL displays a warning
message 'Scoring sensitive information is changed. Re-score the application'. You need
to click on Re-Score to re-validate the grade and pricing accordingly.

The display of the warning message to Re-score the application can be controlled using
the respective System parameter. If the defined System Parameter is flagged 'Y, only
then the message is displayed.

If you are underwriting a Loan, record the following information on the Decision tab:

7. If you are approving the application, complete the Approved section with the values you
want to approve as an underwriter. You can update the default values that appeared
when you selected the pricing string in step 3. (The system calculator may be of use when
completing this section. For more information, refer the Tools chapter.)

8. Click Calculate. The system displays the decision calculation in the respective field.

System Recommendation

The System Recommendation sub screen displays the system generated Score, Decision
and Grade. You will also be able to view the request details of the application under
'Requested' section itself.

A brief description of the fields in System Recommendation section are given below:

Field: Do this:

Score View the system recommended score.
Decision View the system recommended decision.
Grade View the system recommended grade.

A brief description of the fields in Requested section are given below:

Field Do this

Requested Advance Amt View the requested advance amount

Pmt Amt View the requested payment amount.

Term View the requested term (number of payments).
Requested Rate View the requested rate of interest.

Down Pmt% View the down payment percentage
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Field Do this

Down Pmt View the down payment amount

Approx Prc View the approximate cash price

Promotion View the promotion type from the drop-down list.
Balloon Amt View the balloon amount.

Signing Dt View the signing date

Probable Delivery Dt View the probable delivery date.

Stipulations Sub Tab

The Stipulations sub screen allows to add any stipulations or reasons for adverse action you
want to attach to the application. Stipulations are items that need to be addressed before the
Loan can be funded.

If the application was automatically rejected during the application entry edits, the system
displays the automatically generated adverse action codes in this sub screen. If the
application is manually rejected by the Underwriter due to adverse action reasons received
from bureau or otherwise, the same can be recorded for each of the applicant.

In addition, you can enter comments against specific stipulations as required. Whenever a
Stipulation is marked as 'Not Applicable' it becomes mandatory to specify the reason in
comments field. Else, system prompts for the reason while processing the application.

To add or view stipulations or reasons for adverse action

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below.

Field: Do this:

Type Select the reason type. Type can be Stipulation Reasons or Adverse
Action Reasons and Adverse Action Reasons can also be those
received from Bureau.

Name The system displays all applicant’'s name in the drop down list. You

can select the name of the applicant for whom adverse action reason
needs to be recorded. In case the stipulation reason is at the appli-

cation level, then select ALL.

Code Select the reason.
Description Specify the required description.
Stips Satisfied Use the Yes/No/NA buttons to indicate if you verified the stipula-

tion(s) in the Type field

Comment Specify the comment.
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7.8.2.2

7.8.2.3

Field: Do this:

Verified By The system updates the user ID of the person who verified the
details
Verified Dt The system updates the date when the details are verified.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

If your system is set up to manually load predefined stipulations, click the Load Stipulations
button (For more information, refer the following section, Loading Stipulations.)

Add Multiple

The system enables you to add multiple records to stipulations using the 'Add Multiple' option.
To add multiple stipulations
1. Click the drop down list adjacent to the 'Add Multiple' button.

2. Select the check box against to the required stipulations. You can also select ’All’ to load
all the available stipulations.

Click Add Multiple.

4. If required, you can perform any of the Basic Actions mentioned in Navigation chapter.

Copying Stipulations

The system enables you to automatically transfer stipulations from previous decisions on the
Stipulations sub screen with the Copy Stipulations button. This is particularly useful when you
are rehashing an application and want to use the same stipulations as those in place for the
previous decision.

Loading Stipulations

The system supports the automatic generation of default stipulations on the Underwriting
screen’s Stipulations sub screen. The default stipulations can be maintained by company,
branch, product, state, application status and application sub-status. When the application
status changes (either manually and automatically), the system populates the maintained
stipulations with a Stips Satisfied indicator of ‘No’. You can review and update the stipulations
accordingly.

You have the option to manually load predefined stipulations by clicking the Load Stipulations
button on the Stipulation screen.

To load predefined stipulations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Stipulations.

3. Click Load Stipulations. The system loads the default stipulations on the Stipulations
sub screen.

4. Use the Yes/No/NA buttons in the Stips Satisfied column to indicate if you verified the
stipulation(s) in the Type field.

5. Click Save on the Stipulations sub screen.
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7.8.4

Itemization Sub Tab

The Itemizations sub screen enables you to add or verify any itemized amounts associated
with the application. The list of itemizations is determined by the product you selected in the
master screen during the application entry process. The Itemizations sub screen displays an
itemization record of the amount financed, such as the cash price, cash down payment, trade-
in, unpaid cash price balance and so on. Information that was entered on the Itemization sub
screen during the application entry process will appear in the Requested Amt column.
Information that you enter as an underwriter in the Approved Amt column will appear in the
Itemizations sub screen on the Underwriting screen.

To add or view itemizations

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Itemizations sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
ltemization View the itemization.
+/- View whether the itemized amount is added or subtracted

from the Loan amount.

Requested Amt Specify the requested amount.
Approved Amt Specify the approved amount.
Discount Rate Specify the discount rate.
Comment Specify a comment.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Trade-In Sub Tab

The Trade-In sub screen enables you to add or verify any trade-ins associated with the
application. If there is any information regarding an itemized trade-in, use the Trade-In sub
screen to enter the details in the system. (This sub screen might already contain information
supplied during the application entry process.)

To complete the Trade-In sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Trade-In sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Trade-in section

Asset Type Select the asset type.
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Field: Do this:

Asset Sub Type Select the asset sub-type.
Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuation section

Wholesale Amt

Specify the wholesale value.

Base Retail Amt

Specify the retail value.

Addons Amt (+)

Specify the add ons value.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total value.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-

Specify the valuation supplement.

ment

Edition

Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

7.8.5 Rate Schedule Sub Tab

The Rate Schedule sub screen is only available for variable rate Loan and displays the rate
adjustment frequency information based on product setup.

To view the Rate Schedule sub screen

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Rate Schedule sub tab. Click View.

A brief description of the fields is given below:

Field: View this:

Seq The rate adjustment sequence number.

Adjustment Frequency Type The rate adjustment frequency type.

Period The rate adjustment period for the frequency.
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Field: View this:

# of Adjustments The number of rate adjustments for the frequency.

7.8.6 Subvention Sub Tab

With the Subvention sub tab, available only for Loan, you can review the subvention
information from the application entry and calculate the subvention amount, as well as
override the calculated subvention amount. The participant’s information is automatically
populated based on the selected subvention plan.

To complete the Subvention sub tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Decision > Subvention sub tab.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Select the sub plan.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the
Other Details sub section

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In Subvention Detail section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below.

Subvention Detail section:

Participant View the participant.

Participant Type View the participant type.

Collection Method View the collection method.

Rate View the subvention rate.

Rent Factor View the rent factor

Calculation Method View the subvention calculation method.
Factor View the factor.

Calculated Amount View the calculated subvention amount.
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Subvention Amount

Specify the subvention amount.

Include

View if the subvention is included in the application or not.

Total Subvention Rate

View the total subvention rate.

Total Subvention Amt

View the total subvention amount.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. Select the Initialize button to reset the subvention amount to zero.

8. Select the Calculate button to calculate the subvention amount.

Compensation Sub Tab

The Compensation (Loan) sub tab records and displays the terms of compensation between

the finance company and the dealer for Loan transactions.

To complete the Compensation (Loan) sub screen

1. Open the Underwriting screen and load the underwriting application you want to work

with.

2. Click the Decision > Compensation sub tab.

On the Compensation sub screen’s Compensation section, select in the Compensation
Plan section the compensation plan you want to use from the drop-down list. Note that,

the compensation plan will use decision information to calculate compensation.

4. Click Load.

The system loads the following information on the Compensation sub screen:

Field:

Do this:

Compensation section

Compensation Plan

View the compensation plan.

Disbursement Method

View the compensation payment method.

Calculation Method

View the compensation calculation method.

Chargeback section

Paid Calc Method

View the charge back calculation method (early payoff).

Early Payoff %

View the early payoff percentage.

Paid Basis

View the charge back paid basis.

Early Payoff Term

View the early payoff term.

Early Payoff Days

View the charge back early payoff days.

Charge off Calc Method

View the charge back calculation method (charge off).

Charge off %

View the charge back percentage (charge off).

Charge off Basis

View the charge back basis (charge off).
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Field: Do this:

Charge off Term View the charge back term (charge off).

Days View the charge back days (charge off).

Calculation section

Spread Formula View the compensation spread formula.

Buy Rate Specify the buy rate.

Factor % View the compensation factor.

Addl Factor % View the additional compensation factor.

Max Spread % View the maximum spread or percent allowed.
Upfront % View the upfront compensation percentage.
Flat Amt View the flat amount.

Upfront Compensation View the compensation amount paid upfront.
Amt

Rem Compensation Amt | View the compensation amount remaining.

Compensation Amt View the compensation amount.

5. Make any necessary changes in the Approved Buy Rate and Maximum Financed
Amount fields in the Decision tab.

6. Click Calculate.
The system displays the details and amounts for this compensation plan.

7.8.8 Multiple Offers sub tab

When you click Select Pricing on the Decision tab’s Pricing section, multiple offers appear on
the new Multiple Offers sub page. Use the Multiple Offer sub page to select the offer you want
to use.

Note

The Multiple Offers sub tab will be enabled only if the Multioffer company parameter is set
to Yes.

To view multiple pricing offers
1. Open the Underwriting screen and load the application you want to work with.
2. Click Decision, then click the Multiple Offers sub tab.

3. If you are underwriting a Loan, view the following information on the Multiple Offers sub:

Field: Do this:
Pricing View the pricing.
Term Specify the approved term.
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Field: Do this:

Rate Specify the approved rate.

Pmt Amt Specify the approved payment amount.

Index View the approved index.

Index Rate View the approved index rate.

Margin Rate Specify the approved margin.

Maturity Index Specify the approved maturity index.

Maturity Rate Specify the approved maturity rate.

Accepted If selected, indicates that the pricing is accepted. Only
one of the current pricings can be accepted.

Current If selected, indicates that the pricing is current.
Note: All the available pricings are selected as current.

4. On the Multiple Offers sub tab, select the offer once the application is move to Approved
status.

Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

If there are any adverse comments received from the Bureau, system displays them under
'Exceptions/ Comments' section against the specific Bureau record to alert the User.
Following are some of the reasons:

1. Application Indicates Potential Fraud

Bureau Indicates Social Security Number Variance
Duplicate Application Exists

Bureau Indicates a Possible Current Delinquency
Bureau Indicates Bankruptcy

Bureau Indicates Consumer Statement

Bureau Indicates a Possible Repossession

Bureau Reports OFAC hit

© N o o M 0N

9. Bureau Reports Applicant as Deceased

10. Potential Delinquencies for Auto Loans in Past 12 Months
11. Customer Rate (APR) Exceeds the State Usury Rate

12. Open Consumer Credit Counselling

The reasons will also be displayed in the Summary tab in 'Bureau' details under 'Exceptions
/Comments' section.

To verify the credit bureau data using the Bureau tab

1. Open the Underwriting screen and load the underwriting application you want to work
with.
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2. Click Bureau.

ORACLE & Welcome, PRAKRRAO =  Accessibility o
Financial Services Lending and Leasing
Close.
S Origination x [E7)
Origination SearchfTask  Underwriting: 0000001533  Review Requests (Pending: 0) -
Origination
seles Lesd Application: 0000001533: SIGG MARK ZEit | Hven | o noe
simple Application Entry _ _ n N
Application Entry Vieww Fomatw B Freere iff Detach Vrap @) OverideOK ¥ Waming OK ¥
Underwriting Origination Stage Producer Contact o Duplicate
s Dt App # Sub Unit Status i Producer Name i Bisting Customer SR Contact
Application Retrieval 09/05/2015 0000001533 REJECTED - AUTO.. NEW CA-00003 : ACEH. (818)-761-2277 N
S ey >
Application Documents
Image Maintenance
Reports Summary || Applicant | Business || Request || Decision || Bureasi || Collateral || Comments || Tracking || Document || Verification || Correspondence || Tools
Producers
Vendors Consumer  Business
dpadd | Zedt || Elview || & audit
sthorized users and anly for permissible purposes. Unauthorized access is prohibited under the Fair Credit Reporting Act and is
nce
Viewv Formatv [ irap M [ submitr
£ Credit Bureau
; Type # Stas Dt Report Sl
INITIAL TuC ] 02/01/2016 'CREDIT REPORT ~ A
INITIAL EXP 3 01/30/2016 (CREDIT REPORT W/FICO
INITTAL TUC 2 01/30/2016 CREDIT REPORT v
< >
Applicant/Customer Details
View~ Formatv B Frezze il Detach «Jl Wrap ;)]
Type First Name ML Last Name Status Birth Dt S5N Suffix Include Debt
PRIMARY MARK. DOUGLAS 516G FAILED 01/03/1365 oen0e8660 R
< >
Report Header
Viewv Fomatv B Freeze [ Detach J Wrap 5]
R Bureau First Name I Last Name SSN Birth Dt Report Dt anfile Dt Credit Report It
i o TUC STACY P ARBEL bocooc2244  [10/01/1978 01/04/2016 03/01/2007 a1
> Collections <
> WFP
N Bureau Report | Summaryl | Summary2 | Tradelines | Public Records | Collections || Fraud Messages = Inquiries  Also Known As || Consumer Statements | CreditScores | > ¥
v
> Setup
L Noanna

3. Inthe Bureau Details section, view the following information:

Field:

View:

Type

The credit bureau request type.

Bureau

The credit bureau.

#

The credit bureau request number.

Status

The status of credit bureau request.

Dt

The credit bureau request date.

Report

The credit bureau report type.

Credit Bureau
Reorder#

The credit bureau reorder number.

App Ind

If selected, indicates that a bureau was pulled for an application.

4. In the Applicant/Customer Detail section, view the following information:

Field:

Do this:

Type

View the relation type.

First Name

Specify the first name.

Specify the middle name.

Last Name

Specify the last name.

Status

View the credit bureau request status.
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Field:

Do this:

Birth Dt Specify the date of birth.

SSN Specify the social security number.
Note: If the organizational parameter UIX HIDE RESTRICTED _-
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Suffix Select the generation.

Include Debt | Select to include credit bureau information in the Liabilities section of
the Summary sub screen.

Populate Select to load debt information from the credit bureau in the Liabili-

Debt ties section of the Summary sub screen.

Address Type | Select the address type.

Country Select the country.

Address # Specify the building number.

City Specify the city.

State Select the state code.

Street Pre Select the street pre type.

Street Name

Specify the street name.

Street Type

Select the street type.

Street Post

Select the street post type.

Apt #

Specify the apartment number.

Address Line
2

Specify the address line 2.

Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
Phone Specify the phone number.

5. Inthe Report Header section, view the following information:

Field: View:

Bureau The bureau.
First Name The first name.
Mi The middle initial.
Last Name The last name.
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Field: View:

SSN The social security number.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXX-XX-1234.

Birth Dt The birth date.

Note: The SSN and Birth Dt fields in Report Header section are displayed in red if
there is a mismatch in the respective data present in the above Applicant/Customer
Details section.

Report Dt The report date.

Onfile Dt The on file date.

Credit Report | The credit report id.
id

Best Match The best match.

6. Click Bureau Report.

The system parcels out the details from the credit bureau report in the Bureau screen’s
sub tabs (Summary 1, Summary 2, Tradelines, Public Records, Collections, Fraud
Messages, Inquiries, Also Known As, Consumer Statements, and Credit Scores).

7. Click Summary 1 sub tab.

8. You can view the following information:

Field: View:

Trades Records of extended installment payments, mortgage and revolving
credit, as detailed in the credit bureau report.

Bankruptcy | The total number of times the applicant has applied for Chapter 7,
Chapter 11 and Chapter 13 bankruptcies, recently and throughout life.

Past Due The total number of times the applicant has been past due on pay-
ments by 30, 60, or 90 days in the last year, two years, and throughout
life.

Public Number of legal actions, including liens, public records, and judgments

Records over the course of the applicant’s life, as well as any that are currently
open.

Collection Trades referred to an outside vendor for collection.

Credit View the FICO and bankruptcy scores.

Scores

Statistical Ages of the oldest and newest trades, as well as the average age of

Trade Ages | the open and total trades.

Derogatory | Tradelines that an action other than being late was reported; this
Trades includes collections, repossessions, charge offs, and bankruptcies.

9. Click Summary 2 sub tab
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10. You can view the following information:

In this .

. View:

section:

Trades Records of extended credit for auto, bank, credit card, retail, Loan-
finance, and sales finance Loan, as detailed in the credit bureau
report.

Inquiries Requests for a credit report regarding Loan in the Trades section over
the last six months, as well as total requests over 6, 12, and 24-month
periods, as well as the newest and oldest request.

Balance The total balance of retail and bank trades, as well as the high balance
of each.

Open The following information for all of the customer’s open trade lines: the

Derogatory | shortest and longest period of time (in months) since the customer’s
most recent minor derogatory (30-60 days late), major derogatory (90-
180 days late), and derogatory (bankruptcy, repossession, or charge
off).

Derogatory | The following information for all of the customer’s total trade lines

(open and closed): the shortest and longest period of time (in months)
since the customer’s most recent minor derogatory (30-60 days late),
major derogatory (90-180 days late), and derogatory (bankruptcy,
repossession, or charge off).

11. Click Tradelines sub tab to view information about trade lines, such as the creditor’s
name, trade’s status, type and code and balance information

12. View the following details:

Field: View:

Creditors The creditors name.

Name

Status The status of the tradeline.

Type The type of tradeline, such as bank, first mortgage, travel card, and
SO on.

Type Code The code for the type of tradeline.

Past Due Amt

The past due amount

Balance The balance of the tradeline.

Balance Dt The balance date.

Open Dt The date the tradeline was opened.

History Dt The trade line’s history date.

History Data The trade line’s history data.

30 The number of times the tradeline was 30 days past due.
60 The number of times the tradeline was 60 days past due.
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Field:

View:

920 The number of times the tradeline was 90 days past due.
Creditors The creditor’s subscriber number.

Subscriber #

Mop The method of payment.

Account # The account number.

Credit Limit The credit limit.

Term Pmt Amt

The term payment amount.

High Balance | The high balance of the tradeline.
Reported Dt The reported date.
Duplicate If selected, the tradeline is a duplicate.

Special Exclu-
sion

If selected, the tradeline is a special exclusion.

13. Click the Public Records sub tab to view information about public records, including each
one’s type, status, and amount, as well as the date the record was filed and resolved

14. View the following details:

Field: View:

Record The record type.
Type

Status The status.
Amount The amount.
Filed Dt The filed date.
Satisfied Dt | The satisfied date.

15. Click the Fraud Messages sub screen to view information about fraudulent attempts to
use the applicant’s credit.

16. Click the Inquiries sub screen to view all the credit reports for the applicant in reverse
chronological order

17. View the following details:

Field:

View:

Inquirer Name

The inquirer’s name.

Inquirer Subscriber | The inquirer’s subscriber number.

#

Inquirer Industry The inquirer’s industry code.
Code

Inquiry Dt The inquiry date.
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7.9.2

Field: View:

Rate Shopping If selected, the inquiry concerned rate shopping.

Duplicate If selected, if the inquiry was a duplicate.

18. Click the Also Known As sub screen to view other names used by the applicant.

19. Click the Consumer Statements sub screen to view statements that the applicant has
issued to the credit bureau.

20. Click the Credit Scores sub screen to view the score model, the score factor, and the
score returned from the credit bureau report.

Printing the Credit Bureau Data as a Text/PDF Report

To print the credit bureau data as a text or PDF report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. In the Underwriting screen, click Bureau.

3. Inthe Bureau Report tab, the system displays the report in text format. You can also view
the report in PDF format by selecting ‘PDF’ option as View Report.

Note

Google Chrome does not support search functionality in the PDF format of the report.
Hence you have to enable the ad-hoc plug-in in chrome to use the search facility.

4. In the Print Report section, click Print Report to send the information to the default
printer.

Requesting a Credit Bureau Report Manually

The Credit Bureau Summary screen enables you to manually request a credit pull.
Information from a manual credit pull can be used to validate an application.

To manually request a credit bureau report

1. Open the Underwriting screen and load the underwriting application you want to work
with.

2. Click Bureau tab.
In the Bureau Details section click Add.

4. Specify the following information:

Field: Do this:

Applicant Select the applicant.

Spouse Select the applicant’s spouse (if applicable).
Bureau Select the credit bureau.
Report Select the credit bureau report type.

5. Click Create Request.
The system displays this information in the Bureau Details section.
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Note

If you are requesting a report from Experian Credit Bureau for Premier Attribute Consumer
report, you can do so without impacting the consumer FICO score. To facilitate the same,
the ‘Soft Pull’ check box is to be selected in Bureau Details section. This option is available
only when the system parameter ‘EXP_PA_SOFT_PULL_IND’ is enabled in the System
Parameters screen and Bureau is selected as ‘EXP’ with Report as ‘PREMIER ATTRIB-
UTE’ in the Bureau Details section.

6. Select Include Debt and Populate Debt in the Applicant/Customer Detail section to
populate the Liability section on the Applicants link’'s Summary sub screen with data from
the credit bureau pull.

7. If you want to receive a copy of a previously pulled credit bureau report, enter the credit
bureau reorder number in the Credit Bureau Reorder # field on the Bureau Details
section. This enables you to receive a previously pulled credit report.

8. Inthe New Request section, click Submit Request.
The system displays the latest status of the currently requested bureau report in the Bureau

Details section. When the report pull process is complete, the Status field in the Bureau
Details section changes from PENDING to COMPLETED.

Collateral Tab

Having selected and loaded an application, you can view the information about the collateral
of the Loan.

The Collateral link opens screens with information regarding any collateral associated with an
a. Depending on the type of Loan, collateral can be a vehicle, home or something such as
major household appliances. The Collateral tab is unavailable if this is an unsecured Loan.

To verify information about the collateral
1. Open the Underwriting screen and load the application you want to verify.

2. Click the Collateral tab.

Depending on the type of collateral, information about the vehicle, home, or other type
of collateral appears.

If you are entering an unsecured Loan, the Collateral link is present but inactive; in
which case, skip this step.

3. Inthe Collateral Details section (This is information that was recorded during the
application entry process or gathered during the credit pull.)
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To enter collateral information

1. On the Underwriting screen, click Collateral. If the collateral is a vehicle, the Collateral
link displays information about the vehicle.
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< >
1
Vehicle
<A Retum
Existing Asset Body Zip Extn
Existing Asset Id Registration # UNDEFINED City BELLINGHAM
Primary ¥ Age 0 State MASSACHUSETTS
Asset Class NEW VEHICLE Description 2015 AUDL A% County NORFOLK
Asset Type VEHICLE Condition GOOD CONDITIONED
Sub Type CAR Usage Details
Status NOT DEFINED Address Start 12
Country UNITED STATES Base 10
Type & Description Address # 480 NEPONSET 5T Extra 2
Year 2015 Address Line 1 Total 24
Make AUDI Address Line 2 TURNPIKE 5T Charge Amt 2000000
Model A4
Identification # WAUAF7BE26A119602 Zip 02019
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2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Status

Select the asset status.

Type and Description

Model

Select Make and

Select the make and model of the vehicle from drop-down list.

Year

Specify the year of the vehicle.

Age

View the age of the vehicle

Make

Specify the make of the vehicle.
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Field: Do this:
Model Specify the model of the vehicle.
Body Specify the body of the vehicle.

Registration #

Specify the vehicle registration number.

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
State Select the state.
County Select the county.

Usage Details

Start Specify the start.

Base Specify the base.

Extra Specify the extra usage.
Total View the total usage.
Charge Amt Specify the charge amount.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Interface with VINTEK (If interface is installed)

Using the Vintek interface, the system retrieves the year, make, model and body of the vehicle
when you choose Vehicle Details. This time saving feature reduces data entry errors. Using
the VIN entered in the Identification Number field, the system populates following fields in the
Type & Description section:

e Year
e Make
° Model
e Body

7-57

ORACLE



If the Vintek interface is unable to retrieve information based on the VIN entered in the
Identification Number field, the system displays an error message.

If the collateral is a home, the Collateral link displays information about the home.

ORACLE i . & Welcome, VAVAIDYA ~  Accessibilty TR O
Financial Services Lending and Leasing
1ginati Close
e Origination x [E]
Origination Search/Task  Underwriting: 0000001536 Review Requests (Pending: 0)
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sk Lo Application: 0000001536: RODRIGUEZ MILDRED Elview | o audn
simple Application Entry
Application Etsy View v Format~ [ Freeze i Detach Wrap B overide 0K v  Warming OK v
underwriting On Pre Duplicate
Funding Dt App # Sub Unit Status s Producer Name CorExisting Customer  pictin Contacl
Apglicatod REtfiewl 09/05/2015 0000001536 APPROVED - FUNDED F... CA-00003 : ACE HEADQUA... (.. ¥ ¥
Scenario Analysis < >
Application Documents
Image Maintenance
Reports
Producers Summary | Applicant | Business | Request | Dedision | Contract | Collateral | Comments | Tracking | Document | Verification | Comespondence
Vendors
Collateral | Seller
Home B vew || o audt
View~ Formatw  [Ep Freeze 5l Detach Wrap 50
DMSUNO pxstng Assetld  Primary  Asset Class Asset Type Sub Type Occupancy Identification = Country Address =
N o NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 UNITED STATES 480 NEPONSE
1 < >
4
Valuation  Tracking
Valuation El view | « audit
View v Formatv [ Freeze it Detach Wrap @
Loan Currency - Usage Value Amt
et Y Retail Base Amt {1} Valuation Dt Source Currency Edition Supplement \
i 19,000.00 19,500.00 0.00 09/05/2015 NVOICE US DOLLAR
< >
Addons [Elview || o sudit
View v Format~ (5 Freeze jgfi Detach ap 5]
Desaription Value Amount Loan Currency Amount
» Servicing ANTI THEFT 290.00 290.00
> Collections
> WFP
> Teols
> Setup

1.

A brief description of the fields is given below:

Perform any of the Basic Operations mentioned in Navigation chapter.

Field:

Do this:

Existing Asset

Indicates that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Select if this is the main asset on the application.

Asset Class

Select the asset class.

Asset Type

Select the asset type.

Sub Type

Select the asset sub type.

Occupancy

Select owner occupancy type.

Identification #

Specify the vehicle identification number.

Address section

Country

Select the country.

Address #

Specify the home number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.
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Field:

Do this:

State Specify the state.
County Select the county.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.

Type and Description

Census Tract/BNA | Specify census tract/BNA (block numbering area) code.
Code

MSA Code Specify the metropolitan statistical area (MSA) code.
GEO Code Specify the geographical code for the property.
Condition Select the condition of the home.

Description Specify a description of the home.

Select Make and
Model

Select the make and model from the drop-down list

Year Specify the year when the property was built.
Age View the age of the home.

Make Specify the make of the home.

Model Specify the model of the home.

Width Specify the asset width.

Length Specify the asset length.

Area Specify the area of the collateral

PO# Specify the asset purchase order number.

Legal Description

Specify the legal description.

Lot Specify the asset lot.
Sub Division Specify the asset sub division.
Parcel ID Specify the parcel id of the home.

Metes-Bounds

Check this box to indicate the home is considered Metes-Bounds.

Flood Zone

Check this box to indicate the home is in a flood zone.

1098 Not Required

Check this box to indicate that the home does not require 1098

Deed Details
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Field: Do this:

Construction per-
mit Dt

Specify the date on when the construction is permitted.

Deed Dt Specify the date on when the deed is issued

Deed Place Of
Issue

Specify the place where the deed is issued.

Properties Bound-

Specify the boundary of the property from the
ary from East

east side.

North Specify the boundary of the property from the

north side.

West Specify the boundary of the property from the

west side.

South Specify the boundary of the property from the

south side.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

If the collateral is any other, the Collateral link displays information about that collateral.

ORACLE 1 2 Welcome, PRAKRRAD v Accessibility o
Financial Services Lending and Leasing
Close
DashBoard Origination x e
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Poplication Retrieval 09/05/2015 0000001533 REJECTED - AUTO... NEW CAD000S ; ACEH... (818)-7612277 N N
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Application Documents
Image Maintenance
Reporks Summary || Applicant | Business | Request | Decsion | Bureau | Collateral | Comments | Tracking | Document || Verfication | Comespondence | Tocls
Producers
Vendors Collateral  Seller
Other Collateral dradd | Aedt | [E view || 2 Audit
View = Fomatv [ Freeze g Detach Wrap §H)  Existing Asset 1d ¥ o Load Details
5’::(”9 Existing AssetId Primary  Asset Class Asset Type Sub Type Status Year Age Make Modsl
N [ (]
q N oy NEW VEHICLE VEHICLE caR NOT DEFINED 2015 0 AUDI a4
< > il
Other Collateral
[ saveand add || B SaveandStay | [ Seve and Retumn || 3 Retum
Existing Asset__ Body zp -
Existing Asset Id = "
= primary ] :
Identification 2 aty
ass NEW ASSET [v] oy
Description 5
B} : State [v]
Yps (HRGEHCKD COODS 2 Condition | GOOD CONDITIONED ] oty =
/ v
* Sub Type GENERAL HOUSEHOLD GOODS / E[~] =
= Status NOT DEFINED v Address Usaqe Details
* Country UNITED STATES [v] ot
Select Make and Model - 5 Start 0
Address # -
> Servicing *Year 0 e Bas= 0
Address Line 1
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> Collections i Address Line 2 o
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Existing Asset

Check this box to indicate that the vehicle is an existing asset.

Existing Asset ID

View the existing asset identification number.

Primary

Check this box if this is the main asset on the application.
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Field: Do this:

Asset Class Select the asset class.
Asset Type Select the asset type.
Sub Type Select the asset sub type.
Status Select the asset status.

Select Make and
Model

Select the make and model of the vehicle from drop-down list.

Year Specify the year of the vehicle.
Age View the age of the vehicle
Make Specify the make of the vehicle.
Model Specify the model of the vehicle.
Body Specify the body of the vehicle.

Registration #

Specify the vehicle registration number.

Identification #

Specify the vehicle identification number.

Description View the vehicle description.
Condition Select the vehicle condition.
Address

Country Select the country.

Address # Specify the apartment number.

Address Line 1

Specify the first address line.

Address Line 2

Specify the second address line.

State Select the state.
Zip Select the zip code.
For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
City Specify the city.
County Select the county.

Usage Details

Start Specify the start.

Base Specify the base.

Extra Specify the extra usage.
Total View the total usage.
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Field: Do this:

Charge Amt Specify the charge.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Valuations Sub Tab

The Valuation sub tab contains information about the value of the asset. The Values section
enables you specify the value of the asset. The Addons section records information about any
add ons associated with the collateral.

To complete the Valuations sub tab
1. Click the Valuations sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value section

Current Select if this is the current valuation.

Valuation Dt Specify the valuation date.

Source Select the valuation source.

Currency Select the currency based on which the valuation is to be done.

Edition Specify the valuation edition.

Supplement Specify the valuation supplement.

Whole Sale

Loan Currency | Specify the Loan currency wholesale value.

Wholesale

Base Amt

Wholesale- Specify the wholesale value.

Base Amt

Usage Specify the usage value; that is, the monetary effect that the current
mileage has on the value of the vehicle.

Retail

Retail Base Specify the retail value.

Amt

Addons Amt (+)

View the add-ons value.

Usage Value
Amt (+)

Specify the usage. This pertains to Loan and usually is entered as the
current mileage on the vehicle.

Total Value Amt
(=)

View the total value.
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7.10.2

Field: Do this:

LoanCurrency View the Loancurrency retail value.
Retail Base
Amt

LoanAddons View the Loan addons.
Amt(+)

Loan Currency | View the Loan currency usage value.
Usage Value
Amt (+)

Loan Currency | View the Loan total value.
Total Value Amt

=)

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Addons Section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Description Select the description for the attribute.
Value Specify the value of the attribute.
Amount Specify the add-on amount.

Loan Currency Specify Loan currency amount.
Amount

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Complete the Addons/Attributes, Value, and Amt fields for each of the asset’s add-ons
and attributes on the application.

Tracking Sub Tab

The Tracking sub screen enables you to record further information associated with the
collateral. What items you choose to track are setup during implementation.

To track attributes for the collateral

1. Click Tracking sub tab

2. On the Tracking sub screen, click Load Details.

3. Inthe Tracking Items section, select the item you want to track.

4. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Tracking Item View the tracking type

Disposition Select the disposition.
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7.10.3

Field: Do this:

Start Dt Specify the tracking start date.

End Dt Specify the tracking end date.

Follow up Dt Specify the next follow-up date.

Enabled
field.

Select to track the information from the start date in the Start Dt

Comment

Specify any comments regarding the tracking item.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Complete the Tracking Item Details section by entering information about a parameter

in the corresponding the Value field.

Seller Tab

The Collateral link’s Seller Details tab enables you to enter the seller details of the collateral

of the Loan.

To enter the Seller details
1. Click the Seller Details tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE & Welcome, VAVAIDYA v  Accessibility o
Financial Services Lending and Leasing
- Close
ieaa Origination ma
Origination Search/Task  Underwriting: 0000001533 Review Requests (Pending: 0)
Origination
Salenend Application: 0000001533 SIGG MARK Evew | 2 audt
Simple Application Entry
Anplication Entry View v Formatw [ Freeze  Eff Detach Wrap @) Override OK v Warning OK v
Underwriting ori prc St
Funding Dt App # Sub Unit Status = Producer Name CoiBsisting Customer L L0iCos, Contad
Appinatichi REHIcN 09/05/2015 0000001533 APPROVED - FUNDED F. CA-00003 : ACE HEADGUA . (L N N
Scenario Analysis >
Application Documents
Image Maintenance
Reports
Producers Summary Applicant Business Request Deasion Contract Collateral Comments Tracking Document Verfication Comespondence | Tools
Vendors
Collateral  Seller
Seller Details [ Sl vew | 2 Aud
View = Format~ [ Freeze [l Detach ol Wrap 5]
= Nationality ID / Reg  Authorized
Seller Type Seller Name Nationality # sty
CORPORATE MAJESTIC MARBLE & GRANITE INC usa 382099685
‘«
- ‘.
Seller Details
@ Retun
Seller Type CORPORATE Nationality 1D / Reg # 382099685
Seller Name MAJESTIC MARBLE & GRANITE INC Authorized Signatory
Nationality USA
Seller Address [E view || o Audit
Vieww Format~ [ Freeze {fiDetach | <l Wrap (5]
Mailing Current Country Address = city state Addressinel  Addressine2  Zip
¥ ¥ UNITED STATES 555 TURNPIKEST  CANTON MASSACHUSETTS  TURNPIKE ST STE 02021
< >
> Servicing
> Collections
> WFP
> Tools
 Setup

A brief description of the fields is given below:

Field: Do this

Seller Information section
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Field: Do this

Seller Type Select the seller type.

Seller Name | Specify the seller name

Nationality Select the seller’s nationality.

National 1D/ Specify the national identification number or registration number.

Reg #

Authorized Specify the authorized signatory of the seller.

Signatory

Seller Address section

Mailing Select if this is the mailing address. Only one address entry can be
marked as the mailing address.

Current Select if this is a current address. The mailing address must be marked
as current.

Country Select the country code.

Address # Specify the address number.

Address Line | Specify the first address line.

1

AddressLine | Specify the second address line.

2

State Select the state.

Zip Select the zip code.
For non US country, you have to enter zip code.

Zip Extn Select the zip extension.

City Specify the city.

Phone Specify the telephone number.

Extn Select the telephone extension.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Comments Tab

When using the Underwriting screen, you can add/delete comments to an application at any
time in the underwriting process by using the Comments screen.

Whenever an application is decisioned by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Underwriter <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of
User2, who is the concerned Underwriter. The concerned Underwriter’'s name will also be
selected in Application section > 'Proxy for Underwriter' field.
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To add comments

1. Click Comments tab.

ORACLE . . . # Welcome, VAVAIDYA ~  Accessibilty  [EEITOUON O
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» Servicing
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> WEP
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 Setup

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Alert Check this box to make the comment appear on the Customer
Service screen Alert section

Type Select the type of comment you are adding.

Sub Type Select the sub type of comment you are adding.

Comment Specify your comment.

Comment By The system displays your user ID.

Comment Dt The system displays commented date and time stamp.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

7.11.0.1 Deleting Comment(s)

You can delete ‘REGULAR’ type comments displayed in the Comments sub tab.

To delete a comment

1. Select the row which consists of the comment and click Delete from the actions.

2. Click “Yes’ to confirm delete in the warning message displayed.
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7.12 Tracking Tab

When using the Underwriting screen, you can add tracking attribute information to an
application at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes
1. Click Tracking tab.
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2. On the Tracking Attributes screen, click Load Tracking to load the tracking attributes.
3. Select the item you want to track.

4. Click Edit to edit the following information:

Field Do this

Sub-Parameter | View the sub-parameter

Parameter View the parameter.

Value Specify the information about the corresponding Value field.

5. Save changes you made to the account.

7.12.1 Field Investigation Sub Tab

The Field Investigation link enables lending institutions to perform field investigations and
verify an applicant’s contact points (address and employment information, for example) and
credentials (such as asset details). Clients can chose the details to be verified (address,
employment, asset or any combination of the three), as well as the verifying agency.

With the Underwriting screen’s Field Investigation screen, you can select which details from
application entry are to be verified. The verifying agency performs a field investigation of the
details and responds to the lending institution with either XML or a text file. The details are
entered in the system for an underwriter to review when making a decision.
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1. Click Field Investigation sub tab.

2. In Field Investigation section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Do this

Applicant

Select the applicant from the adjoining drop-down list

Verification Type

Select the verification type from the adjoining drop-down list.

Verification Agency

Select the verification agency from the adjoining drop-down list.

Status Select the status from the adjoining drop-down list.
Spoke to Specify the name of the person applicant spoke to
Call Dt Specify the call date

# of Attempts Specify the number of attempts made.

Result Select the result from the adjoining drop-down list

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In Verification Details section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field

Do this

Verification Match

Check the box if the verification has matched.

Remarks

Specify remarks, if any

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Document Tab

The Document tab allows you to view documents attached to the application in the form of

GIF files, PDF files, DOC files, XLS files and TXT files and add comments regarding a

selected.

For more information, see the chapter Document Management in this User Guide.
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To view a document attached

1. Click Document tab.
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2. Inthe Application Document section, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below.

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the document.

Field:

View this:

Document Sub
Type

The document sub type.

Version

The version. (Version numbers will be incremental by batch job, first
version will start with 1.0.)

Page #

The page number.

Document File
Type

The document file type.

Tracking #

The tracking number of the document.

Docket #

The docket number of the document.

Location

The location of the of the document.

Received Dt

The effective date of the document.
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Field:

View this:

Effective Dt The effective date of the document.
Expiry Dt The expiration date of the document.
Comment Any comments regarding the document.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

Checklist Sub Tab

The Checklist sub tab enables you to view tasks performed during the underwriting process.

To view the underwriting Checklist screen

1.

o M 0D

Click Document > Checklist.
If the Checklist section is empty, click Load Checklist in the Checklist section.

In the Checklist Actions section, click Regular sub tab.

In Checklist Actions section, complete the tasks listed in the Checklist Action column.

Use the Yes/No/NA buttons in the Yes No NA column to indicate whether you completed
the task or not.

Use the Comment field to add remarks regarding any of the tasks, if you choose.

When you are finished completing the tasks, choose Complete in the Checklist section.

= © ® N o

Click Save.

In the Checklist Actions section, click the Documents sub tab

0. In the Documents section, select the record you want to work with and click View in the
Details column.

11. In the Documents section, view the following information:

Field:

Do this:

Action

View the action to be performed.

Document Type

View the document type.

Document Sub
Type

View the document sub type.

Status Select the status of the action.

Response Use the Yes/No/NA buttons to indicate whether or not
you completed the task.

Comment Specify comment.
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Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning, or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Loan until you fix all the errors.

Ifitis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)

The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Loan. Each one of these ‘edit types’ has its own set of ‘edit details’.

Note

The Edit Details section’s errors and warnings are created during the setup process.

Edit Sub Tab

To complete the Edits section
1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Edits.
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3. Inthe Edits screen’s Edit Type section, select the type of edit you want to verify.

4. Click Check Edits.

The system checks the data for the verification process selected in the Edit Type section
and displays the results in the Edit Details section.

The Edit Details section contains the following display only information:

Field: View this:

Edit Name The edit.

Result The result.

Expected Value The expected value.

Actual Value The actual value.

Override Responsibility The override responsibility, if an override is required.

5. Inthe Edit Details section, view the verification results and begin making corrections on
the Underwriting screen. Remember, edits resulting in ERROR must be corrected. Edits
resulting in WARNING can be by passed.

The system begins processing the credit application.

7.14.2 Audits Sub Tab

The Audits screen is a display only screen that enables you track changes to the contents of
predetermined fields (which fields are determined during set up). For example, the Audits
screen can be configured to monitor when the contents of the Status and Sub Status is
changed. The Audits screen lists the field that was changed, who made the change, when the
change was made, and the old and new values in the field.

To view the Audits
1. Open the Underwriting screen and load the application you want to work with.
2. Click Verification > Audits.

3. Inthe Audit Details section, view the following display only information:

Field: View:

Record Id The record identifier for the record changed.
Field The field which was changed.

Old Value The old value of the column which was changed.

New Value The new value of the column which was changed.

Changed By | The user code who made the change.

Changed The date and time when the change was made.
Date

7.14.3 History Sub Tab

You can track the time it took a user to complete each stage of the application process with
the History section. It displays:

e The date and time when an application changed status / sub status
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e The user who changed the status / sub status
e The elapsed time of how long an application was in a particular status / sub status.

1.  To view the History Open the Underwriting screen and load the application you want to
work with.

2. Click Verification > Historyln the Application Status History section, view the following
display only information:

Field: View this:

Status The application status.

Sub Status The application sub status.

User The user name.

Start Dt The date and time when the application moved to that status.

End Dt The date and time when the application moved from that sta-
tus.

Elapsed The elapsed time between the status change.

Time

7.15 Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter
or view a previously generated letter.

7.15.1 Correspondence Sub Tab

To generate an ad hoc correspondence

1. Open the Underwriting screen and load the application you want to work with.
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2. Click Correspondence > Correspondence.
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3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Correspondence

Select the correspondence you want to generated.

ID

System displays the correspondence ID.

Date

System displays the correspondence generation date.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

The Documents section displays all the types of documents available for the type of
correspondence you selected.

5. In the Documents section, view the following information for each document:

Field:

View this:

Document ID

The document ID.

Document

The document description.

Recipient

The recipient description.

E-Form Source

The e-form source.

Source Type

The source type.

Selected

If selected, indicates that this document is selected to be included
in the correspondence.

Generated

If selected, indicates that the system generated the document.

6. Inthe Documents section, select the correspondence you want to view.
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7. The Document Elements section displays the elements the system used to generate the
correspondence. You view the following information:

Field: Do this:

Element Type View the element type.

Element View the element description.

Content Specify/view the value of the element.

e Click All to view all elements in the correspondence.
- Or -
e Click User Defined, to view user-defined elements in the correspondence.

8. Inthe Document Elements section, click User Defined and complete the Content fields
for the Document Element fields you want to include in the correspondence.

9. In the Document Elements section, click Save.

10. In the Documents section, click Generate.

The system ‘locks’ the information included in the correspondence and prevents it from
being changed.

11. In the Document Elements section, click View.
The system displays a PDF of the ad hoc correspondence.

7.15.1.1 Recipient Details Sub Tab

The recipient details sub tab facilitates you to send ad-hoc correspondence to Applicants,
Customers, Producers, and Others as either Fax or Email.

To add recipient details

1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Recipient Details.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

4. In the Recipient Details section, click Save.

5. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details::

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.15.2 Letters Sub Tab

The Letters link enables you to generate letters using predefined letter templates for Loan.

Letters can be sent in hard copy or Email / Fax. Among the two options provided for each of
these options, you can select the required mode for sending letters.

e When 'Letters' option is selected the correspondences generated are displayed in a
table below with a button 'View Letter'.

e When 'Fax' radio button is selected, the correspondence table displays all
correspondence including those in Fax or email formats in the table below.

In addition to the above, a section for recording 'Recipient details' opens below. On clicking
'Add' you can specify recipient details, Mode, Type, provide comments and Save the same.
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Comments captured will be appended to Fax / Email sent to recipient. You will then need to
click on the 'Send' in the action block for email / fax to be sent from OFSLL. In case the
correspondence generation is dependent on any job run, then on click of 'Send' system
displays an error message "Fax / Letter not generated. Please try sending later”; else event
successful message is displayed.

On the Underwriting screen, these predefined correspondences are as follows:

e Decision Letter
e Adverse Action Letter
e Adverse Conditional Letter

To generate letters on the Underwriting screen
1. Open the Underwriting screen and load the application you want to work with.
2. Click Correspondence > Letters.

3. Inthe Letters screen, select the type of letter you want to generate, and click View Letter.
UNDERWRITING:
— Ifyou select Decision Fax, and click View Letter, the system displays the decision
letter.

The predefined Decision letter is automatically sent after an application receives a
status of APPROVED, REJECTED, or CONDITIONED on the Underwriting screen.

The Decision fax/e-mail is available for Loan(fixed and variable rate).

— Ifyou click Adverse Action, and click View Letter, the system displays the adverse
action letter.

The predefined LoanAdverse Action letter is automatically sent to the producer after a
configurable number of days when an application receives a status of REJECTED on the
Underwriting screen.

The Adverse Action letter is available for Loan(fixed and variable rate).

— Ifyou click Conditional Adverse Action, and click View Letter, the system
displays the adverse conditional letter.

The predefined Conditional Adverse Action letter is automatically sent to the producer
a configurable number of days after an application receives a status of CONDITIONED
on the Underwriting screen.

The Conditional Adverse Action letter is available for Loan(fixed and variable rate).

4. In the Recipient Details section, you can send the ad-hoc correspondence. You can
specify the following details:

Field: Do this:

Recipient Select the recipient from the drop-down list. The list displays the
following options:

- Applicant
- Customer
- Producer
- Others

Note: Based on the type of recipient selected the other corre-
spondence options are displayed for selection.
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Field: Do this:

Mode Select the mode of correspondence from the drop-down list. The
list displays the following options:

- Fax
- Email

Note: When the recipient is selected as ‘Applicant’, the Mode is
defaulted to Email.

Type Based on the recipient selected, the following type of correspond-
ence is listed for selection:

- When the recipient is selected as Applicant, you can select the
‘Applicant Type’ from the drop-down list and ‘Type’ as either
EMAIL/ADHOC. The ‘Mode’ is defaulted as ‘Email’.

- When the recipient is selected as Customer / Producer, you
can select the ‘Mode’ as either FAX/EMAIL and ‘Type’ as FAX/
ADHOC or EMAIL/ADHOC respectively.

- When the recipient is selected as Others, you can select the
‘Mode’ as either FAX/EMAIL and ‘Type’ as ADHOC only.

FAX/Email Specify the FAX/Email details for correspondence.

Comments Specify additional information as comments.

5. In the Recipient Details section, click Save.

6. Click Send to FAX/Email the correspondence details to the specified recipients.

System validates the correspondence details and generates a PDF document through
Bl Publisher with the Correspondence details. The same is emailed to the specified
recipient as an attachment and a system generated comment is updated in ‘Comments’
Tab. The correspondence consists of following header details:

Alert Type & Comment Comment Comment Date
Subtype By
N System <Type> <Correspondence Logged in | Current System
Generated type> sent to <Recipient Type> | user date with time
through < Mode> to <'Email' id> stamp

7.16 Tools Tab

The Tools tab calculates the payment amount, term, interest rate, Loan amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.
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8.1

8.2

8. Funding

Introduction

At this stage of the Loan origination process, the application has been entered into Oracle
Financial Services Lending and Leasing and approved manually by an underwriter or by the
system. The next step is to view and complete the contract information and make a funding
decision to finance or reject the application. This is accomplished by using the Funding
screen.

This chapter explains how to:

e Load an application on the Funding screen

e Change the status of the application to begin funding process
e Verify the applicant information

e View the credit pull and underwriting information

e Verify the collateral

e Add comments and tracking attributes

e Complete the Contract screens

e View an application’s contract edits

e Audit changed fields and status history

e Change the status at the end of the funding process.

Funding (an overview)

In Oracle Financial Services Lending and Leasing, the funding process follows these basic
steps:

1. Open the Funding screen and load the application you want to work with.

2. Inthe Funding screen’s Applications master screen, Change the status of the application
to APPROVED - VERIFYING.

3. Using the Funding screen’s Applicants link, view and verify information about the
applicant (data recorded from the Application Entry screen). This includes verifying the
applicant’s actual address and employment information.

4. Using the Funding screen’s Decision link, view and verify information supplied during the
credit bureau pull and underwriting process. This is display only information and cannot
be edited.

5. Using the Funding screen’s Collateral link, view and verify information regarding the
collateral for the application.

6. Using the Funding screen’s Contract link, complete the truth-in-lending information.

7. Inthe Funding screen’s the Applications master screen, change the status to FINAL
DOCUMENT CHECK.

8. Using the Funding screen’s Verification link, view any errors and warnings that prevent
the status change.

9. Make changes to the application data that correct the errors until you can change the
status.

When the system changes the status of the application to FINAL DOCUMENT CHECK, it
sends the application to a supervisor or Loan officer queue where it is viewed and verified.
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After this, the application’s status is changed to APPROVED - VERIFIED. If the supervisor/
Loan officer decides to fund the Loan, he or she will change status of the application to
APPROVED - FUNDED.

Loading an Application on the Funding screen

The first step in the funding process is to open the Applications form and manually or
automatically load the application you want to work with. You can manually select an
application using the Search tab’s Criteria and Results screens. If your system is configured
to load applications based on work queues, use the Queue field in the Quick Search section.

Refer the chapter Searching for Application for more information on the following:

e Using Search Criteria screen
e Using Quick Search section
e Using Result screen

e Loading an application

Funding non OFSLL Loan Applications

Oracle Financial Services Lending and Leasing can readily process credit contracts
generated from external system for funding. You can load the credit applications data
received from external system into OFSLL through the 'Application Entry' screen and proceed
with funding. For more information, refer 'Entering a Credit Application' section.

Once the application is processed or approved through OFSLL funding screen, the external
system is intimated with the decision. Those applications can still be processed further in
external system itself to validate the contract against approved credit. If agreed, the signed
contract documents can be distributed in electronic format to OFSLL for funding. Once Credit
Contract is distributed, the ‘Contract Type’ is automatically changed to eContract/Dealer in
OFSLL and notified to the user.

All communications between OFSLL and external systems are recorded into a log and is
accessible through Dashboard > System Monitor > Database Server Log Files screen. Also
the ‘Comments’ screen facilitates to exchange information regarding credit contract
processing between OFSLL and external system as comments, provided the comment Sub
Type is selected as 'OUTBOUND TO INTERFACE' for such communications.

In addition, OFSLL also supports revoking of funded credit contracts worked through external
interface by reversing the active transaction in Customer Service > Transaction History >
Transaction tab. Whereby the application/account status is changed to 'Void' and
subsequently categorized as FLAT CANCEL (indicating as fraud application and funding is
withdrawn) or UNWIND (when application still has errors and allowed to update/rectify details
and resubmit for funding).

Overall, this process minimizes the application processing time and fastens the funding
process.

Funding Screen’s Master Screen

The Funding screen’s master screen displays information from the Application Entry and
Underwriting screens, such as the application number, product and producer. It also contains
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the Status field that allows you to change the status/sub status of the application and begin
the funding process.

ORACLE’
Financial Services Lending and Leasing
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For details on this screen refer Applications section in Underwriting chapter.

After opening the Funding screen and loading the application you want to work with, you must
change its status to APPROVED - VERIFYING before you can begin the funding process. This
allows you to begin working with the application.

To change the status and begin work on the application on the Funding screen
1. Open the Funding screen and load application you want to verify.

2. Inthe Funding screen’s Applications master screen, use the Status field to select
APPROVED - VERIFYING.

3. Click Save on the Funding screen.
You can now begin making changes to the application.

Funding an Application

After you have verified the application, entered the contract information and completed the
contract edits, the application is ready to be funded. Applications can be approved
automatically or manually. To manually fund an application, change the status to APPROVED
- FUNDED.

After an application is funded, the Loan origination cycle is over. The system moves the
application to the Loan servicing module (Customer Service form) where it receives an
account number. The system also automatically creates a check requisition for the funded
account.

Funding tasks
1. Load the application on the Funding form
2. Change the status and initiate Funding process

3. Verify the applicant information
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Complete Contract (5) details

Verify the documents

Generate letters

Attempt to change the application status

Verify edits

© ©®© N o o &

Complete Funding

After you approve the application, the information on the Decision tab is unavailable. The
application remains in this status of Approved - Verified until a user (usually a supervisor)
changes the status to Approved - Funded. When the status is changed to Approved - Funded,
the account is created.

Summary Tab

The summary screen provides a unified view of the application details without navigating to
the respective screens/ sub-tabs.

Using this screen, the user can view the applicant details, asset details, ratios (only for
Primary Applicant), trade-In, requested details, approved details, itemization, decision history,
alerts, comments, and checklist details in the respective section.

To view the Summary

1. Open the Funding screen and load the application you want to work with.

2. Click Summary.
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For details on this screen refer Summary Tab section in Underwriting chapter.

Applicants Tab

Having selected and loaded an application, you can use the Applicants link to view
information about the applicant (s). This is information that was recorded on the Application
Entry screen or gathered during the credit pull. You can edit the data from the Application
Entry screen at anytime in the following steps. Remember to save your work with each
change. Information from the credit bureau pull is available to view only.
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To verify information about an applicant
1. Open the Funding screen and load the application you want to work with.
2. Inthe Funding tab, click Applicants.

3. Inthe Applicants Details section, select the applicant you want to verify and click Edit.

For details on this screen refer Applicant Tab section in Underwriting chapter.

Business tab

If this application is an SME Loan (defined in the Applications section Class field as SMALL
BUSINESS), the Business Applicant link appears on the Funding link bar. This link displays
the small business information recorded on the application entry process. You can edit the
Funding screen at anytime in the following steps. Remember to save your work with each
change.

If there is no business information associated with the application, the Business Applicant link
is unavailable.

For more information about the individual fields in this section, see the Application Entry
chapter.

To verify business information from the Business Applicant link
1. Open the Funding screen and load the application you want to work with.

2. Click Business Applicant.
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For details on this screen refer Business Tab section in Underwriting chapter.
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Request Tab

System displays the calculated Payment, Interest Rate, Term and Loan Amount in the

Request tab.

e, PRAKRRAQ +
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For details on this screen refer Request Tab section in Underwriting chapter.

Decision Tab

With the Decision tab, the system displays information gathered during the underwriting
process. Depending on the type of application you are working with, system displays Loan
information. On Clicking Calculate, the user can calculate the Loan amount, rate, term, and

payment.
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8.9

The fields on the Decision screens and sub screens are described in detail in the Underwriting

chapter.

ORACLE’

Financial Services Lending and Leasing

VAVAIDYA +

DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WEP

> Tools

> Setup

Origination s,

Search/Task ~ Funding: 0000001533 | Review Requests (Pending: 0)

Application: 0000001533: SIGG MARK

Viewv Formatv [ freeze EfiDetach | ol Wrep W owerideok v Waming OK v
= Prc
ot App# Sub Unit Status Jrigination S128 progucer Name & s 2::"“::;; Cor
09/05/2015 10000001533 REJECTED - AUTO REJEC.. NEW CA-D0003 : ACE HEADQUA.. (.. N N
>

Summary || Applicant | Business | Request | Dedision || Bureau

Decision Information

View v Format~ [ Fresze i Detach | wrap

Cument Grade Score
¥ DGRADE 0]

D GRADE o
N D GRADE o
N D GRADE o
N D GRADE o

<

Decision Information

Pricing
Pricing VEHICLE LOAN PRICING-FR
Current V'

Approved

Decision Term 15
Pmt Amt 1,302.31
Index FLAT RATE
Index Rats 0.0000
Decision Margin Rate 4.9900
Decision Rate 4.9500
Fricing Buy Rate 2.9900
Approved Buy Rate 2.9900

Collateral || Comments | Tracking | Decument | Verification || Correspondence | Tools

B 8% select Pricing

Max Advance Amt LTVL  Max Financed Amt

18,900.00 95,50 18,900.00
18,900.00 95.50 18,900.00
18,900.00 95.50 18,900.00
18,900.00 95.50 18,900.00
18,900.00 95,50 18,900.00

Status REJECTED
Sub Status AUTO REJECTED

Down Pmt Amt1,890.00
Max Advance % 0.0000
Max Advance Amt 18,500.00
Max Financed % 0.0000
Max Financed Amt 18,900.00
Maturity Index FLAT RATE
Maturity Margin Rt 4.5500
Balloan Amt 0.00

A edt | E vew || o audit

[v] [@ caleulate 48k Re-Score
L Decision Term Decision
95.50 i 4
95.50 15 4N
95.50 15 4
95.50 15 40 “
95.50 15 4
>
£a Retum

Decision Dt 02/01/2016
Underwriter INTERNAL

Bureau 1 BXP

Bureau 2

Bureau 3
Grade D GRADE
Score D

Collzteral Value 19,790.00

LTV1 9550
LTV2 9550

For details on this screen refer Decision Tab section in Underwriting chapter.

Bureau Tab

The Bureau tab displays the credit report (if pulled) for an applicant. If there is a need for
another pull for any applicant, it can be done here manually using the New Request section.

To verify the credit bureau data using the Bureau tab

1. Open the Funding screen and load the underwriting application you want to work with.
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2. Click Bureau

ORACLE" , VAVAIDYA v Accessibiity o
Financial Services Lending and Leasing
i Close.
T Origination 5 g
Origination Search/Task | Funding || Review Requests (Pending: 0) =
Origination
Sales Lead Application At | Elvew | o auit
Simple Application Entry ~
Acsdication Bty View~ Fomaty Ep Freeze il Detach Wrap ¥ overdeOK__  Waming OK __
Undenwriting i b
Funding Dt App = Sub Unit Status g:dgé"'“m S0 prducer Name :ﬁw Existing Customer 2;:"\‘:;;\ Cor
Apslication et eyl No data to display.
Scenario Analysis < 5
Application Documents
Image Maintenance
Reports
Producers. Summary | Applicant || Request | Decision  Bureau | Contract = Comments| Tracking | Document | Verfication || Correspondence
Vendors
Consumer
Bureau Details dradd | SEdt | [ view | <2 audt
1 users and anly for purposes. Unautherized access is prohibited under the Fair Credit Reporting Act and is
= Credit Bureau
q Type Bureau # Status Dt Report ol
No data to display. f
>
Bureau Details
A Create Request | | GaRetum
New Request
* applicant | [v] =Report [v]
TBureau | [v]
Applicant/Customer Detail:
. View v Formatw [ Freeze EfiDetach | ol Wiap %]
ZiScncig Tyee First Name M Last Name Status Eirth Dt ) Suffix Include
> Callections No data to display.
- < >
> WFP
> Tools
> Setup Report Header v

For details on this screen refer Bureau Tab section in Underwriting chapter.

Contract Tab

The screens associated with the Contract link are the core of the funding process. They allow
you to perform the important task of completing the truth-in-lending details. These screens
include information mandated by Regulation Z; information about the financed amount, the
payment schedule, the total of these payments, the finance charge, the resulting annual
percentage rate (calculated according to Federal/Central bank guidelines; that is, within 125%
of the Treasury OCC calculated APR) for the conventional Loan, and internal rate of return for
Islamic Loan. Use the Loan packet to supply the required information.

In completing the truth-in-lending details on the Contract link, you will enter Loan information.
The truth-in-lending details must be completed before a Loan can be funded.

The tabs opened from the Contract link share the following sub tabs:

e Contract (2)

e Repayment

e Itemizations

e Trade-In

e Subvention

e Insurances

e ESC

e Escrow

e Compensation
e Proceeds

e Disbursement
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e Fees

e ACH

e Coupons

e PDC

e References
e Real Estate

On clicking Calculate, you can calculate the Loan amount, rate,

term and payment. You can

use the calculator available in Tools section for completing this step. For detailed information
on using the Calculator tools, refer “Tools” chapter in the document.

To enter the contract details

1. Open the Funding screen and load the application you want to work with.

2. On the Funding screen, click the Contract tab.

e If the application you opened is for a Islamic Loan, the Loan screen appears.

3. Using the information in the contract packet, complete the Contract section.

ORACLE’ 3
Financial Services Lending and Leasing
i Close.
DashBoard Origination 5 il
Origination Search/Task | Funding: 0000001536 | Review Requests (Pending: ) =
Origination
Sales Lead Application: 0000001536: RODRIGUEZ MILDRED Elvew || o audt
Simple Application Entry
e iy View v Formate [ Fresze i Detach Wrap W) OverideOK ¥ Waming OK v
Underwriting Origination Stage Producer Gontact s Duplicate
=ik ot App# Sub Unit Status e Preducer Nama s Existing Customer  LBLE0 Contact
Application Retrieval 08/05/2015 10000001536 APPROVED - FUN. FUNDED (CA-00003 : ACE H. (818)-761-2277 h ¥
Scenario Analysis >
Application Documents
Image Maintenance
REorde Summary || Applicant || Business || Request || Decsion || Contract || Collateral || Comments || Tracking || Document || Verification | | Correspondence.
Producers
Vendors
Contract Information Bl vew |« audit
View v Format~ [ Freeze i Detach | wrap 1]
Contract Dt Term 1st Pt Dt Instrument A Credit Limit Draw Term Repmt Term Maturity Dt Index
09/05/2015 24 10/01/2015 LINE INS WEEKLY 18,900.00 6 24 09f01/2017 PRIME RATE
< >
. Contract Information
{A Retum Al
Gontract Dt 09/05/2015 Start Days 0 # of Adis / Life 999
Instrument  LINI ¥ Stop Accrual Days 99999
& ument Detz POC Security Ind Advance
Credi Linid 15,2000 Initial Advance Min 1,000.00
D T Promotion Details Tnitial Advance Max 10,000.00
Repmk Term 24 Advance Min 1,000.00
em 24 Promotion UNDEFINED Advance Max 10,000.00
Maturty D 09/01/2017 Type NONE
Index PRIME RATE Tebi 0 Billing
Index Rate 8.9900 Index
Margin Rate 4.9900 Index Rate 0.0000 Draw Period Billing Method PERCENTfGE OF PRINCIPAL
te 13 PLUS INTEREST
Rk 13800 Margin Rate 0.
P . o Draw Period Payment % 2.0000
1st Pmt Dt 10/01/2015 Rate 0.0000
DueDay 1 o Repmt Pericd Billing Method PERCENTAGE OF PRINCIPAL
 Servicing el O 0 052015 PLUS INTEREST
- % /05201 Rate Caps and Repmt Period Payment % 2.0000
> Collections Verified Dt 09/05/2015 Adjustments R
S Min Payment Amt  50.00
5 ed By 3 s
> WFP oy s P T Min Finance Charge 1.00
> Teols ncrease Max Lifetime
> setup Instrument Details . ihm; i v

(The system calculator may used when completing this section. For more information, see

the Tools chapter.)

4,
chapter.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

Contract section

Contract Revd Dt

Specify the contract received date.

Contract Dt

Specify the contract date.
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Field:

Do this:

Instrument

Select the required instrument from the drop down list and click
on Load Instrument Details.

Amt Financed

Specify the amount financed: the Loan amount applied minus the
prepaid finance charges. Prepaid finance charges can be found
on the Good Faith Estimate/Settlement (HUD-1 or 1A). For exam-
ple, if the borrower’s note is for $100,000 and the prepaid finance
charge total is $5,000, the amount financed would be $95,000.
The amount financed is the figure on which the annual percent-
age rate (APR) is based.

Loan Term Specify the term/number of payments.
Index Select the index.
Index Rate View the index rate.

Contract Margin
Rate

Specify the margin rate.

Contract Rate

View the interest rate.

Balloon Method

View the balloon payment method.

Balloon Amt Specify the balloon amount.
Due Day Specify the due day.

1st Pmt Dt Specify the first payment date.
Maturity Dt Specify the maturity date.

Finance Charge
Amt

Specify the finance charge: the amount of interest, prepaid
finance charge, and certain insurance premiums (if any) that the
borrower will be expected to pay over the life of the Loan.

Total of Pmts

Specify the total of payments.

Down Pmt Amt

Specify the down payment amount.

Total Sale Price

Specify the total sales price.

Payment Amt

Specify the payment amount.

Final Pmt Amt

Specify the final payment amount.This amount will be same as
that in the Payment Amt field when the installment method is
EQUAL PAYMENTS. (required).

Repmt Currency

Specify the currency to be used for repaying the Loan.

Principal Balance

View the principal balance on the Loan.

ORACLE



Field: Do this:

APR Specify the annual percentage rate: the cost of the Loan in per-
centage terms taking into account various Loan charges of which
interest is only one such charge. Other charges which are used in
calculating the APR are private mortgage insurance of FHA mort-
gage insurance premium (when applicable) and prepaid finance
charges (Loan discount, origination fees, prepaid interest and
other credit costs). The APR is calculated by spreading these
charges over the life of the Loan, which results in a rate higher
than the interest rate shown on the mortgage/deed-of-trust note.
If interest was the only finance charge, then the interest rate and
the annual percentage rate would be the same.

Verified Dt Specify the contract verification date.
Verified By View the user id who verified the contract.
Signing Dt Select the signing date on when the documents is signed.

Probable Delivery | Select the probably delivery date.
Dt

Note: For Islamic products the following additional fields will be displayed.

Residual Income View the residual income for the residual days.

Residual Days View the number of residual days.
IRR View the interest rate of return.
Profit Rate View the profit rate (display only).

Instrument Details — An instrument is a contract with specific rules tied to it. An instru-
ment associated with the application indicates OFSLL of the type of contract being
used for the approved loan. Items defined in the contract are “locked in” when you
select the instrument from drop down list and click on "Load Instrument Details". These
values cannot be changed on the funding screen.

Any changes to the instrument in account will be handled by monetary/non-monetary
transactions.

The system loads all the rules established by the company that are required at the time
of funding; for example, the accrual method, billing method, type of billing, tolerance,
due dates, extensions and so on.

Accrual Method View the accrual calculation method.
Start Dt Basis View the accrual start basis.

Base Method View the accrual base method.

Bill Method View the billing method.

Bill Type View the billing type.

Time Counting View the time counting method.
Method

Installment View the installment methods.
Method
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Field:

Do this:

Calendar Method

View the Calendar Method.

Start Days

View the accrual start days.

Stop Accrual Days

View the accrual stop days.

ACH Fee Ind

Indicates that the ACH fee should be applied or not. Depending
on the status of check box, the ACH fee is applied based follow-
ing conditions

- When the check box is selected and the fee amount is ZERO,
system will not apply the ACH fee.

- When the check box is selected and the fee amount is BLANK,
system will apply the ACH fee from Contract setup.

- When the check box is selected and the fee amount is specified,
system will apply the specified amount and overrides the ACH fee
amount mentioned in Contract Setup.

- When the check box is not selected, system will apply the ACH
fee amount mentioned in Contract Setup.

Promotion Details

If applicable, enter information regarding any promotion associ-

ated with the application in the Promotion section

Promotion Select the promotion.

Type View the promotion type.
Dlg Days View the delinquency days.
Period Type View the period type.
Period View the promotion period.

Tolerance Amt

View the tolerance amount (displays only).

Index

View the promotion index (displays only).

Index Rate

View the promotion index rate (displays only).

Promotion Margin
Rate

View the promotion margin rate (displays only).

Promotion Rate

View the promotion rate.

Rate Caps and Adj

ustments section

Increase Per Year

View the maximum rate increase allowed in a year.

Increase Max Life-
time

View the maximum rate increase allowed in the life of the Loan.

Increase Floor

View the rate cap (minimum).

Increase Ceiling

View the rate cap (maximum).

Decrease Per
Year

View the maximum rate decrease allowed in a year.
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Field:

Do this:

Decrease Max
Lifetime

View the maximum rate decrease allowed in the life of the Loan.

# of Adjs / Year

View the maximum number rate changes allowed in a year.

# of Adjs / Life

View the maximum number of rate changes allowed in the life of
the Loan.

Advance section

Stage Fund If selected, indicates that multiple disbursements are allowed.
Allowed
Draw End Dt Specify the advance draw end date.

Initial Advance
Max Amt

View the maximum initial advance amount.

Initial Advance
Min Amt

View the minimum initial advance amount.

Advance Max Amt

View the maximum subsequent advance amount.

Advance Min Amt

View the minimum subsequent advance amount.

Late Charge

If selected, late charges are allowed during the disbursement

Allowed period.
Billing Allowed If selected, billing is allowed during the disbursement period.
Billing Method View the billing method during the disbursement period.

Draw Period Rate

Specify the applicable interest rate during the disbursement
period.

PDC section

PDC Ind

If selected, indicates that the customer has opted for PDC.

PDC Security Ind

If selected, indicates that the customer has submitted the PDC as
a security.

Escrow section

Allowed View the escrow allowed indicator. If selected, escrow is allowed
for this account.
Opt Out View the escrow opt out indicator. If selected, escrow is not

allowed for this account.

Post Maturity secti

on

Default Rate

If selected, indicates the default rate is available.

Index

Select the post maturity index.

Post Margin Rate

Specify the past maturity rate.
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Field:

Do this:

Billing section

Pre Bill Days

This is the number of days before the first payment is due that
accounts funded with this Loan instrument will be billed for the
first payment. Thereafter, the accounts will be billed on the same
day every month.

If an account has a first payment date of 10/25/2003 and Pre Bill
Days is 21, then first payment due will be on 10/04/2003, and
then 4th of every month.

Bill Cycle

View the billing cycle.

Payment Caps

Max Pmt Increase
/ Year

The maximum payment that can be increased for the year.

Max Pmt Increase
/ Life

The maximum payment that can be increased in the life of an
application.

Others

Stmt preference
mode

Select the account statement preference mode as either Email or
PHYSICAL from the drop-down list.

By default, the option selected in ‘Product’ setup screen (Setup >
Administration > Products > Contract screen) is displayed.

Recourse Details

Recourse

View the recourse indicator. If selected, it indicates that there is a
recourse associated with the Loan and the following recourse
details can be specified.

Recourse Type

Select the recourse type as either 'Partial' or 'Full' from the drop-
down list.

Recourse Rea-
son

Depending on the type of recourse selected, you can select the
following type of recourse reason from the drop-down list.

For recourse type as 'Partial', system defaults the recourse rea-
son as ‘Partial’.

For recourse type as 'Full', you can select one of the following
options:

- Fraud

- Titles

- Fraud and Titles
- Full

- Full and Titles
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Field:

Do this:

Recourse Max %

Specify the maximum percentage of recourse allowed. Ensure
that the specified amount does not exceed 100% or the amount
defined at Contract.

Note: You can specify the recourse either in percentage or as flat
amount in the below field.

Recourse Amt

If ‘Recourse Max %’ is not specified, you can specify a flat
amount to be allowed for recourse.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Contract (2) Sub Tab

The Contract sub screen records the application’s servicing branch and collector. It also
displays additional information regarding the contract not covered on the Loan screen, such
as the tolerance, delinquencies, due dates, billings, and extensions.

To complete the Contract sub tab

1. Open the Funding

screen and load the application you want to work with.

2. Click the Contract > Contract sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Servicing Branch

Select the servicing branch for the contract.

Collector

Select the collector for the contract.

Funder

If you are acting as a proxy for a Funder, then you can select
the Funder’s name from the adjoining options list. The list
displays all the associated Funders, Funding Supervisors,
and Funding Managers.

However, this is not mandatory and can be used while auc-
tioning an application on behalf of another Funder.

Misc section

Link To Existing Cus-
tomer

Select to link the application to the existing customer.

Anniversary Period

View the anniversary term.

Default Pmt Spread

View the spread.

HMDA section
Lien Status Select the lien status.
HOEPA Select the home owner equity protection act (HOEPA) code.
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Field:

Do this:

Rate Spread

Specify the rate spread. You can calculate this spread from a
tool on the Home Mortgage Disclosure Act (HMDA) website.

Others section

1st Pmt Deduction

View the first payment deduction indicator. If selected, the
first payment deduction is in use.

Days

View the first payment deduction days.

1st Pmt Refund

View the first payment refund indicator. If selected, the first
payment refund is in use.

Days

View the first payment refund days.

Pre-Pmt Penalty

View the prepayment penalty indicator. If selected, a prepay-
ment penalty can be applied.

% of Term for Penalty

View the prepayment penalty percentage of term.

Pay Off Fee

View the payoff fee indicator. If selected, a payoff fee can be
applied to the Loan.

Rebate section

Rebate Method

View the rebate calculation method.

Rebate Term Method

View the rebate term method.

Rebate Min Fin Chg
Method

View the rebate minimum finance charge calculation
method.

Rebate Min Fin Chg
Value

View the minimum finance charge value.

Acquisition Charge
Amt

View the acquisition charge amount.

Tolerance section - This section displays the tolerance details as defined in Setup >
Products > Contract screen.

Refund Allowed

View the refund allowed indicator. If selected, the refund pol-
icies in this section are in use.

Refund Tolerance

View the refund tolerance amount.

Pmt Tolerance Amt

View the payment tolerance amount.

Pmt Tolerance%

View the payment tolerance percentage.

Promise Tolerance
Amt

View the ‘Promise to Pay’ tolerance amount.

Promise Tolerance %

View the ‘Promise to Pay’ tolerance percentage.

Writeoff Tolerance

View the write-off tolerance amount.
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Field:

Do this:

Delinquency section

Late Charge Grace
Days

View the late charge grace days.

Delq Grace Days

View the delinquency grace days.

Delq Category
Method

View the delinquency category method.

Time Bar Years

View the total number of years allowed to contact the
customer starting from the first payment date as defined in
Setup > Products > Contract screen.

Due Date section

Max Due Day Change | View the maximum due days.

Days

Min Due Day View the minimum due day.

Max Due Day View the maximum due day.

Max Due Day Change | View the maximum due day changes allowed (year).
Year

Max Due Day Change | View the maximum due day changes allowed (life).
Life

Extension section

Max Extn Period /
Year

View the maximum extension allowed (year).

Max Extn Period / Life

View the maximum extension allowed (life).

Max # Extn / Year

View the maximum number of extensions allowed (year).

Max # Extn / Life

View the maximum number of extensions allowed (life).

Minimum # Payments

View the minimum number of payments.

Extension Gap in
Months

View the extension gap in months.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Repayment Sub Tab

The Repayment sub screen records the application’s advance information, repayment
schedule, and skipped repayment months for variable rate Loan.

To complete the Repayment sub tab

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Repayment sub tab.
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3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Repayment section:

Flexible Repay- | If this display only check box is selected, then the flexible repay-

ment Allowed ment functionality is set up and allowed for this application's prod-
uct type.
Type Select the flexible repayment schedule you want to use from the

following: SKIP PERIOD, USER DEFINED, UNDEFINED.

If you select the repayment schedule type of SKIP PERIOD, you
then select the months for which borrower won't make any pay-
ments in the Skip Months section.

If you select the repayment schedule type of USER DEFINED, you
then enter the repayment schedule requested by borrower in the
Schedule section; for example, $300.00 for first 12 months,
$350.00 for next 18 months, and so on.

Note: The borrower may not provide a complete repayment sched-
ule with the contract. Provisions are available with the system to
compute the repayment schedule for remaining periods at a later
time, if borrower provides partial repayment schedule.

Skip Months section

Jan If selected, indicates that repayment is skipped for January.
Feb If selected, indicates that repayment is skipped for February.
Mar If selected, indicates that repayment is skipped for March.
Apr If selected, indicates that repayment is skipped for April.

May If selected, indicates that repayment is skipped for May.

Jun If selected, indicates that repayment is skipped for June.

Jul If selected, indicates that repayment is skipped for July.

Aug If selected, indicates that repayment is skipped for August.
Sep If selected, indicates that repayment is skipped for September.
Oct If selected, indicates that repayment is skipped for October.
Nov If selected, indicates that repayment is skipped for November.
Dec If selected, indicates that repayment is skipped for December.

Extendable Balloon section

Max Term Specify maximum number of payments.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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8.10.3

5. In the Repayment Schedule section, click View.

6. View the following information:

Repayment Schedule section

Note: Complete the Schedule section only if you have entered USER DEFINED in the

Repayment section’s Type field. Click Add to make new entries.

Seq Specify the sequence number of the repayment schedule.

Pmt Amt Specify the repayment amount borrower agreed to pay during the
schedule.

# of Pmts Specify the number of payments borrower agreed to pay for stated
repayment amount during this schedule.

Generated If selected, indicates that the schedule is system generated.

Enabled If selected, indicates that the schedule is enabled.

7. In the Payment Change Schedule section, click View.

8. View the following information:

Payment Change Schedule section

Seq Specify the payment sequence number.
Option Type Select the option type.

Frequency Specify the payment change frequency.
Period Specify the period.

# of Adj Specify the number of adjustments.
Value Specify the adjustment value.

Itemizations Sub Tab

The system lists the distribution of the Loan proceeds on the Itemizations sub screen when
you choose Select Instrument on the Contract link. It lists amounts paid to the borrower
directly, amount paid to the borrower’s account, and amount’s given on the borrower’ behalf
to third parties. Itemizations are categorized according to advances, finance fees, prepaid
fees, producers or escrows. If you have entered itemization amounts during application entry
or underwriting, you will see these values in the Amount or Approved Amt columns.

The Itemizations sub screen offers the option of computing the values for itemization
according to a itemization formula associated with the selected instrument based on system
setup.

If you require any new itemizations, you can add them using the Setup menu Products
command. (For more information, see the Products chapter in the Setup Guide.)

To complete the Itemizations
1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Itemizations sub tab.
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3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Itemization View the itemization.

+/- View whether the itemization is added or subtracted.
Amount View the amount.

Approved Amt | View the approved amount. This is information recorded on the
Underwriting screen.

Discount Rate | Specify the discount rate.

Tax View whether the itemization is taxable (Sales) if box is selected.
Sir View the seller payment.

Itemization View the itemization type.

Formula

[temization View the itemization type.

Type

Prefunding View the prefunding status.

Status

Pmt Dt View the payment date.

Pmt Ref # View the payment reference number.
Comment Specify additional comments, if any.

4. Choose the option button for the type of itemization you want to use: Advance, Financed
Fees, Pre-Paid Fees, Producer or Escrow.

5. In the Amount column, enter the amount corresponding with what is listed in the
Itemization column.

6. If the Itemization Formula field contains an entry other than UNDEFINED, you can
choose Compute to auto-compute the value in the Amount field using a predefined
itemization formula.

Itemization formulas are created on the Product Setup screen’s Origination Fees
screens. (For more information, see the Org. Fees tab section of the Products chapter
in the Setup Guide.)

To ensure you create the correct computed value, choose Compute after entering
values for all base itemizations; that is, values of all such itemizations with an
Itemization Formula of UNDEFINED.

You can also manually enter amounts for auto-computed itemizations.

If you click Initialize, the system sets the values of auto-computed itemizations to 0
(zero).

7. If you choose, use the Comment field to add remarks.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
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8.10.4 Trade-In Sub Tab

If there is any information regarding an itemized trade-in, use the Trade-In sub screen to enter
the details in the system (This sub screen might already contain information supplied during
the underwriting process.)

To complete the Trade-In sub screen

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Trade-In sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Trade In section

Asset Type

Select the asset type.

Asset Sub Type

Select the asset sub-type.

Year Specify the year of the asset.
Make Specify the make of the asset.
Model Specify the model of the asset.

Identification #

Specify the identification number.

Body

Specify the body of the asset.

Description

View the asset description.

Valuations section

Wholesale Amt

Specify the wholesale amount.

Base Retail Amt

Specify the retail amount.

Addons Amt (+)

Specify the add ons amount.

Payoff Amt (-)

Specify the payoff amount.

Total Amt = View the total amount.
Valuation Dt Specify the valuation date.
Source Select the valuation source.

Valuation Supple-
ment

Specify the valuation supplement.

Edition

Specify the valuation edition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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8.10.5

Subvention Sub Tab

With the Subvention sub screen, you can enter the subvention information and calculate the
subvention amount, as well as override the calculated subvention amount. The participant’s
information is automatically populated based on the selected subvention plan.

To use the Subventions sub screen

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Subventions sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

4. A brief description of the fields is given below:

Field:

Do this:

Subvention section:

Plan Select the subvention plan code.
Description View the subvention plan description
Sub Plan Select the sub plan.

Sub Plan Description

Select the subvention sub plan.

Subvention Type

View the subvention type

Subvention Amount

View the subvention amount for the plan.

Include

If selected, indicates that the subvention is included.

5. Click View in the Subvention Details section.

View the following:

Participants section:

Participant

View the participant.

Participant Type

View the participant type

Collection Method

View the collection method.

Rate

View the subvention rate.

Rent Factor

View the subvention rent factor.

Calculation Method

View the subvention calculation method.

Factor

View the factor.

Calculated Amount

View the calculated subvention amount.

Subvention Amount

Specify the subvention amount.

Total Subvention Rate

View the total subvention rate.
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8.10.6

Total Subvention View the total subvention amount.
Amount

Include If selected, indicates that the subvention is included.

6. Click Initialize to reset the subvention amount to zero.
7. Click Calculate to calculate the subvention amount.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

Insurance Sub Tab

If there is any information regarding an itemized insurance amount, enter the details on the
Insurance sub screen. The Insurance sub screen also enables you to calculate the
commission if there is a commission rule defined during Contract setup.

To complete the Insurance sub tab
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Insurance sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Insurance Plan Select the insurance plan associated with the financed insurance
product.

Insurance Type View the insurance type associated with the insurance plan.

Sub Type Select the insurance sub type offered under the insurance plan.

Insurance Com- Specify the insurance company associated with the insurance

pany plan. The system populates the default insurance plan defined

during product setup.

Policy # Specify the insurance policy number.
Effective Dt Specify the insurance effective date.
Term Specify the insurance term.

Expiry Dt Specify the insurance expiry date.

Commission Rule | View the insurance premium amount.

Premium Amt Specify the insurance premium amount.

Commission Amt | View the insurance commission amount.

Phone Specify the insurance company’s primary phone number.
Extn Specify the insurance company’s primary phone extension.
Phone Specify the insurance company’s alternate phone number.
Extn Specify the insurance company’s alternate phone extension.
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Field:

Do this:

Beneficiary section

Primary

Specify the primary beneficiary of the insurance.

Secondary

Specify the secondary beneficiary of the insurance.

Cancellation/Refund section

Cancellation
Refund Allowed

If selected, a refund is allowed. A selected box indicates that the
insurance premium can be rebated to the customer in case of
early payoff.

Grace Days View the number of grace days allowed for cancellation without
charging a cancellation fee.

Calculation View the insurance premium refund/rebate calculation method to

Method be used when insurance is cancelled.

Grace Days Can-
cellation Fee
Allowed

If selected, indicates that cancellation fees during grace is
allowed.

Cancellation Fee

View the amount of the cancellation fee to be charged when the
insurance is cancelled.

4. |If you click the Ca

Iculate button, the system computes the commission based on the

commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the

Policy Information section.

It also appears on the Itemizations sub screen.

You can overwri

te the suggested value if you choose.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

8.10.7 ESC Sub Tab

If there is information

regarding an itemized extended service contract or warranty amount,

enter the details on the ESC sub screen.

To complete the ESC (extended service contracts) sub tab

1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > ESC sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

4. A brief description of the fields is given below:

Field: Do this:

Warranty Information section

Service Con- View the extended service contract type.
tract
Policy # Specify the ESC number.
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Field: Do this:

Effective Date | Specify the ESC effective date.

Term Specify the ESC term.

Expiration Dt Specify the ESC expiry date.

Premium Amt | View the ESC premium amount

Commission View the commission amount.

Amt

Commission View the commission rule.

Rule

Warranty Specify the ESC company’s name.

Company

Comment Specify comment if any.

Phone No Specify the ESC company’s primary phone number.
Extn Specify the ESC company’s primary phone extension.
Phone No Specify the ESC company’s alternate phone number.
Extn Specify the ESC company’s alternate phone extension.

Cancellation/Refund

Allowed Check this box to allow cancellation/refund.

Method Specify the method of cancellation/refund.

5. In the Cancellation/Refund section, view the following information.

— Ifthe Allowed box is selected, a refund is allowed. A selected box indicates that the
ESC premium can be rebated to the customer in case of early payoff.

— The Method field displays the refund method.

6. If you click the Calculate button, the system computes the commission based on the
commission method in the Cancellation/Refund section.

The commission appears in the Commission Rule and Commission Amt fields of the
Warranty Information section.

It also appears on the Itemizations sub screen.
You can overwrite the suggested value if you choose.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

8.10.8 Escrow Sub Tab

If there is escrow information selected on the ltemization sub screen, enter information about
it on the Escrow sub screen. The Escrow sub screen records escrow details regarding
disbursement, insurance, and property tax -- information that is parsed to the Customer
Service screen on the Customer Service (2) master tab, where it is available for maintenance.

This sub tab is available if escrow is allowed for the instrument selected on the Loan screen.
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The Escrow Analysis screen enables you to view and perform the initial escrow analysis. You
can perform multiple analyses; however, the system records only the most recent analysis.

To complete the Escrow sub screen

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Escrow sub tab.

3. The Escrow Information section displays information regarding the escrow recorded on
the Itemization sub screen. In this section, you can perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

View:

Escrow

The escrow itemization code and description.

Escrow Type

The escrow type.

Escrow Sub Type

The escrow sub type.

Advance Amt

tion screen under the escrow.

The amount that's been approved for the Item in the itemiza-

Required Escrow

customer can not opt out of this escrow item.

If selected, indicates that this is mandatory itemization and

Cushion Allowed

If selected, indicates that cushion is allowed.

4. Select the Opt Out box only if you want to ignore this particular escrow.

5. In the Disbursement section, enter the following information:

Field: Do this:

Rule Select disbursement rule.

Yearly Amt Specify yearly disbursement amount.

Account # Specify reference account number for vendor.
Note: If the organizational parameter UIX _HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,
XXXXX1234.

Vendor Specify the vendor name.

Maturity Dt Specify the maturity date, if one exists.

6. If this escrow involves an insurance, use the Insurance section to enter the following
information:
Field: Do this:
Coverage Type Specify the coverage type.

Coverage Term

Specify the coverage term.

Policy #

Specify the policy number.

Coverage Amt

Specify the coverage amount.
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Field:

Do this:

Effective Dt

Specify the effective date.

Expiration Dt

Specify the expiration date.

7. If this escrow involves a tax, use the Tax section to enter the following information:

Field: Do this:
Property Tax Type Specify property tax code.
Comment Specify a comment.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

8.10.9 Compensation Sub Tab

The Compensation (Loan) sub tab records and displays the terms of compensation between
the finance company and the dealer for Loan transactions.

To complete the Compensation (Loan) sub screen

1. Open the Funding screen from the Origination master tab’s Funding bar link and load
the application you want to work with.

2. Click the Contract > Compensation sub tab.

3. Onthe Compensation sub screen’s Compensation section, selectin the Compensation
Plan section the compensation plan you want to use.

4. Click Load.

The system loads the following information on the Compensation sub screen:

Field:

Do this:

Compensation section

Compensation Plan

View the compensation plan.

Disbursement Method View the compensation payment method.

Calculation Method

View the compensation calculation method.

Chargeback section

Paid Calc Method

View the charge back calculation method (early payoff).

Early Payoff %

View the early payoff percentage.

Paid Basis

View the charge back paid basis.

Early Payoff Term

View the early payoff term.

Early Payoff Days

View the charge back early payoff days.

Charge off Calc Method | View the charge back calculation method (charge off).

Charge off %

View the charge back percentage (charge off).
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Field: Do this:

Charge off Basis View the charge back basis (charge off).
Charge off Term View the charge back term (charge off).
Days View the charge back days (charge off).

Calculation section

Spread Formula

View the compensation spread formula.

Buy Rate

Specify the buy rate.

Factor %

View the compensation factor.

Addl| Factor %

View the additional compensation factor.

Max Spread %

View the maximum spread or percent allowed.

Upfront %

View the upfront compensation percentage.

Flat Amt

View the flat amount.

Upfront Compensation
Amt

View the compensation amount paid upfront.

Rem Compensation Amt

View the compensation amount remaining.

Compensation Amt

View the compensation amount.

5. Make any necessary changes in the Buy Rate field.

6. Click Calculate.

The system displays the details and amounts for this compensation plan.

8.10.10 Proceeds Sub Tab

The Proceeds sub screen displays the payment amount due to the dealer, based on the
Compensation and Itemization sub screens. It is a view only sub screen, though you can

record comments.

To use the Proceeds

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Proceeds sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field: Do this:
Itemization View the proceed itemization.
+/- View whether the itemization is added to or subtracted from the

total proceeds.

Amount Specify the amount.
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Field: Do this:

Currency Specify the currency of the proceed.

Comment Specify a comment.

Total Amount View the total amount.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.10.11 Disbursement Sub Tab

The Disbursement sub screen records how the Loan payment is disbursed and records
payments to third parties such as the Department of Motor Vehicles. This sub screen needs
to be completed if there is an itemized disbursement.

To complete the Disbursement sub screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Disbursement sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Disbursement section

Validate Payee Check this box to validate payee.

Description View the disbursement description.

Number Specify the disbursement party’s number.

Payment Mode Select the payment mode.

Name Specify the company name.

Account # Specify the account number.

Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is set to Y, this appears as a masked number; for example,

XXXXX1234.

Amount View the payment amount.

Currency Specify the currency.

ACH Account Specify the account type.

Type

Account # Specify the ACH account number.
Note: If the organizational parameter UIX HIDE RESTRICTED -
DATA is setto Y, this appears as a masked number; for example,
XXXXX1234.

ACH Bank Specify the bank number.
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Field:

Do this:

ACH Routing #

Specify the routing number.

BIC

Select the Business Identifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN

Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Comment

Specify a comment.

Country

Select the country.

Address Line 1

Specify the address line 1.

Address Line 2

Specify the address line 2.

Zip Specify the zip code.
For non US country, you have to enter zip code.
City Specify the city.
State Select the state.
Phone 1 Specify the primary phone number.
Extn Specify the primary phone extension.
Phone 2 Specify the alternate phone number.
Extn Specify the alternate phone extension.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Disbursement tab will display the records only if a third party itemization is maintained
during contract setup.

8.10.12 Fee Sub Tab

The Fee sub screen is a view-only table displaying what fees on the Loan instrument are in
use, based on the contract.

To view the Fee

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > Fee sub tab.
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3. Inthe Fee sub screen, view the following display only information:

Field: Do this:

Fee View the fee type.

Fee Calc Method View the fee calculation method.

Txn Amt From View the minimum transaction amount.

Amount Financed | View the minimum value of amount financed on the contract.

From

Percent View the maximum percentage.
Min Amt View the minimum fee amount.
Max Amt View the maximum fee amount.
Enabled If selected, the fee rule is enabled.

8.10.13 ACH Sub Tab

The ACH sub screen records details about automatic clearing house, if this is a direct deposit
payment account; otherwise, it remains empty. This information is used to receive payments,
primarily when working with the Payments screen.

To complete the ACH
1. Open the Funding screen and load the application you want to work with.
2. On the Funding screen, click the Contract tab, then choose the ACH sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Bank Name Specify the bank name.

Routing # Specify the routing number.

Status Select the required ACH status from the drop down list. By default,

the ACTIVE status is selected.

Default By default, this check box is selected indicating that the current
ACH is the default one. If not, you need to uncheck the same.

Start Dt Specify the ACH start date. By default the first payment date of the
contract is auto populated and can be edited.

End Dt Specify the ACH end date.

Account Type Select the account type.

Account # Specify the account number. Note: If the organizational parameter
UIX HIDE RESTRICTED DATA is set to Y, this appears as a
masked number; for example, XXXXX1234.
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Field: Do this:

BIC Select the Business Identifier Code from the drop-down list. The list
displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is
used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation based
on modulo 97. On save, system automatically validates the IBAN
number length based on country code, characters, white spaces,
and checksum. Validation is also done during posting non-monetary
transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as per
the country code in the user defined table (Setup > Administration >
System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is defined
by default with length of IBAN as 18.

Pmt Day Specify the payment day. By default the payment due day specified
for the contract is auto populated and can be edited.

Pmt Amt Specify the payment amount. By default the payment amount
decided for the contract is auto populated and can be edited.

Note: If the payment amount is specified as ZERO, system will
automatically consider the EMI amount.

Pmt Amt Specify the additional payment (if any). This is the additional amount
Excess over and above the regular EMI. Appropriation of this amount is
based on the ‘Spread’ defined in the contract.

Pmt Freq Select the payment frequency. By default the bill cycle frequency
defined for the contract is auto populated and can be edited.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. If there are more than one ACH banks and an optional End Date, click Add and repeat
steps 3 through 5.

8.10.14 Coupon Sub Tab

The Coupon sub screen enables you to order (or re-order) new coupon books. This sub
screen is only available if the bill type for this application is a coupon payment, not a
statement.

To complete the Coupon
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Coupon sub tab.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.
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A brief description of the fields is given below:

Field: Do this:

Order Select to order coupon book.

Order Dt Specify the coupon book order date.

Ordered By Select the user id of the user who ordered the coupon book.

# of Coupons

Specify the number of coupons.

First Pmt Dt

Specify the first payment date.

Coupon Start-
ing #

Specify the starting number of the coupon book.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.10.15 References Sub Tab

The References link enables you to enter any number of people as a reference on the

application.

To complete the Reference screen (Contract link)

1. Open the Funding screen and load the application you want to work with.

2. Click the Contract > References link in this section, you can perform any of the Basic

Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Relationship Select the reference type.

Name Specify the reference name.

Status Select the status of the reference from the drop-down list.
Years Specify the number of years.

Months Specify the number of months.

Comment Specify a comment.

Country Select the country.

Address Line
1

Specify the address line 1.

Address Line
2

Specify the address line 2.

State Select the state.
Zip Select the zip code.

For non US country, you have to enter zip code.
Zip Extn Specify the zip extension.
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Field: Do this:

City Specify the city.

Phone 1 Specify the reference’s primary phone number.

Extn Specify the reference’s primary phone extension.

Permission Check this box if customer has provided permission to contact
to call through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

Phone 2 Specify the reference’s secondary phone number.

Extn Specify the reference’s secondary phone extension.
Permission Check this box if customer has provided permission to contact
to call through the specified phone number.

When selected, system auto validates this option against the phone
number specified. Atleast one phone number should have the per-
mission to call for successful pre-qualification of the application.
Else, an error message is displayed.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
If you want to add another reference, click Add and repeat steps 3 and 4.

8.10.16 Real Estate Sub Tab

The Real Estate Fields screen records additional information regarding manufactured home
Loan.

To complete the Real Estate Fields screen
1. Open the Funding screen and load the application you want to work with.
2. Click the Contract > Real Estate.

3. In this section, you can perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Note Transmittal Number Specify the note transmittal number.

Deed Transmittal Number Specify the deeding transmittal number.
Cancel/Cashout Transmittal Specify the deeding cancel/cash out transmittal
Number number.

Deed Input Date Specify the deed input date.

Deed Recording Date Specify the deed recording date.

Deeding Book Number Specify the deeding book number.
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Field:

Do this:

ConDeeding Page Number

Specify the condeeding page number.

Mortgage Recording Date

Specify the mortgage recording date.

Mortgage Book Number

Specify the mortgage book number.

Mortgage Page Number

Specify the mortgage page number.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

8.10.17 PDC Sub Tab

The PDC sub screen displays any post dated checks associated with the contract.

To complete the PDC

1.
2.
3.

chapter.

Open the Funding screen and load the application you want to work with.
Click the Contract > PDC sub tab.

In this section, you can perform any of the Basic Operations mentioned in Navigation

A brief description of the fields is given below:

Field: Do this:

PDC Ind If selected, indicates that this account involves a post dated check as
a method of repayment.

PDC Type Select the post dated check type, SECURITY CHECKS or POST
DATED CHECKS FOR PAYMENT.

Account # Specify the account number, on which the cheque is drawn.

Routing # Specify the routing number of the cheque. It is the number printed on
the cheque, also called MICR number (Magnetic Ink Character Rec-
ognition).

Account Specify the type of the account

Type

Bank Name Specify the bank name of the customers cheque

Branch Specify the Branch name of the customers cheque

Name

Docket # Specify the docket number where post dated checks are supposed
to be stored.

Check # Specify the starting cheque number.
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8.1

Field: Do this:

Check Dt Select the check date. In case there are multiple checks being
deposited that have sequential serial numbers, the date of the first
cheque in the series would be entered in the date field. The remain-
ing cheque dates would be anniversary dates based on the fre-
quency set up.

For example, the cheque range could be from 111 to 180. If the date
on the first cheque-111 is October 12, 2003 and the frequency is set
to Monthly, the next cheque would be picked up for processing on
November 12, 2003.

Check Amt Specify the appropriate cheque amount.

No of Specify the total number of checks in the range.

Checks

Billing Cycle | Select the frequency at which the checks are to be sent for collec-
tion.

Comments Specify any remarks for the details.

4. Click Generate.

5. Inthe PDC Table section, select the record you want to work with and enter, view or edit
the following information:

Field: View this:

Select If selected, indicates that this is the current record.

PDC Type The type of post dated check in use.

Account # The account number of the post dated check.

Bank Name The bank name of the post dated check.

Check # The check number of the post dated check.
Status The status of the post dated check.
Check Dt The check date of the post dated check.

Check Amt The check amount of the post dated check.

Account The account type of the post dated check.
Type

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Collateral tab

Having selected and loaded an application, you can view the information about the collateral
of the Loan.

The Collateral link opens screens with information regarding any collateral associated with an
account. Depending on the type of Loan, collateral can be a vehicle, home, or something else,
such as major household appliances. The Collateral link is unavailable if this is an unsecured
Loan.
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A detailed explanation of the fields found on the Collateral link’s screens and sub screens can
be found in the Application Entry chapter.

To verify information about the collateral
1. Open the Funding screen and load the application you want to work with.

2. Click the Collateral link.

Depending on the type of collateral, information about the vehicle, home or other type
of collateral appears.

3. Verify the information regarding the collateral and its sub screens. (This is information that

was recorded during the application entry process or gathered during the credit pull.)

If the collateral is a vehicle, the Collateral link displays information about the vehicle.
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If the collateral is a home, the Collateral link displays information about the home.
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in ¥ NEW VEHICLE HOME SINGLE FAMILY H... OCCUPIED BY OW... E26A119602 UNITED STATES 480 NEPONSE
4 < B
Pl
valuation | Tracking
Valuation Bl view || < Audit
View » Formatw [ Freeze [l Detach o Wrap 50}
Current CUMENTY ot Bage amt U202 VAU AML o ion o Source Currency Edition Supplement \
Wholesale Base Amt +)
iy 19,000.00 19,500.00 0.00 09/05/2015 INVOICE US DOLLAR
< >
Addons Eluew || o audt
View ~ Format~ [ Freeze i Detach o wrap (50
Description Value Amount Loan Currency Amount
[ A THEFT 290.00 290.00

If the collateral is anything other than a vehicle or home, the Collateral link displays
information about the other type of collateral.
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DashBoard
Origination
Origination
Sales Lead
Simple Application Entry
Application Entry
Underwriting
Funding
Application Retrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Origination 5, €] Close.
Search/Task  Underwriting: 0000001533 = Review Requests (Pending: 0) =
Application: 0000001533: SIGG MARK A Edt || 5 vew || o audt
Viewv Fomatv [ 7 Hioench  Jwep @ overideok v Wamingox v
Origination Stage Producer Contact g Duplicate
ot App # Sub Unit Status o Producer Name 1129 Bxisting Customer  URCS Contact
[ 0sf0s/2015 0000001533 REJECTED - AUTO... NEW CA-00003 : ACEH... (818)761-2277 N N
< >
Summary || Applicant  Business || Request | Decision | Bureau | Collateral | Comments || Tracking | Document | Verification | Comespondence | Tooks
Collateral  Seller
Other Collateral dadd | F Edt few || <7 Audit
View~ Fomat~ [ Freese ffiDetach ¢ Wiap B Existing Asset Id ¥ = Load Details
E‘Sﬁ”g Existing Asset Id Primary  Asset Class Asset Type Sub Type Status Year Age Make Model
Wn ¥ ]
N oY NEWVEHICLE  VEHICLE R NOT DEFINED 20150 AUDL A4
< > i
Other Collateral
[ saveand add || B saveand Stay | [ Save and Retum | Ga Retum
Existing Asset__ Body Zp &
g * Registration = UNDEFINED Zip Bxin
* Primary ] B
- ification # i
* Asset Class NEW ASSET [~ ' Gty
Description T
. ~ State [v]
At Type |REUSEHONY GOODS [v] Condition GOGD CONDITIONED [v] et =
" unt v
* Sub Type GENERAL HOUSEHOLD GOODS / E[~]
=Status NOT DEFINED [v] Address - Usaqe Details
*Country UNITED STATES [v] &
Select Make and Model 5 o start 0
Address 2 =
*Year 0 s Base 0
- ddress Line 1 v [
ddress
Viake T *Total 0
Model = Charge Amt 0,00
Valuation  Tracking v

For details on this screen refer Collateral Tab section in Underwriting chapter.
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8.12

8.13

Comments Tab

When using the Underwriting screen, you can add comments to an application at any time in
the underwriting process by using the Comments screen.

Whenever an application is funded by a proxy user, a system generated comment with
timestamp is inserted in the comments tab in the format ‘<User 1> actioned as proxy for
Funder <User2>’. Here, User 1 refers to the logged in user who has acted on behalf of User2,
who is the concerned Funder. The concerned Funder’s name will also be selected in Contract

Tab > 'Funder field.

To add comments to an application

1. Open the Funding screen and load the application you want to work with.

2. Click Comments.

ORACLE"
Financial Services Lending and Leasing

T ———————— )

Ortaination
SearchyTask || Funding || Reve
Appiication
[
ot rop 7

No aata to display.
<

> sarvicing
> Collections
> wep

> Tools
> Setup

Summary || Applicant | mesuest || Decision || Suresu | Cantract || Comments | Tracking | Dacument | Verficstion | Corraspondsnce
comments
G B
View~ Format~ | B rrecze  §ff Detach wa
e 1ype sub iypa Commen
(= REGULAR ~| | LOAN ORIGINATION [~ VAVAIDYA 02/05/2016 12:09:56 AM

For details on this screen refer Comments Tab section in Underwriting chapter.

Tracking Tab

When using the Funding screen, you can add tracking attribute information to an application
at any time in the underwriting process by using the Tracking Attributes screen.

To enter the tracking attributes for an application

1. Open the Funding screen and load the application you want to work with.

2. Click the Tracking tab.

ORACLE"
Financial Services Lending and Leasing

& Welcome, DEMOSUPR ~  Accessbility  *@ Signout

- Glose
»| DashBoard Origination (E3js
Origination Result/Task Funding Search Review Requests (Pending: 0) =
7 Origination "
it Application A Edt | Eview | o audit
Simpie Appication Entry view - Format - | & Frecze fefiDetach B Override ok [] warning ok []
T T T
Applcation Entry [ [ [ Producer
[ |orignation stage | |Existing
| | I |Mumber |
Funding
No data to display.
Application Retrieval e ——— "
Scenario Analysis
Application Documents
Image Maintenance
o Summary Applicant. Request Dedsion Bureau Contract Comments Tracking Document. Verification Correspondence
Producers Tracking Attributes Field Investigation
Vendors .
Tracking Attrubutes
Bl seve andstay | [ seve andRetun | Garewm |
View ~ Format | B Freeze  iff Detach Wrap zh)
_ |subParsmeter  |Parameter [value
o data to display.
4
d

For details on this screen refer Tracking Tab section in Underwriting chapter.
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8.14

8.15

Document tab

The Document Maintenance link allows you to view documents attached to an application in
the form of GIF files, PDF files, DOC files, XLS files, and TXT files and add comments
regarding a selected document.

For more information, see the chapter Document Management in this User Guide.

To view a document attached with an application

1. Open the Funding screen and load the application you want to work with.

2. Click Document.

ORACLE’
Financial Services Lending and Leasing

P — o

ot Close
e Origination 5 =d

Origination Search/Task | Funding | Review Requests (Pending: 0)
Origination
Sales Lead
Simple Applicatiol
Application Entry

Application Z Edit
View v Format~ [y Freeze  ffi Detach Wrap

B view || o Audit

¥ overrideOK _  Waming OK __

Underwriting ot
Funding

Producer Contact
Number

Duplicate

Origination Stage 7
App % Sub Unit Status etk Producer Name Bxisting Customer SRR Contact Sa

No data to display.

>

Image Maintenan

Reports Summary | Applicant || Request | Decision | Bureau | Contract = Comments  Tracking | Document = Verffication | Comrespondence
Froducers

Vendars Checklist  Document

Checklist Zdt | B vew | of agdit

View » Format~ [} Freeze [ Detach Wirap W b Load Checkist 485 Complete
Checklist Type CheckList Comment Complete
No data to display.
! Regular = Document g
Checklist Actions Aede | Elview | o audt
View v Format~ | (B Fresze E4 Detach 5]

Action Comment.
No data to display.

Respanse

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

For details on this screen refer Document Tab section in Underwriting chapter.

Verification Tab

The system can be configured to automatically validate portions of an application when you
attempt to change its status. The results of this data check appear on the Verification link’s
Edit screen as an Error, a Warning or an Override.

If it is an Error, the system will not allow you change the application’s status and approve the
Loan until you fix all the errors.

If itis a Warning, the system enables you to change an application’s status without correcting
the matter. While you should still investigate the problem, Warning messages are of a lesser
importance than Error messages.

Ifitis an Override, the system displays a dialog box informing you that an override is needed;
your responsibility level does not have the authority required to process this step. (Choose
Yes on the dialog box to move the application to the queue of the user with the required
authority.)
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The system can be configured to verify different sets of information; for example, the system
could check one set of data when checking application entries for completeness and another
when approving auto Loan. Each one of these “edit types” has its own set of “edit details.”

Note

The Edit Details section’s errors and warnings are created during the setup process.

To complete the Verification tab
1. Open the Funding screen and load the application you want to work with.

2. In the Edit Type drop-down list, select 'Application Approval Edits' and click on 'Check
Edits' button.

Edit details are displayed in the table below along with the result, expected value, actual
value and the override responsibility. This is based on the product and contract set up
details that is done initially.

For more information, refer to Configuring Lending and Leasing setup guides.

3. Specify all the information associated with the application on the Funding screen.

ORACLE | . . & Welcome, PRAKRRAO v Accessibility o
Financial Services Lending and Leasing

S Origination 5 3§ Clos=

Origination Search/Task | Funding | Review Requests (Pending: 0)
Orgination
Sales Lead

Application Z e | S view || o audit

Simple Applicatiol -
Applicaton Entry Viewy Fomate [ Frezze i Detach Wrap T Override OK__ Waring OK _
Underwriting Origination Stage Producer Contact o Duplicate
e Dt App # Sub Unit Status Code Producer Name Number Busting Customer Application Contact sa

ta to d
hoplication Retriy || Mo data to dispiay. *
Scenario Analysis
Application Docur
Image Maintenan
Reports Summary Applicant ~Request | Decision Bureau Conbract Comments = Tracking Document Verification Correspondence
Producers
Vendors Edits | | Audits || History

Edit Types

View = Fomatw Ep Freeze  {) Detach Wirap W Edit Type [V] 8 check Edits
Date Edit Type
No data to display
“
4
Edit Details
View w Formatw [ Fresze EfiDetach | o Wiap %]

Edit Name Result Expected Value Actual Value Override Responsibility
No data to display.

< >
> Servicing

> Collections
> WFP

> Tools

> Setup

e If there are edits with 'Error' entries, verify and correct the data in the respective tabs
and repeat step 2 until the 'Error' entries are cleared.

e When there are only 'Warnings' left you can choose to change the status of the
application to the next stage in the Origination cycle.

4. When you are finished entering data, on the Funding link bar, click Verification.

For details on this screen refer Verification Tab section in Underwriting chapter.
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8.16

8.17

Correspondence Tab

Ad-hoc correspondence enables you to include information from applications in document
templates you create yourself without manually transferring the data. Ad-hoc documents can
be generated as either Microsoft Word or PDF files.

Ad-hoc correspondence can be viewed on the Correspondence link’s Correspondence
screen when you have opened an account. The screen enables you to generate a new letter

or view a previously generated letter.

To generate an ad hoc correspondence

1. Open the Funding screen and load the application you want to work with.

2. Click Correspondence.

ORACLE’

Financial Services Lending and Leasing

iginatic Close
e Origination E]
Origination Search/Task | Funding || Review Requests (Pending: 0)
Grigination
Sales Lead Application A Edt | Elvew | o audit
Simple Application Entry
Application Entry Vieww Formatw [ Freeze  igffi Detach B Owrideok  WamingOK
Underwriting P Prc
Funding Dt App # Sub Unit Status Jrigination $120¢ producer Name e 2;:,"‘::“; Cor
Appllcotion Recrevel No data to display.
Scenario Analysis < >
‘Application Documents
Image Maintenance
Reports
Producers Summary || Applicant || Request || Decision | Bureau | Contract || Comments | Tracking | Document | Verfication | Correspondence
Vendors
Correspondence | Letiers
Correspondence o add view || o audit
Viewv Fomat~  [B Fresze i} Detach 5]
ID Correspondence Date
o 02/03/2016
‘«
Correspondence 1
Save and Add Save and Stay || [ save and Retun || 3 Return
= Correspondence | [¥] Date 02/03/2016
Documents
View~ Fomat~ [ Fresze Efipetach | o Wrap @
Document Id Document Recipient Eform Sowrcz Source Type Selectac
No data to display.
< >
Document Elements £ it ] v < Aud
View v Format~  [Ep Freeze [} Detach Wrap 51}
> Servicing Element Type Element Content
No data to display.
> Collections
> WEP
Recipient Details add | Edit View | o Audit
> Toals P dad | A ] v u
View v Formatv [ Fresze  fi Detach 0 Wrap W send v
> Setup
Racinient Made Tume FAXTFrail Sent Tndlicator Cammen e

For details on this screen refer Correspondence Tab section in Underwriting chapter.

Escrow Analysis Tab

If escrow is allowed for the selected instrument, the Escrow Analysis link is available on the
Contract drop-down link. This screen enables you to view and perform the initial escrow
analysis. When you are satisfied with the analysis, complete the Approval Dt field in the
Approval section and save your entry.

The escrow payment for the Loan account starts on the 1st date of the Loan payment month.
The disbursement happens on the 10th of the month (as per the disbursement rules). The
escrow analysis lasts for a year (12 months) irrespective of the Loan term.

You can perform multiple analysis; however, the Escrow Analysis screen only records the last
analysis performed. No record of any earlier analysis is currently available.

To complete the Escrow Analysis screen

1. Open the Funding screen and load the application you want to work with.
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2. On the Funding screen, Click Escrow Analysis tab.

%rigination X [¥] Close
Search/Task  Funding: 0000000245 ~ Review Requests (Pending: 0) o
Application: 0000000245: EEVERGREEN SADIE / ROSS E] view | o udt

View= Format~ [ Freeze & Detach Wrap W OverideOk ¥ Waming Ok ¥
4 Prc
- , Origination Stage 2 L Duplicate %
ot App3 Sub Unit Status ok Producer Name: ﬁﬁ' Bistng Cstomer o Contact Sales Agent Branch proi
07/01/2012 0000000245 UNDEFINED APPROVED - FUNDED FUNDED MN-00001 : TN HOUSE (DIR. N [} NLHQ o8
13
Summary ~Applicant = Request = Decision = Contract Collateral Comments Tracking Document | Verification = Correspondence —Escrow Analysis  Tools
Analyzed Escrow Ttems Elvien | o udit
View v Format v 57 Freeze gj' Detach & Wrap GE]
Escrow Disbursement Rule Yearly Amt
COUNTY TAX JANUARY MONTHLY 120000 A
COUNTY TAX JANUARY MONTHLY 120000
COUNTY TAX JANUARY MONTHLY 120000 7
Analyzed Escrow Items
<aReturn
Escrow  COUNTY TAX
Disbursement Rule JANUARY MONTHLY
Vearly At 1,200.00
Escrow Analysis Elvien | o audit
View v Format v EIT Freeze ﬂ' Detach & Wrap Gli}
Date From Dt ToDt Opening Bal (Act)  Opening Bal (Est.) Cushion Type Cushion Value Cushion Amt. Std PmtAmt  Escrow Pmt Amt Spread PmtAmt () Other Pmt Amt (+
12/09/2015 08/01/2012 07/31/2013 0.00 800.20 MONTHS 200 B00.00 4173 500.00 66.68 0.0
b
-

3. Inthe Escrow Analysis section, view or enter the following information:

Field: View:

Escrow The escrow item.

Disbursement Rule The escrow disbursement rule.

Yearly Amt The escrow disbursement yearly amount.

4. Click Analyze.

5. Information on the Analysis Details screen is based on expected cash flow from contract
and escrow disbursement setup. Payments received appear before escrow disbursement
in any given month. Click View in Escrow Analysis section.

6. In the following section, enter, view, or edit the following information:

Field: View:

Parameters section

Date The date.

From Dt The FROM date for the escrow activity.
To Dt The TO date for the escrow activity.

Opening Bal (Act) The opening balance actual amount.

Opening Bal (Est) The opening balance estimated amount.

Calculation: cushion amount + low required balance

Cushion Type The cushion type.
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Field: View:

Cushion Value The cushion value.

Cushion Amt The cushion amount.

Calculation: as per the shortage /cushion Rule maintenance

Results section

Std Pmt Amt The standard payment amount.

Escrow Pmt Amt (+) The escrow payment amount.

Calculation: Yearly Amount/12.

Spread Pmt Amt (+) The spread payment amount.

Calculation: Surplus amount / 12

Other Pmt Amt (+) The other payment amount.

New Pmt Amt = The new payment amount.

Calculation: standard payment amount + escrow payment
amount + spread payment amount + other payment amount

Surplus section

Surplus /<Shortage The surplus shortage amount.

Amt> . .
Calculation: escrow account balance - opening balance

Refund Amt The refund amount.

7. Click View in the Analysis Details section.

8. On the Analysis Details sub screen, view the following information:

Field: View:

Txn Dt The transaction date.

Transaction The escrow transaction.

Vendor The vendor name.

Txn Amt The amount of the transaction.
Balance Amt (Est) The estimated amount of balance.
Balance Amt (Act) The actual amount of balance.

Information on the Analysis Details sub screen is based on expected cash flow from
contract and escrow disbursement setup. Payments received appear before escrow
disbursement in any given month.

9. If you want to re-analyze the escrow analysis, change the escrow information on the
Contract link’s screen and sub screens.
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If you want to approve the escrow analysis, complete the following information fields on
the Approval section:

Field: View:

Approval section

Approval Dt The approval date.

Approved By | The person who approved the Loan.

10. Click Save on the Funding screen.

8.18 Tool Tab

The Tools tab calculates the payment amount, term, interest rate, Loan amount, amortization
schedule and allows for the printing of a report.

For detailed information on using the tools, refer “Tools” chapter in the document.
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9.1

9.1.1

9.1.11

9. Tools

Depending on the type of product you are working with during origination, the Tools screens
enable you to calculate Loan and Vehicle value details.

Tools in the main menu are standalone and information calculated using them can only be
viewed. They cannot be copied to the application / contract.

Whereas, Tools that appear as a sub-tab in Underwriting and Funding Tabs, allows you to

import the contract values, do necessary calculations and copy the calculated values to the
respective Contract / Decision tabs.

Loan Calculator

The Loan Calculator screen facilitates you to calculate various parameters. You can also
define flexible repayment options, and generate amortization schedules.

This screen is similar to the Loan Calculator screen opened from Underwriting or Funding
screens; however, calculators opened from Tools master tab are standalone and do not link
calculations or loan information to any specific application.

Parameters

The Parameters section allows you to calculate the payment amount, term, interest rate, loan
amount, and blended rate. You can also generate a quote based on the details specified.

In the Parameters section, you can select the following parameters:

e Calculate Payment

e Calculate Interest Rate
e Calculate Term

e Calculate Loan Amount
e Calculate Blended Rate

Calculating Payments

The Calculate Payment option on Loan Calculator screen calculates the standard payment
based on information you provide, such as the amount financed, terms, interest rate and
finance fee. You can click Initialize in Loan Calculator screen to clear (or ‘refresh’) the Loan
Calculator screen at any time.
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To calculate a loan payment

1. Click Tools > Tools

> Loan Calculator.

ORACLE"

; - : : ; & Welcome, VAVAIDYA ~  Accessibilty =
Financial Services Lending and Leasing

R Loan calculator x (3] Close
> Origination Loan Calculator
> Servicing
> Collections Parameters
> WEP ® Calculate PaymentC Calculate Interest Rate ) Calculate Term ) Calculate Loan Amount O Calculate Blended Rate {SInitialize | [ Calculate (2, Print Quote
Tools

Vehicle Evaluator

No data to display

> Setup

= Prepaid Fees 0,00

= Financed Fees 0.00

* Balloon Pmt Amt. 0.00

Interest Amt 0.00

Tools Loan Details Finance Charge 0.00
Loan Calculator Total of Pmis 0.00
Lease Calculator * Product Category STANDARD [~ Final Pmt Amt 0.00

* Contract Dt 02/01/2016 (B
=First Pt Dt 03/01/2015
= Loan Term 0

Maturity Dt 02/01/2016
Amt Financed | 0.00

Calculator Options

* Biling Cycle MONTHLY
*Balloon Method N PMTS
= Accrual Base Method ACTUAL/ACTUAL
* Time Counting Method ACTUAL DAYS
Loan Amt 0,00 = Instaliment Method EQUATED PAYMENTS
*Bill Method LEVEL

Calendar Method GREGORIAN

Payment/Finance Charge

HEHEEREERE

Accrual Start Dt Basis EF

Pmt Amt 0.00 Accrual Start Days 0

Repayment Options
Flexible Repayment Allowed [ ] Skip Months
Type UNDEFINED son 1 Feb B Mar B Apr
Extendable Baloon may B 200 B 3l B g
Max term ] Sep oct Nov Dec
Amortization Schedule
View v Formatw B Freezz B Detach Wrap W % amortze B print Report
Seq Pmt Dt Pmt Amt Principal Amt Interest Amt

Calendar Days 0

Rate

=Rate 0.0000
APR 0.0000

First Period

Interest 0.0000

Balance Amt

2. Click Initialize and maintain the following fields.

Field:

Do this:

Loan Details Section

Product Category

Select the category as Standard for conventional loan product and

Islamic for the Islamic loan product.

Contract Dt

Specify the contract date. The system displays current date as the

default value.

First Pmt Dt

Specify the first payment date. The system displays the date one

month from today as default value.

Loan Term

Specify the number of payments.

Maturity Dt

System automatically displays the maturity date based on the val-
ues entered for first payment date, term and billing cycle (i.e.
Maturity Date = First Payment Date + Term (based on billing

cycle).

Amt Financed

Specify the amount financed.

Pre Paid Fees

Specify the prepaid fees, if any exist.

Financed Fees

Specify the financed fees, if any exist.

Loan Amt

View the estimated loan amount: amount financed plus the pre-

paid fees.

Balloon Pmt Amt

Specify the balloon payment amount, if any exist.
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Field:

Do this:

Payment/Finance Charge

Pmt Amt

View the payment amount.

Interest Amt

View the profit amount.

Finance Charge

View the finance charged.

Total of Pmts

View the payment amount.

Final Pmt Amount

View the final payment amount.

Calculator Options

Billing Cycle

Select the payment frequency.

Balloon Method

Select the balloon method.

Accrual Base
Method

Select the accrual base.

Time Counting
Method

Select the time counting method.

Installment Method

Select the installment method: EQUAL PAYMENTS or FINAL
PAYMENT DIFFERS. For more information, see the Installment
method section in this chapter.

Bill Method Select the billing method as either LEVEL, PERCENTAGE OF
PRINCIPAL PLUS INTEREST, INTEREST ONLY, FIXED PRINCI-
PAL PLUS INTEREST, PERCENTAGE OF OUTSTANDING BAL-
ANCE.

Calendar Method Select the calendar method as ‘Hijri’ or ‘Gregorian’ for this loan

contract. This field will be enabled only if the product category is
selected as Islamic.

Accrual Start Dt
Basis

Select to define the start date from when the interest accrual is to
be calculated for this loan instrument. If Effective Date is
selected, then the interest is calculated from Contract date and if
Payment Date is selected then the interest is calculated on basis
of (first payment date minus one billing cycle).

This field will be enabled only if the product category is selected
as Islamic.

Accrual Start Days

Select the actual date from when to start interest accrual

for loans is to be calculated. This field will be enabled only if the
product category is selected as Islamic.

Rate
Rate Specify the interest rate.

Note: For Islamic products this field is displayed as ‘Profit Rate’.
APR View the system calculated the Annual Percentage Rate.
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9113

Field: Do this:

First Period section

Calendar Days View the number of calendar days between contract date and the
first payment date. The calendar days will differ based on the cal-
endar method selected.

Interest View the profit accrued for the calendar days.

3. Specify the required information and click Calculate.The system computes the standard
loan payments with the details specified.

Installment Methods

e Equal Payments: If you select Equal Payment option, then the repayment amount will
be equal for all installments including the final installment.

e Final Payment Differs: If you select Final Payment Differs option, then the final
repayment amount may be slightly more or less than the outstanding loan amount due
to precise rounding calculations. The final payment amount will be equal to the
outstanding loan amount.

When completing Frequency fields, note the following:

e Biweekly in the system means ‘once every two weeks’ and not ‘twice a week’.
e Bimonthly in the system means ‘once every two months’ and not ‘twice a month’.

For more information on frequency, see ‘Appendix B: Payment Amount Conversions’ section.

Calculating Interest Rates

The Calculate Interest Rate option back-calculates the interest rate and APR using the
amount financed, standard payment and terms. It also provides the amortization schedule of
the loan.

To calculate an Interest Rate
1. Click Loan Calculator tab.
2. In the Parameters section, select Calculate Interest Rate.

3. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

4. After you specify all the required information click calculate.The system computes the
payment change schedule.
You can perform the following activities when the Interest Rate is calculated:

e Creating an amortized schedule of payments (Applications screen)
e Copying the Interest Rate Calculations to the Decision tab (underwriting)
e Copying the Interest Calculations to the Contract tab (funding)

Calculating Term

The Calculate Term option back-calculates the term and APR using the amount financed and
standard payment. It also provides the amortization schedule of the loan.

To calculate an Interest Rate

1. Click Loan Calculator tab.
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9.1.1.5

2. In the Parameters section, select Calculate Term. The system enables the required
fields based on this selection.

3. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

4. After you specify all the required information click calculate.
The system computes the payment change schedule.
You can perform the following activities when the term is calculated:

e Creating an amortized schedule of payments (Applications screen)
e Copying the term calculations to the Decision link (underwriting)
e Copying the interest calculations to the Contract link (funding)

The system will use this information during the funding process when you select an
instrument.

Calculating Loan Amount

The Calculate Loan Amount option calculates loan affordability of a customer based on
term, payment amount and the rate quoted.

To calculate an Interest Rate,
1. Click Loan Calculator tab.

2. In the Parameters section, select Calculate Loan Amount. The system enables the
required fields based on this selection.

3. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

4. After you specify all the required information click calculate.
The system computes the payment change schedule.
You can perform the following activities when the Interest Rate is calculated:

e Creating an amortized schedule of payments (Applications)
e Copying the loan amount calculations to the Decision link (underwriting)
e Copying the loan amount calculations to the Contract link (funding)

Calculating Blended Rate

The Blended Rate option calculates a combined single rate (Blended Rate) for multiple
amounts each of at different rates. On selecting this option, system displays the ‘Advances’
section to add multiple records to derive the blended rate. It also provides the amortization
schedule of the loan.

To calculate an Blended Rate,
1. Click Loan Calculator tab.

2. In the Parameters section, select Calculate Calculate Blended Rate. The system
enables the Advances section.

3. Click Add and maintain the following details:

Field Do this:
Amt Financed Specify the financed amount.
PrePaid Fees Specify the pre-paid fees.
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Field

Do this:

Financed Fees

Specify the financed fees.

Balloon Pmt Amt

Specify the balloon payment amount.

Rate

Specify the rate.

Payment Amt

The system displays the calculated payment amount
on clicking ‘Calculate’ button.

Interest Amt

The system displays the calculated interest amount
on clicking ‘Calculate’ button.

Action

Click add button to add next contract details.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Specify the required information. (Refer the section Calculating Loan Payment in this
chapter for more information.)

6. After you specify all the required information click calculate.
The system computes the blended rate of contracts.

You can perform the following activities when the Blended Rate is calculated:

e Creating an amortized schedule of payments (Applications)

e Copying the loan amount calculations to the Decision link (underwriting)

e Copying the loan amount calculations to the Contract link (funding)

Repayment Options

If the calculation involves flexible repayment options, you can include the same through the

following options:

Option

Description

Flexible Repay-
ment Allowed

Select the check box to include a flexible repayment schedule in cal-
culation. On selection, the following sections are enabled.

e REPAYMENT SCHEDULE

e PAYMENT CHANGE SCHEDULE

e RATE SCHEDULE

Based on the selection of repayment type in the subsequent field, any

or all of the above sections are enabled to define the required flexible
repayment schedules.

Type

Select any of the following repayment type that you want to use from
the drop-down list.

e UNDEFINED

e SKIP PERIOD

e USER DEFINED

e GRADUATED PAYMENT
e EXTENDABLE BALLOON

1. Depending on the repayment type selected, complete the following sections:
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e If you have selected the type as UNDEFINED (default), you can specify only the ‘Rate

Schedule’ as explained in step 2.

e If you have selected the type as SKIP PERIOD, select the months which you want to

exclude in repayment schedule by selecting the adjacent check box.

e If you have selected the type as USER DEFINED, click Add in ‘Repayment Schedule’

section and specify the following information:

Field: Do this:
Seq Specify the sequence number of the repayment schedule.
Pmt Amt Specify the repayment amount borrower agreed to pay during

the schedule.

# of Payments

Specify the number of payments borrower agreed to pay for
stated repayment amount during this schedule.

Generated

View if the repayment schedule is generated.

e If you have selected the type as GRADUATED PAYMENT, click Add in ‘Payment

Change Schedule’ section and specify the following information:

Field: Do this:

Seq Specify the sequence number in which the repayment is calcu-
lated.It prioritizes the calculation.

Option Type Select the repayment option type:
STEP UP, STEP DOWN and BULLET.

Frequency Select the frequency of payment. The default value is TERM.

Period Specify the loan period.

# of Adj. Specify the number of times the STEP UP, STEP DOWN or
BULLET needs to happen.

Value Specify the value. For STEP DOWN, value ranges from 1 to 99.

For STEP UP, value ranges from 1 to 990. For BULLET, value
ranges from 1 to 99999999.

e If you have selected the type as EXTENDABLE BALLOON, specify the maximum

number of terms in the ‘Extendable Baloon’ section.

2. If the calculation includes a promotion, complete the Rate Schedule section. Click Add

and specify the following information:

Field: Do this:

Seq Specify the sequence number of the rate schedule.

Rate Specify the repayment amount borrower agreed to pay during
the schedule.

Start Dt Specify the date on which the borrower agreed to make the

first payment.

3. After you specify all the required information click calculate. The system computes the

payment change schedule and populates the Repayment Schedule section.
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9.14

When you fund the loan application, the system copies repayment schedule information
to the loan account on Customer Service screen where it appears in the Repayment
Schedule section.

Amortization Schedule

You can use the calculated payment data to derive the Amortization Schedule. Click
Amortize in the ‘Amortization Schedule’ section. The system generates an amortized
schedule with the calculated data with the following headers:

Field: View this:

Seq Payment number.

Pmt Dt Payment date.

Pmt Amt Payment amount.

Principal Component of the payment amount allocated towards reduction
Amt of the principal balance.

Interest Amt | Component of the payment amount allocated towards reduction
of the interest balance.

Balance Remaining principal balance.
Amt

You can click Print Report to extract a PDF version of the generated amortized schedule.

Printing a Quote

You can generate a summarised report using the calculated loan details in the format of quote
with charges, payment structure, financed amount allocation, and amortization scheduled.

In the Loan Calculator screen, click Print Quote. The system generates a PDF document to
the default downloads repository consisting of the following information in the respective
headers:

Loan Details

The Loan Details section consists of Contract Start Date, Contract End Date, First Payment
Date, Total Loan Term, Rate, and Total Loan Amount (Inc. Fee).

Payment/Finance Charge

The Payment/Finance Charge section consists of Total Interest Amount, Finance Charge,
Total Of Payments, and Balloon Payment Amount.

Payment Structure

The Payment Structure section consists of details based on the number of payments, billing
cycle followed and the payment amount. The payment structure repeats based on the flexible
repayment options defined.

Financed Amount Allocation
The Financed Amount Allocation section consists of total amount that can be financed at the

specified rate. If there are multiple records included to derive blended rate, then the Financed
Amount Allocation varies based on the total number records.
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Amortization Schedule

The Amortization Schedule section consists of records in tabular format with the following
details:

e PmtNo.

e Payment Date

e Scheduled Payment
e Principal

e Interest

e Ending Balance

Copy Calculation to Contract or Decision tab

Depending on the screen from where you have accessed the tools sub tab, you can copy the
calculated values to either Contract or Decision tab. If you are in Underwriting stage, you can
copy the values to decision tab. Similarly during Funding stage, you can copy the values to
contract tab.

1. Click Initialize and reset the calculator.

2. Click Import values. System displays basic values entered in previous tabs.

3. Select one of the following option “Calculate Payment / Interest Rate / Term / Loan
Amount” and click Calculate. System displays calculated values based on selection.

Click Copy to Contract/Decision. The calculated details are copied to the respective fields in
Contract/Decision tab.

Vehicle Evaluator

The Vehicle Evaluator screen allows you to calculate the value of a vehicle. You can use the
Vehicle Evaluator screen to calculate the value of either a vehicle you are entering as the new
collateral or vehicle currently listed as the application’s collateral.

The Vehicle Evaluator screen can be cleared or refreshed at any time by clicking Clear.

To calculate a vehicle value

1. On the Oracle Financial Services Lending and Leasing home screen, click Tools > Tools
> Vehicle Evaluator

oORACLE
Financial Services Lending and Leasing

ashBoard

valuation

> setup < >
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2. In the Vehicle Evaluator section, use Asset field to select the vehicle you want to
appraise. This can be either NEW COLLATERAL or a vehicle entered on the Collateral
link.

3. Inthe Vehicle Evaluator section, click Initialize. The system completes Valuation
Source, Period and Region fields.

4. If needed, you can change the default contents of the fields in Vehicle Evaluator.

If you selected a vehicle from the Collateral link in step 3, information from the Vehicle
section appears in Vehicle section in Vehicle Evaluator screen.

6. If you selected NEW COLLATERAL in step 3, complete the Identification #
-or-
Complete the fields in the Vehicle section.

7. Inthe Vehicle Evaluator section, click Evaluate.

— If you have specified the vehicle identification number, system searches for the
value of that vehicle with that identification number, then completes Vehicle
Evaluator screen with information about that exact match.

— If you completed the Vehicle section, system searches for the value of a vehicle
matching that description.

— In either case, the system displays following information about the vehicle:
— In the Vehicle section, view the returned information:

Field: View this:

Year The asset year.

Make The asset make.

Model The asset model.

Body The asset body style.

Usage The asset usage or current mileage.
Weight The asset weight.

In the Valuation (Total Value) block, view the returned information:

Field: View this:

MSRP Manufacturer’s suggested retail price value of the asset.
Total Total value of the asset.

Usage Adjusted usage value of the asset.

In the Base and Attribute Value section, view the returned information:

Field: View this:

Base Retail Total retail value of the asset.

Base Loan Base loan value of the asset.

Base Trade Base trade value of the asset.
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Field: View this:

Retail Retail value of the asset attributes.

Loan Loan value of the asset attributes.

Trade Base trade value of the asset attributes.
Attributes Tab
In the Attributes section, view the following information:

Field: View this:

Attribute Asset attribute.

Retail Attribute retail value.

Loan Attribute loan value.

Trade Attribute trade value.

Standard Standard indicator. If selected, indicates that the attribute is a standard.

Package If selected, indicates that the attribute is inclusive.

Incl

Selected If selected, indicates that the attribute is selected.

If you want to re-calculate the values using other data in Total Value and Base and Attribute
Value section, do the following:

e Make the required changes to the desired parameters fields in Vehicle Evaluator and
Vehicle sections.

e Inthe Vehicle Evaluator section, click Recalculate.
The system updates the values in Total Value and Base and Attribute Value sections.

If you choose, use Attributes section to select or clear the Selected box for attributes of the
vehicle. This automatically updates the values in Total Value and Base and Attribute Value
sections. (Note: Attribute amounts within brackets reduce the amount in Totals field in the
Total Value section.)

To copy the calculated value to the Collateral link

You can copy the calculated value to Collateral link only if you have accessed the tools tab
either from Underwriting or Funding Tab. Accessing Tools from the main menu does not
support this option.

1. Complete the following steps in the section To calculate a vehicle value.

2. In the Vehicle Evaluator screen, click Copy to Asset.

The system uses calculations on the Vehicle Evaluator screen to complete Valuation sub
screen on Collateral link. Any pre-existing collateral is no longer the primary collateral.
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10.2

10. Application Retrieval

Introduction

The Oracle Financial Services Lending and Leasing system includes archiving and retrieving
feature that provides you with the capability to archive old data and store it in a different table.

Archiving / Purging

The system batch process runs the purge / archive feature based on the system parameter
setup. The system archives the following items:

e Applications and related data
e General ledger data

e Securitization related data

e Producers

e Producer transactions

e Account statements

e Vendor assignments

e Vendor invoices.

The system purges the following items:

e Job request data
e Userlogins
e Output data dump related data.

In the system, archiving is a two-way process:

1. All the archived data is moved and stored in O tables.

2. The archived data in the O tables is then moved and stored into OO tables.

You may set the “default days” for the archive feature by setting the following system

parameters on the Administration screen. The parameters marked with _O are the items
moved from O to OO tables. The other parameters are the items moved to O tables.

Parameter Default Description
Days

PAP_ARCHIVE_DAYS 999 PURGE DAYS FOR APPLICATIONS
LEVEL 1: PUR_APP_STATUS_CD IS USED
TO DECIDE APPLICATIONS WITH WHAT
STATUS ARE PURGED

PAP_OARCHIVE _DAYS 999 PURGE DAYS FOR APPLICATIONS
LEVEL 2

PGL_ARCHIVE_DAYS 999 PURGE DAYS FOR GL LEVEL 1: NO OF
DAYS AFTER THE GL TXN WAS CRE-
ATED

PGL_OARCHIVE DAYS 999 PURGE DAYS FOR GL LEVEL 2
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Default

Parameter Description
Days

PJR_ PURGE DAYS 999 PURGE DAYS FOR JOB REQUEST LEVEL
1: NO OF DAYS AFTER JOB REQUEST
COMPLETION DATE

POD_PURGE DAYS 999 PURGE DAYS FOR OUTPUT DATA DUMP
LEVEL 1: NO OF DAYS AFTER PROCESS
RUN DATE

PPR_ARCHIVE DAYS 999 PURGE DAYS FOR PRODUCERS LEVEL

1: NO OF DAYS AFTER THE PRODUCER
STATUS IS SET TO ACTIVE AND THERE
EXISTS NO “NOT PURGED” ACCOUNT

WITH THIS PRODUCER NAME.

PPR_OARCHIVE DAYS 999 PURGE DAYS FOR PRODUCERS LEVEL
2:

PPX_ARCHIVE DAYS 999 PURGE DAYS FOR PRODUCER TXNS
LEVEL 1: NO OF DAYS AFTER THE PRO-
DUCER TXN WAS CREATED

PPX OARCHIVE DAYS 999 PURGE DAYS FOR PRODUCER TXNS
LEVEL 2:

PUL PURGE DAYS 999 PURGE DAYS FOR USER LOGINS LEVEL
1: NO OF DAYS AFTER THE LOGIN END
DATE

PVA_ARCHIVE DAYS 999 PURGE DAYS FOR VENDOR ASSIGN-

MENTS LEVEL 1: NO OF DAYS AFTER
THE ASSIGNMENT DATE AND ASSIGN-
MENT CODE IN COMPLETED, VOID,

CLOSE

PVA_OARCHIVE DAYS 999 PURGE DAYS FOR VENDOR ASSIGN-
MENTS LEVEL 2:

PVI_ARCHIVE DAYS 999 PURGE DAYS FOR VENDOR INVOICE

LEVEL 1: NO OF DAYS AFTER THE
ASSIGNMENT DATE AND ASSIGNMENT
CODE IN VOID, CLOSE

PVI_OARCHIVE DAYS 999 PURGE DAYS FOR VENDOR INVOICE
LEVEL 2:

10.3 Retrieving an Archived Application

You can retrieve archived applications using the Application Retrieve screen. You can retrieve
only archived applications.

To retrieve an archived application

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination master tab.

2. Click Application Retrieval link.
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The system opens Application retrieval Search screen.

ORACLE

Financial Services Lending and Leasing

> DashBoard
Origination

Origination |

Sales Lead

¢ Simple Applcation Entry
Application Entry
Underwriting
Funding
Application Refrieval
Scenario Analysis
Application Documents
Image Maintenance
Reports
Producers
Vendors

> Servidng
 Collections
> WEP

» Tools

» Setup

Application Retrieval i,

Search

Search Criteria

View = Format v [ Freeze gliDetach | ol Wrap (5]
Criteria Comparison Operator
APPLICATION # LKE
APPLICATION DT GREATER THAN OR EQUAL
APPLICATION STATUS e
APPLICATION SUE STATUS LKE
UNDERWRITER LIE
PRODUCT LKE
APPLICANT LAST NAME LIE
APPLICANT 5N EQUAL
VN LIKE
YEAR EQUAL
MAKE LKE
MODEL LIE
ASSET TYPE LKE
PRODUCER * LIE
PRODLCER NAME LKE

Archived Application Search Results
EfiDetach Wirap W

App =

View v Formatv [ Freeze 1) Retrieve

Company Branch
Mo data to display.

Product

HHPHOEHORER O E]

[ Close:
& Reset Griteria | ) Search
Value
]
b=l
=

Status Sub Status Producer

5. Select the application you want to work with and click Retrieve.
The system loads the application in the Applications screen.

You are now ready to begin work on the application.

10-3

3. Use the Comparison Operator and Values fields to create the search criteria you want
to use to find an application.
For more information about creating search criteria, see Searching for an Application
chapter of this User Guide.
4. Click Search.
The system locates and displays all the applications that meet your search criteria on
the Results screen.
Applications are sorted by priority and application number.
Field: View this:
Company The company of the application.
Branch The branch of the application.
App# The application number.
Date The date of the application.
Title The title (applicant name) of the application.
Product The product of the application.
Status The status of the application.
Sub Status The sub status of the application.
Producer The producer of the application.
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11. Scenario Analysis

11.1 Introduction

With the Scenario Analysis screen, you can simulate the customer’s Loan request (Loan
amount, rate and create a mock proposal in Loan with your lending policies.

You can use scenario analysis screen to complete the following tasks:
e View an Existing Scenario Analysis
e Generating Scenario Analysis
e Auto Suggest Pricing for the Scenario Analysis
e Creating an Amortized Schedule for the Scenario Analysis
e Creating an Application from the Scenario Analysis
e Generating a quote from the scenario analysis

Note

Depending on the product licensed, you can view either Loan or Lease Calculator details.
If you have licensed both, then you are provided with an option in Scenario Analysis screen
to select the required Product Type.

11.1.1 View an Existing Scenario Analysis

You can view a previously generated scenario analysis by inquiring through the identification
code,

To view an existing scenario analysis

1. Click Origination > Origination > Scenario Analysis. The Scenario Analysis screen is
displayed in the main window.

2. Either specify the identification code of a previously generated scenario analysis in the
Inquiry Id field, or select the identification code from the adjacent drop-down list.

3. Click Show Details.
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11.1.2 Generating Scenario Analysis

To generate a scenario analysis

1. Click Origination > Origination > Scenario Analysis. The Scenario Analysis screen is
displayed in the main window.

ORACLE’

Financial Services Lending and Leasing

DashBoard

Origination
Origination
Sales Lead

Simple Application Entry
Application Entry
Underwriting

Funding

Application Retrieval
Scenario Analysis

Producers
Vendors

> Servicing
> Collections
> WFP

> Tools

> Setup

Scenario Analysis x

Scenario Analysis

Viewi v Format v Freeze  f) Detach Wrap
Company Eranch Inguiry Id
0
<

Scenario Analysis

InquiyId 0
Application #
* First Name
= Last Name
* Phone
Emil
* Company
* Branch

* Product

Loan Calculator | Subvention | Compensation

Parameters

@ Calculate Payment () Calculate Interest Rate (O Calculate Term O Calculate Loan Amount O Calculate Blended Rate

Loan Details

Product Categery [~
= contract Dt 02/04/2016 B
*FistPmtDt 020472016 B

Loan Term 0
Maturity Dt
Amt Financed 0,00
= PrePaid Fees |0.00
* Financed Fees |0.00
Loan Amt 0.00
* Balloon Pt Amt | 0.00

@) Product Type @) Loan(D) Lease InquiryId 0
Last Name

Application # First Name

= Producer Type
* Producer Name

Praducer Contact
mber
Region
Territory
=Requested Amt 0.00

[+
= *Term 0
L *state

= Asset Type

Interest Amt 0.0
Finance Charge 0.00
Total of Pmts 0.00
Final Pmt Amt 0.0

Calculator Options

Billing Cycle |MONTHLY
Balloon Method
Accrual Bass Method
Time Counting Method
Installment Method
Bill Method

Calendar Method

¥ [ Show Details

Phone

[ save and Add

=2}

K[

(<] (<] [<] <] [l [<] [

& Welcome, PRAKRRAD ~  Accessibility [ SONOUNON
[ Close

a* £ & v o Audit

-
= »

Email Product Froducer Typz

>

B saveand stay | B Save and Retum || Ca Retum

Assst Sub Type. [v]
Make | UNDEFINED
Model UNDEFINED

* Promotion NONE [v]
Pricing
*Billing Cyde I~

= Instrument NONE

{25 Initialize ] calculate
Rate
IRR 0.0000

First Period

Calendar Days 0
Profit 0.0000

Click Add and complete the following Parameters:

You can click Initialize to clear (or ‘refresh’) the screen details at any time.

Field

Do this:

Inquiry Id

View the inquiry identification code.

Application #

View the application number.

First Name

Specify the first name of the applicant.

Last Name Specify the last name of the applicant.
Phone Specify the phone number of the applicant.
Email Specify the email address of the applicant.
Company Select the company.

Branch Select the branch.

Product

Select the product.

Producer Type

Select the producer type associated with the product.

Producer Name

Select the producer associated with the product.

Number

Producer Contact

View the producer contact number.

Region

View the region where the producer belongs.
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Field Do this:

Territory View the territory where the producer belongs.
Requested Amt Specify the requested advance amount.

Term Specify the requested term (number of payments).
State Select the state code.

Asset Type Select the asset type.

Asset Sub type Select the asset sub type.

Make Specify the make of the vehicle.

Model Specify the model of the vehicle.

Promotion Select the requested promotion.

Billing Cycle Select the billing cycle schedule.

Instrument Select the instrument.

2. In the Loan Calculator section, you can specify the details of various Parameters,
Repayment Options, and Amortization Schedule.
For detailed field information, refer to Loan Calculator section in Tools Chapter.

3. Afteryou have specified all the required details, click Calculate.The system computes the
standard payments with the details specified.

4. Click Save And Stay or any other required save option. For more details on save options,
refer to ‘Basic Actions’ section in Navigation chapter.

The system auto assigns an identification code to your calculations on the Scenario Analysis
screen.

Auto Suggest Pricing for the Scenario Analysis

The Scenario Analysis screen provides an option to calculate and display the Pricing based
on previously generated scenario analysis details.

1. Inthe Scenario Analysis section, specify the required information to generate scenario
analysis and save the details. (Refer section Generating Scenario Analysis).

2. click Suggest. The system displays the Pricing details.

Creating an Amortized Schedule for the Scenario Analysis

You can create the amortized schedule for the selected scenario analysis, The system
computes the and displays the amortized schedule under Amortization Schedule tab

To create an amortized schedule for the scenario analysis

1. Specify the required information to generate scenario analysis. (Refer section Generating
Scenario Analysis)

2. Click Amortization Schedule tab and then click Amortize.
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11.1.6

11.2

11.3

The system uses the calculated payment data to complete the Amortization Schedule
section and displays the following information:

Field View this:

Seq Payment number.
Pmt Dt Payment date.
Pmt Amt Payment amount.

Principal Amt | Component of the payment amount allocated towards reduction of
the principal balance.

Interest Amt | Component of the payment amount allocated towards reduction of
the interest balance.

Balance Amt | Remaining principal balance.

Creating an Application from the Scenario Analysis

To create an application from the scenario analysis

1. Specify the required information to generate scenario analysis. (Refer section
Generating Scenario Analysis)

2. Click Create App.

Generating a quote from the scenario analysis

You can generate a summarised report using the calculated details in the format of quote.

After you have specified all the required information to generate scenario analysis, (Refer
section Generating Scenario Analysis), click Print Quote.

For detailed information, refer to Printing a Quote section in Tools chapter.

Viewing Information from Scenario Analysis

The system assigns the information on the Scenario Analysis screen an application number.
You can open this application on the Application Entry screen and view information from the
Scenario Analysis screen at the following locations:

e The Application screen

e The Request tab

e The Collateral tab

e Underwriting

In the Underwriting screen, the Decision link’s Pricing and Approved sections display the
details from the Scenario Analysis screen. You can modify the price chosen in the Scenario
Analysis screen and re-price the application. If application has been repriced, the comments
regarding the multiple offers on the Comment screen should be manually updated before
approving the application.

Subvention Sub Tab

In the Subvention sub tab you can review the subvention information from the application
entry and calculate the subvention amount, as well as override the calculated subvention
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amount. The participant’s information is automatically populated based on the selected
subvention plan.

The calculated Subvention details of the application created from Scenario Analysis is
populated to Origination > Request > Subvention tab.

To complete the Subvention sub screen
1. Click Origination > Origination > Scenario Analysis > Subvention sub tab.

2. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Subvention Plan section:

Plan Select the subvention plan.

Description View the subvention plan description.

Sub Plan Code Select the sub plan code from the drop-down list.

Sub Plan Description View the subvention sub plan description.

Subvention Type View the subvention type.

Include Check this box to include this record in calculations on the

Other Details sub section

3. Perform any of the Basic Actions mentioned in Navigation chapter.

11.4 Compensation Sub Tab

The Compensation (Loan) sub tab records and displays the terms of compensation between
the finance company and the dealer for Loan transactions.

Note the following:

e The computations in the Compensation sub tab refers to the 'Requested Amt' in
Scenario Analysis tab.

e The 'Buy Rate' is referred from selected ‘Pricing’ definition in Scenario Analysis section.

e The 'Request Rate' is referred from the ‘Rate from' field of selected 'Pricing' definition in
Scenario analysis section.

The calculated Compensation details of the application created from Scenario Analysis is
populated to Origination > Underwriting >Decision tab.

To complete the Compensation (Loan) sub screen

1. Click Origination > Origination > Scenario Analysis > Compensation sub tab. System
load the compensation plan details.

Note that, the compensation plan will use application information to calculate
compensation.
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The system loads the following information on the Compensation sub screen:

Field:

Do this:

Compensation section

Compensation Plan

View the compensation plan.

Disbursement Method

View the compensation payment method.

Calculation Method

View the compensation calculation method.

Chargeback section

Paid Calc Method

View the charge back calculation method (early payoff).

Paid % View the charge back percentage (early payoff).
Paid Basis View the charge back basis (early payoff).
Paid Term View the charge back term (early payoff).
Paid Days View the charge back days (early payoff).

Chg Off Calc Method

View the charge back calculation method (charge off).

Charge Off% View the charge back percentage (charge off).
Chg Off Basis View the charge back basis (charge off).
Chg off Term View the charge back term (charge off).
Chg off Days View the charge back days (charge off).

Calculation section

Spread Formula

View the compensation spread formula.

Buy Rate View the approved buy rate.
Factor View the compensation factor.
AddI Factor View the additional compensation factor.

Max Spread %

View the maximum spread or percent allowed.

Upfront %

View the upfront compensation percentage.

Flat Amt

View the flat amount.

Upfront Comp Amt

View the compensation amount paid upfront.

Rem Comp Amt

View the compensation amount remaining.

Comp Amt

View the compensation amount.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
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12.2

12. Application Documents

Introduction

The Documents Maintenance screen allow for paperless storage of documents within Oracle
Financial Services Lending and Leasing system. Initially with the applications during the Loan
origination cycle and later with accounts during customer service.

This chapter explains how to use the Application Document screen to:
e View an image
e Search for an image
e Split an image to more than one screen
e Change the status of an image
e Combine two images into a multiple screen image
e Attach an image to an existing application
e Print an image
e Attach documents to applications and then view these documents in a browser.

It also explains how to use the Account Document Tracking screen to attach documents to
accounts and then view these documents in a browser.

Application Document screen

The Application Document screen consists of “Document Maintenance” and “Document
Details” sections.

Credit applications are often sent or faxed to financial institutions from producers (or ‘dealers’)
on behalf of the customer. These credit applications, if received as fax, can be stored in the
system as images. Frequently, more than one application is received in a single fax or a single
application is received across multiple faxes. In such cases, the Application Document
Tracking screen can help you organize and maintain your image collection.

The Application Document screen’s Document Maintenance screen allows you to upload
documents to an application in the form of GIF files, PDF files, DOC files, XLS files, and TXT
files. The Document Maintenance screen’s Document Details section allows you to view
these documents.

Application Document screen

Oracle Financial Services Lending and Leasing supports the online attachment of document
images to an application using the Application Documents screen’s Document Maintenance
section. You can attach the documents from either a client machine or server. A defaultimage
directory can be maintained in the system using the system parameter:

UIX DEFAULT IMAGE PATH.

When you choose List File in the Select Document sub section in the Document
Maintenance section, the system displays all available files in the selected directory in the
Document Details section. You can use the Document Maintenance sub-section and
Action sub-section to attach selected documents to a particular account.
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12.2.1 Attaching a Document to an Application from a server

To attach a document to an Application from a server

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination > Origination > Application Documents link.

ORACLE" ) ) & Weome, VEROUTHU »  pccessbiiy (@]
Financial Services Lending and Leasing

a

i % Close
DashBoard Application Documents D
Origination .
Document Maintenance
Qrigination
Sales Lead Action
Simple Applcation Entry
Appleaton Entry None(©) Copy Document(”) Move Document () Attach Document (Server) (@) Attach Document (Clent)
Underwritng
Funding Select Document
Application Retrieval
Scenario Analysis Fieto upoad | Browse.. | No @ Upl
Applcation Documents
Image Maintenance
Reports Document Details
Producers 1 [ saveand stay | [ Saveand Retum <@ Retun
Vendors -
View= Fomat [ Freeze £ Detach Wrap W
Fie Name Document Type Document Sub Type Applcation # Aftach Status Tracking # Docket # Location Received
No data to display.
¢ I )
Servicing
Collections
WFP
Tools
Setup

2. In the Action sub-section, click Attach Document (Server).

3. Inthe Select Document sub-section, use the default image directory in the Directory
Path field. (The default path is the value for the system parameter
UIX_DEFAULT IMAGE_PATH). -or-

4. Inthe Directory Path field, specify the full path name to the document on the server that
you want to attach to an account.

You can click Reset Path at any time to return to the default image directory.

5. Inthe Select Document section, click List File.
The system displays the files from the entry in the Select Document section Directory
Path in the Document Maintenance record.

6. Inthe Document Details record, select the record you want to work with and click Edit
in the Details column.

7. In the Document Details record, specify, view or edit the following information:

Field: Do this:

File Name View the file name for the document.

Document Type | Select the type for the document.

Document Sub Select the sub type for the document.

Type

Application # Select the application number to attach/copy/move the docu-
ment image.

Attach Attach the document.

Status View the status of the document.
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12.2.2

Field:

Do this:

Tracking # Specify the tracking number of the document.
Docket # Specify the docket number of the document.
Location Specify the location of the document.
Received Dt View the document image received date.

Effective Dt

Specify the effective date of the document.

Expiry Dt

Specify the expiration date of the document.

Comment

Specify any comments regarding the document.

8. Select the Attach check box to attach the file to the account.
9. Click Save And Return.

10. In the Action sub-section, click Post.
The system attaches the document to the application.

You can view the document in a browser by clicking View Document in the Document
Details section.

Attaching a Document to an Application from a Client Machine

To attach a document to an application from a client machine

1.

7.
8.
9.

On the Oracle Financial Services Lending and Leasing Application home screen, click

the Origination master tab.

Click the Application Documents link.

In the Action sub-section, click Attach Document (Client).

In the Select Document section, click Browse in File to upload field.

The system opens a Choose File to Upload dialog box.

In the Choose File to Upload dialog box, locate the document you want to attach to the

account. You can select multiple files by holding the Ctrl or Shift key on your keyboard.

When you have located the document you want to attach to the account in the Open

dialog box’s File name: field, click Open.

The selected files appear in the Select Document sub-section’s File to Upload field.
In the Select Document sub-section, click Upload.

In the Document Details record, select the file uploaded from your server and click Edit.

10. In the Document Details section, enter, view or edit the following information:

Field:

Do this:

File Name

View the file name for the document.

Document Type

Select the type for the document.

Document Sub Type | Select the sub type for the document.

Application #

Select the application number to attach/copy/move the docu-
ment image.
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12.2.3

12.2.4

Field: Do this:

Status View the status of the document.

Comment Specify any comments regarding the document.
Tracking # Specify the tracking number of the document.
Docket # Specify the docket number of the document.
Location Specify the location of the document.

Received Dt Specify the received date of the document.
Effective Dt Specify the effective date of the document.
Expiry Dt Specify the expiration date of the document.
Comments Specify any comments regarding the document.

11. Select the Attach check box to attach the file to the account.
12. Click Save And Return.

13. In the Action sub-section, click Post.
The system attaches the document to the application.

You can view the document in a browser by choosing View Document in the Action section.

Copying a Document

The Action section’s Copy Document command copies the document image from one
application to another application. This command has no impact on the source application or
the source application’s document image.

To copy a document to an application from another application

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the origination master tab.

2. Click the Application Documents link.
In the Action sub-section, click Copy Document.

4. In the Document Maintenance sub-section, use the Application # field to specify the
application with the image you want to copy.

5. In the Document Maintenance sub-section, click Search. The system displays the files
attached to that application in the Document Details section.

6. Inthe Document Details section, select the document you want to copy and click Edit.

7. Inthe Copy/Move App # field, specify the application number of the application to which
you want to copy the document.

8. Click Save And Return.

9. In the Action sub-section, click Post.

Moving a Document

The Action section’s Move Document command moves an existing document image from one
application to another application. This command detaches the document image from the
source application and attach to second application.
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12.2.5

To move a document to an application from another application

1.

8.
9.

On the Oracle Financial Services Lending and Leasing Application home screen, click

the Origination master tab.

Click the Application Documents link.

In the Action sub-section, click Move Document.

In the Document Maintenance sub-section, use the Application # field to specify the

application with the image you want to move.

In the Document Maintenance sub-section, click Search.

The system displays the files attached to that application in the Document Details

sections.

In the Document Details section, select the document you want to move and click Edit.

In the Copy/Move App # field, specify the application number of the application to which

you want to move the document.

Click Save And Return.

In the Action sub-section, click Post.

You can view the documents attached to a particular account by loading the application on
the Customer Service screen, then clicking the Customer Service tab and then clicking on the
Document Tracking sub tab.

Viewing a Document Attached to an Application

To view a document attached to an application

1.
2.

Using above method, load the application with the document you want to view.

In the Application Document section, click Edit.

3. View/edit the following display only information:

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the image.

4.

5.

information:

In the Application Document Details section, select the record you want to work with
and click Edit.

In the Application Document Details section, view the following display only

Field:

View this:

Document Sub
Type

The document sub type.

Version The version number. (version numbers will be incremental by batch
job, first version will start with 1.0).
Page # The page number.

Document File
Type

The document file type.

Status

The status.
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Field: View this:

Tracking # The tracking number of the image.
Docket # The docket number of the image.
Location The location of the of the image.
Received Dt The effective date of the image.
Effective Dt The effective date of the image.
Expiry Dt The expiration date of the image.
Comment Any comments regarding the image.

6. Use the Application Document and Application Document Details sections to select
the document you want to view.

— In multiple paged documents, choose 1 in Page # field on Application Document
Details section to view all the pages in the document.

_Or_
— Choose a specific page number to view only that page.

7. Click View Document.
The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work in
conjunction with your Oracle Financial Services Lending and Leasing system).

8. You can add comments to the Comments field in the Application Document and
Application Document Details sections.

9. Click Save And Return.

12.3 Document Tracking section

You can view the documents attached to a particular application by loading the application on
the Underwriting/Funding screen and then clicking on Document tab.

12.3.1 Locating an Application Document

To locate an account document

1. On the Oracle Financial Services Lending and Leasing Application home screen, click
the Origination master tab.

2. Click the Underwriting/Funding link.
Select and open the application you want to work with.

4. Click Document sub tab.
The Account Document screen appears.

Information about the documents attached to the Application appears in the
Application Documents and Application Document Details sections.

12.3.2 Viewing a Document Attached to an Application

To view a document attached to an account
1. Using the above method, load the account with the document you want to view.

2. In the Application Document section, click Edit.
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3. View/edit the following display only information:

Field:

Do this:

Document Type

View the document type.

Comment

Specify any comments regarding the image.

4. Inthe Application Document Details section, select the record you want to work with

and click Edit.
5. Inthe Application Document Details section, view the following display only

information:

Field: View this:

Document Sub Type The document sub type.

Version The version number (version numbers will be incremental by

batch job, first version will start with 1.0).
Page # The page number.

Document File Type

The document file type.

Status The status.

Tracking # The tracking number of the image.
Docket # The docket number of the image.
Location The location of the of the image.
Received Dt The effective date of the image.
Effective Dt The effective date of the image.
Expiry Dt The expiration date of the image.
Comment Any comments regarding the image.

6. Use the Application Document and Application Document Details section to select

the document you want to view.

— In multiple paged documents, choose 1 in Page # field on Application Document

Details section to view all the pages in the document.

-0r-

— Choose a specific page number to view only that page.

7. Choose View Document.

The system opens a browser to display the actual document (which browser appears
depends on what type of document you selected and what browsers are set up to work
in conjunction with your system).

8. You can add comments to the Comments field in the Application Document and
Application Document Details sections.

9. Click Save And Return.
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13. Image Maintenance

You can view any image in the Oracle Financial Services Lending and Leasing system in the
upper list box of the Image Maintenance link.

To view an image

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination
> Origination > Image Maintenance.

ORACLE 2 Welome, PRAKRRAO +  Accessibility o
Financial Services Lending and Leasing

i Close
e Image Maintenance x ]
Origination Image Maintenance
e opicat Image Header
Simple Applicatiol = . - .
Application Entry View v Format- [ Fresze 5! Detach Wrap B View All Images []
Underwriting Image Id Fax Header Status Company Branch Pages
Funding o data to display.
Application Retrie
Seenario Analysis
Application Docur Pages
Image Maintenan View v Fomate  [E Fresze 5, Detach Wrap W
Report:
e:- 5 Select Page(s)
Producers No data to display.
Vendors
Image
LD
=
i @
Application
View v Formatw  [Ep Fresze &) Detach Wrep 5]
App # Title
No data to display.
Action
[E] preview
“ - ® None
> Servicing ) Split Image
> Collections D) Change Status
S O attach to an Image
i © astach to an Application
> Tools
> Setup

2. The Image Header section displays the images in the Oracle Financial Services Lending
and Leasing system.

3. Inthe Image Header section, select the image you want to work with.
The Image Header section displays the following information for each image:

Branch Branch
Select If selected, indicates that this is the current record.
Image Id The image identification number.

Fax Header The fax header.

Status The image status.

Pages The total number of pages of the image.
Company The company the image came from.
Branch The branch the image came from.

4. If an image is more than one page long, select the page you want to view in the Pages
section and click on the page number to preview the image.

5. Select the required transpose type to change the appearance of the image.
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Splitting an Image

If an image is more than one page long, you can split it into two separate images using the

Split Image button in the Action section. This option button is only available when an image
contains more than one page. Also, you cannot splitimages with a status of “PROCESSED” or
“SKIP.”

To split an image

1. On the Image Maintenance section Image Header section, select the multiple page
image you want to split.
2. In the Action section, select Split Image.
The Pages and New Image Id fields appear in the Action block.
3. Inthe Pages block, select the page where you want to split the image.
The selected pages appear in the Pages field on the Action section.
You can select more than one page; however, you cannot select page # 1.
4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing removes the selected pages and
completes the New Image Id field with the image id of the new image.

The new image does not appear in the Image Header section after you click Post.
However, if you refresh the Image Maintenance screen by closing and opening the
screen, the new image id appears in the Image Header section and the change of page
length in the original image is displayed.

Changing the Status of an Image

The Action section on the Image Maintenance screen allows you to change the status of the

image.

The Image Maintenance screen uses the following statuses:

Status: What is does:

RUSH Moves the image to the front of the queue of images to be pro-
cessed.

NEW Places an image in a queue in the order of which it was received
and allows you to process it as an application.

SKIP Makes the image unavailable for processing until the status is
changed.

BAD Notes that the image is illegible and should be deleted.

PROCESSED | Notes that the information on the image has been entered and is
attached to an application or account.

Only images with a status of Rush or New can be attached to an application or account.

To change the status of an image

1. On the Image Maintenance screen’s Image Header section, select the image whose

status you want to change.

2. Inthe Action section, select Change Status.The Status field appears.

3. In the Status field, select the new status for the image.
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4. In the Action section, click Post.
Oracle Financial Services Lending and Leasing changes the status of the image.

Attaching an Image to an Existing Image

You can combine two images to make one image. This is the reverse of splitting an image.

To combine images

1. On the Image Maintenance screen’s Image Header section, select the image to which
you want to attach an existing image.

2. In the Action section, select Attach to an Image.
The Image Id field appears.

3. Inthe Image Id field, select the image id of the image to which you want to attach the
selected image.

4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing joins the two images: the Id of the image
you selected in step 3 remains on the Image Header section. The image you selected
in step 1 now appear as part of the remaining image.

Attaching an Image to an Existing Credit Application

You can attach one or more images to an existing credit application. To attach specific pages
from a multiple page image to an application or account you have to split the image to isolate
the pages you want to attach. You can then attach those pages and, if necessary, link pages
of the original image back together.

To attach an image to an existing application image

1. On the Image Maintenance screen’s Image Header section, select the image you want
to attach to an existing application.

2. Inthe Action section, select Attach to an Application. The App# field appears.

3. Inthe App # field, select the application number of the application to which you want to
attach the image.

4. In the Action section, click Post.

Oracle Financial Services Lending and Leasing attaches the image to the application.
You can view the image in the Image (8) master tab on the Underwriting and Funding
forms.

Printing an Image

The Print Image button sends the selected image to a predefined printer.
To print an image

1. On the Image Maintenance screen’s Image Header section, select the image you want
to print.

2. In the Action section, click Print Image.
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14. Oracle Financial Services Lending and Leasing

Reports

During the day, or at the end of day, you may want to retrieve information on any of the several
operations that were performed during the day in your financial institution. You can generate
this information in the form of reports in Oracle Financial Services Lending and Leasing. You
can specify the values in the Report Parameters section and generate a report using that

information.

Navigation to Reports

On the Oracle Financial Services Lending and Leasing home page, click Origination >
Origination > Reports.

ORACLE
Financial Services Lending and Leasing

DashBoard

Origination

»> Servicing
> Collections
> WFP

> Tools

> Setup

Reports x

Reports
View v Format v

Description
ACCOUNT PAYABLE(ORIGINATION)
COLLATERAL TRACKING LOG
FUNDED CONTRACTS LEASE
FUNDED CONTRACTS LINE

=4

Report Parameters

Miew ~ Format -
Description
FROM MM/DG/YYYY
TO MM/DD/YYYY
REPORT FORMAT

g

=4

PDF

Freeze

! Detach

un Report

Module
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION
ORIGINATION v
ORIGINATION

14.1 Number of Credit Applications Entered by User

This application entry report lists the amount of credit applications entered by user.

Parameters:

e Company/Branch

e User Name
e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format
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Example of the Number of Credit Applications Entered by User report

Report: Number of Credit Applications Entered

Date: 10/14/2013 10:16 AM

NLO2
NLR1

ORACLE"

Financial Services Lending and Leasing

Entered By

Date Entered

# of Applications

ARNATH 07/09/2013 2

Total: 2

Branch Total: 2

Company Total: 2
uUso01
USHQ

Entered By Date Entered # of Applications

ARNATH 05/16/2013 1

ARNATH 06/25/2013 2

ARNATH 06/26/2013 1

ARNATH 07/03/2013 2

Total: 6

Branch Total: 6

Company Total: 3

Grand Total: 8

14.2 Collateral Tracking Log

This servicing report lists collateral tracking details.

Parameters:

e Company/Branch
e Tracking Type
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14.3

14.4

Example of the Collateral Tracking Log report

eral Tracking Log oRACLE"
& 1:17 AM Financial Services Lending and Leasing
NLD2
NLHQ
Type Asset state Focount § Follow Op Start DE Disposition
cmments Date

SEARROW JACK / MARYY M 20120200010081

12/12/20185

2/12/2015 NOT DEFINED

3

SEARROW JACK / MARYY i 201202000100%1

1z/12/z2005

2/12/2016  NOT DEFINED

1
SPARROW JACK / MARYY M 20120200010091  12/12/2015 12/12/2015  WOT DEFINED
1
3
CTustomer State Zccount # Follow Up Start DL Disposition
Date
¢« SMITH JOHN an 20150600011323  12/12/2015 12/13/2015 NOT DEFINED
3
BHANDARI ARBAN PR 20151200012977 01/06/2016 01/06/2016 NWOT DEFINED
SIGG MARK MR 20150900014267 01/30/2016 01/30/2016 NOT DEFINED
RODRIGUEZ MILDRED M 20150900014275 01/30/2016 01/30/2016 NOT DEFINED
RODRIGUEZ ROBINSON Ma 20150900014283  01/30/2016 01/30/2016  ROT DEFINED
RODRICUEZ ROBINSON M 20150900014283  01/30/2016 01/30/2016 WOT DEF:
£ sam R 20160200014338  02/02/2016 02/02/2016 NOT DEF:
®F EF ca 20160200014346 02/02/2016 02/02/2016 NOT DEFINED
§  SMITH JOHN an 20150600011323  12/12/2015 12/12/2015 NWOT DEFPINED
T
= 71

Con 21

24

Credit Bureau Report

This report lists the credit bureau details.
Parameters:

e Credit Request ID
e Credit Request Detail
e Report Format

Example for Credit Bureau report

Report: Credit Bureau Report ORACLE’
Financial Services Lending and Leasing

Date: 9/13/2013 16:37 PM

Account Payable (Origination)

This report lists the payable accounts.
Parameters:

e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format
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Example for Origination Account payable report

(Onigination) ORACLE

Financial Services Lending and Leasing

14.5 Number of Credit Application Images by Status

This report lists the number of credit application images by status.

Parameters:

e Company/Branch
e From MM/DD/YYYY
e To MM/DD/YYYY
e Report Format
Report: Number of Credit Applications Images By Status

Month/Year From: 01/01/1800 To: 01/01/2048
Date: 10/15/2013 12:04 PM

ORACLE’

Financial Services Lending and Leasing

usol

USHQ
Image Status Date Entered # of Applications
BAD 07/23/2013 i1
BAD 07/28/2013 i
BAD 08/23/2013 1
BAD 08/26/2013 1
NEW 07/23/2013 4
NEW 07/26/2013 1
NEW 08/19/2013 1
NEW 08/26/2013 3
NEW 09/24/2013 2
PROCESSED 09/24/2013 E
RUSH 08/26/2013 1
RUSH 09/24/2013 9
Total: 26
Branch Total: 26
CompanyTotal : 26
Grand Total: 26
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14.6 Dealer Reserve Report

This report lists the reserve amount balance of producers.
Parameters:

e Company/Branch

e Producer

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Report : Dealer Reserve Report ORACLE" ) )
Date: 2/29/2016 11:27 AM Financial Services Lending and Leasing
uso1l
USHQ
Producer # Producer Name Incr Due To New Loans Adj Due Payoff/ Chgoff adj Due To Cr Adj Due To Dr Reserve Amt
CA-00004 VOLKSWAGEN OF 0.00 0.00 0.00 0.00 0.00
WOODLAND HIL
CR-00005 RUTO JUNGLE 0.00 0.00 0.00 0.00 991.00
GA-00002 ADVANCE 0.00 0.00 0.00 0.00 0.00
LEASING
(MARIETA)
Branch Total: 0.00 0.00 0.00 0.00 991.00
Company Total: 0.00 0.00 0.00 0.00 991.00
Grand Total: 0.00 0.00 0.00 0.00 991.00

14.7 Batch Job Report

This report lists the batch jobs scheduled and status of execution for the selected period.
Parameters:

e From MM/DD/YYYY
e To MM/DD/YYYY
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14.8

14.9

Report Format

Report : Batch Job Report
Date: 2/22/2016 11:53 AM
Job Bet Job Code

SET-AAL ARTDRC_BJ_100_01
SET-AAT TXNACT BJ_100_01
SET-ACR TABACC BJ_100_01
SET-ACR TXNACE_BJ_100_01
SET-ACR TENACR_BJ_100_02
SET-ACR TXNACRE_BJ_100_03
SET-ACR TXNACRE_BJ_100_04
SET-ADT ADTPRC_EJ_100_01
SET-ACE ACAAPP_EJ_100_01
SET-AGE ACCCON_EJ_100_01
SET-AGS AGSSAL BJ_100_01

Job Description
APPLICATION TO
ACCOUNT INTERFACE

ACCOUNT ACTIVATICOH

ILY TRIAL BALANCE
GENERATION

INTEREST ACCRUAL
AND DELINQUENCY
PROCESEING

PREPARE BATCH DATA
FOR INTEREST
ACCRUAL END
DELINQUENCY
PROCESSING

P INTEREST
ACCRUAL PROCESSING

RE-START INTEREST
ACCRUAL

ATE ROWID IN
IT TABLE (RUN
JOB AFTER
EXPORT-IMPORT OF
TRABLES)
APPLICATION AGING
PROCESS

CONTRACT RCING
PROCESS

SRLE LEAD AGING

Start Date
02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

End Date
02/25/2016

02/25/2016

02/25/2016

02/25/2016

0Z/25/2016

0z/25/2016

0z/25/2016

02/25/2016

02/25/2016

02/25/2016

02/25/2016

ORACLE’

Financial

Btatus
COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

COMPLETED

User Report and Access by Responsibility

Services Lending and Leasing
Result

This report lists the users with their name, code, responsibility and active status for the
selected period.

Parameters:

Report Format

Report : User REporthUSER REPORT & ACCESS BY RESPONSIBILITY)

Date: 2/29/2016 11:52 AM

ORACLE'
Financial Services Lending and Leasing

Taer Code TUser Rame Responsibility Active Stact Date End Date
(¥/N}

AJITHA M YES /11/1800 12/31/4000

BATCH EATCH USER YES /11715982 12/31/9959

DEMOCOLL DEMO COLLECTOR COLLECTOR YES /11/1992 12/31/9559

DEMOEUNDER DEMO FUNDER FUNDING SPECIALIST YES /11/1g992 12/31/9559

DEMOSALES DEMOD ALES LEADER YES /1171592 12/31/9559

DEMOSUER DEMO YES /11/15892 12/31/95539

DEMOUNDW DEMO UNDERWRITER T YES 11/1992 12/31/9559

EVENT EATCH USER ONDEF INED YES /11/1592 12/31/9559%

INTERNAL INTERNAL INTERNAL SUPERUSER YES /11/1800 11/11/4000

TAYANTA JAYANTA C SUPERUSER wES /1171800 12/31/4000

NAVEEN REDDY ERUSER vES /11/1800 12/31/4000

SUPERUSER vES /11/1800 12/31/4000

SUPERUSER YES 02/18/2018 12/31/4000

SUPERD. YES 02/18/2016 12/31/4000

TRITAM JENA SUPERUSER YES 11/11/1800 12/13/4000

SHASHANK S YES /11/1800 12/31/4000

vES /11/1800 12/31/4000

YES /12/1B00 12/31/4000

Transactional Access by Responsibility

This report lists the transactional access to users with their Transaction Code, Transaction
Description and access permission.

Parameters:

User Responsibility
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e Report Format

Report : Transactional Access by Responsibility ORACLE’
Date: 3/9/2016 11:54 AM Financial Services Lending and Leasing
}Lesponsibiliiy Code \ Responsibility Description |
COLLECTOR | COLLECTOR |
Transaction Code Transaction Description Allowed

ACCOUNT CLOSE ACCOUNT CLOSE Y

ACCOUNT CLOSE REV REVERSE ACCOUNT CLOSE Y

ACCRUAL START START ACCRUAL Y

ACCRUAL_STOP STOP ACCRUAL Y

ACCRUAL_STOP_REV REVERSE STOP ACCRUAL Y

ACC_ACH_FEE_MAINT ACH FEE MAINTENANCE Y

ACC_ACH_MAINT ACH MAINTENANCE Y

ACC_ACH NEW NEW ACH MAINTENANCE Y

ACC_CASA_PHP_BATCH ONE TIME INCOMING CASA BATCH Y

PAYMENT
ACC_CASA_PHP_REAL ONE TIME INCOMING CASA REAL TIME Y
PAYMENT
ACC_CHANGE_PMT_DEFAULT_SPREA | CHANGE DEFAULT PAYMENT SPREAD Y
D
ACC_COMP_ADJ_MINUS ADJUSTMENT TO COMPENSATION Y
AMOUNT - SUBTRACT

ACC_COMP_ADJ_PLUS ADJUSTMENT TO COMPENSATION Y
AMOUNT - ADD

ACC_CPN_MAINT COUPON BOOK MAINTENANCE Y

ACC_CRB_PMT_RATING_MAINT MAINTAIN CREDIT BUREAU PAYMENT Y

RATING

ACC_ESC_MAINT WARRANTY MAINTENANCE Y

ACC_ESC_PMT_MAINT WARRANTY PAYMENT MAINTENANCE Y

ACC_INS_MAINT INSURANCE MAINTENANCE Y

ACC INS PMT MAINT INSURANCE PAYMENT MAINTENANCE Y

ACC_OFF_1098_REQ_NOT_IND SWITCH 1098 NOT REQUIRED Y
INDICATOR OFF

ACC_ON_1098_REQ_NOT_IND SWITCH 1098 NOT REQUIRED Y
INDICATOR ON

ACC_PDC_CHK VOID VOID OPEN PDC CHECKS Y

14.10 Front End Access by Responsibility

This report lists the front end screen access permissions depending on the user responsibility.
Parameters:

e User Responsibility
e Report Format

Report : Front End Access by Responsibility ORACLE

Date: 3/9/2016 13:02 PM Financial Services Lending and Leasing
[ Responsibility Code [ Responsibility Description |
| coLLECTOR | COLLECTOR |

[Entity: | COLLECTIONS |

Menu / Screen Menu / Screen / Tab / Sub Tab Item
CUSTOMER SERVICE BANKRUPTCY MENU

CUSTOMER SERVICE COLLECTIONS MENU
CUSTOMER SERVICE DEFICIENCY MENU

CUSTOMER SERVICE RESPOSSESSICN MENU

Entity: | COMMON

Menu / Screen Menu / Screen / Tab / Sub Tab Item
REVIEW REQUEST REVIEWREQUEST ADD BUTTON
REVIEW REQUEST REVIEWREQUEST AUDIT BUTTON
REVIEW REQUEST REVIEWREQUEST EDIT BUTTON
REVIEW REQUEST REVIEWREQUEST VIEW BUTTON
CALCULATOR AMORTIZATIONSCH TAB
CALCULATOR CALCULATORLEASE TAB
CALCULATOR CATCULATORLOAN TAB
CALCULATOR FLLSUITE LEASECALCULATOR MENU
CALCULATOR LOANCALCULATOR MENU
CALCULATOR RATESCH TAB
UNDERWRITING FLLSUITE VEHICLEEVALUATOR MENU
USER PRODUCTIVITY DASHBOARDUSERSPRODUCTIVITY MENU

USER PRODUCTT
USER _PRODUCTIVIT
USER PRODUCTIV.

USERPRODUCTIVITYAPPLICATIONENTRY TAB
USERPRODUCTIVITYCOLLECTORUSER TAB
USERPRODUCTIVITYFUNDING TAB

USER PRODUCTIVIT USERPRODUCTIVITYORGQUEUESTATUS TAB
USER PRODUCTIVITY USERPRODUCTIVITYSERCOLQUEUE TAB
USER PRODUCTIVITY USERPRODUCTIVITYUNDERWRITING TAB
PRODUCER PRODUCERCOMMENT TAB
PRODUCER PRODUCERCOMMENT VIEW BUTTON
PRODUCER PRODUCERCOMMENT EDIT BUTTON
PRODUCER PRODUCERCCMMENT AUDIT BUTTON
PRODUCER RCOMMENT ADD BUTTON
PRODUCER COMPENSATIONBALANCE TAB
PRODUCER PRODUCERCOMPENS ONDETAIL VIEW BUTTON
PRODUCER PRODUCERCO] CT AUDIT BUTTON
PRODUCER PRODUCERCONTACT TAB
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14.11 Underwriting Status by Month and Producer Loan

This underwriting report lists application status by month and producer for loans.
Parameters:

e Company/Branch

e Producer

e From MM/DDYYYY
e To MM/DD/YYYY

e Report Format

Example of the Underwriting Status by Month and Producer loan report

Report: Underwriting Status by Month & Producer (LOAN) ORACLE
Date: 10/31/2013 10:31 AM Financial Services Lending and Leasing

Menth/ Year From: 01/1800 To: 01/2048

NLHQ
ALL AMOUNT ARE IN USD
Month Producer Type Producer § & Name Approved conditioned Rejected Total Funded % Tot Apps Funded
% # %
2006-01 DEALER MN-00001 H&R BLOCK 1 100.000% 1 ©0.000% 1 0.000% 1 1 100.000%
Monthly Total 1 100.000% 1__0.000% 0.000% 1 1 100.000%
2006-02 DEALER MN-00001 H&R BLOCK 1 100.000% 1 0.00 2 0.000% 1 1 33.333%
Monthly Total 1 1 o T 0.000% 1
2006-03 DEALER MN_00DD1 HER BLOCK T % 1 0.0 N 0.000% % 1
Monthly Total 1 100.000% 1 0.000% 1 0.000% 1
Branch Total: 1 100.000% 1 0.000% 1 0.000% 1
ch: NLR1
ALL AMOUNT ARE IN USD
Month Producer Type Producer ¥ & Name Approved conditioned Rejected Total Funded % Tot Apps Funded
% # %
2006-02 DEALER IL-00003 SAM LEMAN 0 0.000% 0 0.000% 0 0.000% 0 0 0.000%
CHRYSLER PLYMOUTH MAZDA
0 100.000% 1] 0.000% ] 0.000% a 0 0.000%
2006-03 DEALER IL-00003 S 0 100.000% 0 0.000% o 0.000% 0 0 0.000%
CHRYSLER
Monthly Total o 0 0.000% 0 0.0f 0 0.000%
Branch Total a o 0.000% o a o 0.000%
Company Total: 3 1 0.000% 1 a. 1 42.857%
Crand Total 1 1__ 0.000% 1 a. E 42 . 857%

14.12 Underwriting Status By Month and Underwriter Loan

This underwriting report lists application status by month and underwriter for loans.
Parameters:

e Company/Branch

e Underwriter

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format
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Example of the Underwriting Status By Month and Underwriter Loan report

)y Month & ORACLE’
inancial Services Lending and Leasing
Month Underwriter Name Approved Conditioned Bejected Total Funded % Tot Appe Funded
£ ) # % E3 %
2006-01 VINAY BEATIR T 1o S 1 a00%
Wonthly Total 0.000%
2006 000% 2
1 no0%
Wonthly Tot: z z ©.000%
Z006-03 TEND GUPERUSER T I 1 G008
RLET
ALL AMOUNT RRE IN USD
month Underwriter Name Approved Conditioned Rejected Total Funded % Tot Apps Funded
H L ¥ ® i L]
2006-02 SREERN WARATAN I 1 T.000%
T 1
ot 1
Grand Toral T00.600% 0 o0 T

14.13 Underwriting Status By Month Loan

This underwriting report lists application status by the month for loans.
Parameters:

e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

e Report Format

Example of the Underwriting Status By Month Loan report

Report: underwriting status by month (lean) oRACLe .
Date: 10/31/2013 10:19 AM Financial Services Lending and Leasing
011800 o1/2048

ALL AMOUNT ARE IN USD

nia2
NLHQ
# of Apps Approvals  Conditioned Rejected Funded

14.14 Funded Contracts Loan

This funding report lists applications funded for loans.
Parameters:

e Company/Branch

e From MM/DD/YYYY
e To MM/DD/YYYY

e Producer

e Report Format
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Example of the Funded Contracts Loan report

ORACLE

Report: Funded Contracts (Loan) Financial Services Lending and Leasing
Month / Year From: 03/2004 To: 03
NLo2
L
ALL AMOUNT ARE IN USD
Producer Name Product Collateral Underwriter Application# ContractDt amount Rate Term
LOAN-UN VINAY 0000097055 10/02/2012 10,000.00 13.580% 36
BEATIA
BHATIA VINAY / S LOAN-UN VINAY 0000097057 10/02/2012 10,000.00 13.980% 36
BHATIA
count 2 Total: 20,000.00
Branch 2 Branch Total 20,000.00
Company count: 2 Company Total: 20.000-00
AMOUNT ARE IN USD
Producer ‘Name produckt collateral onderwriter application¥ ‘Contractpt ‘Amount Rate Term
CO-00002 MILE TEST TEST LOAN-VE 2012 TOYOTA VINAY 0000086046 02/08/2013 32,000.00 4.9350% 36
cr COROLLA 4DR BHATIA
1 Total: 32,000.00
FL-00002 VICAR DELIQUENCY TEST LOAN-VE 0 TOYOTA CAMRY DEMO 000D09E066 02/11/2013 10,100.00 1. 950% 12
= 232 UNDERWRITER
1 Total: 10,100.00
2 h Total
2 ¥ Total:
4 Total:

14.15 Pre Funding Contracts Loan

This funding report lists applications verified for loans.
Parameters:

e Company/Branch

e From MM/DD/YYYY

e To MM/DD/YYYY

e Producer
e Report Format

Example of the Pre Funding Contracts Loan report

ORACLE

Financial Services Lending and Leasing

Report: Pre-Funding Contracts (Loan)

Us01
USHQ
ALL AMOUNT ARE IN USD
Producer Name Product Collateral Underwriter Application # Contract Dt Amount Rate Term
CA-00004 UNDEFINED LOAN-VE DEMO 0000001371 0.o0 0.000% 0
VOLKSWAGEN UNDERWEITER
OF
WOODLAND
HIL
Count: 1 T 0.00
Branch Count: 1 Branch T 0.00
Company Count: 1 Company T 0.00
1 rand Total: 0.00
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15. Producer

Oracle Financial Services Lending and Leasing is capable to create and service direct as well
as indirect Loan. Indirect Loan are generated through Producer Entities like Dealerships and
Agents. It is essential to create and maintain such entities to enable incentive tracking and
business development achieved through each entity.

Applications are sent to financial institutions indirectly through producer entities like dealers
or agents on behalf of a customer. Specifying Producer details is mandatory while creating a
application since the system associates a credit application with the producer entity which
sent it, on the Application Entry, Underwriting, and Funding screens. When the credit
application is approved and funded, the system associates the account with the producer
entity.

When the credit application is approved and funded, system associates account with the
producer.

The following three different status are defined for Producer Entities in OFSLL:

e Active: Only if Producer Status is Active, the application sourced through that Producer
Entity can be funded.

e Inactive: If the Producer Status is Inactive, the application sourced through that
Producer Entity cannot be funded.

e Temporary: If the Producer Status is Temporary, the application sourced through that
Producer Entity can only be reviewed. However it cannot be funded.

The producers are paid for their participation, either:

e Up front during funding
-or-
e Up front on a monthly basis
-or-
e When the interest is earned
-or-
e When the payment is received from customer based on the set up compensation plans.
The Producer Setup screen contains pages that enable you to maintain and administer

producer compensation, compensation payments, charge back plans, and chargeback
parameters.

While setting up Producer entities it is also essential to setup the Producer Cycles under
'Setup' in main menu. For more details, refer to Configuring Lending and Leasing guides.
While working with the Producer Setup screen, you will primarily use the following sub tabs:
1. Payment Details

Tracking Attributes

Contracts

Comments

o M 0N

Summary

The Producers screen, completed during setup, can be used to view and maintain producer
details.
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15.1

Producer Details

The Producer details screen allows you to record or edit basic information about the producer.
You can set up dealers or producers for a company and branch. You can also set up a default
underwriter and a default collector for a producer. The system uses this information in the
origination work flow to select a queue.

The producer number, name, contact information, company and branch to which the producer
is associated with, federal tax number, status, and license information can be stored in this
screen.

Navigating to Producer

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Producers.

2. The system displays the Producers setup screen.

ORACLE - s & Welcome, PRAKRRAQ +
Financial Services Lending and Leasing
Close
DashBoard e =
> Origination Producer Details oF Add | 7 Edit S| View || <7 Audit
= View ~ Format~ P Freeze  ff Detach Wrap W o
Senvicing Producer # Old Producer & Name: Company Branch Start Dt End Dt Status Enabled
- . UNDEFINED 02/03/2016 12/31/9993 Y
Customer Servic
r:;:"zﬂ;"“e AK-00001 HELL HELL uso1 UsRL 12/22/2015 12/31/1999 ACTIVE Y "
S - CA-00001 €A-00001 DEMO usol UsHQ 11/08/2012 12/31/9999 ACTVE ¥
s D‘[ clr:' e 5 CA-D0D02 CA-D000Z RANDYS AUTO SA__ USD1 USHQ 01/01/1800 12/31/4000 ACTIVE "
i o ‘1 ~ ca-00003 Ca-00003 ACE HEADQUART... USO1 usHQ 01/01/1800 12/31/4000 ACTIVE Y
e CA-00004 CA-00004 VOLKSWAGEN OF.. USO1 UsHQ 01/01/1500 12/31/4000 ACTIVE ¥
dcane Df“"”‘f“ﬁ - CA-DDD0S CA-DD0DS AUTO JUNGLE Us01 UsHQ 01/01/1800 12/31/4000 ACTIVE ¥
Colteral Mmneliett CA-DD006 CA-00006 SIMI VALLEY CHR_. USO1 USHQ 01/01/1800 12/31/4000 ACTIVE ¥
Reparts CA-00007 PHANINDRA usol usHa 12/12/2010 12/31/9999 ACTIVE Y v
Producers CA-00008 PHANINDRA PHANINDRA1 Uso1 USHQ 12/19/2012 12/31/9939 ACTIVE Y
Vendors < >
Batch Transactions i
Advances .
M— Producer Details
Fees [Hsaveandadd | [ saveandsmy | [ saveand Retum | 3 Retum
Interfaces.
AP Transactions * Producer # UNDEFINED Max Float 99,999
GL Transactions — = Country [~]
CASA Reconciliation - A
Conversion Accounts i *Name T
R — [w] Address Line 1
- [g] Addressine2
ozj032006 B -x & .
123j9000 (B ip Bn fon Type STATEMENT V]
*Contact - " Collection mMONTHLY [v]
i Frequency
Stat >
*Group 53] o= 2l = Refund | NoNE &
Grade v *Phone 1 (000)-000-0000 Disbursement Method
Extn1 *Region v
Type v g [~
= phone 2 = Tenritos v
Status v] 2 L
Exin2
= Sales Agent [v] Rl = License Details
* Undenwriter [~
= Fax 1 | (000)-000-0000 =Valid From )
. i
Funder = Fax Prefic? [+] *Valid To B
> Collections * Collctor [+ Fax2
> WEP =Fed Tax# UNDEFINED .
> Tools Address Details toetomre |0
Amount v
P Payment Details | Compensation | Subvention || Transactions | Holdback/Loss Reserve || Tracking Attributes || Statements | Contacts || Comments | Summary || Title Staty >~

To set up the Producer

1. In the Producer section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Producer # Based on the system setup, either:
Specify the producer number

-or-

The system generates producer number.

Producer will be activated on the next system date (current system
date + 1) and not on the start date.
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Field:

Do this:

Old Producer #

Specify the old producer number.

Name Specify the producer name.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Select the producer start date by clicking on the adjoining Calendar
icon.

End Dt Select the producer end date by clicking on the adjoining Calendar
icon.

Contact Specify the producer contact.

Group Select the producer contact group from the drop-down list.

Grade Select the producer grade as per business processes from the drop-
down list. The list consist of values which are used only for
categorizing at the producer level and can be changed periodically
as per business requirement.

Type* Select the producer type from the drop-down list. The Group and
Type fields help in setting up the pricing schemes on Pricing screen.

Status Select the appropriate status from the drop-down list. The contents
of this field can be linked to edits in Loan origination cycle so that
only applications from Producers whose status is 'Active' can be
funded.

Sales Agent Select the sales agent associated with this producer from the drop-

down list.

Underwriter

Select the default underwriter assigned to this producer from the
drop-down list. Only users with a responsibility for an
UNDERWRITER can be designated as underwriters for producers.

Funder

Select the users with responsibility as Funding Specialist, from the
drop-down list.

Collector

Select the default collector or agent assigned to this producer from
the drop-down list. (This will appear in the Collector field in
Delinquency Information section of Account Details screen on
the Customer Service screen).

Fed Tax #

Specify the federal tax identification number. If the organizational
parameter UIX HIDE RESTRICTED_ DATA is set to Y, this appears
as a masked number; for example, XXXXX1234.

Address section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1

Address Line 2

Specify address line 2
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Field:

Do this:

Zip Select the zip code from the drop-down list.

Zip Extn Specify the extension of the zip code.

City Specify the city.

State Select the state from the drop-down list.

Phone 1 Specify phone number 1.

Exnt 1 Specify phone number 1 extension.

Phone 2 Specify phone number 2.

Extn2 Specify phone number 2 extension.

Fax Prefix1 Select fax prefix number 1 from the drop-down list.
Fax1 Specify fax number 1.

Fax Prefix2 Select fax prefix number 2 from the drop-down list.
Fax2 Specify fax number 2.

E-Mail Specify the producer mail address.

Loss Reserve Specify the loss reserve amount

Amount

Max Float Specify the value of maximum float allowed for the Producer.

A Float represents the application sourced by the producer that is
Funded and awaiting 'Title perfection' from the concerned authorities
for marking lien. If you do not know the exact value but want to
provide a maximum float, then specify the value as 99999.

Remaining Float

System automatically displays the available number of floats by
calculating the remaining float value based on 'Max Float' and Title
perfections under processing.

Enabled

Check this box to enable the product.

Subvention Partici

pation Details

Subvention
Participant

Check this box to maintain the producer as subvention participant

Collection Type

Select the collection type from the drop-down list.

Collection Select the collection frequency from the drop-down list.
Frequency

Refund Select the refund disbursement method from the drop-down list.
Disbursement

Method

Region Select the region of producer from the drop-down list.

Territory Select the territory of producer from the drop-down list.
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Field: Do this:

License Details

Valid From Specify the date from when the producer’s license is valid.

Valid To Specify the date till when the producer’s license is valid.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

Oracle Financial Services Software recommends that you double-check the fax numbers
(especially the 10 digit number) and email addresses you enter on this screen, since the
system uses this information to send its system-generated underwriting decisions.

15.1.1 Payment Details

You can setup ACH as the payment mode for a dealer or producer on Payment Details sub
screen. The Payment Details sub screen stores information regarding the payment mode,
currency and producer’s bank details, such as bank’s name, routing number, account type,
account number, BIC and IBAN. Once the details are updated the same has to be verified and
approved in the payment details section before processing.

The dashboard of Oracle Financial Services Lending and Leasing displays all the producers
whose payment details are either APPROVED or WAITING FOR APPROVAL in the
‘Producers Count By ACH Status’ section. You can click on the respective links to view the
details in ‘Producers’ screen.

To complete the Payment Details
1. Click Origination > Origination > Producers > Payment Details.

2. In the Payment Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Pmt Mode Select the payment mode from the drop-down list.

Bank Specify the ACH bank name.

Start Dt Select ACH start date if payment mode is ACH. You can even
select the date from adjoining Calendar icon.

Routing # Specify the ACH bank routing number.

Account Type Select the ACH bank account type from the drop-down list.

Account # Specify the ACH bank account number.

Currency View the currency of the Producer. System defaults the

currency depending on the Company or Branch selected for
the Producer.

BIC Select the Business Identifier Code from the drop-down list.
The list displays the BIC codes defined in the system.
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Field: Do this:

IBAN Specify the IBAN (International Bank Account Number). IBAN
is used for identifying bank accounts across national borders
with a minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during
posting non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required
as per the country code in the user defined table (Setup >
Administration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement Select the disbursement currency from the drop-down list.
Currency System defaults the currency depending on the Company or
Branch selected for the Producer.

Approval Detail section - When the payment details are approved, system
automatically populates the following fields with the approver details along with the
status as ‘Approved’. However on subsequent update, the details are reset till
further approval and status is changed to ‘Waiting for approval’.

Approved By View the user who has approved the payment details.

Approved Dt View the date and time when the payment details were
approved.

Status View the status of producer payment details.

Perform any of the Basic Actions mentioned in Navigation chapter.

To Approve Payment Details

You can verify and approve the producer payment details defined by another user in the
Producers > Payment Details section. You can either directly select the required record in the
‘Producers’ screen or sort the list of payment details awaiting approval using the Dashboard.

Before you proceed, ensure that you have approval rights assigned to your login. Else,
contact your system administrator.

1. To access the payment details to be approved, do one of the following:
e Click Origination > Origination > Producers.

e Click Dashboard and navigate to ‘Producer’ section. In the ‘Producers Count By ACH
Status’ sub section, click WAITING FOR APPROVAL. The payment details are sorted
accordingly and displayed in ‘Producers’ screen.

2. Inthe Producer Details section, select the required Producer. The payment details
associated with the producer are displayed in the ‘Payment Details’ section.

3. Inthe ‘Payment Details’ section, click Approve Payment Detail.
The payment details are approved and approver information is captured in Approval Detail

section. Also on approval, the Dashboard counters in ‘Producers Count By ACH Status’
section are updated.
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15.1.2

15.1.3

Compensation Plan

The Compensation Plan sub screen displays information related to compensation and
chargeback for the producer. It displays summaries as well as account level information. The
data is gathered from relevant applications and accounts in the system that are approved and
funded.

A brief description of the fields in the Compensation Plan sub screen is given below:

Field: View this:

Account/Application | The account/application number and title

Compensation Plan The compensation plan defined for the producer.

Upfront Amt The Upfront Amount defined for the producer.
Remaining Amt The remaining amount for the producer.
Total Amt The total amount defined for the producer.

1. In the Loss Reserve section, view the loss reserve amount.

You can view additional details of the Compensation Plan, Chargeback Methods, and
Compensation/Chargeback Amounts in the sub screen.

Subvention

The Subvention sub screen displays information related to Subvention Receivables for the
producer. It displays summaries as well as account level information.

In the Subvention Receivables section, you can view the following details. A brief description
of the fields is given below:

Field: View this:

Subvention Participant The status of subvention participant.

Collection Type The collection type defined for the subvention.
Collection Frequency The collection frequency defined for the subvention.

Refund Disbursement Method The Refund Disbursement Method for the

subvention.
Receivable Amt(Open) The outstanding receivable amount for the
subvention.
Receivable Amt(Current) The current receivable amount for the subvention.
Received Amt The received amount for the subvention.
Netted Refund Amt The netted refund amount for the subvention.
Net Receivable Amt The net receivable amount for the subvention.
Payable Refund Amt The payable refund amount for the subvention.
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15.1.4

15.1.5

15.1.6

Transactions

The Transactions sub screen facilitates you to post the following types of transactions based
on the selection in the action block.

e All transactions relating to Payment to / from Producers, Disbursements transactions
from Holdback / Reserve, adjust/add Recourse amount from/to dealer reserve can be
posted by selecting ‘Others’ option in the action block.

e Subvention Receivables / Payments and adjustments can be posted by selecting
‘Subvention’ option in the action block.

In the Transactions sub screen, you can sort the list of transactions to be displayed based on
elapsed days by selecting the ‘View Last’ option (1/2/5/All Days).

Select ‘Others’ or ‘Subvention’ option, click Add and specify the following field information. A
brief description of the fields is given below:

Field: View this:

Effective Dt Select the Effective Date of the transaction from the calendar.
Transaction Select the transaction from the drop down list.

Amount Specify amount for the transaction.

Reference Specify the transaction reference.

Account # Select the account from the drop down list.

Account Title | View the account title information.

Comment Specify additional details of the transaction if any.

Click Post to post the transaction for processing.

Holdback/Loss Reserve

The Holdback/Loss Reserve sub screen displays information related to Proceed Holdback
and Loss Reserve for the producer.

To view the Holdback/Loss Reserve
1. Click Producers > Holdback/Loss Reserve.

2. Inthe Proceed Holdback section, you can view the account and Holdback amount details.

In the Loss Reserve section, you can view Loss Reserve amount details.

Tracking Attributes

The Tracking Attributes sub screen allows you to link information to a producer who is not
tracked in the system, by default, however is part of company’s business practices.

To complete the Tracking Attributes
1. Click Origination > Origination > Producers > Tracking Attributes.

2. In the Tracking section, you can edit the parameter and Value details.
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15.1.7

15.1.8

3. A brief description of the fields is given below:

Field: View this:

Sub-Parameter View the sub-parameter details.

Parameter View the parameter details.

Value Enter the required value for the selected parameter.

4. In the Statements Transactions section, view the following information:

Field: View this:

Effective Dt | The statement transaction date.

Transaction | The statement transaction.

Account The statement account number.

Debit Amt The statement debit amount.

Credit Amt The statement credit amount.

Contacts

The Contacts sub screen allows you to record information regarding contacts associated with
a producer, such as employees at a dealership.

To complete the Contacts
1. Click Origination > Origination > Producers > Contacts sub tab.

2. On the Contacts sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Contact Type Select the producer contact type from the drop-down list.
Name Specify the producer contact name.

Phone Specify producer contact phone number.

Extn Enter phone number extension.

Fax Enter producer contact fax number.

Enabled Check this box to indicate this is a current contact.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Comments

The Comments sub screen allows you to view and enter comments regarding the producer.

To enter a comment on the Comments

1. Click Origination > Origination > Producers > Comments sub tab.
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15.1.9

2. Inthe Comments section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment Enter comment.
Comment By Displays user id.
Comment Dt Displays comment date.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Summary

The display only Summary sub screen allows you to view summary information regarding the
producer.

To view summary on the Summary
1. Click Origination > Origination > Producers > Summary sub tab.

2. In the Summary section, view the following information.

A brief description of the fields is given below:

Field: View this:

Year Month | The year and month.

Total Apps The application total status count.

Approved The application approved status count.

Conditioned | The application conditioned status count.

Rejected The application rejected status count.

Withdrawn The application rejected status count.

Funded The application withdrawn status count.

Amount The application funded status total amount.

15.1.10 Title Status Summary

The Title Status Summary screen displays the various stages of titles of assets for
applications sourced by the producer. The details are available for specific periods like last 1
day, 2 days, 5 days, 7 days and All (entire history) and results are displayed for selected
period with each date as new row.

For example, if user has selected 2 days and the system date is 2nd June 2014, then system
will group statuses in mentioned buckets and displays data for each 'Lien event date'.

To view Title Status Summary on the Summary

1. Click Origination > Origination > Producers > Summary sub tab.
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2. Onthe Title Status Summary screen, perform any of the Basic Operations mentioned in
Navigation chapter.

3. Select the Title Status Summary period as 1 day/2 days/5 days/7 days/All.

A brief description of the fields are given below:

Field: View this:
New Status Displays lien status as 'New'
Perfection Displays lien status as either Sent for Perfection/ Sent for Re-

Processing Status

perfection

Perfected Status

Displays if lien status has 'Perfected Title'

Release
Processing Status

Displays lien status as either Sent for Title Release/Re-sent for
Title Release

Released Status

Displays lien status as either Service Requested/Pending Delete

Hold Release

Displays lien Hold Release status

To be Released

Displays lien status if ‘To be released’

Closed Status

Displays lien status if ‘Deleted’

Exception Status

Displays lien status as either Pending Lien Holder/ Pending DMV

Lien Event Date

Displays lien Event Date attached against each status.
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16.1

16.1.1

16. Vendors

During the life of an account, a financial institution might require the use of specialized
services of a vendor for various purposes; for example, repossessing a vehicle, retaining an
attorney for bankruptcy court proceedings or making field calls. With the system’s Vendors
screen, you can:

e Maintain vendor information

e Maintain services offered by the vendor

e Assign tasks to the vendors and subsequently track and process those tasks
e Charge vendor expenses to customers

e Enter and update invoices raised by the vendors

e Post vendor transactions

e Process vendor payments

Once an invoice has been presented for a service performed by a vendor, you can enter

information on Vendor Management form and create a monetary transaction. You can then
choose if the customer should pay any particular expense or not.

Vendors Screen

The Vendors screen allows you to set up vendor information. You can also use the copy
feature to quickly create new vendors with the existing details. By default it will show current
address but if the vendor receives escrow disbursement at an address which is different from
current business address the information can be entered in Payment Details sub screen. Also,
the Payment Details sub screen allows you to enter number of days prior to the due date by
which payment to vendor must be processed.

Navigating to Vendor Detail Screen

1. On the Oracle Financial Services Lending and Leasing home screen, click Origination >
Origination > Vendors.

2. The system displays the Vendor screen. The details are grouped under four tabs:
e Vendors
e Assignment Allocation
e Work Orders
e Follow-up

e Invoices
Vendors tab

1. Click Origination > Origination > Vendors > Vendors. The details in the screen are
grouped into the following tabs:

e Payment Details
e Vendor Groups
e Tracking Attributes

e Comments
2. In the Origination > Origination > Vendors > Vendors > Vendor Details section, you
can create or edit vendor details. While creating new, you can also use the copy feature

to copy the existing details to new vendor. The copy option in the Vendor Details screen
is controlled by the system defined parameter (UVN_VEN_NBR_SYS_GENERATED).
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Based on the valued defined for the parameter in Setup > Administration > System >
System Parameter screen, you can copy the existing vendor details in the following ways:

e If the value of the parameter is set to ‘Y’ (default), specify a new name in ‘New Vendor
Name’ field and click ‘Create Copy’.

e If the value of the parameter is set to ‘N’, specify a vendor number in ‘New Vendor #
field and click ‘Create Copy’.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE'
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depending on the system parameter defined at setup screen.

System auto generates the vendor number when the following sys-
tem parameter is set to ‘Yes’ in Setup > Administration > System >
System Parameter screen.

- Parameter: UVN_VEN_NBR_SYS_GENERATED
- Description: VENDOR NUMBER IS SYSTEM GENERATED

Channel Select the vendor channel from the drop-down list.

Old Vendor # Displays the old vendor number if exists.

Name Specify the vendor name.

Status Select the vendor status from the drop-down list.

Company Select the vendor portfolio company from the drop-down list.
Branch Select the vendor portfolio branch from the drop-down list.

Start Dt Specify the vendor start date. You can select data even from the

adjacent Calendar icon.

End Dt Specify the vendor end date. You can select data even from the
adjacent Calendar icon.

Contact Person | Specify the vendor contact name.
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Field:

Do this:

Fed Tax # If available, enter the vendor federal tax identification number. If the
organizational parameter UIX HIDE RESTRICTED DATA is set to
Y, this appears as a masked number; for example, XXXXX1234.

Credit Days Specify the credit days for the vendor invoice. This number is used
to check that Invoice Due Date is not more than the credit days from
Invoice Date.

Phone 1 Specify primary phone number.

Extn 1 Specify the primary phone extension.

Phone 2 Specify alternate phone number.

Extn 2 Specify the alternate phone’s extension.

Fax Specify the fax number.

Fax 2 Specify the fax number 2.

Country Select the country code from the drop-down list.

Address # Specify the vendor address.

Address Line 1

Specify address line 1.

Address Line 2

Specify address line 2.

Zip Select the zip code from the drop-down list.
Zip Extn Specify the extension of the Zip code.

City Specify the city.

State Select the state from the drop-down list.
Email Specify the email address.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.1.1 Payment Details

Click Origination > Origination > Vendors > Vendors > Vendor Details > Payment
Details. The Payment Details sub tab allows you to set up automatic clearing house
information for vendors.

On the Payment Details sub tab, perform any of the Basic Operations mentioned in

Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Remittance section

Country

Select the country code from the drop-down list.

Address Line 1

Specify address line 1.

16-3 ORACLE




Field:

Do this:

Address Line 2

Specify address line 2.

Zip Specify zip code from the drop-down list.
Zip Extn Specify extension of the zip code.

City Specify city.

State Select state from the drop-down list.

Pre-Process Days

Specify the remittance pre-process days. This is the number of
days prior to due date by which payment to the vendor must be
processed.

Currency

View the currency attached to vendor.

Payment Details section

Mode Select the mode of payment from the drop-down list.

Bank Specify the ACH bank.

Start Dt View ACH start date.

Routing # Specify the bank routing number.

Account Type Select the account type from the drop-down list.

Account # Specify the account number. If the organizational parameter UIX-
_HIDE RESTRICTED DATA is set to ‘Y’, this appears as a
masked number; for example, XXXXX1234.

BIC Select the Business Identifier Code from the drop-down list. The
list displays the BIC codes defined in the system.

IBAN Specify the IBAN (International Bank Account Number). IBAN is

used for identifying bank accounts across national borders with a
minimal of risk of propagating transcription errors.

Ensure that value entered satisfies the check-digit validation
based on modulo 97. On save, system automatically validates
the IBAN number length based on country code, characters,
white spaces, and checksum. Validation is also done during post-
ing non-monetary transaction (ACH Maintenance).

You can maintain the IBAN length and other details required as
per the country code in the user defined table (Setup > Adminis-
tration > System > User Defined Tables).

Note: IBAN for 'NL' country code (IBAN_FORMAT_NL) is
defined by default with length of IBAN as 18.

Disbursement
Currency

Select the disbursement currency for vendor payment from the
drop-down list. The list displays all the available currencies appli-
cable to the vendor.

Perform any of the Basic Actions mentioned in Navigation chapter.
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16.1.1.2

16.1.1.3

16.1.1.4

Vendor Groups

Click Origination > Origination > Vendors > Vendors > Vendor Details > Vendor Groups.
The Vendors Groups allows you to set up vendor groups.

On the Vendor Groups section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Sort Specify sort sequence.
Group Select the vendor type to which the vendor belongs from drop-down list,

based on services provided by the vendor.

Enabled Check this box to enable the vendor service.

Perform any of the Basic Actions mentioned in Navigation chapter.

Tracking Attributes

Click Origination > Origination > Vendors > Vendors > Vendor Details > Tracking
Attributes. The Tracking Attributes allows you to load tracking attributes and define the
parameter value for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

Comments

Click Origination > Origination > Vendors > Vendors > Vendor Details > Comments. The
Comments sub tab allows you to add comments and also view comments posted through AP

interface.

On the Comments sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Comment View or add the required comment.
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16.1.2

16.1.2.1

Field: Do this:

Comment System automatically selects the logged in user details.
By

Comment System automatically displays the current date.
Dt

Perform any of the Basic Actions mentioned in Navigation chapter.

Assignment Allocation

The Assignment Allocation tab allows you to define criteria for selecting a specific vendor to
execute a work order. A criteria here refers to a combination of a Channel, Work Order Type,
Company and Branch associated to a vendor. If the same combination or criteria is selected
during work order creation, system selects a specific vendor or highest weighted vendor in the
list by default for the work order.

Click Origination > Origination > Vendors > Assighment Allocation. The details are
grouped under two sections:

e Vendor Assignment Criteria
e Vendor Assignment Allocation

Vendor Assignment Criteria

In the Vendor Assignment Criteria section, you can define the criteria used for vendor
selection.

1. In the Origination > Origination > Vendors > Work Order > Assignment Allocation,
perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE"
Financial Services Lending and Leasing
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A brief description of the fields is given below:

Field: Do this:

Channel Select the OFSLL interfaced channel from the drop-down list.

If the channel is selected as ‘GENERIC RECOVERY INTERFACE’,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface

(GRIy.
Work Order Select the work order type from the drop-down list.
Type
Company Select the Company from the drop-down list.
Branch Select the company’s Branch from the drop-down list.
Enabled Check this box to enable the vendor assignment criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.2.2 Vendor Assignment Allocation

16.1.3

In the Vendor Assignment Allocation section, system fetches the list of vendors qualifying the
combination of channel, work order, company and branch selected and allows you to define
the weightage for each vendor in percentage.

By default, the allocated assignment percentage for each vendor is ‘0’. During subsequent
update, the total of assignment percentage allocation for all vendors should be equal to ‘“100’.
A vendor with the highest weightage is selected by default during work order creation.

1. In the Origination > Origination > Vendors > Work Order > Assignment Allocation,
perform any of the Basic Operations mentioned in Navigation chapter.

Field: Do this:

Vendor # View the Vendor number. The same is either specified manually or
system generated in the Vendors tab.

Name View the name of the vendor.

Assigned Cases View the total number of cases assigned to the vendor.

% Allocation View the percentage of total cases assigned to the vendor.

Assignment % Specify the percentage allocation value (out of 100) for each vendor.
However, ensure that the total of all assignment % is equal to “100’.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Work Orders Tab

The Work Orders link allows you to assign an account to a vendor for a service that the vendor
provides, view the history of work order changes and define tracking attributes.

1. Click Origination > Origination > Vendors > Work Order. The details are grouped
under three tabs:

e Services
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Work Order History
Tracking Attributes

2.

In the Origination > Origination > Vendors > Work Order > Work Order, sort the list

of work orders based on status using the ‘View Options’ drop down list.

3. Perform any of the Basic Operations mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Work Order #

Displays the work order number.

Case #

Displays the case number received from third party vendor interface.

Channel

Select the OFSLL interfaced channel from the drop-down list.

If the channel is selected as ‘GENERIC RECOVERY INTERFACE,
the work order is processed through an external system. For more
information, refer to Appendix chapter - ‘Generic Recovery Interface
(GRIy.

Work Order
Type

Select the work order type from the drop-down list.

Account

Select account number for the work order from the drop-down list.

Company

Displays the company name based on the account selected.

Branch

Displays the branch based on the account selected.

Vendor

Select vendor who will service the work order from the drop-down
list. The list of vendors are displayed based on the selected Chan-
nel, Work Order Type, and Account.

Override Rea-
son

In case of vendor re-assignment, select the appropriate override
reason for the selected Vendor.
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Field:

Do this:

Status

Select the work order status from the drop-down list.

If the status is selected as ‘SEND TO GRVI’, the work order is pro-
cessed through an external system. For more information, refer to
Appendix chapter - ‘Generic Recovery Interface (GRI)'.

Reason

This field is enabled only if the status of work order is selected as
PENDING ON HOLD, RLRELEASED, or PENDING CLOSE. You
can select the appropriate reason from the drop-down list.

Collector

Select the Collector from the drop-down list. The list displays all the
users defined with ‘Collector’ responsibility.

Work Order Detai

Is section

Dt Displays the date when work order was created.

Status Dt Displays the last work order status-change date.

Currency Displays the vendor company currency based on the vendor
selected.

Estimated Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Displays amount billed by the vendor for the work order.

Paid Displays amount paid to the vendor for the work order.

Reference #

Specify vendor reference details if any.

Assigned By

Displays the user who created/assigned the work order to vendor.

Followup Dt

Select the subsequent follow-up date from adjoining calendar.

Account Information section - System displays the following information depending on
the account selected for the work order in ‘Work Order’ section.

Account Status

Displays the status of the account.

Charged off Dt

Displays the date when the account was charged off.

Due Amt

Displays the due amount to be paid to the account.

Total Outstand-

Displays either ‘Account outstanding principal balance’ for active

ing Balance accounts, or ‘Deficiency balance’ for charge-off accounts.
Total Due Displays the total of all dues pending on the account.
Due Dt Displays the last elapsed due date on the account.

Days Past Due

Displays the total number of days elapsed past due date.
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Field: Do this:

Service Displays the combined details of Customer, Address Type and
Address Address based on the account selected. You can also select the
required service address from the drop-down list only while creating
work order details (i.e. when status = New).

Note: When selecting the service address for an external interfaced
channel (i.e. changing primary address), ensure to select the sec-
ondary address only. Else, system displays an error message.

Collateral Details section - This section displays the asset details associated with the

work order.
Collateral System displays the primary collateral associated with the account
Description by default. You can also select the collateral from the drop-down list.

The list displays all the assets associated with the account.

Identification # | Displays the identification number of the asset.

Year Displays the manufacturing year of the asset.
Make Displays the asset’s manufacturing company.
Model Displays the asset’s model.

Vendor Information section

Contact Specify the vendor contact for the work order.

Phone Specify the vendor contact phone for the work order.

Extn Specify the vendor contact phone extension for the work order.
Fax Specify the vendor contact fax for the work order.

Comment Specify any comments regarding the work order.

Vendor Messages section - This section is displayed only when the selected channel is
‘GENERIC RECOVERY INTERFACE’ and allows you to add specific communication or
instructions as a message to the vendor.

Vendor Msg Select the type of vendor message from the drop-down list.

Type

Vendor Msg Specify additional information that is to be communicated to the
external interface.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
16.1.3.1 Services

In the Origination > Origination > Vendors > Work Order > Services, perform any of the
Basic Operations mentioned in Navigation chapter.

Click ‘Load Services’ button in the Services section header to load all the services associated
with the selected combination of ‘Work Order Type’ and ‘vendor (Vendor Group)'.

16-10 ORACLE



A brief description of the fields is given below:

Field: Do this:

Service # Specify an unique service number for the work order.

Service Select the service type from the drop-down list (required).

Currency System defaults the currency defined in work order which is the vendor
currency.

Estimated System defaults the Estimated cost of the service offered by the vendor

as defined in vendor administration setup screen (Setup > Administra-
tion > System > Vendors > Vendor Fees > Vendor Service Fee Defini-
tion).

However, you can also modify the estimated value to the required
amount.

Billed Amt Displays amount billed by the vendor for the service.

Paid Amt Displays amount paid to the vendor for the service.
Status Select the status from the drop-down list.
Status Dt Displays the last service status change date.

Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.3.2 Work Order History

The Work Order History sub tab displays the details of the selected work orders in the
sequence of the changes done i.e. last change details appear as the first record.

In the Work Order History section, select the required work order and click View.
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16.1.3.3 Tracking Attributes

Click Origination > Origination > Vendors > Work Order > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value for
various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.

eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.4 Follow-up Tab

The Work Orders link lists the work orders that are not complete and hence require follow-up.

1. Click Origination > Origination > Vendors > Follow-up tab. The details are grouped
into two:

e Work Order Follow-up
e Assigned Services
2. In the Origination > Origination > Vendors > Follow-up > Work Order Follow-up,

perform any of the Basic Operations mentioned in Navigation chapter except for creating
a new record.

vendors ; [ Close
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»
4
Work Order Follow-up
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Work Order Follow-up < i il v
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A
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A brief description of the fields is given below:

Field: Do this:

Company Displays the vendor company.

Branch Displays the vendor branch.
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Field:

Do this:

Followup Dt Specify the next follow-up date. You can even select the date from
adjoining Calendar icon.

Work Order # Displays the work order number.

Dt Displays the work order date.

Account Displays the account associated with the work order.

Vendor Displays the vendor associated with the work order.

Status Select the work order status from the drop-down list.

Status Dt Displays the last work order status change date.

Work Order section

Currency Displays the currency for the work order.

Estimated Displays the estimated amount, which is the sum of all the services
added to the work order.

Billed Amt Displays amount billed by the vendor for the work order.

Paid Displays amount paid to the vendor for the work order.

Vendor Information section

Contact Displays the vendor contact name.

Phone Displays the vendor contact phone number.

Extn Displays the vendor contact phone number’s extension.
Comment Specify a comment.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.4.1 Assigned Services

In the Origination > Origination > Vendors > Follow-up > Assigned Service, perform any
of the Basic Operations mentioned in Navigation chapter except for creating a new record. A

brief description of the fields is given below:

Field: Do this:

Services Displays the service provided by the vendor.
Currency Select currency for the vendor from the drop-down list.
Estimated Specify the estimated amount for the service.

Billed Amt Specify amount billed by the vendor for the service.
Paid Specify amount paid to the vendor for the service.
Status Select the service status from the drop-down list.
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16.1.5

Field: Do this:

Status Dt Specify the last service status change date. You can even select the
date from the adjoining Calendar icon.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Invoices Tab

In the invoice tab of vendors screen, you can define invoices and process them along with
internally generated and externally received invoices. Invoice processing involves validating
the invoice information either manually or through an automated process.

Manual validation involves verifying the invoice information, accepting or rejecting the details,
updating the invoice status and indicating if the invoiced amount is Collectible.

Auto validation is supported for invoices which are in ‘OPEN’ status and generated internally
(i.e. channel = Internal). During auto validation, the invoice details are verified against specific
business rules defined in the system and corresponding status update and collectible
indicator is updated accordingly.

However, other invoices received from externally interfaced channel would get auto validated
with specific business rules when they are received and corresponding status is appended to
the invoice while listing in the Invoice Information section.

Post the validation, invoices may still have difference in estimated and invoiced amount. Such
invoices are marked with status ‘FOR APPROVAL” and requires to be manually approved.

Further in the Invoices tab, you can define Tracking Attributes, Payment Schedules and view
the Related Invoice/Work Orders (if any) in the system.

1. Click Origination > Origination > Vendors > Invoices tab. The details are grouped into
following sections:

e Details

— Payment Schedules sub tab

— Related Invoice/Work Orders sub tab
e Tracking Attributes

2. Inthe Origination > Origination > Vendors > Invoices > Invoice Information, sort the
list of invoice based on status using the ‘View Options’ drop down list.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE"
Financial Services Lending and Leasing
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A brief description of the fields is given below:

Field: Do this:

Vendor Select the vendor name for whom the invoice is to be created.
Company Displays the vendor portfolio company.

Branch Displays the vendor portfolio branch.

Invoice # Specify the invoice number.

The invoice number should be unique for every vendor. In case the
Invoice # already exists for Vendor, system displays a warning message.

External Ref | Specify the reference number which can be used for invoice tracking.

# For invoice received from external system, this field is auto populated
with the reference number generated in external interfaced system.

Invoice Dt Specify the invoice date. You can even select the date from the adjoining
Calendar icon.

Due Date Select the due date. You can even select the date from the adjoining
Calendar icon.

Status Select the invoice status from the drop-down list.

Details section

Status Dt Displays the last invoice status change date.

Address Displays the vendor address.

Currency Select the currency from the drop-down list.

Estimated Displays the total estimated amount of all the invoices defined in ‘Invoice
Details’ sub tab.

Invoice Amt | Displays the total invoice amount.

Agreed Amt | Displays the total agreed amount.

Paid Amt Displays the total paid amount.

Channel Displays the Channel as ‘Internal’ for manually defined or internally gen-

erated invoice and ‘Generic Recovery Interface (GRI) for externally gen-
erated invoice.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.5.1 Auto Validate Invoice

You can auto validate the invoice details in the Invoice Information section for those invoice
which are in ‘OPEN’ status. Auto validation with system defined business rules ensure that
every approved invoice comply to required processing standards and helps to quickly proceed
with further action.

1. Inthe Origination > Origination > Vendors > Invoices > Invoice Information, sort the
list of invoice with status as ‘OPEN’ from the ‘View Options’ drop down list.
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2. Select the required invoice form the list and click ‘Validate Invoice’ button on the Invoice
Information section header.

The invoice details are validated and the status of the invoice is updated based on validation.
For more information on validations, refer to ‘Business Rules’ section.

16.1.5.2 Invoice Details sub tab

1. Inthe Origination > Origination > Vendors > Invoices > Invoice Details, perform any
of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Work Order | Select the work order from the drop-down list. This list displays the gen-
erated work orders. Each work order name is defined in the format which
consists of work order number, account number, service number and
service name.

Case # System displays the Case number only if there is a Case number is
associated for the selected work order.

Estimated Displays the estimated cost of selected work order as defined in Vendors
> Work Order > Services section.

Invoice Amt | Specify the invoice amount.

Agreed Amt | Specify the agreed amount.

Paid Amt Displays the paid amount.

Txn Post Dt | Specify transaction effective date. You can even select the date from the
adjoining Calendar icon.

Status Select the status from the drop-down list.

Status Dt Displays the last status change date. On edit, system updates the cur-
rent date by default.

Authorized Displays the name of the user who verified (accepted/rejected) the
By invoice details.

Authorized Displays the date when the invoice details were verified.
Dt

Collectible Check this box to indicate if the agreed amount is collectible from the
customer. When checked, the collectible amount is posted as an
expense on the customer account.

During auto invoice validation, this check box is automatically selected if
the same combination of a service and work order status matches with
the state specific rule defined in Setup > Administration > System > Ven-
dors > Invoice Rules tab.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
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16.1.5.3

16.1.5.4

Accept/Reject Invoice details

In the Invoice Details sub section, you can accept or reject the details of those invoices which
are in ‘FOR APPROVAL'’ status. This status is updated during invoice processing and when
there is difference in estimated and invoiced amount which needs manual approval.

1. In the Origination > Origination > Vendors > Invoices > Invoice Details, select the
required invoice record.

2. Click ‘Accept’ or ‘Reject’ in the Invoice Details section header and click ‘Yes’ to confirm
the action.

3. Click Refresh button to view the status update.
On Accepting or Rejecting the invoice details, the ‘Authorized By’ and ‘Authorized Dt fields
are auto updated with user name and current date. Also the status of Invoice information and

Payment Schedules are updated as either ‘CLOSE’ or ‘REJECTED’ respectively. However,
auto update of status is controlled by the ‘Current/Next’ status defined in Cycle Setup screen.

If the status of a particular invoice is updated from ‘APPROVED’ to ‘CLOSE’, system
generates a payment requisition record for payment processing.

Payment Schedules sub tab

1. In the Origination > Origination > Vendors > Invoices > Invoice Details > Payment
Schedules, you can maintain the payment schedules information. Perform any of the
Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Currency System displays the vendor currency.

Payment Specify the actual payment amount for the invoice.
Amt

Status Select the payment status from the drop-down list.

Payment Dt | Select the payment date from the adjoining calendar.

Payment (Optional) Specify reference details for the payment if any.
Reference

Payable Id View the auto-generated payable ID which is the requisition ID in the AP
Transaction screen.

Payment Id | View the Requisition ID generated during AP transaction.

Disburse- View the vendor disbursement currency. However, you can select the
ment Cur- vendor payment disbursement currency from the drop-down list.

rency

Account View the currency of the account selected at in ‘Invoice Details’ sub tab.
Currency

Amount in View the Invoice Currency amount equivalent of the Account Currency.
Account System displays the ‘Amount in Account Currency’ by converting Vendor
Currency Currency value to Account Currency and considering the exchange rate
as per the scheduled payment date.
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2. Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.5.5 Related Invoice/Work Order Details sub tab

1. In the Origination > Origination > Vendors > Invoices > Invoice Details > Related
Invoice/Work Order Details, view the following details.

A brief description of the fields is given below:

Field: Do this:

Invoice # View the invoice number for the work order.

Invoice Sta- | View the status of invoice generated for the work order.

tus

Status Dt View the date on which the status of invoice is recorded.
Currency View the currency in which the invoice is generated.
WO Esti- View the estimated amount for the work order.

mated Amt

WO Agreed | View the vendor agreed amount for the work order.
Amt

WO Paid View the amount paid for the work order.
Amt

16.1.5.6 Tracking Attributes sub tab

1. In the Origination > Origination > Vendors > Invoices > Tracking Attributes. The
Tracking Attributes allows you to load tracking attributes and define the parameter value
for various parameters listed.

On the Tracking Attributes sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Sub-Param- | View the Sub-Parameter.
eter

Parameter View the listed Parameter.

Value Specify the required parameter value. By default, NA is displayed.

Perform any of the Basic Actions mentioned in Navigation chapter.

16.1.5.7 Business Rules

Business rules facilitate to auto validate invoices and approve only those which comply to the
invoice processing requirements in OFSLL. Business Rules are always validated on Invoice
information, Invoice details and payment schedules which are in ‘OPEN’ status.

Business rule validation for Invoices created or generated internally can be performed in the
Vendors > Invoices tab and external invoices are auto validated before listing in Invoices tab.
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For invoices received from external system, following pre-validation checks are also
performed before validating with the business rules.

e A duplicity check is performed based on External Reference number to ensure that
there are no two invoices with same details. In case the external reference number of
new and existing invoice in the system are same, the status is auto updated as
‘Rejected’ and invoice is not processed further.

e When the payment for a ‘Service’ in work order is already paid and the same work order
is again received with a new external reference number, system validates the ‘Paid’
status and if ‘Yes’, would auto update the invoice status as ‘Rejected’.

Following business rules are defined in the system for invoice validation. During the process,
if any of the business rule validation fails, system stops the validation process and updates
the status of Invoice as ‘Rejected’.

Rule 1
Every work order should have a specific closure status corresponding to the type of work

order defined. Accordingly, an invoice generated for that work order should comply with any
of the following combination of ‘Work order Type’ and ‘Work Order status’.

Work Order Type Work Order Status
Door Knock Completed
Involuntary Repossession Repossessed
Voluntary Repossession Repossessed
Impound Involuntary Repossessed
Impound Voluntary Repossessed
Involuntary Repossession Closed
Voluntary Repossession Closed
Impound Involuntary Closed
Impound Voluntary Closed
Skip Investigation Repossessed
Skip Investigation Closed
Rule 2

Validate invoice for the status of ‘Collectible’ check box in Vendors > Invoice tab > Invoice
Details section.

During invoice processing, if the combination of Service, Work Order Status and State
matches with any of the state specific rule defined in Setup > Administration > System >
Vendors > Invoice Rules tab, the ‘Collectible’ check box is selected and invoice is allowed to
process the next business rule.

In case the above combination does not exist in Invoice Rules tab, the ‘Collectible’ check box
is NOT selected and the invoice is still allowed to process the next business rule.
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Rule 3

Validate invoice based on Estimated and Invoiced amount and updated the corresponding
status in Invoice Information, Invoice Details and Payment Schedules sections of Vendors
screen.

e If the Invoice Amount is ‘Less than or equal’ to Estimated amount, the invoice is
approved and the status of Invoice Details and Payment Schedules is updated to
‘APPROVED’.

e If the Invoice Amount is ‘greater than’ the Estimated amount, then the invoice needs
manual approval and the status of Invoice Details and Payment Schedules is updated
to 'FOR APPROVAL'.

An invoice status in Invoice Information section is auto updated to “APPROVED’ if both
Invoice Details and Payment Schedules have the same status. Else, if status is rejected in
either of the sections, the status of invoice is also updated as ‘REJECTED’ in Invoice
Information section without allowing further edits on the same.
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Appendix A:Rounding Amounts and Rate Attributes

Rounding Amounts

Generally in the lending industry, computed amounts (interest, fees, costs and so on) are
rounded to the second decimal place. However, there are occasions where the rounding of
the computed amounts has to be carried out using different methods. Oracle Financial
Services Lending and Leasing supports the rounding, raising of or cutting off calculated
amounts.

e Rounding will increase the resulting amount to next number up to the second decimal,
based on values of third decimal.

e Raising will always increase the resulting amount to next number up to the second
decimal.

e Cutting off will always cut the number after the second decimal.

The system only rounds calculated amounts (calculated fees, calculated payment, and
so on) and not user-entered amounts.

You can choose the rounding method you want to use by setting the parameter value for
system parameter CMN_AMOUNT _ROUND_METHOD on the Administration form (Setup
menu > Administration master tab > System drop-down link > System Parameters link >
System tab).

You can choose the rounding factor you want to use by setting the parameter value for system

parameter CMN_AMOUNT _ROUND_FACTOR on the Administration form. Currently, Oracle
Financial Services Lending and Leasing supports rounding up to two decimals only.

Examples of how resulting amounts differ by RAISE, ROUND, and CUTOFF:

Example 1: Amount: 234.136

Method Result
Round 234.14
Raise 234.14
Cut off 234.13

Example 2: Amount: 234.134

Method Result
Round 234.13
Raise 23414
Cut off 234.13

Example 3: Amount: 234.1319999

Method

Result

Round

234.13
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Method Result

Raise 234.14
Cut off 234.13
Rate Attributes

The system supports rounding of index rate to keep the rate calculation as simple as possible
for the customers. The general practice is to round the rate to nearest eighth (1/8th) (to keep
index rate in the multiple of 125) or fourth (1/4th) (to keep index rate in the multiple of 25). The
system rounds only index rate and not the margin or final rate. You can define the index
rounding method on the Product tab’s Product Definition screen for variable rate Loan.

Note

Index rounding does not apply to fixed rate Loan.

The system currently supports the following rounding of methods.

1. NO ROUNDING TO INDEX RATE
2. INDEX RATE ROUNDED TO NEAREST.25
3. INDEX RATE ROUNDED TO NEAREST.125

NO ROUNDING TO INDEX RATE:

Select this method for no rounding.

INDEX RATE ROUNDED TO NEAREST 0.25:

Select this method to round up to 1/4th (to keep the index rate in the multiple of 0.25).

Examples:

Method Result

Current rate: 5.125

Round of rate: | 5.25

Method Result

Current rate: 5.124

Round of rate: | 5.00

INDEX RATE ROUNDED TO NEAREST 0.125:

Select this method to round up to 1/8th (to keep the index rate in the multiple of 0.125).

Examples:

Method Result
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Current rate: 5.325
Rate rounded 5.375
to:

Method Result
Current rate: 5.312
Rate rounded 5.250

to:
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Appendix B: Payment Amount Conversions

The following table contains the calculations Oracle Financial Services Lending and Leasing
uses to convert different payment frequencies (weekly, biweekly, semi monthly, and so on) to
standard monthly values for instalment accounts.

Payment Frequency:

Scheduled Monthly Income Amount:

D = Deferred

Zero fill

P = Single payment Loan

Zero fill

W = Weekly (due every week)

Multiple by 4.33

B = Biweekly (due every two weeks)

Multiple by 2.16

E = Semi-monthly (due twice a month) | Multiple by 2
M = Monthly (due every month) As given

L = Bimonthly (due every two months) | Divide by 2
Q = Quarterly (due every three Divide by 3
months)

T = Triannually (due every four Divide by 4
months)

S = Semi-annually (due twice a year) Divide by 6
Y = Annually (due every year) Divide by 12

ORACLE



Appendix C:Generic Recovery Interface (GRI)

C.1 Introduction

In general, a Generic Recovery Interface (GRI) is a platform to connect Oracle Financial
Services Lending and Leasing (OFSLL) with any third party recovery system. This integration
facilitates auto lending institutions to repossess non-performing assets and recover them
through a network of third party vendor managed systems.

Accordingly, in an integrated system a particular account in OFSLL can be assigned to a
vendor (third party) through GRI for recovery services. Depending on each stage of the
process, OFSLL triggers appropriate web service requests to create and update the details
into the third party system. Subsequently, the acknowledged details and case updates are
retrieved into the corresponding work order(s) and account(s) in OFSLL.

Following type of web service requests are supported:

e Create Case

e Update Case

e Case Comments

e Hold Case

e Reopen Case

e Reassign Case

e Close Case

e Case Updates Received via FireHose WebService
e Case Repossession

e Case Invoice

CcCA11 Pre-requisites

Following are the pre-requisites while working with third party integrated system:

e Ensure that 'Cycle' setup (Setup > Vendors> Cycles tab) is defined for the Work Order,
where channel is selected as 'Generic Recovery Interface'. Also if the system is defined
to automatically post any specific conditions on account, you need to maintain the
Action and Result Code.

e Ensure that Vendor Fees (Setup > Vendors > Vendor Fees tab) defaults the 'Estimated
Amount'.

e Ensure that the Work Order Types are mapped consistently and are in sync between
OFSLL and third party system. The following table lists the Work Order Types
maintained in the system.

Work Order Type | Description

DRK DOOR KNOCK (GRI)

IR IMPOUND INVOLUNTARY REPOSSESSION (GRI)
VRP VOLUNTARY REPOSSESSION (GRI)

IVR IMPOUND VOLUNTARY REPOSSESSION (GRI)
SKP SKIP TRACE (GRI)
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Work Order Type | Description

IRP INVOLUNTARY REPOSSESSION (GRI)

e Ensure that the details of Vendors, Collectors and Service types are mapped
consistently and are in sync between OFSLL and third party system.

e Define Invoice Rules (Setup > Vendors > Invoice Rules tab) that are applicable to each
Vendor Service with appropriate Work Order Status, Close Reason, and State
combinations. This ensures that the 'Collectible’ flag is set to "Y' for selected invoice
during processing.

Create Case

Once a non-performing account is identified in OFSLL, the details are to be registered in the
third party system for further action. Using the Work Orders tab (Vendors > Work Orders tab),
you can create a work order with the identified account details and selecting the channel as
Generic Recovery Interface (GRI).

Note that, system does not allow to create a work order during the following conditions:

e If there is already a case created with the same work order type which is active on the
account. On updating the details and clicking ‘Save’, system displays an error message
as ‘Active Work Order with same Order Type already exists on account’.

e If a CURE letter is issued on an account and the same is in-force. If the case creation
date is before the cure letter expiry date, then system displays an error message as
‘Cure Letter Issued and Active. Cannot create work order’.

For information on creating a work order, refer to section Vendors > Work Orders tab.

When the 'Channel' is selected as GENERIC RECOVERY INTERFACE, the Work Orders tab
enables 'Vendor Messages' section to specify additional details that are required by the third
party vendors to act upon the case. For more information, refer to ‘Case Comments’ section.

After the work order details are created, the same needs to be registered as a case in third
party system by updating the status. Accordingly, when the Status of Work Order is selected
as 'SEND TO GRI', the 'add Case()' web service is initiated to create a case in third party

system.

ORACLE'
Financial Services Lending and Leasing

@ Vendors x [®Dose
Work Order -
Save and Stay. SaveandRetun || {3 Return
> DashBoard
Origination Work Order Work Order Details
Ot 12/26/2016 Collateral Details

Origination e
Sales Lead
Simple Appiication Entry

Work Order # WO:0021410 StatusDt 12/26/2016

Casei £ UNDETINED, Currency USDOLLAR Coliateral | 2006 CHEVROLET MONTECARLO 20w |
Appiication Entry Channel GENERIC RECOVERY INTERFACE Estimated 100.00 Description
Undernriting Work Order IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00 Ideniification # 284GP4SG IXR378252

. 2006
Funding paid 0.00 ]
Pacain et Account 200:SMITH bt Make CHEVROLET

; Company US01 i Model MONTECARLO

Scenzrio Analysis Assigned By PRITAM

Appiication Documents Branch USHQ Followup D [2)

Image Maintenance *Vendor  123MAC_VENDORMAC VENDOR =

Vendor Information
Account Information
Repartz Override Reason = Account Status ACTIVE:DELQIBKRPIREPO Contact ME

producers = I * Status SENDTO GRI (= | Charged off Dt Phone
Vendors Due Amt 450.03

Reason Extn
Total Outstanding 20500.36
Collector ~
[‘ Balance Fax

Total Due 5050.33 Comment E
DueDt 02/10/2017
DaysPastDue 315
Service Address

The 'add Case()' web service request consists of the following Case details to be registered
in third party system:

e Primary Customer
e Secondary Customer (Based on the sequence)
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Address Details
Account Details

Collateral Details

When the web service request is successful, the response would contain the new case
number created in third party system. The case # is then appended to the work order and the
status is changed from 'SEND TO GRI' to '"ASSIGNED'. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

Type = SYSTEM GENERATED

Sub Type = INBOUND FROM INTERFACE

Comment = [Case No]: "NEW CASE CREATED"
Comment By = "INTERNAL"
Comment Dt = Comment Posted date

Search  Customer Service: 20000100015971  Review Reguest (Pending: 0)  Queue Assignment

Account(s): 2000 SMITH

View v Formatv Freeze EffDetach Wrap [E)]
Company Branch Sub Unit Account £
uso1 usHQ SUB UNIT1 2000

q

&, @ curent© show All ©) Group Follow-up

Product Days Past Due Currency
LOAN VEHICLE {FR) 315 USD

m

Sl view || o audit
Pay Off Amt Amount Due !
27,947.17 4,950.33]

r

Summary = Customer Service = AccountDetais = Customer Detals | Transaction History — PmtModes | Bankruptcy —RepofForedosure | Defidency  Collatersl | Bureau  Cross/UpSellAc > =

Call Activities = Maintenance ~Comments | Promises = Checklists | Tracking Attributes ~ Field Investigation | References = Correspondence | Letters | DocumentTracking | Scenario Ar > ¥

N SYSTEM GENERATED

Comments AP add | ZEdt || [Fview | o Audit
View v Format~ [P Freeze i Detach Wrap @ 3¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GEMERATED INBOUND FROM INTERFACE  2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR... INTERMAL 12/06/2016 07:45:48 AM B
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:90DEMO-GRI_INTERFACE-CASE GOT REPOSSESS... INTERNAL 12/21/2016 06:55:39 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312529:90DEMO-GRI_INTERFACE-CASE WAS ACCEFTED  INTERNAL 12/21/2016 06:48:07 AM
N SYSTEM GENERATED INBOUND FROM INTFRFACE 2044312529:90DEMO-GRI_INTERFACE-ACCEPTED CASE INTERNAL 12/21/2016 06:48:07 AM
I N SYSTEM GENERATED INBOUND FROM INTERFACE 2044312529: NEW CASE CREATED INTERMAL 12/21/2016 05:59:15 AM I
M SYSTEM GENERATED INBOUMND FROM INTERFACE  2044297557:90DEMO-GRI_INTERFACE-ACKNOWLEDGED CASE... INTERNAL 12/20/2016 10:08:05FPM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. {CORRESPONDENCE: C... INTERMNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044298164:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR... INTERNAL 12/06/2016 07:45:49 AM
INBOUND FROM INTERFACE 2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIR INTERNAL 12/06/2016 07:45:48 AM

In case of an error in the web service response received from third party system, the status
of work order is changed from 'SEND TO GRI' to 'GRI FAILED' and a comment is posted on
the corresponding account in Customer Service > Comments tab, with the following details:

Type = SYSTEM GENERATED

Sub Type = INBOUND FROM INTERFACE
Comment = "<<Error Message>>"

Comment By = "INTERNAL"
Comment Dt = Comment Posted date

Note

Error in web service response can also arise when a work order type is not mapped be-
tween the two systems and a case creation request is sent to third party system.

Update Case

Once the details of a work order has been registered as a case in third party system, there
can be subsequent updates in the details of the mapped account arising due to mismatch in
account details, change in address, collateral and so on. These changes need to be
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incrementally updated into the third party system and are done through the following web
services which are triggered when corresponding details are updated.

Web Service Type of change in mapped account

updateCaseAccountinfo() | When Account details are updated.

updateCaseAddress() When Address details are updated.

updateCaseCollateral() When Collateral details are updated.

updateCaseDebtor() When Primary Customer details are updated.

updateCaseCosigner() When Secondary Customer details are updated.

Secondary Customer can also be the next customer type
defined in the sequence.

The update web service request consists of the modified field details that are to be updated
in third party system.

ORACLE’
Financial Services Lending and Leasing

iy g sonout O

Customer Service 3 (3] Close

Search  Customer Service: 2000010015971 Review Request (Pending: ) | Queue Assignment
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Company Branch Sub Unit Account = Product Days Past Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
uso1 UsHQ SUB UNITL 0000100015871 LOAN VEHICLE (FR) 338 USD 27,9545 5,200.36 [TV TR Wl 02/10/2016

« M » -

Summary  CustomerService | AccountDetsls  CustomerDetals | Transaction History —PmtModes Barkruptcy | RepofForecosure  Defidency | Collateral | Bureau | CrossiUp Sell Activities  External Interfaces

Call Activities | Maintenance | Comments  Promises | Cheddists | Tracking Attributes || Field Investigation | References | Correspondence || Letters | Document Tracking || Scenario Analysis | Access History

Comments dradd | AEdt | Fen | o Audit
View v Format v By Freeze  Efi Detach Wrap @ 38 Delere
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ ADDRESS UPDATED - ADDRESS NUMBER: OLD VALUE : 745 NEW VALUE : 111ADDRESS UPDATED - ADD INTERNAL 01/13/2017 03:01:58 AM -
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044297557:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:56 AM ‘
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 03:01:54 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ COLLATERAL INFORMATION UPDATED - COLLATERAL TYPE: VEHICLE, PRIMARY IND: Y INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER UPDATED - NAME: UPDATE-1 ADD CASE-2, RELATION: PRIMARY, DATE OF BIRTH CHAN... INTERNAL 01/13/2017 03:01:24 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ CUSTOMER URDATED - NAME: COSIGNER DETAILS-1, RELATION: SPOUSE, DATE OF BIRTHCHANGED  INTERNAL 12/06/2016 02:03:51 PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044298164:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57: 11 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044287557:UPDATED ACCOUNT DETAILS ACCEFTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:09 AM =

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312529:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 01/13/2017 02:57:07 AM

If the web service request is successful, the modified details are updated into the case in third
party system. Also a comment is posted on the corresponding account in Customer Service
> Comments tab, with the following details:

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.

In case of an error in the web service response received from third party system, case details
are not updated and the following details are posted as a comment against the account.

e Type =SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<UPDATED ACCOUNT DETAILS NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date and time.
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Case Comments

Case comments refers to additional details provided in the 'Vendor Messages' section of
Work Orders tab that are required by the third party vendors to act upon the case.

The ‘Vendor Messages’ section can be updated after the case has been created in third party
system and serves as a communication channel between the integrated system.

'Vendor Messages' section is available in the Work Orders tab only when the 'Channel' is
selected as GENERIC RECOVERY INTERFACE and by default, the Vendor Message Type
is selected as ‘CLIENT UPDATE'.

ORACLE
Financial Services Lending and Leasing

@ vendors x [ Ciose
Work Order Work Order Details =
Dt 12/26/2016 Collateral Details
S Work Order # UNDEFINED StatusDt 12/26/2016
Origination i Ehand currency e )
* Channel GENERIC RECOVERY INTERFACE [ Estimated 0.00 5 n:“'ﬂ‘” "
Sngemon = * Work Order INTERNAL Biled Amt 0.00 enifcain &
SelesLead W G-1\ERIC RECOVERY INTERFACE pad 0.00 i
Smple Application Entr Moke
hiE * * Account - Reference #
Appication Entry Model
s Company Assigned By ABSHEKAR
Funding Brenh Followup Dt £ Vendor Information
Applcation Retrieval e = Account Information
Scenario Analysis Ovarride Reasen Account Status Contact
Application Documents *Status NEW [=] Charged off Dt el
Image Maintenance Hocmon Due Amt i
Reports Total Cutstanding
Producers ; iGeleci = Balance Fax
Vendors i Total Due: Comment
Due Dt
Days Past Due
Service Address [=]
Vendor Messages
Vendor Msg Type | CLIENT UPDATE -
= Vendor Msg
> Servicing
* Collections
> WEP
» Tools
> Setup

Accordingly, in the ‘Vendor Messages’ section when the details of Vendor Message Type and
Vendor Message are updated for a work order, system triggers ‘addCaseUpdate()’ to update
the same details in the third party system.

An outbound comment is posted on the corresponding account in Customer Service >
Comments tab, with the following details and the update details are also captured as a record
in Work Order History tab.

e Type =SYSTEM GENERATED

e Sub Type = OUTBOUND TO INTERFACE

e Comment = “[Case No]: <<Vendor Msg Text >>"
e Comment By = “USER”
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e Comment Dt = Comment Posted date

ORACLE’
Financial Services Lending and Leasing

Vendors 3 Customer Service yx [%] Close:

Search  Customer Service: 20160900013226  Review Request (Pending: 0) | Queue Assignment

Account(s): 20160900013226: CHAKS JACY E View || o Audit
view v Format~ [ Freeze i Detach Wrap W & @ curent® show Al © Group Folow-up
Company Branch Sub Unit Account £ Product Days Past Due Currency Pay Off Amt Amount Due Status =
uso1 usHQ SUB UNIT1 20160800013226  LOAN VEHICLE (FR) 108 USD 51,936.86 17,405.28

Summary || Customer Service AccountDetals | Customer Detals | TransactonHistory | PmtModes  Bankruptcy | RepofForedosure | Defidency Colatersl | Bureau  Cross/Up Sell Activities | E > 7

» Cal Activities = Maintenance Comments Promises = Checklists Tracking Attributes = Field Investigation ~ References | Correspondence  Letters DocumentTracking ~ Scenario Analysis A > 7
Comments dpadd | Fedt | Fyew | o audt
view v Format» [ Freezz il Detach Wrap W S8 Deete
Alert Type Sub Type Comment. Comment By Comment Dt
I N SYSTEM GENERATED OUTBOUND TO INTERFACE 2044317321:OTHER:TOYCTA CAMRY - NEW EDITION 2017 MODEL ABSHEKAR 01/27/2017 05:22:59 AM I
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/24/2017 01:07:20 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERMNAL 01/13/2017 03:00:07 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:58:09 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:56:04 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 204431732 1:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERMNAL 01/13/2017 02:53:59 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044317321:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/13/2017 02:51:26 AM " -

Hold Case

A particular work order or case which is already scheduled for repossession can undergo a
status change when a payment is received (either full outstanding due or partial) on the non-
performing account associated with the work order.

Also, an automatic case status change can happen on work order for an account based on
Delinquency Days. Whenever the delinquency days falls below certain number of days as
defined in system parameter “GRI_DLQ_DAYS_AUTO_STATUS_CHG” (DELINQUENCY
DAYS FOR AUTOMATIC CASE STATUS CHANGE), system auto updates the case status
as ‘PENDING ON HOLD/ON HOLD’ on running the batch job SET-GRI
(RDNDLQ_BJ_100_01-AUTOMATIC CASE STATUS CHANGE).

Accordingly, when the status of a work order is changed to ‘PENDING ON HOLD’ in Work
Orders screen, system triggers ‘holdCase()’ web service request to update the status of
corresponding mapped case in third party system. This ensures that a work order in hold
status is not processed further with third party vendor managed systems.

For information on updating the work order details, refer to section Vendors > Work Orders
tab.

ORACLE’
Financial Services Lending and Leasing

Vendors 3 [ Close
View v Format = [y Freeze i Detach Wrap o)
Col
Work Order & Case # Charnel Account neVerOverride Reason  Company  Branch Status Reasol Work Order Type
WOI0021403 2044313030 GENERIC RECOVERY INTERFACE  20000100015856:DE AMIT / SMITH ... 20(901 uso1 usHQ PENDING ONHOLD | CUS... IMPOUND INVOLUNTAR
W0:0021392 2044312906 GENERIC RECOVERY INTERFACE ~ 20000100014056:DE AMIT / SMITH ... 200900 uso1 usHQ PENDING ONHOLD | CUS... DOOR KNOCK (GRI)
W0:0021089 2044298163 GENERIC RECOVERY INTERFACE ~ 20000100015856:DE AMIT f SMITH .. 200900 usot usHQ PENDING ON HOLD JCUS... IMPOUND INVOLUNTAR
WO0:0021090 2044298164 GENERIC RECOVERY INTERFACE  20000100015971:DE AMIT f SMITH ... 201901 usot USHQ PENDING ON HOLD | CUS... IMPOUND INVOLUNTAR
] i v

Services | Work Order History  Tracking Atiributes

Work Order History 5] view
view = Format v k52 Freeze &ff Detach Wrap 6]
Collateral
Work Order # Case # Channel Acount Vendor  Override Reason Company  Branch Status Reason Work Order Type
W0:0021403 2044313030 GENERIC RECOVERY 2000010, 2006 CHEVROLET S0DE. uso1 usHQ OPEN IMPOUND INVOLU
W0:0021403 2044313030 GENERIC RECOVERY 2000010, 2006 CHEVROLET S0DE. uso1 USHQ ASSIGNED IMPOUND INVOLU
W0:0021403 UNDEFINED ~ GENERIC RECOVERY 2000010, 2006 CHEVROLET S0DE. usoi USHQ NEW INVOLUNTARY RE
< i v

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE HOLD REQUEST ACCEPTED BY THIRD PARTY
INTERFACE (Reference No)>>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date.

ORACLE’
Financial Services Lending and Leasing

Customer Service x 3] Close

Search  Customer Service: 20160300018800 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160318800: FOSTER RICK [El view || « Audit
View v Formatv [ Freeze i Detach Wrap @ & © curent® show Al © Group Fallew-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
uso1 usHQ SUBUNIT1 2016030018800  LOAN VEHICLE (FR) 50 USD 32,536.20 3,861.52 ACTIVE:DELQ 11/24/2016 |

Summary ~ Customer Service ~AccountDetails Customer Detais || Transaction History | PmtModes || Bankruptcy | RepofForedosure | Defidency | Colateral | Bureau Cross/Up Sell Activities | External Interfaces

Call Activities || Maintenance | Comments | Promises | Checists | Traddng Attributes | Field Investigation | References | Correspondence || Letters || DocumentTracking | Scenario Analysis || Access History

Comments add | ZEdt | [Hyew | o audt |
View » Format v [ Freeze  [ffiDetach Wirap W 9 peete .
Alert Type Sub Type: Comment Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27 PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPOMDENCE: CNLNCE_COL_LTR1_VR JOB REQUEST ID: 21... INTERNAL 12/13/2016 12:47:35 AM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 12/06/2016 02:03:51 PM
N SYSTEM GENERATED SYSTEM GENERATED. WELCOME LETTER GENERATED. (CORRESPONDENCE: CNLNCE WEL_LTR_VR JOB REQUEST ID: 17499 INTERNAL
I N SYSTEM GENERATED INBOUND FROM INTERFACE 2044275575 : CASE HOLD ACCEPTED BY THIRD PARTY INTERFACE : INTERNAL 11/10/2016 03:00:35 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275575:90DEMO-RDN_INTERFACE-CASE WAS ACCEFTED INTERNAL 11/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275575:90DEMO-RDN_INTERFACE-ACCEPTED CASE INTERNAL 11/10/2016 02:54:45 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275575:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTERFACE INTERNAL 11/10/2016 02:51:43 AM i

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

e Alert=Y
e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment="“CASE NO: <<CASE HOLD REQUEST NOT UPDATED IN THIRD PARTY
INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date.

Reopen Case

When the status of a work order is updated from ‘ON HOLD’ to ‘RELEASED’ in Work Orders
screen, system triggers ‘reopenCase()’ web service request to update the status of
corresponding mapped case in third party system.
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This ensures that a work order in hold status is processed further with third party vendor
managed systems.

ORACLE'
Financial Services Lending and Leasing

Vendors 3 [®)Dose
Vendors | Assignment Alocation | Work Orders  Folow-up  Invoices I
Work Order
Fradd | FEdt | Evew | o Audt
View Format~ [EF) (1] Freeee EfiDetach wep @
& woooa1117
Colateral Overrid A
Work Order # Case # Chamnel  Account s Vendor e company  Branch Status Resso Work Order Type % Reference = Fol |2
Desaription Reason By
WO:0021117 2044295035 GENERIC RE.. 20151100019817:... 2006 CHEVROLET .. 0DEMO-RDN_INT. UsD1 UsHy ONHOLD CUS... IMPOUND INVOLUNTARY REPOSSE... VE.
« i '
Work Order
[ saveand stay save andRem | (aRetwn
4 Work Order Work Order Details
Dt 12/01/2016 Collateral Details .
Work Order # WO:0021117 StatwsDt 12012016
Case & 2044293035 Currency USDOLLAR Colateral Description 2006 CHEVROLET MONTECARLO 2DR
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 284GP45G DR 378252
Wiork Order Type IMPOUND INVOLUNTARY REPOSSESSION (GRI) Biled Amt 0.00 Year 2006
Account 20151100019317:DON TAMPRI Faid 0.00 e o
Company USO1 RSy Model MONTECARLO
Branch USHQ A
i Jeeined By SNECT Vendor Information
Vendor | SODEMO-RDN_INTERFACE - g e
Override Rezson Select the work order status P e Y
= Status | ON HOLD [5] Account Status CLOSED:ACTIVESTTP Phone
Reason | ONHOLD. Charged off Dt
HELEASD Due Amt 1078.8 e
colector
RerEaSeD | Total Qutstanding Balance -207.84 Fax
— Total Due 0 Comment
Due Dt 02/02/2017
Davs Past e 22 52

The processing update of REOPEN case request at the third party system is tracked
separately through a FIREHOSE web service scheduled at specific interval using a batch
process. For more information, refer ‘Case Updates Received via FireHose WebService’
section.

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:
e Type = SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE
e Comment = “CASE NO: <<CASE REOPEN UPDATED IN THIRD PARTY
INTERFACE>>"
e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE’ KR y g sgnout &
Financial Services Lending and Leasing

Vendors x| Customer Service x [ Close
View v Format= | g7 rreeze g vemn wirap GRS} @ LUENTL SNOW AN LrOUD FOIOW-Up -
Company Branch Sub Unit Account £ Praduct Days Past Due Currency Pay Off Amt Amount Due Status
uso1 usHQ SUB UNITL 0160300021035  LOAN VEHICLE (FR) 264 USD 46,032.86 17,561.52 ACTIVEIDE

Summary  Customer Service | AccountDetails | Customer Detaiis | Transaction History | PmtModes | Bankruptcy  RepofForedosure  Deficency | Collateral | Bureau | CrossfUp Sell Activiies | E >

Call Activities | Masintenance  Comments | Promises  Checklsts | Tracking Atrbutes | Field Investigation | References | Correspondence | Letters  DocumentTracking | Scenario Analyss A >

Comments dpadd | Ledt | Fyew | o audt E
View ~ Format ~ [ Freeze £ Detach Wrap W 8¢ Delete
» Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044302016:CASE REOPEN UPDATED IN THIRD PARTY INTERFACE INTERNAL 12/06/2016 07:26:30 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR . INTERNAL 12/13/2016 12:48:33 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION1 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL _LTR... INTERNAL 12/13/2016 12:47:35 AM —
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPOMDENCE: CNLNCE_WEL _LTR_VR ... INTERNAL 12/06/2016 02:03:15PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044302016: NEW CASE CREATED INTERNAL 12/06/2016 07:22:53 AM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

o Alert=Y
e Type =SYSTEM GENERATED

c-8 ORACLE



C.7

e Sub Type = INBOUND FROM INTERFACE

e Comment = “CASE NO: <<CASE REOPEN REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE>>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

Reassign Case

A particular work order or case which is already scheduled for repossession in third party
system can be reassigned to a different vendor due to delay in action, response, status
updates or any such conditions.

Accordingly, when a case is reassigned to a different vendor, the change is processed for
update in third party system depending on the current case status maintained across systems
as indicated below:

. OFSLL Work | GRI Case .
Scenario Order Status | Status Case Reassignment Update

1 Send to GRI NEW Case is assigned to new Vendor.
FROM
CLIENT
2 Open Open Existing case is closed (i.e. status is updated

as ‘PENDING REASSIGN/CLOSE’) and new
case is created and assigned to new Vendor.

Also, system automatically updates the work order status to ‘PENDING REASSIGN/CLOSE’
based on a system parameter. If the case status is OPEN for specific number of days as
maintained in the system parameter “VEN_REASSIGNMENT_DAYS” (VENDOR
REASSIGNMENT DAYS), system auto updates the case status as ‘PENDING REASSIGN/
CLOSE’ on running the batch job SET-GRI (RDNVNA_BJ_100_01 - AUTOMATIC VENDOR
REASSIGNMENT).

Accordingly, when a case is reassigned, system triggers ‘reassignCase()’ web service
request for reassigning the case to new vendor in third party system. Depending on the case
status, the case is either directly assigned to new vendor, or a new case is created with new
vendor by closing the existing case.

If a new case is created in third party system due to vendor reassignment, then the web
service response will include the new case number. Subsequently, when a close confirmation
is received on the existing case as part of case status update from FIREHOSE web service
response, the work order in OFSLL is closed (status = ‘CLOSE’) and new work order is
created with new case number, new assigned vendor and previous work order account
details.

Note the following:

— New work order is created in OFSLL only if the ‘reassignCase()’ web service
response consists of new case number created in third party system.

— If the web service response is successful but does not contain a case #, then the
case is directly assigned to new vendor in third party system.

A comment is posted on the corresponding account in Customer Service > Comments tab,
with the following details:

e Type =SYSTEM GENERATED
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e Sub Type = INBOUND FROM INTERFACE

e Comment=NEW CASE NO: “<<CASE REASSIGNMENT REQUEST ACCEPTED BY
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE’ SHEKAR g sanout ©
Financial Services Lending and Leasing

Vendors y  Customer Service y [®] Close

Search | Customer Service: 20160100025071  Review Request (Pending: D) Queue Assignment

Account(s): 20160100025071: JENA PRITAM Elyen | o Audt
View » Format v [Ep Fresze ! Detach Wrap @ & @ curent© Show Al ) Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status =
uso1 USHQ SUB UNIT1 20160100025071  LOAN VEHICLE (FR) 349 USD 15,748.99 5,400.36 LlapliEv:

« i, B

Summary ~ Customer Service | AccountDetsils | Customer Detsils | Transaction History | PmtModes | Bankuptcy | RepojfForedosure | Deficency | Collateral | Bureau | CrossfUp Sell Activites | £ > ~

Call Actvites  Maintenance Comments Promises  Checklists  Tracking Atrrbutes | Field Investigaton  References  Correspondence | Letters  DocumentTracking | Scenario Analyse A > 7

Comments P add || AEdt | [FVew | o Audt
View v Formatv  Ep Freeze i Detach Wrap W 3¢ Delete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/24/2017 01:06:33 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/13/2017 02:59:12 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/13/2017 02:50:25 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE... INTERNAL 01/08/2017 09:45:22PM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044314205:UPDATED ACCOUNT DETAILS ACCEPTED BY THIRD PARTY INTE. INTERNAL 01/02/2017 12:23:35 AM
| N SYSTEM GENERATED INBOUND FROM INTERFACE  2044314205: REASSIGNMENT IN PROGRESS INTERNAL 12/29/2016 04:43:20 AM | =

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account and the work status is not updated nor
a new work order is created with new assigned vendor.

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE REASSIGNMENT REQUEST NOT UPDATED IN
THIRD PARTY INTERFACE >>"

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

C.8 Close Case

A particular work order or case which is already scheduled for repossession can be closed
after validating the preceding status and subsequently a repossession may not be required
on the account mapped to the work order.

Accordingly, when the status of a work order is changed to ‘PENDING CLOSE’ in Work
Orders screen, system triggers ‘closeCase()’ web service request to update the status of
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corresponding mapped case in third party system. This ensures that the work order is not
processed further with third party vendor managed systems.

ORACLE’ e AR ity 1§ Ssmout ©
Financial Services Lending and Leasing

Vendors 3 (3] Close
Work Order =
dpadd | ZEdt | Guew | o Audt
View + Format~ [0 Freeze i Detach Wrap o]
Work Order # Case % channel Account i vendor QUM oy Branch Status Reasor Work Order Type  Assigned By Reference #
Description Reason
WO:0021175 2044302017 GENERIC RE... 20160300021051:... 2006 CHEVROLET ... SODEMO-RDN_INT. uso1 UsH cLose CUS... IMPOUND INVOLLL... HMACHA

« 1 »

b  Services  Work Order History | Tracking Attributes

I

Work Order History [E] view
View = Formatv  [E (1[|Fresze §iDetach wae | @
&
Work Order # Case = Channel Account EZ!Z‘E:;” Vendor S::;Z:E Company  Branch Status Reason Work Order Type  Assigned By R
Wo:0021175 2094302017 GENERICRE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. uso1 UsHQ PENDING CLOSE | CUSTOMER .. IMPOUND INVOLLL... HMACHA
Wo:0021175 2044302017  GENERICRE... 20150300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. usot UsHQ E= IMPOUND INVOLU... HMACHA
Wo:021175 2044302017  GENERICRE... 20150300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. usot UsHQ ASSIGNED IMPOUND INVOLU... HMACHA
WO:0021175 UNDEFINED  GENERIC RE... 20160300021051:... 2006 CHEVROLET ... S0DEMO-RDN_INT. usot UsHQ NEW IMPOUND INVOLU... HMACHA

q] M »

If the web service request is successful, a comment is posted on the corresponding account
in Customer Service > Comments tab, with the following details:

e Alert=N
e Type =SYSTEM GENERATED
INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE CLOSE REQUEST ACCEPTED BY THIRD PARTY
INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date

ORACLE’ -
Financial Services Lending and Leasing

e Sub Type

‘Customer Service [ Close

Search | Customer Service: 20160300018545 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160300018545: FOSTER B view || o Audit
View = Format~ B Freeze  f Detach Wrap M & @ curentO show AllD Group Follow-up
Company Branch Sub Uit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Oldest Due Dt
uso1 UsHQ SUB UNITL 20160300018545  LOAN VEHICLE (FR) 264 USD 46,345.17 17,561.52 ACTIVEDELQ 04/24/2016
bl m T =|

Summary | Customer Service | AccountDetalls | Customer Details | Transaction History | PmtModes  Bankruptcy | RepojfForecosure | Defidency Colateral | Buresu  Cross/Up Sel Activities | External Interfaces

Cal Activities | Maintenance =~ Comments | Fromises || Checists | Tracking Attributes | Field Investigation | References  Corespondence | Letters | DocumentTracking | Scenario Analysis | Access History

Comments dpadd | Zedt || Elven || o audt
View v Format v B Freeze  fiDetach wirap W 3¢ Delet=

Alert. Type Sub Type Comment Commenit By Comment Dt

N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNGE_STM_LTR_VR JOB REQUEST ID: 2... INTERNAL 01/12/2017 11:19:27PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR._VR JOB REQUEST ID: 2... INTERNAL 12/06/2016 02:03:5LPM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED, (CORRESPONDENCE: CMLNCE_COL_LTR2 VR JOB REQUEST ID: 15... INTERNAL 11/23/2016 05:06:53 AM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL LTR3 VR JOB REQUEST ID: 15... INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE INTERNAL 11/03/3016 10:44:48 PM
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED, (CORRESPONDENCE: CNLNCE_WEL I TR_VR JOB REQUEST ID; 17330)  INTERNAL 11/08/2016 08:27:10 FM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044274356: NEW/ CASE CREATED INTERNAL 11/09/2016 03:15:10 PM

In case of an error in the web service response received from third party system, following
details are posted as a comment against the account with an alert flag and the status of Work
Order is not changed.

e Alert=Y
e Type =SYSTEM GENERATED
INBOUND FROM INTERFACE

e Comment = CASE NO: “<<CASE CLOSE REQUEST NOT UPDATED IN THIRD
PARTY INTERFACE >>”

e Comment By = “INTERNAL”
e Comment Dt = Comment Posted date

e Sub Type
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Case Updates Received via FireHose WebService

Retrieving case status updates from the third party system is through a FIREHOSE web
service response received into OFSLL through a pull service. Each response is channelled
through an individual Event ID and Event Type.

A FIREHOSE web service 'getGriFireHose' - scheduled at specific interval using batch
(GRIFRH_BJ_100_01) retrieves the case updates. This response consists of case activities
recorded in third party system between specific intervals (based on Max event ID).

Note that, the FIREHOSE web service response always contains specific Event Type Code
from the third party system which are updated in the database and inturn is validated for
appropriate action in OFSLL. The table below indicates the list of Event Type and the
corresponding action updated in the system.

Event Event Description Action

Type

600 ACCEPTED CASE Change Work order status to “OPEN”

601 DECLINED CASE Change Work order status to “DECLINED”

602 ACKNOWLEDGED Change Work order status to “CLOSE”

CLOSE
603 ACKNOWLEDGED Change Work order status to “ON HOLD”
HOLD

300 CASE WAS REPOED Change Work order status to “REPOSSESSED”
And
Trigger “getRepossessionDetails()” web service to
get repossession details and update in Servicing >
Repo/Foreclosure” tab.

302 CASE COMPLETED Change Work order status to “COMPLETED”

200 FIRST UPDATE ADDED | Post the received update as “Inbound Comment”

CUSTOM from Interface in Servicing >Customer Service
>Comments tab.

201 UPDATE EDITED Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

203 UPDATE UNHIDDEN Post the received update as “Inbound Comment”
from Interface in Servicing >Customer Service
>Comments tab.

811 INVOICE SENT TO CLI- | Call the “getCaselnvoiceData()” web service and

ENT create the invoices in OFSLL.

1300 CR ADDED Update ‘Condition Report Status =Y’ and Condition

Report Recd Dt = Event Received Date

Based on the web service response received from third party system, the status updates are
posted onto corresponding work order(s) and account(s) in OFSLL.

ORACLE
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For example, if the FIREHOSE web service response consists of the Event Type ‘600’, it

indicates that the case is accepted by the assigned vendor in third party system and status of

the work order is to be updated to ‘OPEN’ in OFSLL. Also a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type =SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = "[Case No]: <<[Vendor] ACCEPTED CASE>>"
e Comment By = "INTERNAL"

e Comment Dt = Comment Posted date and time

Note

Work order status change is permitted only if the previous status matches with the defined
cycle setup (Setup > Products > Cycles). Else, update is not allowed and comment is post-
ed on the account with the message ‘Work Order Status Update failed due to mismatch of

previous status’.

Case Repossession

When a case has been repossessed, the status of the case is updated by the assigned vendor

in third party system. The case status is then retrieved through a FIREHOSE web service

scheduled at specific interval using a batch process.

On receiving the case status update as ‘REPOSSESSED’ (i.e. Event Type 300) from

FIREHOSE web service response, system triggers ‘getRepossessionDetails() web service

request to fetch the repossession details and update the status of corresponding mapped

work order and account in OFSLL.

If the web service request is successful and repossession details are received as part of the
response, the status of the work order is updated in Work Orders tab and a comment is posted

on the corresponding account in Customer Service > Comments tab, with the following
details:

e Type=SYSTEM GENERATED
e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: REPO DETAILS RECEIVED FROM THIRD
PARTY INTERFACE >>"

e Comment By = “INTERNAL”

e Comment Dt = Comment Posted date and time

ORACLE"
Financial Services Lending and Leasing

Summary || Customer Service | Account Details | Customer Details | Transaction History | PmtModes | Bankruptcy ~RepofForedosure | Defidency | Colateral | Bureau = CrossfUp Sell Activities | External Interfaces

Call Activities || Maintenance | Comments | Promises | Cheddists | Tracking Attributes || Field Investigaion | References | Correspondence || Letters | Document Tracking | Scenario Analysis | Access History

Customer Service s~ Customer Service 5 (3 Close
Search | Customer Service: 2016060001 Review Request (Pending: 0) || Queue Assignment =
Account(s): 2016060001: COSIGNER Elview || o Audit
View ¥ Format~ [y Freeze i Detach Wrap W & @ curent© Show Al O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status OldestDue Dt
uso1 usHQ SUBUNITT 20160600018906  LOAN VEHICLE (FR) 170 USD 102,758.36 51,382.92 ACTIVE:DELQ 07/27/2016

Comments dpadd || AEdit || [F view || o Audt
View v Fomat~  Ep Freeze i Detach Wrap M 38 ekt

Alert Type Sub Type Comment ‘Comment By Comment Dt
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR _VR JOB REQUEST ID: 25332) INTERNAL 01/12f2017 11:19:27PM
N SYSTEM GENERATED SYSTEM GENERATED ACC_STATEMENT LETTER GENERATED. (CORRESPONDENCE: CNLNCE_STM_LTR _VR JOB REQUEST ID: 20948) INTERNAL 12/06/2016 02:03:51PM
N SYSTEM GENERATED SYSTEM GENERATED COLLECTION2 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR2_VR JOB REQUEST ID: 18920) INTERNAL 11/23/2016 05:06:53 AM
N SYSTEM GEMERATED SYSTEM GENERATED COLLECTION3 LETTER GENERATED. (CORRESPONDENCE: CNLNCE_COL_LTR3_VR JOB REQUEST ID: 18906) INTERNAL 11/23/2016 04:50:43 AM
N SYSTEM GENERATED SYSTEM GENERATED WELCOME LETTER GENERATED. (CORRESPOMNDENCE: CNLNCE_WEL _LTR_VR JOB REQUEST ID: 17499) INTERNAL 11/10/2016 02:02:51PM
N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044275584: GRI_INTERFACE:REPOSESSION DETAILS FROM GRL UPDATED INTERNAL 11/10/2016 05:02:30 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE GOT REPOSSESSED INTERNAL 11/10/2016 05:02:25 AM “«
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-AGENT UPDATED LICENSE PLATE FROM UNDEFINED TO 123456 INTERNAL 11/10/2016 05:02:25 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584: 90DEMO-RDN_INTERFACE-ACCEPTED CASE INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE  2044275584:90DEMO-RDN_INTERFACE-CASE WAS ACCEPTED INTERNAL 11/10/2016 04:53:19 AM
N SYSTEM GENERATED INBOUND FROM INTERFACE 2044275584 NEW CASE CREATED INTERNAL 11/10/2016 04:51:00 AM =
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The Repossession details are also updated in Repo/Foreclosure tab of Customer Service

screen.

ORACLE'
Financial Services Lending and Leasing

Customer Service x || Customer Service x [ Close
Search | Customer Service: 2016060001 Review Request (Pending: 0) | Queue Assigrment i
Account(s): 2016060001: COSIGNER Ewew o Audit
View = Formatv & Freeze i Detach Wrap W & © Curent© Show Al O Group Follow-up
Company Branch Sub Unit Account # Product Days Past Due Currency Pay OFf Amt Amount Due Status Cldest Due Dt
uso1 UsHg SUB UNITL 0160600018306 LOAN VEHICLE (FR) 170 USD 102,758.36 51,382.92 ACTVEDELQ 07/27/2016

Summery || Customer Service || Account Details | Customer Detais || Transaction History || PmtModes | Bankupicy | RepofForeclosure | Deficency || Collateral | Bureau || Cross/Up Sell Activities || Extermal Interfaces

Repossession  Analysis

Repossession Details: 2B4GP45G1XR378254 dpAdd | FEdit || B Vew | o Audit 3
view v Formatv [ Freeze i Detach Wrap 5]
Current FolowupDt  Work Order Type  Collateral Disposition File Received Dt Repo Dt RepoEndDt  Comment
v 12/31/4000  INVOLUNTARY 2010 VOLVO AMDO07 NEWLY RECEIVED

Repossession Details

(aRetum
Current ¥ File Received Dt
Followup Dt 12/31/4000 Repo Dt i
Work Order Type  INVOLUNTARY Repo End Dt
Colateral 2010 VOLVO AMDO7 Comment
Disposition NEWLY RECEIVED
Case Repo Details
Case 2044275584 Is Drivable ¥ Storage Location Space 12123123 Phone (123)-333-4444
Vendor Work IMPOUND VOLUNTARY REPOSSESSION (GRI) Personal Items  HGHG) Fax (333)-444.5555
Order Type Storage Days 0 Storage Location
Identification B4GP4SGIR378254 Transport Release Date 11/08/2016 Repo Location
= "l Delivered ReleasedTo 0 e
Vehide C.wl‘wr Ff?m Condition Report Status _ Country UNITED STATES Address »}EE 1NiT FE:{ N‘—; :w'rlza |

C.11 Case Invoice

When a case has been repossessed, an invoice with the actual cost incurred for repossession
and the details of the asset repossessed are updated in the third party system by the assigned
vendor.

Subsequently, when the case status update is received as ‘REPOSSESSED’ (i.e. Event Type
300) from FIREHOSE web service response, system triggers ‘getCaselnvoiceData()’ web
service request to retrieve the invoice and asset details from the third party system.

ORACLE' d ISHEKAR ility g Sign Qut o
Financial Services Lending and Leasing

Vendors x [ Close
Work Order
[ save and stay, saveandRetun || (3Return
Work Order Work Order Details
Dt 12/22/2016 Collateral Details
Work Order # W0:0021380 StatusDt 12/22/2016
Case # 2044312777 Currency US DOLLAR Collateral Description 2006 CHEVROLET MONTECARLO 2DR.
Channel GENERIC RECOVERY INTERFACE Estimated 0.00 Identification # 2B4GP45G 1XR 378252
Wark Order Type  IMPOUND INVOLUNTARY REPOSSESSION (GRT) Billed Amt 0.00 Year 2006 |
b Account  20160100011187: Paid 0.00 WMake CHEVROLET 3
Company USO1 Reference # Model MONTECARLO
Branch USHQ Assigned By VENKAT 3
§ Vendor Information
Vendor 90DEMO_INTERFACE Followup Dt
Override Reason Account Information T —
E o= ontac ]
N —— Account Status - ACTIVE:DELQ:BKRP:REPO e
o Charged off Dt
£ason Em
Collector Due Amt 450,03 e
Total Quistanding Balance  15834.6
Total Due 5625.36 e
DueDt 03/10/2017 <

If the web service request is successful and repossession details are received as part of the
response, the details are updated in Vendors > Invoices tab and a comment is posted on the
corresponding account in Customer Service > Comments tab, with the following details:

e Type = SYSTEM GENERATED

e Sub Type = INBOUND FROM INTERFACE

e Comment = “[Case No]: <<[Vendor]: INVOICE RECEIVED FROM THIRD PARTY
INTERFACE >>"

e Comment By = “INTERNAL”
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e Comment Dt = Comment Posted date and time

ORACLE’
Financial Services Lending and Leasing

Vendors Customer Service 5 [3€] Close

Search  Customer Service: 2016010001187 | Review Request (Pending: 0) | Queue Assignment

Account(s): 20160100011187: Elyen | o Audit
view v Format~  [5p Fresze i Detach Wirap W & © curent® show Al Group Follow-up i
Company Branch Sub Unit Account # Product Days Past Due Currency Pay Off Amt Amount Due Status
uso1 UsHQ SUB UNIT1 2016010001187  LOAN VEHICLE (FR) 343 USD 15,809.54

Summary | Customer Service | AccountDetals Customer Detals | Transaction History | PmtModes Bankruptcy RepofForedosure  Defidency | Collateral | Bureau | CrossfUp Sell Activies | E > ¥

Cal Activiies | Mantenance Comments Promises | Checkists | Tracking Attrbutes  Field Investigation | References | Correspondence | Letters | DocumentTracking | Scenario Anlyss A > ¥

Comments qpadd | FEdt | [SJven | o Audt
view v Format~ &y Freeze i Detach Wirap W 3¢ Delete

Alert Type Sub Type Comment Comment By Comment Dt

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE:INVOICE RECEIVED FROM THIRD PA... INTERNAL 12/22/2016 03:37:12 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE-ORACLE ONE HAS APPROVED THE IN... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:90DEMO-GRI_INTERFACE-INVOICE CREATED IN THIRD PARTY ... INTERNAL 12/22/2016 03:37:10 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE ~ 2044312777:90DEMO-GRI_INTERFACE:REPOSESSICN DETAILS FROM GRIUL... INTERNAL 12/23/2016 03:30:53 AM

N SYSTEM GENERATED INBOUND FROM INTERFACE  2044312777:0DEMO-GRI_INTERFACE-CASE GOT REPOSSESSED INTERNAL 12/22/2016 03:30:51 AM -

The details of the invoice in the web service response are captured in Vendors > Invoice
Information tab with invoice details and Payment Schedule. By default, the status of the
invoice is ‘OPEN’ to update the payment details.

ORACLE"
Financial Services Lending and Leasing

Vendors 5 [ Close

Vendors | Assignment Allocation  Work Orders || Folowup  Invoices

Invoice Information dpadd | AEdt || [ vew || 2 audit
View options AL =
Veww Fomatv [EJ] [[]Fresze jfiDetach wap | @R Velidate Invoice
& By S
Vendor ‘Company Branch Invoice # External Ref = Invoice Dt Due Dt Status Channel
'90DEMO-RDN_INTERFACE usoL usHQ 3851 23066216 12/22/2016 12/22/2016 CLOSE GENERIC RECOVE...
'90DEMO-RDN_INTERFACE usoL UsHQ 3849 23066207 12/21/2016 12/21/2016 OPEN GENERIC RECOVE...

Invoice Information

Gagewm | [
Invoice Dt 12/22/2016 Currency USDOLLAR
B Invoice Due Dt 12/22/2016 Estmated 122,00
Status CLOSE Invoice Amt 122.00

Vendor SODEMO-RDN_INTERFACE Agreed Amt 122.00

Company US01 Details Paid Amt 122,00
Branch USHQ Channel GENERIC RECOVERY INTERFACE
Invoice # 3651 StatusDt 12/22/2016
External Ref # 23066216 Address ADD12 ADD13 REDDING, CA 96001
Details | Tracking Attributes
Invoice Details Elview || o Audit L
View v Format v [ Freeze i Detach Wrap @
Work Order & Estimated Tnvoice Amt Agreed Amt Paid Amt Txn Post Dt Status Status Dt Authorized By Authorized Dt Colectble
WO:0021360 2016010011187 2758 10.00 10.00 10.00 10.00 12/22/2016 clLose 12/22/2016 N
WO:00Z1380 2016010001187 2758 100.00 100.00 100.00 100.00 12/22/2016 CLosE 12/22/2016 ¥
WO:00Z1380 2016010001187 2758 12.00 12.00 12.00 12.00 12/22/2016 cLose 12/22/2016 N

Payment Schedule  Related Invoice Mork Orders

Copyright © 1998,2015, Orade andor its affilates. Al rights reserved. About

System auto validates the invoice details which are received from third party system with
specific business rules before creating a record in the Invoice Information tab. Hence the
‘Validate Invoice’ button in the Information tab is disabled for invoice records from external
channel (Generic Recovery Interface) and the details are marked as view only.

For more information on business rules and working with Invoices tab, refer to ‘Vendors’
chapter.
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